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Preface

This guide describes how to use the Compound Discoverer™ application to qualitatively 
process RAW data files in a targeted workflow that evaluates the mass spectral data for the 
presence of specific compounds, a semi-targeted workflow that evaluates the mass spectral 
data for compounds with specific properties, or both.

To familiarize yourself with the Compound Discoverer application, follow the “Getting 
Started Tutorials” on page 30.

Related Documentation
The Compound Discoverer application includes these manuals as PDF files:

• Compound Discoverer User Guide

• Compound Discoverer Data Processing Quick Start 

• Compound Discoverer Data Review Quick Start 

• Compound Discoverer Reporting Quick Start 

The Compound Discoverer application also includes a Help system.

Contents

• Related Documentation

• System Requirements

• Installation Instructions

• Special Notices

• Contacting Us
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 To view the Compound Discoverer manuals 

From the application window, choose Help > Manuals.

–or–

From the Microsoft™ Windows™ taskbar, choose Start > All Programs (or Programs) > 
Thermo Compound Discoverer >.

System Requirements
The Compound Discoverer 1.0 application can process data files produced by high-resolution 
accurate-mass (HRAM) Thermo Scientific™ mass spectrometers, such as the Orbitrap 
Fusion™, Q Exactive™, and Exactive™.

Table 1 lists the the minimum hardware requirements and the software requirements for the 
processing computer.

Table 2 list the recommended hardware configurations for enhanced performance using the 
Compound Discoverer application.

Table 1. Hardware and software requirements for the processing computer

System Requirements

Hardware • 3.4 GHz dual-core processor

• 8 GB RAM

• 500 GB hard drive

• DVD-ROM and USB drive

• Display monitor resolution of 1920  1080

Software • Microsoft™ Windows™ 7 Pro SP1 (64-bit) operating system

• Microsoft .NET 4.5.1

• Microsoft Office 2010

• Mass Frontier™ 7.0 SR 3.0 

• Adobe™ Reader™ 10

• Adobe Flash™ Player 15
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To verify that the system meets the minimum requirements, follow these procedures:

• To check the computer specifications

• To check the font DPI for a Windows 7 system

 To check the computer specifications

1. From the Windows Explorer directory, right-click OSDisk (Drive:) (the directory for the 
hard drive where the operating system is installed) and choose Properties.

The OSDisk (Drive:) Properties dialog box opens. This dialog box lists the file system 
(NTFS or FAT) and the free disk drive space.

2. From the Windows Desktop, choose Start > Control Panel > System and Security > 
System.

The System page opens. This page lists the operating system; the processor type, speed, 
and number of cores; the installed RAM; and the system type (32-bit or 64-bit).

 To check the font DPI for a Windows 7 system

1. From the Windows Desktop, choose Start > Control Panel.

2. On the Adjust Your Computer’s Settings page, do the following:

a. For View By, select Category.

b. Under Appearance and Personalization, click Adjust Screen Resolution.

The Screen Resolution page opens.

3. Click Make Text and Other Items Larger or Smaller.

Table 2. Recommended hardware configurations

System Recommended configurations

Hardware • Intel Core™ i7 3930x @ 3.30 GHz processor (or equivalent)

• 3.4 GHz dual-core processor

• 32 GB RAM

• 1 TB SSD (solid-state disk) hard drive for OS

• 2nd 3 TB (conventional disk) hard drive for data storage

• DVD-ROM and USB drive

• Two 27 in. HD monitors: Display monitor resolution of 
1920 1080
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4. On the left panel, click Set Custom Text Size (DPI).

The Custom DPI Setting dialog box opens (see Figure 1).

Figure 1. Custom DPI Setting dialog box

5. Make sure that the DPI setting is 96 pixels per inch.

Installation Instructions
Compound Discoverer is a licensed application. Thermo Fisher Scientific provides a full 
version and a demo version of the application. For either version, you must use the license key 
provided to successfully install the software.

• Full version—Install the Compound Discoverer 1.0 application from the software media 
kit that includes a key-shaped USB flash drive with the installation executable and a small 
card with the license key.

• Demo version—Install the Compound Discoverer 1.0 application from the DVD. The 
license key is on the back of the DVD case.

This section contains the following topics:

• Upgrading the Mass Frontier Application

• Installing the Compound Discoverer Application

IMPORTANT  

• The Compound Discoverer 1.0 application requires the Mass Frontier 7.0 SR3 
application to run the FISh Scoring and FISh Tracer nodes. If you do not have this 
version of the Mass Frontier application on your computer, install it before you install 
the Compound Discoverer application. 

• The Compound Discoverer 1.0 installation process requires an Internet connection to 
validate the software license. If your computer does not have Internet access, see To 
install the Compound Discoverer application on a computer without Internet access. 
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Upgrading the Mass Frontier Application

If you already have Mass Frontier 7.0, 7.0 SR1, or 7.0 SR2 installed and licensed, use the 
following procedures to upgrade to Mass Frontier 7.0 SR3.

• To check the Mass Frontier 7.0 version

• To upgrade the Mass Frontier 7.0 application to the current SR3 version

• To install the Mass Frontier 7.0 SR3 application from a DVD

 To check the Mass Frontier 7.0 version

1. Open the Mass Frontier 7.0 application and choose Help > About. 

The About Mass Frontier 7.0 dialog box opens. 

2. Verify that the version number is 7.0.5.9 SR3.

3. If the version is lower than 7.0.5.9, upgrade the application.

 To upgrade the Mass Frontier 7.0 application to the current SR3 version

1. Go to www.highchem.com/index.php/support#. 

2. Download the SR3 executable under Mass Frontier 7.0 > Service Release 3 and save it 
to your local directory (Figure 2). 

Figure 2. Website location of the Mass Frontier 7.0 SR3 executable

3. Run the executable file to install the SR3 patch. 

4. After the installation is complete, verify that the About Mass Frontier 7.0 dialog box lists 
the software version as 7.0.5.9. 

http:\\www.highchem.com/index.php/support#
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 To install the Mass Frontier 7.0 SR3 application from a DVD

1. Insert the Mass Frontier DVD into your computer’s DVD-ROM drive. 

2. Follow the installation instructions.

3. Send your license request to ThermoMSLicensing@thermofisher.com and include the 
barcode number on the back of the Mass Frontier DVD case.

Installing the Compound Discoverer Application

Follow one of these procedures:

• To install the Compound Discoverer application on a computer with Internet access

• To install the Compound Discoverer application on a computer without Internet access

 To install the Compound Discoverer application on a computer with Internet access

1. Do one of the following:

• For the full version, insert the Compound Discoverer USB flash drive into a USB 
port on your computer.

• For the demo version, insert the Compound Discoverer DVD into the DVD drive on 
your computer.

2. Open Windows Explorer and select the USB or DVD drive to view its contents.

3. Double-click XInstall_Compound Discoverer.exe.

The installation wizard starts (Figure 3). 

Figure 3. Compound Discoverer installation wizard

mailto:ThermoMSLicensing@thermofisher.com
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4. Click Compound Discoverer 1.0 and continue the installation process.

The Minimum Product Requirements screen appears with a product requirements scan 
summary. If the computer meets the system requirements, the box displays the following 
summary: 

All the system minimum requirements checks passed.

5. When the License Activation dialog box opens, type the activation code in the Activation 
Code boxes.

• For the full version, enter the license key from the small card in the Compound 
Discoverer 1.0 software media kit.

• For the demo version, enter the license key from the back of the Compound Discoverer 
1.0 DVD case.

6. Complete the installation process.

 To install the Compound Discoverer application on a computer without Internet 
access

1. On the computer without Internet access, do the following:

a. Follow step 1 through step 4 of “To install the Compound Discoverer application on 
a computer with Internet access” on page x.

b. When the License Activation dialog box opens, do the following:

i. Type the activation code in the Activation Code boxes.

ii. In the If You Do Not Have an Internet Connection on this Computer area, click 
Export the License Request.

The Export License Request dialog box opens.

iii. Select the directory where you want to store the license request file, type a name 
for the file in the File Name box, and click Save.

Note  Installing the application on a Host computer without Internet access is a 
three-step process:

1. Export the Host computer information to a license request file, and then transfer 
the license request file to a computer with Internet access.

2. Activate the license request file, and then transfer the file back to the Host 
computer.

3. Import the activation information to the Host computer and complete the 
installation.

IMPORTANT  If an Activation Error dialog box opens, temporarily connect the 
computer to a network switch or hub that is turned on but is not connected to a 
network. Wait a few minutes. Then continue the installation process.
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c. Eject the flash drive or DVD from the computer and leave the License Activation 
dialog box open.

d. Transfer the license request file to a computer with Internet access. 

For example, copy the license request file to a read-writable USB flash drive. Insert 
the USB flash drive into a USB port on the computer that has Internet access and 
copy the File Name.licrequest file to an appropriate directory.

2. On a computer with Internet access, activate the license as follows:

a. Verify that you transferred the File Name.licrequest file to this computer.

b. Follow step 1 through step 3 of “To install the Compound Discoverer application on 
a computer with Internet access” on page x.

c. Click Offline Activation. 

The Import License Activation Request dialog box opens with the Thermo License 
Activation dialog box in the background. 

–or–

If the computer does not have the appropriate version of the .NET Framework, a 
message box appears in front of the installation screen (Figure 4).

Figure 4. .NET Framework initialization message box

d. Browse to the license request file that you copied to this computer and click Open. 

The Import License Activation Request dialog box closes, the Thermo License 
Activation dialog box becomes available, and the Activation Code boxes are 
populated with the license activation code from the license request file. 

e. Enter the appropriate information in the Contact Information area.

Note  Ensure that the license request file is not write-protected.

Note  The License Activation dialog box requires Microsoft Visual C++ ™ 
redistributables and .NET Framework 4.0 or later. If the redistributables are not 
present on the computer, the program installs them automatically. If the 
appropriate version of the .NET Framework is not present, click OK to close the 
message box. Then, click Microsoft .NET Framework 4.5.1.
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f. Click Activate. 

The program activates the license and stores it in the license request file.

g. Click OK when the following message appears:

Activation was successful.

h. Close the installation wizard.

i. Transfer the activated license request file back to the computer without Internet 
access.

For example, copy the activated license request file to a read-writable USB flash drive. 
Insert the USB flash drive into a USB port on the computer with no Internet access 
and overwrite the unactivated File Name.licrequest file with the activated File 
Name.licrequest file.

3. On the computer without Internet access, do the following:

a. Verify that you transferred the activated File Name.licrequest file to this computer. 

b. In the License Activation dialog box that you left open in step 1c, click Reimport the 
Activated License Request to Continue Activation.

The Import License Activation Request dialog box opens.

c. Browse to the activated license request file and click Open.

The Activation Success box opens and displays the following message:

Licenses successfully imported.

4. Complete the installation.

Special Notices
Make sure you follow the precautionary statements presented in this guide. The special 
notices appear in boxes.

Special notices include the following:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. You 
can use your smartphone to scan a QR code, which opens your email application or browser. 

 For Compound Discoverer customer support questions

Send an email message to CD.support@thermofisher.com.

Contact us Customer Service and Sales Technical Support

(U.S.) 1 (800) 532-4752 (U.S.) 1 (800) 532-4752

(U.S.) 1 (561) 688-8731 (U.S.) 1 (561) 688-8736

us.customer-support.analyze
@thermofisher.com 

us.techsupport.analyze
@thermofisher.com 

 To find global contact information or customize your request

1. Go to www.thermoscientific.com. 

2. Click Contact Us, select the Using/Servicing a Product option, and then 
type the product name. 

3. Use the phone number, email address, or online form. 

 To find product support, knowledge bases, and resources

Go to www.thermoscientific.com/support. 

 To find product information

Go to www.thermoscientific.com/lc-ms. 

Note  To provide feedback for this document: 

• Send an email message to Technical Publications (techpubs-lcms@thermofisher.com).

• Complete a survey at www.surveymonkey.com/s/PQM6P62. 

mailto:us.customer-support.analyze@thermofisher.com
mailto:us.customer-support.analyze@thermofisher.com
mailto:us.techsupport.analyze@thermofisher.com
mailto:us.techsupport.analyze@thermofisher.com
http://www.thermoscientific.com
http://www.thermoscientific.com/lc-ms
mailto:techpubs-lcms@thermofisher.com
http://www.surveymonkey.com/s/PQM6P62
mailto:CDsupport@thermofisher.com
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Introduction

Compound Discoverer is a qualitative data-processing application for the structural 
identification of small molecules. It can process the accurate-mass spectra from the entire 
product line of Thermo Scientific high-resolution mass spectrometers. It can also display the 
graphical data acquired from a variety of detectors: UV-visible and photodiode array (PDA) 
detectors that are controlled by a Thermo Scientific data system and third-party analog 
detectors that are connected to the analog input channels of a Thermo Scientific mass 
spectrometer.

Compound Discoverer Features
The Compound Discoverer 1.0 application includes the following features:

• A node-based processing workflow for the detection and structural elucidation of 
expected compounds and unknown compounds. You can minimize the processing time 
by filtering out non-relevant MS scans or by using only those nodes that are relevant to 
your experiments. 

• A study-based design for grouping analyses on the basis of experimental study variables 
and running sample-to-sample and sample-to-control comparisons.

• Multiple mass defect filters for minimizing false positives from structurally unrelated 
compounds.

Note  Compound Discoverer is a licensed software application. For information about 
installing the application, see “Installation Instructions” on page viii.

Contents

• Compound Discoverer Features

• Supported File Formats

• Compound Discoverer Window and Start Page

• Understanding the Basic Processing Workflows

• Getting Started Tutorials
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• A Fragment Ion Search (FISh) trace that displays a total ion chromatogram (TIC) trace of 
the summed intensities of the predicted fragment ions for a user-specified compound. 
The TIC trace includes the mass spectral peaks for fragment ions with an m/z value that 
falls within the specified mass tolerance window. The FISh tracer node predicts the 
MS/MS or higher fragments for a compound by using a general set of fragmentation rules 
or the Mass Frontier fragmentation libraries. The FISh Tracer node also provides XIC 
traces for individual fragment ions. 

• A pattern trace that displays a TIC trace of the summed intensities of the mass spectral 
peaks that match a specified pattern in the full MS scans. 

• Support of analog traces from UV, PDA, and radioisotope detectors.

• A structural confidence scoring (FISh scoring) and annotation tool for comparing the 
predicted fragments of expected compounds to their experimental MS/MS and MS3 
fragmentation scans.

• A custom explanation editor that consists of a drawing tool for creating custom structures 
on the basis of a compound’s theoretical exact mass and elemental composition (if 
available) and the FISh Scoring algorithm, which uses the proposed structure to evaluate 
the matching fragments in the MS/MS and higher scans.

• The Parameterless Peak Detection (PPD) algorithm for automatically detecting and 
integrating chromatographic peaks in extracted ion chromatograms.

• A manual peak integration tool for specialized traces.

• Editing tools for creating custom libraries of expected compounds, transformation 
reactions, and adducts. 
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• An isotope ratio editor that you can use to do the following: 

– Define custom patterns by using mass spectra from enrichment studies.

– Select the isotopes of interest in an isotope pattern for a specified elemental 
composition.

• A reporting package for creating custom report templates.

• The following visualization tools:

– A chromatogram viewer for evaluating chromatographic peaks and for comparing 
two or more traces by overlaying, stacking, or freezing plots from different detectors, 
such as a UV or radioisotope detector, or from different trace types, such as XIC 
traces, FISh traces, or pattern traces.

This figure shows overlaid and color-coded UV, TIC, pattern, and FISh traces.

– A spectral tree viewer for viewing the full MS scans, data-dependent MS/MS and 
MSn scans, and all-ion fragmentation (AIF) scans near the peak apex of each detected 
chromatographic peak. 

– A mirrored plot in the mass spectrum view for comparing an MS/MS reference 
spectrum to any other MS/MS or MS3 spectrum.
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– Color-coded rectangles in the full MS scans for expected compound hits for 
visualizing the isotopic pattern fit on the basis of both mass accuracy and relative 
intensity. The height and y-axis placement of each rectangle corresponds to the 
relative intensity window for the theoretical centroid. The width and x-axis 
placement of each rectangle corresponds to the mass tolerance window for the 
theoretical centroid (see Figure 38 on page 51).

– Color-coded centroids and structure annotations in the fragmentation scans of the 
expected compound hits help you to visually elucidate the transformation site. 
Centroids that match a predicted fragment for the parent compound (direct match) 
are displayed in green, and centroids that match a predicted fragment for a 
transformation product (shifted match) are displayed in blue.

Glucuronide conjugation
of the parent compound
Mass shift = 176.0321 Da
Mass defect shift = 31 mDa
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Supported File Formats
Table 3 describes the file types that the application recognizes, creates, or both.

Table 3. Supported file formats (Sheet 1 of 2)

File format Description

RAW Contains unprocessed data acquired from a high-resolution, 
accurate mass LC/MS/MS instrument with a Thermo Scientific 
data system that is layered on the Thermo Foundation™ platform.

MOL format (.mol), 
compressed structure 
(.mcs), template (.tml)

You can open structure files by using the Structure Editor or the 
Custom Explanations Editor.

For more information, see Adding and Editing Compounds with 
the Compound Editor and “Adding Custom Explanations” on 
page 231.

cdProcessingWF Contains the data processing instructions for the application. To 
create a processing workflow, you must start or open an analysis in 
a study.

For more information about processing methods, see “Creating 
and Editing Processing Workflows” on page 100.

cdAnalysis Stores the processing workflow information.

cdStudy Stores the study information, which includes the names and 
locations of the input files, the sample information, and the 
relationship between the input files. 

For more information about studies, see Chapter 2, “Creating 
Studies.” 

cdResult Contains the results produced by processing one or more raw data 
files and information about the processing workflow and raw data 
files that were used to process the raw data.

For information about opening a result file and reviewing its 
contents, see Chapter 4, “Reviewing the Analysis Results.” 

cdResultView Contains the layout settings that the application uses to display 
the result file’s tables and graphical views. In addition, these 
settings include the applied result filters.

cdReportTemplate Contains the layout for reports that extract data from the 
following items in a result file: one or more of the columns in one 
master table, one or more of the columns in the related tables, and 
one or more graphical views.
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Filter Set (.filterset) Contains the result filters created in the Result Filter view. User 
filter set files for data reduction when reviewing and reporting the 
data in Compound Discoverer result files.

mgf, mzML, mzDATA You can export the MS scans in a raw data file to an open file 
format that can be read by third-party mass spectrometry 
applications.

For information about exporting MS scans in a raw data file to an 
open file format, see “Spectrum Exporter Node” on page 118.

XML You can export each library to an XML file and you can import 
library entries from an XML file (see Chapter 6, “Modifying the 
Libraries.” 

text (.txt) You can save the data points in the graphical views to a text file. 

For more information, see “Mass Spectrum View Shortcut Menu 
Commands” on page 194 and “Chromatogram View Shortcut 
Menu Commands” on page 184.

EMF, BMP, JPG, GIF, 
PNG, TIFF

You can save the images in the graphical views as image files of the 
following file types: enhanced metafile (.emf), bitmap (.bmp), 
Joint Photographic Group (.jpg), graphic interchange format 
(.gif ), portable network graphics (.png), and tagged image file 
format (.tiff ).

You can open EMF files in a raster image editor or a vector image 
editor. 

For more information, see the topics listed above for the text (.txt) 
file format.

CSV You can export the contents of a result table to a CSV (.csv) file.

Table 3. Supported file formats (Sheet 2 of 2)

File format Description
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Compound Discoverer Window and Start Page
The startup window contains a title bar, a menu bar, a toolbar, and the Start Page. From the 
startup window, you can open all of the other application pages by choosing a menu 
command or by clicking a toolbar icon.

 To start the Compound Discoverer application

Do one of the following:

• From the taskbar, choose Start > All Programs (or Programs) > Thermo 
Compound Discoverer.

• From the computer desktop, double-click the Compound Discoverer icon, .

Figure 5 shows the Compound Discoverer window and the Start Page, which open when you 
start the application.

Figure 5. Compound Discoverer window

Note  This user guide uses the following terms to describe the user interface: 

• Page—A tabbed document. You can have many pages open simultaneously; however, 
only one of these pages is the active page.

• Dialog box—A graphical element that accepts user input. Only one dialog box can be 
open at a time. When it is open, a dialog box blocks you from working in other parts 
of the application. 

• View—A dockable window that you can move to a second monitor.

Menu bar Toolbar
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These topics describe the Compound Discoverer Start Page, menu bar, and toolbar:

• Using the Start Page

• Compound Discoverer Menu Bar

• Compound Discoverer Toolbar

“Working with Tabbed Documents” on page 15 describes how to open and close the pages 
that appear as tabbed documents in the Compound Discoverer window.

Using the Start Page

The Start Page is a tabbed document that you can place in the auto-hide mode. Use the Start 
Page to open studies and result files. The Start Page displays lists of the most recently opened 
study and result files. The left side of the Start Page contains helpful links to get you started 
with creating a new study, opening an existing study, or opening an existing result file. 

 To open the Start Page if it is not visible

Do one of the following:

• From the menu bar, choose View > Start Page.

• In the toolbar, click the Show Start Page icon, .

 To begin a new study

Under What Would You Like To Do?, click New Study.

The Create New Study dialog box opens. For information about the Create New Study 
dialog box, see “Starting a New Study” on page 66.

 To open an existing study

Under What Would You Like To Do?, click Open Study.

The Open Study dialog box opens. For information about opening an existing study, see 
“Opening an Existing Study” on page 64.

 To open a result file

Under What Would You Like To Do?, click Open Result.

The Open Result File dialog box opens. For information about reviewing the graphical 
and tabular data in a result file, see Chapter 4, “Reviewing the Analysis Results.” 

 To keep a study name or result file name at the top of its list

Click the pin icon to the left of the name.

The orientation of the pin changes from  to .
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Start Page Shortcut Menus

The Start Page has three shortcut menus: one controls the window’s docking properties and 
the other two control the contents of the Recent Studies and Recent Results lists.

 To open the shortcut menu that controls the window’s docking properties

Right-click the page tab.

 To open the shortcut menus for the file lists

Right-click an item in the list.

 To remove a result or study file from the list

Right-click the file and choose Remove From List from the shortcut menu.

For information about the shortcut menu that controls the window’s docking properties, see 
“Working with Tabbed Documents” on page 15.

Table 4 describes the shortcut menu commands that control the content of the file lists.

Table 4. File shortcut menu

Command Description

Open Opens the selected file.

Explore Path Opens the folder where the file is stored.

Remove From List Removes the selected file from the list.

Clear Recent List Clears the entire list, including the column heading. 

The Recent Results list reappears when you run an analysis that 
generates a result file.

The Recent Studies list reappears when you create a new study.
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Compound Discoverer Menu Bar

Table 5 describes the menu commands in the menu bar at the top of the Compound 
Discoverer window.

Table 5. Compound Discoverer menu bar (Sheet 1 of 3)

Menu Command Description

File > New Study Opens the Create New Study dialog box where you can start to create a new 
study (see “Starting a New Study” on page 66).

Open Study Opens the Open Study dialog box where you can select an existing study file to 
open.

The CD Study File type has the .cdStudy file name extension.

Open Result Opens the Open Result File dialog box where you can select an existing result file 
or result view file (see “Opening Result Files” on page 174).

Opening result files does not require an active software license.

The CD Result file type, which contains the data processing results, has the 
.cdResult file name extension. 

The CD Result View file type, which contains the display layout for the results 
tables and graphical views and the filter settings, has the .cdResultView file name 
extension. 

To restore the default layout for a result file, delete its associated CD Result View 
file.

Save Saves recent changes to the current active page (selected tab), for example, the 
current study page or result page.

Save All Saves recent changes to all of the open pages in the Compound Discoverer 
window.

Recent Studies Displays a list of recent studies.

Recent Results Displays a list of recent results.

Exit Closes the Compound Discoverer application.
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Reporting > Create Report Opens the Open Report Design Template dialog box where you select a report 
template to resolve specific data in the result file (see “Generating a Report with 
an Existing Report Template” on page 252).

This command is available when a result page is active.

Create Report 
Template

Opens the Customize Report dialog box where you set up the main properties of 
a report template (see “Creating a New Report Template” on page 254).

This command is available when a result page is active.

Edit Report 
Template

Opens the Open Report Design Template dialog box where you can choose an 
existing report template that you want to edit (see “Editing an Existing Report 
Template” on page 263).

This command is available when a result page is active.

Libraries > Compounds Opens the Compounds page where you can view or modify a list of compounds 
(see “Modifying the Compound Library” on page 315).

Ion Definitions Opens the Ion Definitions page where you can view or modify a list of ion 
definitions (see “Modifying the Ion Definitions Library” on page 341).

Adducts Opens the Adducts page where you can view or modify a list of adducts (see 
“Modifying the Adducts Library” on page 335).

Transformations Opens the Transformations page where you can view or modify a list of 
transformations (see “Modifying the Adducts Library” on page 335).

Table 5. Compound Discoverer menu bar (Sheet 2 of 3)

Menu Command Description
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View > Start Page Opens the Start Page, which lists the most recently opened result files and study 
files.

Job Queue Opens the Job Queue page (see “Working with the Job Queue” on page 165).

Mass Spectrum Opens the Mass Spectrum View (see “Working with the Mass Spectrum View” 
on page 188).

Chromatogram Opens the Chromatogram View (see “Working with the Chromatogram View” 
on page 179).

Result Filters Opens the Result Filters view (see “Using Result Filters for Data Reduction” on 
page 236).

Scatter Chart Opens the Scatter Chart view (see “Working with the Scatter Chart View” on 
page 194).

Result Summaries Opens the Summaries view (see “Viewing the Processing Summaries” on 
page 246).

Help > Compound 
Discoverer Help

Opens the Compound Discoverer Help file, which is a compiled Help file with 
Contents, Index, and Search tabs. The Help contains context-sensitive topics; 
that is, when you press F1, the Help topic that corresponds to the current area of 
the application opens.

How to Use the 
Help

Opens the Using This Help topic in the Compound Discoverer Help.

Glossary Opens the Compound Discoverer Help to the table of contents for the glossary.

Manuals Displays links to the Compound Discoverer User Guide, Quick Start Guides, and 
Release Notes.

License Manager Opens the License Manager page where you can activate your Compound 
Discoverer license or scan for missing application features.

Help >

(Continued)

Create Bug Report Creates a report of your computer’s configuration and stores it as a Compound 
Discoverer Bug Report (timestamp).zip on your computer Desktop.

To report software errors to Thermo Fisher Scientific, send a detailed error 
description with screen shots and attach this bug report to the email.

About Opens the Compound Discoverer dialog box where you can view lists of the 
installed components and processing workflow nodes.

Table 5. Compound Discoverer menu bar (Sheet 3 of 3)

Menu Command Description
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Compound Discoverer Toolbar

Table 6 describes the icons in the Compound Discoverer window toolbar from left to right.

Table 6. Toolbar icons (Sheet 1 of 2)

Icon Description

Opens the Create New Study dialog box where you can create a new study 
folder and study file.

Open an Existing Study icon—Opens the Open Study dialog box where you 
can select an existing study.

When you open a study file by using the Open Study dialog box, the 
application gives you the option of opening the current version or a previous 
version of the study file.

Opens the Open Result File dialog box where you can select a result file. When 
you open a result file by using the Open Result File dialog box, the application 
gives you the option of opening the current version or a previous version of the 
result file.

Save the Currently Active Item icon—Saves the currently active item, such as a 
study or result file. 

Save All Open Items icon—Saves all of the open pages, such as the study pages 
and the result pages.

Opens the Start Page if it is not already open and makes it the active page.

Opens the Job Queue page if it is not already open and makes it the active 
page.

Opens the Mass Spectrum View.

This icon is available only when a result file is the current page in the 
Compound Discoverer window and the Mass Spectrum View is closed.

Opens the Chromatogram View.

This icon is available only when a result file is the current page in the 
Compound Discoverer window and the Chromatogram View is closed.

Opens the Result Filters view as a floating window.

This icon is available only when a result file is the current page in the 
Compound Discoverer window and the Result Filters view is closed.

Opens the Scatter Chart view as a floating window.

This icon is available only when a result file is the current page in the 
Compound Discoverer window and the Scatter Chart view is closed.
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Opens the Summaries view.

This icon is available only when a result file is the current page in the 
Compound Discoverer window and the Summaries view is closed.

Opens the Open Report Design Template dialog box where you can select a 
report template (.cdReportTemplate).

This icon is available only when a result file page is open in the Compound 
Discoverer window. The result file page does not need to be the active page.

Opens the Customize Report dialog box where you can set up a custom report 
template.

This icon is available only when a result file page is open in the Compound 
Discoverer window. The result file page does not need to be the active page.

Opens the Open Report Design Template dialog box where you can select a 
report template (.cdReportTemplate).

This icon is available only when a result file page is open in the Compound 
Discoverer window. The result file page does not need to be the active page. 

Opens the Compounds page (compound library) where you can delete a 
library compound, import a library, or export the library.

To add new compounds to the library, click New on the Compounds page.

To edit a compound, select the compound and click Edit on the Compounds 
page.

Opens the Ion Definitions page (ion definitions library) where you can delete 
ion definitions, import a library, or export the library.

To add new ion definitions to the library, click New on the Ion Definitions 
page.

To edit an ion definition, select the definition and click Edit on the Ion 
Definitions page.

Opens the Adducts page (adducts library) where you can delete adducts, 
import a library, or export the library.

Opens the Transformation page (transformation library) where you can delete 
transformations, import a library, or export the library.

Table 6. Toolbar icons (Sheet 2 of 2)

Icon Description
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Working with Tabbed Documents

The following pages appear as tabbed documents in the Compound Discoverer window:

• Start Page ( )

• Study files (  Study Name )

• Result files (  Result File Name )

• Libraries (  Compounds, Adducts, Ion Definitions, and Transformations)

• Job Queue ( )

• Report Templates (  Report Template Name)

• License Manager ( )

While you can have all of the documents listed above open simultaneously, including multiple 
study files and result files, the number of tabs that the application can display is limited by the 
monitor size. As you open more files than the monitor can display, the tabs begin to disappear 
from view in the order that you opened the files. To indicate that one or more tabs are hidden, 
the Current Tab icon changes from  to  (Figure 6). To view the list of open files, click the 
Current Tab icon.

Figure 6. Compound Discoverer window with a list of open files

When you have two or more tabbed documents open in the same tab group, you can create 
more tab groups. Each tab group has its own Current Tab icon, . Figure 7 shows tab group 
examples.

List of open files

Current Tab 
icon
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Figure 7. Orientation of tab groups

 To display an open tabbed document when its tab is hidden

1. Click the Current Tab icon, , to display a list of open files.

2. Select the appropriate tabbed page from the list.

The selected page becomes active.

 To close a tabbed page

Do one of the following: 

Right-click the tab and choose Close from the shortcut menu.

–or–

Click the Close icon, , on the right side of the tab.

 To use the auto-hide feature

1. Right-click the page tab and choose Dockable.

The Auto Hide command becomes available for the Start Page and the Chromatogram 
and Mass Spectrum Views. This command remains unavailable for all other dockable 
pages. 

2. Right-click the page tab and choose Auto Hide.

Single tab group

Two vertical tab groups

Two horizontal tab groups

Current Tab icon
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3. To view the hidden page, click its tab.

4. To hide the page, click anywhere in the Compound Discoverer window outside the page 
borders.

Table 7 describes the shortcut menu commands that control the tabbed document properties. 

Table 7. Shortcut menu for the tabbed documents in Compound Discoverer (Sheet 1 of 2)

Command Description

Dockable This command is only available for the Start Page or the 
Chromatogram and Mass Spectrum Views.

Activates the Auto Hide command for the Start Page or the 
Chromatogram and Mass Spectrum Views.

For more information about the Chromatogram and Mass 
Spectrum Views, see “Working with the Graphical Views” on 
page 176. 

Tabbed Document Makes the page a tabbed document. 

This command is available for the Start Page, Job Queue page, 
License Manager page, library pages, study pages, result pages, and 
report template pages. 

For more information about these pages, see the following topics:

• “Working with the Job Queue” on page 165

• “Opening the License Manager” on page 375

• “Working with a Study Page” on page 70

• “Opening Result Files” on page 174

• “Editing an Existing Report Template” on page 263

Auto Hide This command is available only for the Start Page and the 
Chromatogram and Mass Spectrum Views when these pages are 
dockable windows.

Hides the page while leaving the tab visible. Clicking the tab 
opens the page. Clicking outside the page closes the page if more 
than one tabbed document is open. The location of the tab 
depends on the tabbed document’s position in the Compound 
Discoverer window.

Hide Closes the tabbed document.
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Move to Previous Tab 
Group

Changes the position of the tabbed document.

This command is available only when the Compound Discoverer 
window contains two or more tabbed groups.

Move to Next Tab 
Group

Changes the position of the tabbed document.

This command is available only when the Start Page is a tabbed 
document that belongs to a vertical or horizontal tab group. 

New Horizontal Tab 
Group

Moves the selected tabbed document to a new horizontal tab 
group.

This command is available only when there are two or more 
tabbed documents that belong to the same tab group in the 
Compound Discoverer window. Each tab group has its own 
Current Tab icon.

New Vertical Tab 
Group

Moves the selected tabbed document to a new vertical tab group.

This command is available only when there are two or more 
tabbed documents that belong to the same tab group in the 
Compound Discoverer window. Each tab group has its own 
Current Tab icon.

Table 7. Shortcut menu for the tabbed documents in Compound Discoverer (Sheet 2 of 2)

Command Description
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Understanding the Basic Processing Workflows
The Compound Discoverer application uses a node-based method to create custom 
processing workflows.

You can combine the following processing pathways to create branched processing workflows: 

• Finding Expected Compounds

• Detecting Unknown Compounds

• Adding Specialized Traces to the Processing Workflow

For information about creating and editing processing workflows, see “Creating and Editing 
Processing Workflows” on page 100.

Finding Expected Compounds

Figure 8 shows a basic processing workflow that uses the Compound Generator and Expected 
Finder nodes to find an expected parent compound and its dealkylation and transformation 
products. To find more than one expected parent compound, add more Compound 
Generator nodes to the Expected Finder node.

Figure 8. Processing workflow that finds one parent compound and its transformation products

During this targeted analysis, the following events occur:

1. The Spectrum Files node sends the file names and location of the input files to the 
connected nodes (typically the Spectrum Selector node, Analog Tracer node, or both of 
these nodes).

2. The Spectrum Selector node filters the MS scan data. 
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3. The Retention Time Aligner node chromatographically aligns non-reference samples 
against an associated reference sample by using the specified alignment algorithm.

4. The Compound Generator node creates a list of expected compound ions on the basis of 
the following user-specified parameter settings:

• Parent Compound

• Number of dealkylation and dearylation steps

• Number and type of transformation steps

• List of possible adduct ions

The Compound Generator node passes the following information to the Expected Finder 
node for each expected compound:

• Parent Compound

• Elemental composition of the expected neutral compound

• Molecular weight of the expected neutral compound

• Whether the expected compound is a product of a dealkylation step

• Transformations required to produce the expected compound

• Composition change between the parent and expected compound

It also passes the following information for each expected compound ion:

• Charge

• Theoretical m/z value

IMPORTANT  When the processing workflow includes the Expected Finder node, do 
not filter out all of the full (MS1) scans, as this node requires the full scan data. When 
the processing workflow includes the FISh scoring node, do not filter out the 
fragmentation scans, as this node uses them to provide a confirmation score for the 
expected precursor ions.

IMPORTANT  The Retention Time Aligner node is designed to chromatographically 
align separate raw data files that were acquired with the same instrument method and 
the same chromatographic column. The Retention Time Aligner node cannot align 
input files that were acquired with different chromatographic methods or different 
MS acquisition settings.

Note  The Compound Generator node does not send information to a result table. It 
sends information to the Expected Finder node, which requires input from at least 
one Compound Generator node. The Mass Defect Filter node can also process the 
input from one or more Compound Generator nodes.
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5. The Expected Finder node does the following by using the full (MS1) scan data from the 
Retention Time Aligner node and the information from the Compound Generator node 
(or multiple Compound Generator nodes):

a. Creates a set of mass tolerance and intensity tolerance rectangles for each expected 
compound ion (m/z value) on the basis of the theoretical m/z value for the ion, the 
user-specified mass tolerance window, the theoretical isotope pattern for the ion, and 
the user-specified intensity tolerance window for the isotopic ions (see Table 8 and 
Figure 9).

For example, the node creates the following set of rectangles for the monoisotopic 
protonated ion ([M+H]+1) of omeprazole. The elemental composition for this ion is 
C17 H20 N3 O3 S.

• User-specified mass tolerance window: ±5 ppm (default)

• User-specified intensity tolerance window: ±30% (default)

Figure 9. Rectangular search pattern

Table 8. Rectangular search pattern

Isotope Width Height

Theoretical m/z Mass range Theoretical
rel intensity

Intensity 
range

A0 346.12199 346.12026–346.12372 100.00% N/A

A1a

a Isotope with one carbon-13 atom

347.12530 347.12356–347.12704 19.15% 13.4 to 24.9%

A2b

b Isotope with one sulfur-34 atom

348.11783 348.11609–348.11957 4.57% 3.20 to 5.94%

A2c

c Isotope with two carbon-13 atoms

348.12802 348.12628–348.12976 2.17% 1.52 to 2.82%

In
te

ns
ity

%

m/z

100%

50%

0%

346.12 348.11

347.12530

348.11783
348.12802

347.12 348.12

346.12199 ± 0.00173

± 0.00174

± 0.00174
± 0.00174
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b. For each expected compound ion, the Expected Finder node does the following: 

i. Checks each full (MS1) scan that passes through the connected data processing 
node for centroids that match the mass and intensity tolerance rectangles. The 
pattern search (set of rectangles) looks for the base peak (most intense centroid) 
of the pattern first. 

In most cases, the base peak is the A0 centroid for the monoisotopic ion. But in 
some cases, for example, in compounds that contain two bromine atoms or four 
chlorine atoms, the isotopic peaks have a higher intensity than the monoisotopic 
peak.

ii. Draws a filtered XIC trace by summing the centroids found for each data point. 
If a data point does not contain the user-specified number of matching isotopes 
and the theoretical intensity of the missing isotope was above the noise threshold, 
the node assigns a 0 intensity value to the data point (Figure 10).

c. For each expected compound hit, the Expected Finder node creates a summed trace 
by summing the XIC traces of the associated expected compound ions. 

d. Detects and integrates the chromatographic peaks in each XIC trace. Does not report 
chromatographic peaks with an apex peak height that is below the user-specified 
minimum (chromatographic) peak intensity. If the average peak width of the peaks in 
the processed retention time range is greater than the setting for the Average Peak 
Width parameter, the Expected Finder node rejects all of the chromatographic peaks.

Figure 10. Filtered XIC trace (in blue) with a 0 intensity data point

Zero intensity 
data point

Filtered XIC trace (blue)

Integrated 
chromatographic peak
(gray shading)
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The Expected Finder node passes the following information to the Expected Compound 
Hits table for each expected compound that it finds in an input file: 

• RT (min)—Retention time of the chromatographic peak apex. 

• Best SD—Best spectral distance score between the measured and expected isotope 
patterns for the expected compound ions. When the node finds only one adduct ion, 
the best spectral score is equal to the score for the adduct ion that it found.

• Max # MI—Maximum number of matched isotopes for any of the adduct ions. 
When the node finds only one adduct ion, the maximum number of matched 
isotopes is equal to that for the adduct ion that it found.

• #Adducts—Number of adduct ions that it found.

• Area—Total area of the chromatographic peaks for the found adduct ions of the 
expected compound.

• Parent Area%—Relative area of the chromatographic peak for the expected 
compound as compared to the total area for all found peaks for the expected 
compound.

• Compound Area%—Relative area of the chromatographic peak for the expected 
compound as compared to the total area for all found peaks.

Note  A chromatographic peak with a 0 intensity value indicates one of the following:

• The user-specified mass tolerance, intensity tolerance, or number of required 
isotopes for the Expected Finder node is not suitable for this sample set. Modify 
these parameter settings and rerun the analysis.

–or–

• The chromatographic peak does not represent the presence of an expected 
compound. Ignore this chromatographic peak.

Note  If the node finds more than one adduct ion for an expected compound, the 
chromatogram is a summed trace.

Note  The parent area is the chromatographic peak area of the expected 
compound, rather than the area of the compound listed in the Parent Compound 
column. The compound listed in the Parent Compound column is the library 
compound that you selected in the Compound Generator node. In most analyses 
this compound is only one of the expected compounds.
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6. The Peak Consolidator node performs three functions:

• When the processing workflow includes both the Expected Finder node and the 
Unknown Detector node, it consolidates the chromatographic peaks found by these 
nodes on the basis of their m/z values and retention times in the Consolidated Peaks 
table.

• When the analysis includes aligned input files and the Compare with Control feature 
is turned on, it compares the area of a chromatographic peak in a non-reference file to 
the same chromatographic peak in a reference file.

• Adds an empty Custom Explanations table to the master table set in the result file. If 
the processing workflow does not include the Peak Consolidator node, you cannot 
add custom explanations to the result file.

For information about the master and related result tables that this processing workflow 
generates, see these topics:

• “Expected Compounds Table” on page 206

• “Expected Compound Hits Table” on page 208

• “Consolidated Peaks Table” on page 217

• “Custom Explanations Table” on page 221

• “Transformations Table” on page 227

• “Related Structures Table” on page 226

• “Input Files Table” on page 222

• “Chromatogram Peaks Table” on page 228

Figure 11 shows a schematic of the master and related tables for a basic targeted workflow. 
The Custom Explanations table is empty until you populate it. For information about adding 
custom explanations to the table, see “Adding Custom Explanations” on page 231.
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Figure 11. Result tables for a basic targeted workflow (without the FISh Scoring node)

Detecting Unknown Compounds

Figure 12 shows a basic processing workflow that uses the Unknown Detector node to find 
unknown compounds. 

Figure 12. Processing workflow that finds unknown compounds

Expected Compound Hits

Expected Compounds Consolidated Peaks Custom Explanations

Custom Explanations Custom Explanation Ions

Consolidated Peaks

Input Files

Input Files

Expected Compound Hits

Related Structures

Transformations

Expected Compound Hits

Expected Compound Ions

Related Structures

Input Files

Expected Compounds 

Chromatogram Peaks

1. Reads the input files list and sends information about the input files, 
including their file names and location, to the connected nodes.

2. Reads the input files and filters the MS scans in each input file by retention 
time, polarity, MS order, and so on.

3. Chromatographically aligns non-reference samples against a 
reference sample.

4. Extracts XIC traces from the full (MS1) scans. Groups isotopes and adducts. 
Reports the unknown compounds by molecular weight in the Unknown 
Compounds table. Reports the unknown compound hits by molecular weight 
and retention time in the Unknown Compound Hits table.

5. Consolidates the chromatographic peaks with the same m/z values and 
retention time in the Consolidated Peaks table and creates an empty 
Custom Explanations table.
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For information about the result tables that this processing workflow generates, see these 
topics:

• “Unknown Compounds Table” on page 212

• “Unknown Compounds Hits Table” on page 214

• “Unknown Compound Ions Table” on page 224

• “Chromatogram Peaks Table” on page 228

• “Consolidated Peaks Table” on page 217

• “Custom Explanations Table” on page 221

• “Input Files Table” on page 222

Figure 13 shows a schematic of the master and related tables for a basic untargeted workflow. 
The Custom Explanations table is empty. For information about adding custom explanations 
to the table, see “Adding Custom Explanations” on page 231.

Figure 13. Result tables for a basic untargeted workflow

Unknown Compound Hits

Unknown Compounds Consolidated Peaks Custom Explanations

Custom Explanations Custom Explanation Ions

Consolidated Peaks

Input Files

Input Files

Unknown Compound Hits

Unknown Compound Hits

Unknown Compound Ions

Input Files

Unknown Compounds 

Consolidated Peaks

Chromatogram Peaks
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Using the Mass Defect Filter Node to Find Structurally Related Compounds

Figure 12 shows a processing workflow that finds or removes unknown compounds that are 
structurally related by their mass defects.

Figure 14. Processing workflow that finds unknown compounds

You can enter the elemental compositions for the filters directly in the Mass Defect Filter node 
or you can connect a set of generated elemental compositions from the Compound Generator 
node to the node.

Figure 15 shows an example where the elemental compositions for omeprazole and its 
oxidation product are entered directly in the Custom Compositions area of the Mass Defect 
Filter node. It also shows an example where the Compound Generator node passes the 
elemental compositions for omeprazole and its oxidation product to the Mass Defect Filter 
node. The end result is the same list of compounds in the Unknown Compounds table for 
both methods.

1. Reads the input files list and sends information 
about the input files, including their file names 
and location, to the connected nodes.

2. Reads the input files and filters the MS 
scans in each input file by retention time, 
polarity, MS order, and so on.

3. Chromatographically aligns non-reference 
samples against a reference sample.

5. Extracts XIC traces from the full (MS1) 
scans. Groups isotopes and adducts.

Reports unknown compounds by 
molecular weight in the Unknown 
Compounds table and by m/z value and 
retention time in the Unknown Compound 
Hits table.

6. Consolidates the chromatographic peaks within 
same m/z and RT tolerance windows in the 
Consolidated Peaks table and creates an empty 
Custom Explanations table.

4. Filters the mass spectral peaks in full 
(MS1) scans by charge state and by using 
multiple mass defect windows.
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Figure 15. Two ways to generate the same list of unknown compounds with the Mass Defect Filter node

Mass Defect Filter node 
with 

custom compositions

Compound Generator node

Set to generate 
elemental compositions for omeprazole 
and its oxidation product.

Mass Defect Filter node 
with input from a 

Compound Generator node

Oxidized 
omeprazole 
and 
omeprazole

–or–
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Adding Specialized Traces to the Processing Workflow

You can extract the following specialized traces from raw data files: 

• Single-wavelength UV trace

• Spectrum maximum PDA trace

• Wavelength range PDA trace

• Single-wavelength PDA trace

• Analog detector trace from a detector, such as a radioisotope detector that is connected to 
the Analog Input channels of a Thermo Scientific mass spectrometer

• Pattern trace

• Fragment Ion Search (FISh) trace

• Total ion chromatogram trace (TIC)

• Extracted ion chromatogram trace (XIC)

• Base peak ion chromatogram trace (BPC)

Figure 16 shows a basic processing workflow that extracts an analog trace, a mass 
chromatogram trace, a pattern trace, and a FISh trace.

Figure 16. Processing workflow that finds unknown compounds

1. Reads the input files list and sends 
information about the input files, including 
their file names and location, to the 
connected nodes.

2. Reads the input files and filters the MS 
scans in each input file by retention time, 
polarity, MS order, and so on.

3. Chromatographically aligns 
non-reference samples with a 
reference sample.
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Getting Started Tutorials
Compound Discoverer is a study-based application. A study is where you define the variables 
for each sample, such as the sample type and sample matrix. A study is also where you set up 
the relationship between the samples. 

Each study can include one or more analyses. After you create a study and run an analysis, you 
can review, rework, and reprocess the analysis from the Analysis Results page of the study.

To familiarize yourself with the Compound Discoverer workflow, Thermo Fisher Scientific 
recommends that you create a practice study and process a set of input files. To create a 
practice study, use the example raw data files. To process the example files, use the example 
processing workflow or build a custom processing workflow by following the instructions in 
this tutorial.

Figure 17 shows the workflow for the getting started tutorials. The default compound library 
contains information for the compound of interest, omeprazole, in the example raw data files. 

For the tutorials, use the example files provided on the software installation media. You can 
find these files on the Compound Discoverer USB key in the following folder: Omeprazole 
Example Study\RAW Files. Copy these files to your computer.
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Figure 17. Getting started workflow

Start the Compound 
Discoverer application.

Create a new study and define the 
relationship between the samples.

Start a new analysis and select the 
files that you want to process.

Open the result file, review and filter the data, 
and create custom explanations.

Create a report template 
and print a report. 

Build a new processing 
workflow.

Submit the analysis to 
the job queue.

Add the parent compound to the 
Compound library.
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Follow these tutorials to process the example raw data files, review the result file produced by 
the analysis, create a custom template, and print a report.

• Tutorial 1: Running a Targeted Analysis

• Tutorial 2: Reviewing the Analysis Results

• Tutorial 3: Creating and Printing Reports

Tutorial 1: Running a Targeted Analysis

Follow these procedures to set up and run a targeted analysis:

1. To check whether the Compound library contains the compound of interest

2. To create a new study with the example raw data files

3. To start a new analysis

4. To select the input files that you want to process

5. To build a custom processing workflow

6. (Optional) To save the processing workflow as a template

7. To submit the analysis to the job queue

 To check whether the Compound library contains the compound of interest

1. From the menu bar, choose Libraries > Compounds.

The Compounds page opens. The default Compound library that ships with the 
application contains only one compound, omeprazole.

2. If your library contains a large number of compounds, type Omeprazole in the filter row 
of the Name column.

If your library does not include omeprazole, add it as described in the next procedure.

 To add a compound to the Compound library

1. Download a 2D structure file from the Internet. 

2. From the menu bar, choose Libraries > Compounds.

The Compounds page opens.

3. On the Compounds page, click New.

The Compound Editor dialog box opens.

4. In the Name box, type the compound name.
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5. Add the compound structure as follows:

a. In the Compound Editor toolbar, click the Load Structure from Disk icon, . 

The Open Structure dialog box opens.

b. In the Known Structure Formats list, select the format of the structure file.

The Compound Editor dialog box supports the following file formats:

• MOL Format (.mol file name extension)

• Compressed Structure (.mcs file name extension)

• Template (.tml file name extension).

c. Select the structure file of interest and click Open.

The chemical structure appears in the drawing pane of the Compound Editor dialog box, 
and the application automatically populates the Elemental Composition and Molecular 
Weight boxes. 

6. If the structure is not visible or it is only partially visible in the pane, right-click the pane 
and choose Select All from the shortcut menu. Then, while pressing the SHIFT key, drag 
the structure into the pane.

7. Click Save to add the new compound to the Compound library.

The Compound Editor closes.

8. Click  on the Compounds tab to close the Compound library.

 To create a new study with the example raw data files

1. From the Compound Discoverer menu bar, choose File > New Study.

The Starting a New Study dialog box opens.

2. In the Starting a New Study dialog box, do the following:

a. In the Study Name box, type a name for your new study. 

For example, type Omeprazole.

b. Click the browse icon, , to the right of the Studies Folder box and select the 
directory and the folder where you want to store the individual study folders. 

For example, browse to your local disk drive or a location on your local network. 
Click New Folder to create a new folder. Then, name the new folder Drug Studies.

c. Click Create Study. 

The application creates a folder with your study name, for example, Omeprazole. 
The application stores the new study file with the same name, for example 
Omeprazole.cdStudy, in the Omeprazole folder. The application stores the 
Omeprazole folder in the Drug Studies folder (Figure 18).
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The Study Name page opens with the Study Definition page displayed (Figure 18). 
The Study Summary area displays the names of the studies folder and the folder for 
the current study.

Figure 18. Open study page with the Study Definition page displayed

3. Add one study factor as follows:

a. In the Study Factors area, choose Add > Categorical Factor.

An editor for the new categorical factor appears with the focus in the new factor box. 
If you do not click anywhere else on the page, the focus remains in the new factor box 
(Figure 19). 

Figure 19. Editor for a categorical study factor (variable)

b. Type Matrix.

Your text entry overwrites the new factor text.

c. In the box to the left of the Add button, type Urine.

Study command 
bar

Folder hierarchy

 Drug Studies folder

Omeprazole folder

Omeprazole.cdStudy

Note  When you make a change to a study, an asterisk (*) appears to the right of 
the study name on the study page tab. The asterisk indicates that the study 
contains unsaved changes. 
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d. Click Add.

The text “Urine” appears in the Items list.

e. Click Apply.

4. To add input files to the study, do the following:

a. In the Study command bar, click Add Files.

The Add Files dialog box opens.

b. Browse to the following folder where you copied the files: 

c. Select the example raw data files and click Open.

• Urine_0-3_GSH_PhII_01.raw

• Urine_3-5_GSH_PhII_01.raw 

The Input Files page opens (Figure 20). 

Figure 20. Input Files page with selected input files

d. Verify that you selected the appropriate files. To remove one or more files, select the 
files that you want to remove and click Remove Files in the Study command bar.

5. To select the sample type for each sample, do the following:

a. Click the Samples tab.

b. In the Sample Type column, select the Control sample type for 
Urine_0-3_GSH_PhII_01, and keep the default sample type of Sample for the other 
sample. 

c. In the Matrix (study factor) column, select Urine for both samples.

Figure 21 shows the sample type selections. 

Note  In this tutorial, you process two samples to learn how to use the Compare 
with Control feature. Neither of the provided raw data files is from a true control 
sample (predose sample from the study participant). Both samples are 
post-dosage samples.
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Figure 21. Samples page with unsaved changes

6. To set up the relationship between the samples, do the following:

a. Click the File Relations tab.

b. In the File Relations command bar, click Auto Detect File Relations.

Figure 22 shows the file relationship for the example raw data files.

Figure 22. Aligned files

7. While the study page is the active page, save the new study by choosing File > Save in the 
menu bar or by clicking the Save the Currently Active Item icon in the toolbar.

The asterisk disappears from the study page tab.

Keep the study open to the File Relations page and go to the next procedure.

Note  For information about using the fill-down feature, see “To fill a set of 
contiguous rows with the same value” on page 85.

File Relations 
command bar

Note  For more information about using the Auto Detect File Relations command, 
see “Setting Up the Relationship Between the Input Files” on page 88.
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 To start a new analysis

1. If you have not already done so, create a new study, select the input files to be included in 
the study, and set up the relationship between the input files as described in the previous 
procedure, “To create a new study with the example raw data files” on page 33.

2. Click New Analysis in the Study command bar.

The Analysis pane appears to the right of the study pages, and the Workflows tab appears 
in the set of study pages. 

Keep the File Relations page and the Analysis pane open and go to the next procedure.

 To select the input files that you want to process

1. If you have not already created a study and opened the Analysis pane, do so now.

2. Drag the aligned group of input files from the File Relations page to the Input Files area 
of the Analysis pane (Figure 23).

Figure 23. Dragging input files to the Analysis pane

The application automatically populates the Result File box with the name of the last 
input file (Figure 24).

The Caution symbol on the Processing Step title bar remains until the Workflow Tree 
area contains a valid processing workflow.

Figure 24. Analysis pane with two input files

Placing the cursor 
over this icon opens a 
pop-up message box 
with troubleshooting 
information.
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 To build a custom processing workflow

1. Click the Workflows tab.

The Workflows page opens.

2. Select the Spectrum Files node in the Workflow Nodes pane and drag it to the Workflow 
Tree pane. See Figure 25, Figure 26, and Figure 27.

Figure 25. Selecting the Spectrum Files node in the Workflow Nodes pane

Figure 26. Dragging the Spectrum Files node to the Workflow Tree pane

Figure 27. Dropping the Spectrum Files node in the Workflow Tree pane
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The Spectrum Files node is the starting workflow node for all processing workflows. It 
reads the input files list and sends the file names and location of the raw data files to the 
connected nodes (typically the Spectrum Selector node, which is required for MS scans, 
and the optional Analog Tracer node).

3. Select the Spectrum Selector node and drag it to the Workflow Tree pane.

The application automatically connects the Spectrum Files node to the Spectrum Selector 
node. 

4. Select the Retention Time Aligner node, drag it to the Workflow Tree pane, and position 
the node below the Spectrum Selector node.

The Retention Time Aligner node chromatographically aligns non-reference samples 
against an associated reference sample. If the input file set does not include a reference 
file, the application does not align the samples, and the processing time that it allots to 
the Retention Time Aligner node is insignificant.

5. Connect the Spectrum Selector node to the Retention Time Aligner node as follows:

a. Place the cursor over the Spectrum Selector node. 

Five white boxes appear, with one box at the center of the node and the other boxes at 
the center of each side.

b. Click one of the white boxes until a red border and an arrowhead appear. 

c. Continue holding the mouse button down as you drag the arrowhead to the 
Retention Time Aligner node.

A green border appears around the Retention Time Aligner node. When you release 
the mouse button, a directional arrow connects the input node to the output node.

6. To create a processing workflow that searches the scan data for omeprazole and its 
dealkylation and transformation products, do the following:

a. Drag the Expected Finder node to the Workflow Tree pane and position it below the 
Retention Time Aligner node. Then, connect the Retention Time Aligner node to 
the Expected Finder node. 
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b. Drag the Compound Generator node to the Workflow Tree pane and position it 
near the Expected Finder node. Then, connect the Compound Generator node to the 
Expected Finder node. 

c. Drag the FISh Scoring node to the Workflow Tree pane and position it near the 
Expected Finder node. Then, connect the Expected Finder node to the FISh Scoring 
node. 

d. Drag the Peak Consolidator node to the Workflow Tree pane and position it below 
the Expected Finder node. Then, connect the Expected Finder node to the Peak 
Consolidator node.

Notice that the Run command in the Analysis pane is unavailable. The Run 
command does not become available until the Workflow Tree pane contains a valid 
processing workflow and the Input Files area in the Analysis pane contains one or 
more input files. The Run command is unavailable because the Compound 
Generator node requires user input. 

e. Set up the parameters for the Compound Generator node as follows:

i. In the Workflow Tree pane, click the Compound Generator node.

The Parameters pane opens and displays the parameters for the Compound 
Generator node (Figure 28).
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Figure 28. Targeted compound processing workflow, showing the default parameter 
settings for the Compound Generator node

ii. In the Compound list, type O. If Omeprazole is the only library compound that 
begins with an O, it appears in the box. Otherwise, scroll up or down in the list 
of compounds and select Omeprazole.

iii. Under Dealkylation, keep the default parameter settings (apply a maximum of 
one dealkylation step).

iv. Under Transformations, select the following chemical reactions:

– In the Phase I list, select the Oxidation check box.

– In the Phase II list, select the Glucuronide Conjugation check box.

– Keep the default parameter settings for the remaining parameters.
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With these parameter settings (maximum of one dealkylation step and one 
glucuronide conjugation step, up to three oxidation steps, and a maximum total of 
three steps), the Compound Generator node predicts the reaction products of 
omeprazole generated by the following 12 reaction pathways (Table 9). For more 
information about the Compound Generator node, see “Compound Generator 
Node” on page 153.

Figure 29 shows the analysis setup for the two example raw data files.

Table 9. Reaction pathways for this processing workflow

Reaction pathway

1. No reaction steps—Parent compound

2. Dealkylation

3. Dealkylation, Glucuronide Conjugation

4. Dealkylation, Oxidation

5. Dealkylation, Oxidation, Glucuronide Conjugation

6. Dealkylation, Oxidation, Oxidation

7. Oxidation

8. Glucuronide Conjugation

9. Oxidation, Oxidation

10. Oxidation, Glucuronide Conjugation

11. Oxidation, Oxidation, Glucuronide Conjugation

12. Oxidation, Oxidation, Oxidation
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Figure 29. Example analysis

If the processing workflow is valid, the Run command becomes available. When you 
add more than one input file to the Analysis pane, the As Batch check box becomes 
available.

f. Check the parameter settings for the Peak Consolidator node as follows:

i. In the Workflow Tree pane, click the Peak Consolidator node.

The Parameters pane opens and displays the parameters for the Peak 
Consolidator node.

ii. Keep the default parameter settings. 

The Peak Consolidator node contains the Compare with Control feature, and by 
default, the Compare with Control parameter is enabled (set to True).
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 (Optional) To save the processing workflow as a template

1. In the Workflow box below the Workflows command bar, type a name for the processing 
workflow template. Then, click the Workflow box in the Processing Step area to copy the 
name to the Analysis pane.

2. In the Description box, type a general description for the processing workflow.

The application displays this description in the Description column on the Job Queue 
and Analysis Results pages.

3. In the Workflows command bar, click Save (Figure 30).

Figure 30. Naming and saving the processing workflow as a template

The Save Workflow dialog box opens.

4. Select an appropriate folder for this template and click Save.

 To submit the analysis to the job queue

1. To create one result file for the two input files, leave the As Batch check box clear.

When you run the targeted workflow on a set of aligned input files (one or more samples 
and one control), the application aligns the retention time of the components in the 
sample file with the retention time of the components in the control file.

2. In the Result File box, rename the result file to Target Omeprazole. cdResult.

3. Click Run to submit the analysis to the job queue.

The Job Queue page opens and an asterisk appears to the right of the study name.

4. When the run is completed, save the study by choosing File > Save All in the Compound 
Discoverer menu bar, leave the Job Queue page open, and then go to the next procedure.

Note  When you run two or more input files as a batch run by selecting the As Batch 
check box, the application uses the input file name for each result file and does not 
allow you to change the file name in the Result File box.

Renamed
result file
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Tutorial 2: Reviewing the Analysis Results

Follow these procedures to review the analysis results:

1. To open the result file generated by the analysis

2. To review the table of expected compounds

3. To reduce the number of expected compound hits to review

4. To inspect the remaining rows in the Expected Compound Hits table

5. To compare the fragmentation spectra of a metabolite and the parent compound

6. To add custom explanations

 To open the result file generated by the analysis

Open the result file by double-clicking the completed run on the Job Queue page.

The result file opens as a tabbed document in the Compound Discoverer window 
(Figure 31).

By default, the Chromatogram View opens in the upper right, the Mass Spectrum View 
opens in the upper left, and a set of tabbed tables opens in the bottom half of the page. 
Neither the Chromatogram View nor the Mass Spectrum View is populated with data.

The current table is the Consolidated Peaks table. The first row of the Consolidated Peaks 
table displays the results for the chromatographic peak with the largest area.
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Figure 31. Result file generated by processing the example files

 To review the table of expected compounds

1. Click the Expected Compounds tab.

This table lists one parent compound for each Compound Generator node that is 
connected to the Expected Finder node.

2. To sort the columns and bring the parent compound (no dealkylation or transformation 
reactions) to the first row, do the following:

a. Click the Dealkylated column heading to sort the rows by whether a dealkylation 
reaction occurred.

b. Hold down the CTRL key and click the Transformations column heading.

Figure 32 shows the Expected Compounds table with the parent compound sorted to the 
top of the table (no dealkylation reactions and no transformations). The Checked and 
Compound Area [%] (Max.) columns are hidden. 
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Figure 32. Expected Compounds table 

3. Click the first row.

Composite chromatograms for both input files appear in the Chromatogram View 
(Figure 33). One chromatogram is displayed as a blue trace and the other is displayed as a 
green trace. The integrated peak area is shaded in gray.

4. Right-click the Chromatogram View and choose Show Legend from the shortcut menu.

5. Right-click the Chromatogram View and choose Legend Size > 2 Rows from the 
shortcut menu.

Figure 33. Composite chromatograms for both input files

6. To view the composite chromatograms for all twelve reaction products and to compare 
the chromatographic peaks areas in the two input files, do the following:

a. Click Show Related Tables below the Expected Compounds table.

b. Click the Input Files tab.



1 Introduction
Getting Started Tutorials

48 Compound Discoverer User Guide Thermo Scientific

c. Click each row in the Expected Compounds table and inspect the chromatograms in 
the Chromatogram View and the chromatographic peak areas in the Area column of 
the Input Files table (Figure 34). 

As you click each row in the Expected Compounds table, review the area values:

• The value in the Area (Max.) column of the Expected Compounds table matches 
the value in the Area column for one of the input files. 

• The Total Area (%) and Compound Area (%) values are the same because the 
analysis targeted only one parent compound (omeprazole).

Figure 34. Viewing the composite chromatograms

7. Click the Expected Compound Hits tab.

The Expected Compound Hits table lists the results per input file. The chromatographic 
peaks found for the product compound that you selected in the Expected Compounds 
table are listed in descending order by peak area (Figure 35). 
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8. In the Expected Compound Hits table, sort the File ID column by clicking the column 
header. 

Review the area columns (Figure 35):

• The Area column lists the areas for each chromatographic peak found for an expected 
compound (same formula, MW, and reaction pathway).

• The Parent Area [%] column lists the relative percent area of the selected 
chromatographic peak to the summed area of all the chromatographic peaks found in 
the XIC trace for the related expected compound of a specific parent compound. 

• The Compound Area [%] column lists the relative percent area of the selected 
chromatographic peak to the summed area of all the chromatographic peaks found 
for all the expected compounds for the same parent compound (omeprazole).

Figure 35. Comparison of the area values in the Expected Compounds table to the area values 
in the Expected Compound Hits table

 To reduce the number of expected compound hits to review 

a. Click the Expected Compound Hits tab in the set of master tables.

b. From the menu bar, choose View > Result Filters.

The Result Filters view opens as a floating window (Figure 36).

For each input file, the sum of the Parent Area [%]
for the expected compound hits of the related
expected compound = 100%.

For each input file, the Compound Area [%] 
for each expected compound hit of the 
related expected compound is a percentage 
of the total chromatographic peak area for 
all of the expected compounds found for the
same parent compound (omeprazole).
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c. In the left pane of the Result Filters view, make sure that the Expected Compound 
Hits table is selected.

d. In the right pane of the Result Filters view, set up a filter that removes hits with peak 
areas below 1% of the parent area:

i. Click Add Property and select Compound Area [%] from the dropdown list.

ii. Click the (pink) relation list and select Is Greater Than or Equal To. 

iii. Type 1 in the box to the right of the (pink) relation list.

e. Click Apply Filters.

Figure 36 shows the Compound Area [%] filter for the Expected Compound Hits 
table.

Figure 36. Result filter for the Expected Compound Hits table

 To inspect the remaining rows in the Expected Compound Hits table

1. In the Chromatogram View, inspect the chromatographic peak shape (Figure 37). 

Figure 37. Chromatogram for a single input file

2. In the Mass Spectrum View, inspect the isotope pattern for the full MS scan. 

The mass spectral peaks in the full MS scan are color-coded as follows:
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• Lavender bars indicate centroids for A0 (monoisotopic) ions. The x-axis position and 
the width of the bar reflect the expected m/z value of the centroid and the 
user-specified mass tolerance window, respectively. The Expected Finder node 
searches for the monoisotopic peaks associated with the selected ion species, for 
example, [M+H]+1, [M+Na]+1, and so on. In this tutorial, you selected only the 
protonated ion species.

• Green rectangles indicate matching centroids for isotopic ions. When you zoom in 
on the matching centroid, the x-axis position and width of the rectangle reflect the 
expected m/z value of the centroid and the user-specified mass tolerance window, 
respectively. The y-axis position and height of the rectangle reflect the expected 
relative intensity of the centroid and the user-specified intensity tolerance window, 
respectively.

• Red rectangles indicate centroids that are missing from the expected isotopic pattern. 

• Blue rectangles indicate centroids that are missing from the expected isotopic pattern 
but that are also expected to have an intensity below the measured baseline noise 
[determined by the Fourier transform mass spectrometry (FTMS) mass analyzer].

Figure 38 shows the matching centroids for an oxidized and conjugated metabolite of 
omeprazole.

Figure 38. Matching centroids for an omeprazole metabolite

 To compare the fragmentation spectra of a metabolite and the parent compound

1. In the Expected Compound Hits table, sort the Dealkylated and Transformations 
columns to bring the parent compound to the top of the table.

A0 (mass spectral peak for the monoisotopic protonated ion)

A1 (one carbon-13 atom)*
A2 (two carbon-13 atoms)**

*Mass shift for carbon-13 = 1.003355 Da
**Mass shift for two carbon-13 = 2.00671 Da
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2. For the parent compound, click the row with the largest peak area.

3. In the spectral tree pane of the Mass Spectrum View, click the MS2, data-dependent 
(DDF) scan (scan #1605).

The annotated fragmentation scan appears in the right pane (Figure 39). Notice that the 
value in the FISh Coverage legend matches the value in the Best FISh Coverage column.

Figure 39. Fragmentation scan of omeprazole

4. Right-click the Mass Spectrum View and choose Use As Reference from the shortcut 
menu.

5. Click the row for a metabolite of interest, for example, click the metabolite produced by a 
glucuronide conjugation that has a Best FISh Coverage score of 38.71. 

A mirror plot appears in the Mass Spectrum View. The MS2 spectrum for omeprazole is 
on the bottom and the MS2 spectrum for the metabolite is on the top (Figure 40).

Notice that the value in the FISh Coverage legend matches the value in the Best FISh 
Coverage column.

= 7/18 × 100 = 38.89%

Note  The FISh Scoring node cannot calculate a Best FISh Coverage score for 
compounds that lack data-dependent (DDF) scans. This means that the FISh Scoring 
node cannot calculate Best FISh Coverage scores for data acquired with a Thermo 
Scientific Exactive™ mass spectrometer or chromatographic peaks that contain only 
all-ion fragmentation (AIF )scans. 

Best FISh Coverage # Direct Matches
# Direct Matches # Unmatched Centroids+
---------------------------------------------------------------------------------------------------------------------------------- 100=
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Figure 40. Mirror plot with the data-dependent scan for omeprazole set as the reference

 To add custom explanations

1. In the Expected Compound Hits table, right-click the row of interest and choose Add to 
Custom Explanations from the shortcut menu.

2. Click the Custom Explanations tab to open the Custom Explanations table.

The table contains a row for your new custom explanation.

3. To edit the information in the new row, right-click the row and choose Edit from the 
shortcut menu.

= 12/31 × 100 = 38.71%

Best FISh Coverage # Direct Matches # Shifted Matches+

# Direct Matches # Shifted Matches # Unmatched Centroids+ +
---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 100=

Tip  The Custom Explanations table is part of the result file only when the processing 
workflow includes the Peak Consolidator node. For best results, always include the 
Peak Consolidator node when the processing workflow contains an Expected Finder 
node, an Unknown Detector node, or both of these nodes; and connect these nodes 
to the Peak Consolidator node.
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The Custom Explanation Editor opens with the Description page displayed (Figure 41).

Figure 41. Custom Explanation Editor dialog box

4. To assign a name to this custom explanation, type a name in the Name box.

5. To assign a structure to this custom explanation, open a MOL file or use the drawing 
tools to draw a structure.

The application checks whether the calculated exact mass of the structure matches the 
molecular weight and the elemental composition (if available) of the selected peak within 
the mass tolerance (for XIC trace creation) that you specified in the Expected Finder or 
Unknown Detector node. 

6. Rerun the FISh scoring algorithm as follows:

a. Click the FISh Scoring tab.

b. Select the Apply FISh Scoring check box.

c. Select the Use Fragmentation Libraries check box (Figure 42).
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Figure 42. FISh Scoring page

d. Click Save.

The application recalculates the FISh Coverage score and annotates the 
fragmentation spectra on the basis of the proposed structure.



1 Introduction
Getting Started Tutorials

56 Compound Discoverer User Guide Thermo Scientific

Tutorial 3: Creating and Printing Reports

Follow these procedures to create report templates and print reports:

1. To create a report template for the Custom Explanations table

2. To save a report as a template

3. To export the contents of a report to a file

4. To print the report

 To create a report template for the Custom Explanations table

1. On the result file page, click the Custom Explanations tab.

2. From the menu bar, choose Reporting > Create Report Template.

The Customize Report dialog box opens (Figure 43).

3. Set up the basic features of the report as follows:

a. In the Reported Table list, make sure that Custom Explanations is selected.

b. Under Columns, clear the Checked check box. Keep the remaining column 
selections.

c. To view the selected columns in a vertical layout, do the following:

i. Select the Custom Explanations table heading in the list of data items. 

ii. To the right of Appearance, select the Transpose Data check box.

Selecting this check box transposes the data from columns as it appears in the 
result table to a two-column layout of rows with each column heading in row 1 
and the associated data in row 2.

d. Expand the Graphs list and select the Chromatogram Trace check box.

e. In the General Settings area, select the appropriate paper size in the PaperKind list.

Tip  When you select a table name in the data item list, the application 
automatically clears the Transpose Data check box. For each table that you 
want to transpose, select the table name to highlight it in blue, and then 
select the Transpose Data check box. 
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Figure 43. Settings for the Custom Explanations report

4. Click OK to close the dialog box and accept the settings.

The report designer page opens (Figure 44).

Data items
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Figure 44. Report designer page with your selections for the Custom Explanations table

5. Click the Preview Report icon, , to preview the report.

The Report Preview dialog box opens with a preview of the first page of the report. Notice 
that the structure is only partially visible (Figure 45).

Figure 45. Preview of Custom Explanations report

Cropped structure
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6. Click OK to close the dialog box and return to the report designer page.

7. Make more space for the picture container that holds the structure by shifting the design 
items down as follows:

a. Make more space at the bottom of the DetailSection by dragging the PageFooter 
handle down (Figure 46). Begin by adding about 1.0–1.5 inches.

b. Select all of the design items that are below the picture container, starting just below 
the picture and dragging the cursor down the vertical ruler to the last item. 

Figure 46 shows the selected vertical range.

Figure 46. Selected items in the DetailSection of the workspace

c. With the items selected, press the down arrow key on the keyboard until there is 
adequate space above for the picture (Figure 47).

Selected 
range

PageFooter 
handle

Picture container (not selected)
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Figure 47. Items moved down to make space for the picture

8. Enlarge the picture container as follows:

a. To view the container’s size as you change it, click the Dimension Lines icon, , in 
the toolbar at the bottom of the report designer page.

b. Enlarge the height of the container by dragging down the bottom border.

c. Enlarge the width of the container by dragging the right border farther right.

Dimension Lines icon
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9. To preview the report, click the Preview Report icon, , to display the Report Preview 
dialog box. Check whether the picture container is sized appropriately (Figure 48). Then, 
click OK to close the dialog box and return to the report designer page.

Figure 48. Visible structure in the enlarged picture container 

10. When you are satisfied with the report layout, do one or more of the following: 

• Save the report layout as a template.

• Export the contents of the report to a file. 

• Print the report.

 To save a report as a template

1. In the report designer toolbar, click the Save As icon, .

The Save Report Template As dialog box opens.

2. Select the directory where you want to store the template.

3. Type a name in the File Name box.

4. Click Save to save the template and return to the report designer page.
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 To export the contents of a report to a file

1. In the report designer toolbar, click the Print Report icon, .

The Report Print dialog box opens.

2. At the right end of the toolbar, choose Export > File Type.

The Save As dialog box opens.

3. Select the directory where you want to store the file, type a name in the File Name box, 
and click Save.

 To print the report 

1. In the report designer toolbar, click the Print Report icon, .

The Report Print dialog box opens.

2. In the Current Page/Total Number of Pages box, check how many pages are in the report.

3. Click the Print icon, , make the appropriate selections in the Print dialog box, 
including any advanced settings, and click OK. 
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2

Creating Studies

In the Compound Discoverer application, you process your raw data files (run analyses) 
within the study environment. This chapter describes how to create a Compound Discoverer 
study. In addition, this chapter describes the features of a study page, including its command 
bar and set of tabbed pages.

When you create a study, the application creates a study file (.cdStudy) and a study folder. The 
study file contains a list of input files (Xcalibur raw data files) with their associated sample 
information and a list of analyses with their associated result files (.cdResult). The sample 
information includes the sample type of each input file and the relationship between the input 
files. The study folder contains the study file and the result files that the application generates 
during data processing. Figure 51 on page 66 shows the folder hierarchy for study and result 
files.

The application stores the name and location of the input files that you add to the study. If 
you delete an input file from the specified folder location after you add it to a study, the 
following warning symbol appears to the left of the ID column for the deleted file on the 
Input Files page:  File Name does not exist. For information about resolving this issue, see 
“To resolve the input files list when you move a study or the raw data files” on page 81.

A study template is a study file that contains the study factors of interest.

Contents

• Opening a Study

• Starting a New Study

• Working with a Study Page

• Setting Up the Study Variables and Adding a Description of the Study

• Managing the Input Files in a Study

• Selecting the Sample Type and Study Factors for Each Input File

• Setting Up the Relationship Between the Input Files

• Saving a Study File
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For information about the Analysis Results page of the study page or reviewing or 
resubmitting an analysis that the Compound Discoverer application has completed, see 
“Reprocessing an Analysis” on page 170.

To create a new study, follow these procedures in order:

1. Opening a Study

2. Setting Up the Study Variables and Adding a Description of the Study

3. Managing the Input Files in a Study

4. Setting Up the Relationship Between the Input Files

5. Saving a Study File

Opening a Study
Follow the appropriate procedure to open an existing study or to create a new study.

• Opening an Existing Study

• Starting a New Study

For general information about the study command bar and pages, see “Working with a Study 
Page” on page 70. 

Opening an Existing Study

Follow one of these procedures to open an existing study. When you open an existing study, 
the study opens to the Analysis Results page. The study tab includes an image of two test 
tubes, , on the left, the study name in the middle, and a close icon, , on the right. When 
you make changes to a study, an asterisk (*) appears to the right of the study name to indicate 
unsaved changes.

 To open an existing study from the Start Page

1. If the Start Page is closed, do one of the following to open it:

• From the Compound Discoverer menu bar, choose View > Start Page.

• In the Compound Discoverer toolbar, click the Show Start Page icon, .

2. Do one of the following:

• Under What Would You Like to Do?, click Open Study to open the Open Study 
dialog box. Select a study file and click Open.

–or–

• Under Recent Studies, click the study name of interest. 
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The Start Page lists the 20 most recent studies. The study name appears in blue 
hypertext. Placing the cursor over a study name underlines it (Figure 49).

Figure 49. Start page

 To open an existing study from the Compound Discoverer window

Do one of the following:

• From the Compound Discoverer menu bar, choose File > Open Study to open the 
Open Study dialog box. Select a study file and click Open.

–or–

• In the Compound Discoverer toolbar, click the Open an Existing Study icon, . 
to open the Open Study dialog box. Select a study file and click Open.

The study page opens as a tabbed document with the Analysis Results page displayed 
(Figure 50).

Figure 50. Study page with the Analysis Results page displayed

Study name
in blue hypertext

Menu barOpen an Existing Study icon
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Starting a New Study

This topic describes how to set up the directory structure for a new study. You can use any 
study as a study template, which is a study that contains the study factors of interest.

Figure 51 shows the hierarchy of the Compound Discoverer folders. The studies folder, which 
is the top-level folder for all of your studies or a particular set of studies, holds one or more 
second-level study folders. Each second-level study folder holds one study file (.cdStudy) and 
one or more result files (.cdResult). 

Figure 51. Studies folder structure 

Note  You can create more than one top-level folder for your studies; however, when you 
do so, you must take care when selecting the top-level folder for a new study folder.

Study 1.cdStudy

Study 2.cdStudy

Study 3.cdStudy

File B1.cdResult

File A1.cdResult

File C1.cdResult

Studies

Study 2

Study 3

Study 1
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 To create a new study or a new study template

1. From the Compound Discoverer menu bar, choose File > New Study.

The Starting a New Study dialog box opens (Figure 52).

Figure 52. Starting a New Study dialog box

2. In the Study Name box, type a name for the new study.

The application uses the specified name for the study file (.cdStudy) and the study folder 
where it stores the study file.

3. Select the top-level folder where you want to store the new study folder as follows:

a. Click the browse icon, , to the right of the Studies Folder box. 

The Select Folder dialog box opens. 

b. Browse to an appropriate folder or create a new folder.

c. Click Select Folder.

The folder name and location appears in the Studies Folder box.

4. To extract the study factors from another study, do the following:

a. Click the browse icon, , to the right of the Study Template File box. 

The Select Template Study File dialog box opens.

b. Select a study template file with the appropriate study factors.

c. Click Open.

The name and location of the study template file appear in the Study Template File 
box.

5. Click Create Study.

The following events occur:

• A new study page opens in the Compound Discoverer window.

• A link to the new study appears on the Start Page.

• The new study (second-level) folder appears in the selected top-level folder, and the 
new study file appears in the new study folder. 
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Figure 53 shows the directory structure for the following entries:

• Top-level folder: Drug Studies (example)

• Second-level folder: New Drug (example)

• File name of the new study: New Drug.cdStudy

Figure 53. New Drug folder with New Drug.cdStudy file

To continue setting up a complete study, see “Managing the Input Files in a Study” on 
page 79. If you are creating a study template by defining only the study factors, see “Setting 
Up the Study Variables and Adding a Description of the Study” on page 72.

Specifies the name of the study and its folder. The application stores 
the study file and the result files in this folder.

Specifies the top-level folder, where you want the application 
to store the current study folder and other study folders.
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Starting a New Study Dialog Box Parameters

Table 10 describes the parameters in the Starting a New Study dialog box.

Table 10. Starting a New Study dialog box parameters

Parameters Description

Study Name Defines the name of a study file and the name of the folder where 
the application stores the file. The application also stores result 
files (.cdResult) processed within this study in this folder.

Studies Folder Specifies the folder where you want to store the named study 
folder.

Study Template File Specifies the study file (.cdStudy) that contains the study factors 
(study variables) that you want to use for the new study. 

The application extracts these variables from the Study Definition 
page of the template and adds them to the Study Definition page 
of the new study.

Buttons

Create Study Creates the study file and the study folder. The application stores 
the following items in these locations:

• Study file (.cdStudy) in the study folder of the same name

• Study folder in the selected studies folder

Cancel Closes the Create New Study dialog box without creating a new 
study file and folder.
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Working with a Study Page
Use a study page to select the raw data files that you want to include in the study, to set up the 
sample information for these files, and to set up the relationship between these files.

In addition, you can open result files, review the details of an analysis, and reprocess an 
analysis from the Analysis Results page of the study page.

For information about opening a study, see “Opening a Study” on page 64. For information 
about adding and removing input files, see “Managing the Input Files in a Study” on page 79.

 To open an empty Analysis pane and an empty Workflows page

In the study command bar, click New Analysis.

An empty analysis pane opens to the right of the study page and the Workflows tab 
appears in the tab set (Figure 54). Once you open the Analysis pane, the New Analysis 
and Open Analysis Template commands become unavailable. Opening the Analysis pane 
does not affect the study.

Figure 54. Empty Analysis pane on the right side of the study page

 To open an analysis template

1. In the study command bar, click Open Analysis Template.

The Open Analysis Template dialog box opens.

2. Browse to the appropriate folder and select an analysis template.

3. Click Open.

The Analysis pane appears on the right side of the study page and the Workflows tab 
appears in the tab set. An analysis template usually contains a processing workflow.
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Study Page Parameters

The study page is a tabbed document that contains a command bar and several tabbed pages. 
The study tab includes an image of two test tubes, , on the left, the study name in the 
middle, and a close icon, , on the right. When you make changes to a study, an asterisk (*) 
appears to the right of the study name and indicates unsaved changes.

Table 11 describes the parameters on a study page.

Table 11. Study page parameters (Sheet 1 of 2)

Command or page Description

Commands

Add Files Opens the Open dialog box where you select the input files 
(Xcalibur raw data files) that you want to include in the study.

For more information, see “Managing the Input Files in a 
Study” on page 79.

Remove Files Executes one of two actions:

• Removes the selected files on the Input Files page when it 
is the active page.

• Removes the selected analysis results on the Analysis 
Results page when it is the active page.

For more information, see “Managing the Input Files in a 
Study” on page 79.

New Analysis Opens the Analysis pane and adds the Workflows tab to the 
tab set on the study page. The Workflows page itself is empty.

This command is unavailable when the Analysis pane is open. 

Open Analysis Template Opens the Analysis Template dialog box where you select an 
analysis template.

This command is unavailable when the Analysis pane is open.

Tabbed pages

Study Definition Use this page to set up study factors and to view the study 
name, file location, creation date, modification date, and 
description.

When study factors are in use, you cannot delete them.

Input Files This page opens when you add files to the study (see 
“Managing the Input Files in a Study” on page 79). This page 
lists the file ID, file name, and sample information for each 
raw data file.
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Setting Up the Study Variables and Adding a Description of the Study
You can select the study factors (variables), such as time point, organism, matrix, and so on, 
by selecting a study template when you create the study; you can set up the study factors on 
the Study Definition page; or you can use a combination of these two methods. After you 
create a study, you can edit the study factors (variables) on the Study Definition page.

There are two types of study factors: categorical and numeric. Categorical study factors 
include non-quantifiable categories such as organism, matrix, tissue, gender, and so on. 
Numeric study factors include variables that you can quantify such as time, amount, 
concentration, and so on.

Follow these procedures as needed:

• To open the Study Definition page

• To add a categorical study variable

• To add a numeric factor

• To delete a study factor

• To create a new study factor by using the Copy and Paste commands

• To edit a study factor

• To save the changes

 To open the Study Definition page

On the study page, click the Study Definition tab.

If you selected a study template when you created the study, the Study Factors area 
contains one or more factors (variables). 

Samples Use this page to select the sample type and study factors for 
each raw data file (see “Selecting the Sample Type and Study 
Factors for Each Input File” on page 85).

File Relations Use this page to set up the relationship between the reference 
and non-reference files (see “Setting Up the Relationship 
Between the Input Files” on page 88).

Analysis Results Use this page to access the result files created within the study, 
to review the analysis details for the results files, and to 
reprocess an analysis. 

Table 11. Study page parameters (Sheet 2 of 2)

Command or page Description
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Figure 55 shows an empty Study Factors area.

Figure 55. Study Definition page of the study page

 To add a categorical study variable

1. From the Study Factors menu bar, choose Add > Categorical Factor.

The categorical factor editor appears with [new factor] automatically selected. See 
Figure 56. 

Figure 56. Categorical factor editor

2. Leave the cursor in the Study Factors pane and type the name of the factor, for example, 
Matrix.

The application replaces [new factor] with your text.

3. For each item that you want to add to the Items list, do the following:

a. In the Items box (to the left of the Add and Delete buttons), type a study factor item, 
for example, Urine.

Note  If you click another pane before typing the factor name, the typed text appears 
in the pane where you placed the cursor. For example, if you click the Study 
Description pane and type text, the text appears in the Study Description pane.
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The Add button becomes available (Figure 57).

Figure 57. Entering items in the item box

b. Click Add.

The current item appears in the Items list. 

4. To save the study factor, click Apply.

The factor editor collapses to show only the study factor name and the Items list 
(Figure 58). The items appear in alphabetical order.

Figure 58. Named factor with a list of items

 To add a numeric factor

1. From the Study Factors menu bar, choose Add > Numeric Factor.

The numeric factor editor appears with [new factor] automatically selected (Figure 59).

Figure 59. Numeric factor editor

2. Leave the cursor in the Study Factors pane and type the name of the factor, for example, 
Time Point.

The application replaces [new factor] with your text.

Note  If you click another pane before typing the factor name, the typed text appears 
in the pane where you placed the cursor. For example, if you click the Study 
Description pane and type text, the text appears in the Study Description pane.
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3. In the Factor Unit box, which appears when you place the cursor to the right of Factor 
Unit, type a unit for the factor, for example, hrs.

The unit is only a text label.

4. For each numeric value that you want to add to the Values list, do the following:

a. In the box to the left of the Add and Delete buttons, type a numeric value.

The Add button becomes available (Figure 60).

Figure 60. Entering numeric values in the values box

b. Click Add.

The value appears in the Values list in ascending numeric order. 

5. To save the study factor, click Apply.

The factor editor collapses to show only the study factor name and the Values list 
(Figure 61).

Figure 61. Numeric factor with a list of values

 To delete a study factor

1. In the title bar of the factor of interest, click .

The Remove Study Factor dialog box appears (Figure 62).

Figure 62. Remove Study Factor dialog box

2. Click Yes to delete the study factor.
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 To create a new study factor by using the Copy and Paste commands

1. Select the factor that you want to copy.

The title bar of the selected factor turns blue.

2. Click Copy.

3. Click Paste.

A copy of the selected factor appears in the Study Factors area.

4. Edit the factor as described in the next procedure, “To edit a study factor.” 

 To edit a study factor

1. In the factor title bar, click Edit.

The text entry box and the Add and Delete buttons appear. For a numeric factor, the 
Factor Unit box also appears.

2. To change the unit for a numeric factor, select the current unit and type a new unit.

3. To add more entries to the Items or Values list, type alphanumeric text in the appropriate 
box, and then click Add.

4. To delete a list entry, select the entry and click Delete. 

You cannot delete a value when it is in use—that is, when you have selected the value for 
a sample.

 To save the changes

With the study page open, click the Save the Currently Active Item icon, , in the 
Compound Discoverer toolbar.



 2 Creating Studies
Setting Up the Study Variables and Adding a Description of the Study

Thermo Scientific Compound Discoverer User Guide 77

Study Definition Page Parameters

Use the Study Definition page of the study page to view information about the study, to enter 
a description of the study, and to set up the study variables.

Figure 63 shows a Study Definition page with a categorical study factor and a numeric study 
factor.

Figure 63. Study Definition page

Table 12 describes the parameters on the Study Definition page.

Table 12. Study Definition page parameters (Sheet 1 of 2)

Parameter Description

Study Summary pane

Study Name Displays the study name.

Study Directory Displays the file location where the study is stored.

Last Changed Displays the date and time of the last saved change to the study.

Creation Date Displays the creation date of the study file.

Study Description pane

Use this pane to enter and store a description of the current study. 

Study Factors pane

Menu commands

Paste Pastes the entries in the copied factors below the existing factors.

Copy Copies the selected factors to the Clipboard.
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Add > Categorical Opens a blank categorical factor editor.

Add > Numeric Opens a blank numeric factor editor.

Factor box

Title bar Displays the factor name. You can edit this text.

Buttons and icons

Apply Saves the current entries in the factor editor.

Cancel Closes the item or value entry box and removes any entries made 
during the current editing session. Does not remove previously 
saved entries.

Deletes the factor from the study.

Add Adds an item to a categorical factor or a numeric value to a 
numeric factor.

Delete Deletes the selected item or value from the list in the respective 
Items or Values area.

Text entry boxes

[new factor] Use this box to type a factor name.

Item box Use this box to type the name of an item that you want to add to 
the Items list for a categorical factor.

Value box Use this box to type a numeric value that you want to add to the 
Values list for a numeric factor.

Table 12. Study Definition page parameters (Sheet 2 of 2)

Parameter Description
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Managing the Input Files in a Study
Use the Input Files page to manage the input files in a study. The input files for the 
Compound Discoverer application are raw data files (.raw) acquired by a Thermo Scientific 
mass spectrometer. 

To manage the input files in a study, follow these procedures as needed:

• To add input files to the study

• To sort the input files

• To display the details for an input file

• To open the details for all of the input files

• To remove a raw data file from the input files list

• To resolve the input files list when you move a study or the raw data files

 To add input files to the study

1. Do one of the following:

a. In the study command bar, click Add Files.

The Add Files dialog box appears.

b. Browse to the appropriate folder and select the raw data files of interest.

c. Click Open.

–or–

a. In the set of study page tabs, click the Input Files tab.

b. Using Windows Explorer, open the folder that contains the raw data files of interest.

c. Drag the raw data files that you want to add to the study to the Input Files page and 
drop the files anywhere on the page.

The application populates the table rows on the Input Files page as follows:

• ID—Displays a unique ID in the following format: F#, where # is a unique integer.

• Name—Displays the file name of the input file. 

• Sample Information—Assigns Sample as the default Sample Type and n/a for each 
study factor.

If the study already contains the files that you are attempting to add, the Adding 
Duplicate Files message box opens. If the study already contains the files but in a different 
directory folder, the Adding Files message box opens. 
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2. If a message box opens, do one of the following:

• If the Adding Files message box opens and contains a message about changing the 
storage path, click OK to close the dialog box. Then, click OK in the next message 
box. If the application does not automatically update the directory path (in less than 
a minute), save the study. Then close and reopen the study.

• If the Adding Duplicate Files message box opens, click OK to close it.

If you remove the file from the input files table, the application does not reuse the ID. The 
default sample type is Sample.

 To sort the input files

Click a column heading.

 To display the details for an input file

Click the Show Details icon, , for the file of interest.

A subordinate row appears below the selected row. You can modify the sample type and 
study variables in this row.

 To open the details for all of the input files

Click the Show Study File Details bar to the left of the table.

 To remove a raw data file from the input files list

1. Select the row of interest and click Remove Files in the study command bar.

Depending on whether you have run an analysis with the selected input file, one of the 
following message boxes appears:

• If you have not run an analysis with the selected input file, the Remove Input File 
message box appears.
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• If you have run an analysis with the selected input file, the Remove Analysis Result 
Files message box appears.

2. Do one of the following:

• In the Remove Input File message box, click Yes to remove the input file from the 
study. Or, click No to close the message box without removing the file.

–or–

• In the Remove Analysis Result Files message box, click Remove Files to remove the 
input file and its associated analyses from the study. Or, click Cancel to close the 
message box. 

When you remove an input file from the study, the analyses associated with the input 
file disappear from the Analysis Results page, but the result files (.cdResult) remain in 
the study folder.

 To resolve the input files list when you move a study or the raw data files

1. Display the details for the missing files and check their original location.

2. If you know where the files are currently stored, add the files to the study as described in 
“To add input files to the study” on page 79.

The Adding Files confirmation box opens. The progress remains at 0.0% until you click 
OK (Figure 64).

Note  If the network or directory path changes between the study and the raw data 
files, an exclamation symbol ( ) appears to the left of the file ID. 
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Figure 64. Adding Files confirmation box with progress information

3. Click OK to continue. 

The Adding Duplicate Files message box opens. The progress continues to remain at 
0.0% until you click OK.

4. Click OK to continue.

The application restores the connection between the study and the raw data files.

5. Save the change (see “Saving a Study File” on page 93).
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Input Files Page Parameters

Use the Input Files page of the study page to review the raw data files in the study and their 
associated sample information (Figure 65).

Figure 65. Input Files page with two input files

Table 13 describes the parameters on the Input Files page.

Show Study File 
Details bar

Study command bar

Show Details icon

Select All icon

Table 13. Input Files page parameters (Sheet 1 of 2)

Parameter or feature Description

Show Study File Details bar Clicking this vertical gray bar (on the far left side of the 
page) opens the study file details for all of the input files.

When you click the Show Study File Details bar, it turns 
blue.

Select All icon ( ) Clicking the Select All icon selects all of the table rows.

The Select All icon is located on the top left corner of the 
page to the right of the Show Study File Details bar.

Show Details icon The first table column contains the Show Details icon for 
each row. 

Clicking this icon does the following:

• Opens the study file details for the current raw data file.

• Rotates the icon by 90 degrees and turns it red, from the 
hidden state ( ) to the show details state ( ).
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Columns

ID Displays a unique ID in the following format: F#, where # is 
a unique integer. If you remove a file, and then add it again, 
the application updates the ID number.

Name Displays the file name of the raw data file.

File Types Displays the file type of the input file. The Compound 
Discoverer 1.0 application supports raw data files (.raw).

Sample Information Displays the sample type and any other selected study 
factors.

Expanded row columns

First row

Sample Displays a unique identifier for the input file.

Sample Identifier Displays the file name of the raw data file.

Sample Type Specifies the sample type. You can select one of these sample 
types from this list: Sample, Control, Blank, or Standard.

When you change the sample type on the Input Files page, 
the application updates the sample type on the Samples 
page.

Study factor (variable) 
columns

Specify the study variables. You can modify the study 
variable selections.

When you change the variables on the Input Files page, the 
application updates the sample type on the Samples page.

Second row—File

ID Displays a unique ID (reserved for future implementation).

Name Displays the file name and directory location of the raw data 
file.

Date Modified Displays the acquisition date and time of the raw data file.

Size Displays the size of the raw data file in bytes.

Table 13. Input Files page parameters (Sheet 2 of 2)

Parameter or feature Description
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Selecting the Sample Type and Study Factors for Each Input File
In the Compound Discoverer application, you can identify the sample type and other study 
factors for each input file on either the Samples page or the Input Files page of the study page.

Follow these procedures to select the sample type and study factors on the Samples page:

• To open the Samples page

• To select the sample type for each sample

• To select the study factor or factors for each sample

• To fill a set of contiguous rows with the same value

• To view additional information for each input file

 To open the Samples page

On the study page, click the Samples tab.

For information about the study page, see “Working with a Study Page” on page 70. 

 To select the sample type for each sample

Do one of the following:

• For each sample, select one of the following in the Sample Type list: Sample, Control, 
Blank, or Standard.

–or–

• If you want to select the same sample type for multiple consecutive rows, follow this 
procedure, “To fill a set of contiguous rows with the same value.” 

 To select the study factor or factors for each sample

Do one of the following:

• For each sample, make the appropriate selections in each factor column.

–or–

• If you want to select the same factor item or value for multiple consecutive rows, 
follow this procedure, “To fill a set of contiguous rows with the same value.” 

 To fill a set of contiguous rows with the same value

1. Drag the cursor up or down a range of consecutive cells. 

Releasing the mouse button highlights the selected cells in a light blue, and the row where 
you release the button in a darker blue as shown in Figure 66. 
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Figure 66. Column cells selected by dragging the cursor down the column

2. On the keyboard, press the F2 key. 

A thick gray border appears around the selected cells. The last cell in the selection; that is, 
the cell where you released the mouse button in step 1, has a light blue background. 
Figure 67 shows the effect of pressing the F2 key.

Figure 67. Cell selection with a thick gray border

3. On the keyboard, press the Down or Up arrow keys, until you populate the cell with the 
light blue background with the selection you want (Figure 68).

Figure 68. Cell with a light blue background containing your selection 

Selected cells that are 
highlighted with a light 
blue background

Cell with your 
selection
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4. On the keyboard, press Enter.

The application populates the selected cells with the same selection (Figure 69). 

Figure 69. Same selection for the matrix sample variable

 To view additional information for each input file

Click the expand icon to the left of the Sample Identifier column.

The expanded row displays the full file name and location, the file size in kilobytes, and 
the acquisition time of an Xcalibur raw file or the creation time of a common format data 
file.

Samples Page Parameters

Use the Samples page to select the sample type and study variables (factors) for each raw data 
file.

Use the filter row to limit the sample list to specific samples.

Figure 70 shows the Samples page.

Figure 70. Samples page with the file name of the first sample displayed

Same selection in all 
of the selected cells
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Table 14 describes the parameters on the Samples page.

Setting Up the Relationship Between the Input Files
When you submit a set of input files for processing, you can process the data in one of two 
ways:

• Set up the analysis to produce one result file for each input file.

–or–

• Set up the analysis to produce one result file for the entire set of input files.

When you set up an analysis that produces one result file from multiple input files and the 
processing workflow includes the Retention Time Aligner node, the Peak Consolidator node, 
or both of these nodes, the application assumes that you want to compare the 
chromatographic peaks in each non-reference file to those in a corresponding reference file. If 
you have not already set up the relationship between the files, a validation message appears 
when you start the analysis. You can choose to ignore the message, or you can stop the run, 
open the File Relations page, and set up the relationship.

Table 14. Samples page parameters

Parameter Description

Columns

Sample Displays a unique number for the sample (S#).

Sample Identifier Displays the file name of the raw data file.

Sample Type Lists the sample type of the raw data file.

Selections: Sample, Control, Blank, or Standard

Study factor columns Lists the study variable selection for the raw data file.

You can add, remove, or edit the study variables (factors) on the 
Study Definition page (see “Setting Up the Study Variables and 
Adding a Description of the Study” on page 72).

Columns in the expanded rows

File Name Displays the file name and directory location of the raw data file.

File Size Displays the size of the raw data file in bytes.

File Time Displays the acquisition date and time of the raw data file.



 2 Creating Studies
Setting Up the Relationship Between the Input Files

Thermo Scientific Compound Discoverer User Guide 89

You can set up the file relations manually by using the drag-and-drop technique or 
automatically by using the Auto Detect File Relations command. 

• When you manually associate the files, you can use any sample type as a reference file and 
any sample type as a non-reference file; that is, the reference file does not have to be a 
Control sample type.

• When you use the Auto Detect File Relations command, the application aligns Samples, 
Blanks, and Standards under Controls. If your data set includes more than one Control 
sample type, you must define at least one study factor. 

If you have not already added two or more input files to the study, selected their sample types, 
and set up the study factors for the study, do so now by following the procedures in these 
topics: “Setting Up the Study Variables and Adding a Description of the Study” on page 72, 
“Managing the Input Files in a Study” on page 79 and “Selecting the Sample Type and Study 
Factors for Each Input File” on page 85.

 To open the File Relations page

Click the File Relations tab on the study page.

 To manually associate the sample files

1. Open the File Relations page by clicking the File Relations tab.

Figure 71 shows the File Relations page with two unaligned files.

Figure 71. File Relations page with a two unaligned files

2. Drag the non-reference file under the reference file. 

Figure 72 shows input file F2 being dragged under input file F1.

Figure 72. Dragging a non-reference file under a reference file

File Relations command bar
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When you release the non-reference file, the application places it in the Aligned Files list 
below the reference file, which has a blue background (Figure 73). 

Figure 73. File Relations area with one set of aligned files

 To manually remove an aligned file from an Aligned Files list

Drag the file out of the Aligned Files list in the File Relations area until the marker ( ) 
appears, and then release the mouse button (Figure 74).

Figure 74. File Relations area with a file being dragged out of an alignment area

 To automatically align the non-reference files with the Control files

1. Open the File Relations page by clicking the File Relations tab.

2. Make sure to select the appropriate check boxes in the Select Study Variables Used for File 
Relations Detection pane.

• If your study files include more than one control sample, you must select at least one 
additional study variable (check box) for the application to set up the file relations. 

• If your study includes samples with different study factor definitions, make sure to 
select only those study variables that apply.

3. In the File Relations command bar, click Auto Detect File Relations.

The application automatically detects the relationship between the input files and aligns 
the Sample, Blank, and Standard sample types under the appropriate Control files. 

Figure 75 shows one reference file and three non-reference files. In this case, the sample 
type of the reference file is Control. The study variables are the same for all four files.

Marker 
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Figure 75. File Relations page with one set of aligned files

Figure 76 shows a set of files from different time points in a study. The application cannot 
automatically align the non-reference samples with the Control sample because the Time 
Point check box is selected, and the time points of the non-reference samples do not 
match those of the Control sample.

Figure 76. File set that the application cannot automatically align

 To automatically undo the alignment of the input files

Click Reset File Relations in the File Relations command bar.
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File Relations Page Parameters

Use the File Relations page to set up the relationship between the reference and non-reference 
files. 

Note  When processing sets of aligned files, the application uses the file relations 
information in two ways:

• The Retention Time Aligner node uses the file relations information to 
chromatographically align the non-reference files with the reference files.

• The Compare with Control feature in the Peak Consolidator node uses the file 
relations information to compare the peak areas in the non-reference files to the peak 
areas in the reference files.

Table 15. File Relations page

Column Description

Commands

Auto Detect File Relations Automatically aligns the Sample sample type under the 
Control sample type. When the input files list contains more 
than one Control sample type, this command aligns the 
Samples under the Controls by using the matching study 
factors.

Reset File Relations Undoes the file alignment.

Panes

Select Study Variables... Use this pane to select the study factors that the auto-detect 
feature uses to align the Sample files under the appropriate 
Control files.

File Relations Use this pane to set up or view the relationship between the 
reference files that the application highlights with a blue 
background and the non-reference files that the application 
highlights with a green background.
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Saving a Study File
Always save your study file after you modify it and before you close it, unless you want to 
cancel the changes.

 To save a study file

With the study that you want to save open, do one of the following:

• From the Compound Discoverer menu bar, choose File > Save.

–or–

• In the Compound Discoverer toolbar, click the Save the Currently Active Item icon, 
.

For information about reviewing the details of an analysis that the Compound Discoverer 
application has processed, see “Reprocessing an Analysis” on page 170.

IMPORTANT  If you do not save the study file before you close the application, the 
application does not save any unsaved changes. In addition, the application does not save 
the results list on the Analysis Results page. 

If you close the study file before you close the application, the following message appears:

Want to save your changes to study Study Name?

Click Yes to save the changes.
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3

Creating, Running, and Reprocessing Analyses

In the Compound Discoverer application, you process one or more of the raw data files in a 
study by running an analysis from within a study. An analysis consists of a processing 
workflow, a list of input files, and the batching process: one input file to one result file or 
multiple input files to one result file. You can store processing workflows as separate files. The 
application stores complete information for an analysis in the result file or files that the 
analysis generates. After you run an analysis, the application stores a link to the information to 
rerun the analysis on the Analysis Results page of the current study. 

After you open a study, you can start an analysis in two ways: 

• Starting a new analysis opens an empty Workflow Tree area on the Workflows page. 

• Opening an existing analysis template file (.cdAnalysis) opens a processing workflow that 
you can edit on the Workflows page.

Contents

• Starting an Analysis and Submitting It to the Job Queue

• Creating and Editing Processing Workflows

• Setting Up the Workflow Node Parameters

• Working with the Job Queue

• Reprocessing an Analysis

• Reviewing an Analysis Sequence
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Starting an Analysis and Submitting It to the Job Queue
When you start a new analysis or open an existing analysis template, the Analysis pane where 
you set up the processing sequence opens to the left of the study page. The Workflows page, 
where you set up the processing workflow, opens as a tabbed document in the set of study 
page tabs. When you start a new analysis, the Workflow Tree area on the Workflows page is 
empty. When you open an analysis template (cdAnalysis), the Workflow Tree area contains 
the processing workflow that was saved with the template.

Follow these procedures to start an analysis and submit it to the job queue:

1. To start an analysis

2. To select the input files that you want to process

3. To troubleshoot an analysis

4. To submit an analysis to the job queue

 To start an analysis

1. If you have not already created a study, create one as described in “Creating Studies” on 
page 63.

2. If you have not already opened the study of interest, open it as follows:

• Choose File > Open Study from the Compound Discoverer menu bar. 

–or–

• Click the Open Study icon, , in the Compound Discoverer toolbar. 

3. In the study command bar, do one of the following:

• Click New Analysis.

The Analysis pane opens to the right of the study page and the Workflows tab 
appears in the set of study page tabs. When you click the Workflows tab, the 
Workflows page opens with an empty Workflow tree area.

• Click Open Analysis Template.

The Analysis pane opens to the right of the study page and the Workflows tab 
appears in the set of study page tabs. When you click the Workflows tab, the 
Workflows page opens with the processing workflow saved with the template.

4. To select or create a processing workflow, go to “Creating and Editing Processing 
Workflows” on page 100.
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 To select the input files that you want to process

On the study page, do one of the following:

a. Click the File Relations tab to open the File Relations page.

b. Drag the aligned files of interest to the Input Files area of the Analysis pane.

–or–

a. Click the Input Files tab to open the Input Files page.

b. Drag the files of interest to the Input Files area of the Analysis pane (Figure 77).

Figure 77. Dragging input files to the Input Files area of the Analysis pane

The application automatically populates the Result File box with the file name of the last 
input file, and the Run command becomes available if the Workflows page contains a 
valid processing workflow. When you add more than one input file to the Input Files area, 
the As Batch check box becomes available. 

If the Caution symbol in the Processing Step title bar does not disappear, the processing 
workflow contains an error.
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Figure 78 shows four input files in the Input Files area of the Analysis pane.

Figure 78. Analysis pane with four input files

 To troubleshoot an analysis

Place the cursor over the Caution symbol.

A pop-up message box lists the missing analysis items, for example, missing input files, 
missing selections for one or more workflow node parameters, or missing node 
connections.

 To submit an analysis to the job queue

1. Decide whether you want to create one result file for the entire set of input files or one 
result file for each input file.

• To create a single result file, leave the As Batch check box clear.

• To create a separate result file for each input file, select the As Batch check box.

2. (Optional) In the Result File box, type a name for the result file to overwrite the default 
name.

3. In the Analysis command bar, click Run. 

If you have not set up the file relations for the input files, the Analysis Validation Issues 
confirmation box opens when the analysis meets all of these conditions:

• The Input Files area contains two or more input files.

• You are not batch processing these files; that is, you are processing these files together 
to create one result file.

• The processing workflow includes the Retention Time Aligner node, the Peak 
Consolidator node, or both of these nodes.



 3 Creating, Running, and Reprocessing Analyses
Starting an Analysis and Submitting It to the Job Queue

Thermo Scientific Compound Discoverer User Guide 99

4. If the Analysis Validation Issues confirmation box opens, do the following:

a. Click Abort. 

b. Open the File Relations page of your study, set up the file relations for the input files, 
and then restart the run by clicking the Run command.

The Job Queue page opens. For information about working with the job queue, see “Working 
with the Job Queue” on page 165.

Analysis Pane Parameters

The Analysis pane appears on the right side of the study page when you start a new analysis or 
open an existing analysis template.

Table 16 describes the parameters in the Analysis pane.

Table 16. Analysis pane parameters (Sheet 1 of 2)

Parameters Description

Title bar 

As Batch This check box becomes available when you add more than one 
input file to the Input Files area.

• When this check box is clear (default setting), the application 
creates one result file as it processes the input files in the Input 
Files area.

• When this check box is selected, the application creates one 
result file for each input file in the Input Files area.

Run This command becomes available when the Workflow Tree area 
on the Workflows page contains a valid processing workflow and 
the Input Files area contains a list of one or more input files.

Save Opens the Save Analysis Template dialog box where you can 
provide a file name for the analysis template and save it to an 
appropriate directory.

Closes the Analysis pane.

Processing Workflow area

Show Workflow 
icon 

Opens the Workflows page.

Workflow By default, the text matches the text in the Workflow box on the 
Workflows page. You cannot change the text in the Analysis pane. 
To change the name of the processing workflow, edit the text in 
the Workflow box on the Workflows page.
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Creating and Editing Processing Workflows
The Compound Discoverer application uses a processing workflow to analyze the MS data 
acquired with a high-resolution, accurate-mass LC/MS/MS instrument. In addition to 
analyzing the MS data, the application can display chromatograms acquired with a 
photo-diode array (PDA) or ultraviolet-visible (UV-Vis) detector that is controlled by a 
Thermo Scientific data system or an analog detector that is connected to the mass 
spectrometer’s analog input channels.

For information about adding input files to the Analysis pane and starting a run, see “Starting 
an Analysis and Submitting It to the Job Queue” on page 96. For information about the 
workflow node parameters, see “Setting Up the Workflow Node Parameters” on page 117.

These topics describe how to create and edit processing workflows and provide an overview of 
the workflow nodes and node connections:

• Opening the Workflows Page

• Editing an Existing Processing Workflow

• Creating a New Processing Workflow

• Saving a Processing Workflow as a Template

These topics provide an overview of the Workflows page, workflow nodes, and node 
connections:

• Workflow Node Connections

• Overview of the Workflows Page and the Workflow Nodes

Result File This box is empty until you drag one or more input files to the 
Input Files area.

The application automatically populates the Result File box with 
the name of the first input file. If the analysis creates one result 
file, you can type a name for the result file in the Result File box.

Input Files: (#) Displays the number of input files in the Input Files area.

Input Files area Displays the names of the input files after you drag one or more 
input files from the Input Files page of the study to this area.

Table 16. Analysis pane parameters (Sheet 2 of 2)

Parameters Description
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Opening the Workflows Page

Use the Workflows page to create or edit processing workflows. The Workflows page is a 
tabbed page and is available only when the Analysis pane is open (Figure 79).

Figure 79. Workflows page with a processing workflow in the Workflow Tree area

 To open the Workflows page

1. Start an analysis or open an existing analysis (see “To start an analysis” on page 96).

2. To open the Workflows page, do one of the following:

• Click the Workflows tab in the set of tabbed study pages.

–or–

• Click the Show Workflow icon, , in the title bar of the Processing Workflow area. 

The Workflow Tree and Workflow Nodes panes appear. For a new analysis, the Workflow 
Tree pane is empty. For an existing analysis template, the Workflow Tree pane usually 
contains a processing workflow.
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Editing an Existing Processing Workflow

The Compound Discoverer application includes these standard processing workflow 
templates:

• Omeprazole Expected Basic Workflow.cdProcessing WF

• Omeprazole Expected Full Workflow.cdProcessing WF

• Omeprazole Advanced Workflow.cdProcessing WF

You can modify an existing template by changing the parameter settings in the workflow 
nodes, by deleting one or more of the workflow nodes, or by adding more nodes.

 To fix a workflow node that is labeled with an exclamation mark

1. To view the validation errors, move the cursor over the Caution symbol in the Analysis 
pane.

A workflow node error typically begins with the following text: 

Validation of processing node

For example, the following figure shows the error message that appears when the 
Compound Generator node is missing a selection for the Compound parameter.

2. Using the provided information, fix the workflow node error.

 To delete a node in the Workflow Tree pane

Right-click the node in the Workflow Tree pane and choose Cut from the shortcut menu.

 To add a node to the processing workflow

1. Select the node in the Workflow Nodes pane and drag it to the Workflow Tree pane.

2. Make the appropriate connections as described in “To connect the nodes” on page 106.

3. To display a node’s parameters, click the node in the Workflow Tree pane.

The Parameters page lists the parameters for the selected node.

4. Edit the parameter settings for the node as described in “Setting Up the Workflow Node 
Parameters” on page 117.

IMPORTANT  If one or more of the libraries used to create an existing processing workflow 
contains entries that differ from your Compound Discoverer libraries, the application 
labels one or more of the workflow nodes with an exclamation mark ( ). 
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Creating a New Processing Workflow

A processing workflow is part of an analysis, and you can only perform analyses from inside a 
study. Therefore, you must open a study and start a new analysis or open an analysis template 
to access the Workflows page where you can create or edit a processing workflow.

A processing workflow always begins with the Spectrum Files node and typically ends with the 
Peak Consolidator node (required for sample-to-control comparisons and custom 
explanations). All processing workflows that process MS data require the Spectrum Selector 
node. The only processing workflow that does not require the Spectrum Selector node is 
limited to processing the data from an analog detector. 

A basic processing workflow that searches the data for known compounds consists of the 
following nodes: Spectrum Files, Spectrum Selector, Retention Time Aligner (optional for 
single input file or batch analyses), Compound Generator, Expected Finder, and Peak 
Consolidator (see “Finding Expected Compounds” on page 19). 

A basic processing workflow that searches the data for unknown compounds consists of the 
following nodes: Spectrum Files, Spectrum Selector, Retention Time Aligner (optional for 
single input file or batch analyses), Unknown Detector, and Peak Consolidator (see 
“Detecting Unknown Compounds” on page 25).

To create a completely new processing workflow, follow these procedures:

1. To open a blank Workflow Tree area

2. To build a processing workflow in the Workflow Tree area

3. To connect the nodes

4. To edit the parameter settings for each node

 To open a blank Workflow Tree area

1. In the study command bar, click New Analysis.

The Workflows tab appears as the last tab in the set of study page tabs and the Analysis 
pane appears to the right of the tabbed pages.

2. Click the Workflows tab.

The Workflows page contains the following:

• The Workflow Nodes and Parameters panes to the left of the Workflow Tree area

• A toolbar and two input boxes above the Workflow Tree area

• The Workflow Tree area, which is a workspace, at the bottom right of the page
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 To build a processing workflow in the Workflow Tree area

1. Drag the Spectrum Files node from the Workflow nodes pane to the Workflow Tree 
pane.

The Spectrum Files node reads the information in the raw data files and is a required 
node.

2. Drag the Spectrum Selector node to the Workflow Tree pane.

The application automatically connects the Spectrum Files node to the Spectrum Selector 
node. The Spectrum Selector node reads and filters the MS scan data in the raw data files. 
The default parameter settings pass all of the scan data to the next node.

3. Drag the Retention Time Aligner node to the Workflow Tree pane, and position the 
node below the Spectrum Selector node.

The Retention Time Aligner node chromatographically aligns the non-reference files with 
the associated reference files.

4. Connect the Spectrum Selector node to the Retention Time Aligner node. See “To 
connect the nodes” on page 106.

5. To create a processing workflow that searches the raw data for one or more expected 
compounds, do the following:

a. Drag the Expected Finder node to the Workflow Tree pane, and position it below 
the Retention Time Aligner node.

b. Connect the Retention Time Aligner node to the Expected Finder node. 

c. Drag the Compound Generator node to the Workflow Tree pane, and position it 
near the Expected Finder node. Repeat this step for every library compound in your 
search.

d. Connect the Compound Generator node or nodes to the Expected Finder node. 

e. Drag the Peak Consolidator node to the Workflow Tree pane, and position it below 
the Expected Finder node.

f. Connect the Expected Finder node to the Peak Consolidator node.

Note  For information about adding analytes to the compound library, see 
“Modifying the Compound Library” on page 315.

Note  In this example, you connect the Retention Time Aligner node to the 
Expected Finder node. The Expected Finder node accepts input from any of the 
Data Processing nodes.

Note  The Compound Generator node generates a list of expected compounds by 
using a user-specified library compound and a set of user-specified chemical 
reactions.
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6. To include a search for unknown compounds in the processing workflow, set up an 
untargeted or a semi-targeted workflow.

To set up an untargeted search, do the following:

a. Drag the Unknown Detector node to the Workflow Tree pane, and position it near 
the Retention Time Aligner node.

b. Connect the Retention Time Aligner node to the Unknown Detector node. 

c. Connect the Unknown Detector node to the Peak Consolidator node.

To set up a semi-targeted search, do the following:

a. Drag the Mass Defect Filter node to the Workflow Tree pane, and position it near 
the Retention Time Aligner node.

b. Connect the Retention Time Aligner node to the Mass Defect Filter node.

c. (Optional) Drag the Compound Generator node to the Workflow Tree pane, and 
position it near the Mass Defect Filter node. Then, connect the Compound 
Generator node to the Mass Defect Filter node.

For more information about working with the Mass Defect Filter node, see “Using 
the Mass Defect Filter Node to Find Structurally Related Compounds” on page 27.

d. Drag the Unknown Detector node to the Workflow Tree pane and position it near 
the Mass Defect Filter node.

e. Connect the Mass Defect Filter node to the Unknown Detector node.

f. Connect the Unknown Detector node to the Peak Consolidator node.

7. To add one or more tracer nodes to the processing workflow, do the following:

• For each UV, PDA, or analog trace that you want to extract, drag an Analog Tracer 
node from the Workflow Nodes pane to the Workflow Tree pane, and position it near 
the Spectrum Files node. The application automatically connects the Spectrum Files 
node to each Analog Tracer node.

• For each pattern trace that you want to extract, drag a Pattern Tracer node to the 
Workflow Tree pane. Then, connect the Retention Time Aligner node to each 
Pattern Tracer node.

• For each Fragment Ion Search (FISh) trace that you want to create, drag a FISh 
Tracer node to the Workflow Tree pane. Then, connect the Retention Time Aligner 
node to each FISh Tracer node.

• For each mass trace that you want to extract, drag a Mass Tracer node to the 
Workflow Tree pane. Then, connect the Retention Time Aligner node to each Mass 
Tracer node.

Note  In this example, you connect the Retention Time Aligner node to the tracer 
nodes. The Pattern Tracer, FISh Tracer, and Mass Tracer nodes accept input from 
any of the Data Processing nodes.
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8. To add FISh scoring to the processing workflow, drag the FISh Scoring node to the 
Workflow Tree pane, and position it near the Expected Finder node. Then, connect the 
Expected Finder node to the FISh Scoring node.

9. To export the MS scan data in the raw data files to a common data format, drag a 
Spectrum Exporter node to the Workflow Tree pane. Then, connect one of these nodes 
to the Spectrum Exporter node:

• Spectrum Selector

• Retention Time Aligner

• Mass Defect Filter

• Scan Event Filter

 To connect the nodes

1. Place the cursor over the input node of interest. 

Five white boxes appear, with one box at the center of the node and the other boxes at the 
center of each side.

2. Click one of the white boxes and hold down the mouse button until a red border and an 
arrowhead appear.

3. Continue holding down the mouse button as you drag the arrowhead to the output node 
of interest.

Depending on the compatibility, one of the following occurs:

• If the selected input node is not compatible with the output node, a red border 
appears around the output node.

• If the selected input node is compatible with the output node, a green border appears 
around the output node. When you release the mouse button, a directional arrow 
connects the input node to the output node.

Note  The Spectrum Exporter node does not export analog data.
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4. To automatically format the layout of the workflow nodes, click Auto Layout in the 
Workflows command bar.

For more information about the workflow node connections, see “Workflow Node 
Connections” on page 108.

 To edit the parameter settings for each node

1. In the Workflow Tree area, select the node of interest. 

The Parameters page opens and displays the parameters for the selected node.

2. Click Show Advanced Parameters below the Parameters page title bar.

If the node contains hidden advanced parameters, the advanced parameters appear below 
the basic parameters.

When you place the cursor in the box to the right of the parameter name, information 
about the parameter appears at the bottom of the Parameters page.

3. Enter the appropriate values or make the appropriate selection for each parameter (see 
“Setting Up the Workflow Node Parameters” on page 117).

Saving a Processing Workflow as a Template

You can run an analysis without saving the processing workflow in the Workflow Tree pane; 
however, you might want to save the processing workflow to a template for reuse later on. 
When you save the processing workflow as a template, the application does not automatically 
store it in the study folder. You can save a processing template to the Common Templates 
folder or a folder of your choice.

 To save a processing workflow template

1. Do one of the following:

• To save the template in the Common Templates folder, click Save Common.

The Save Workflow dialog box opens to the Common Templates folder. 

• To save the template to the last folder that you opened or to another folder, click 
Save.

The Save Workflow dialog box opens to the last opened folder.

2. Select the folder where you want to store the template. For example, if you opened the 
Common Templates folder, select the Workflow Templates folder where the three 
common processing workflow templates that are provided with the application reside.

Note  The application automatically connects the Spectrum Files node to the Analog 
Tracer node and the Spectrum Selector node.
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3. In the File Name box, type a name for the processing workflow.

4. Click Save.

If the processing workflow is valid, the application saves the template with the file name 
extension .cdProcessingWF. If the processing workflow contains an error, an error 
message box opens.

5. If the Exporting Template Workflow Failed message box opens, do the following:

a. Read the list of errors.

b. Click OK to close the message box.

c. Fix the errors. 

d. Save the processing workflow.

Workflow Node Connections

You can use the following nodes only once in a processing workflow: Spectrum Files (required 
as the first node), Spectrum Selector, Retention Time Aligner, Expected Finder, Unknown 
Detector, FISh Scoring, and Peak Consolidator.

For information about connecting the nodes, see “To connect the nodes” on page 106.

Table 17 lists the input and output nodes for each workflow node. 

Table 17. Input and output nodes for each workflow node (Sheet 1 of 3)

Workflow node Input nodes Output nodes

Input/Output

Spectrum Exporter 
Node

Spectrum Selector Centroid Filter

Spectrum Files
(Begins every 
processing workflow.)

None Spectrum Selector
Analog Traces

Data Processing 

Centroid Filter Node • Spectrum Exporter
• Retention Time Aligner
• Spectrum Selector
• Scan Event Filter

• Mass Defect Filter
• Retention Time Aligner
• Scan Event Filter
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Mass Defect Filter 
Node

• Any of the other data 
processing nodes

–or–

• One of the other data 
processing nodes and one or 
more Compound Generator 
nodes

One or more of these nodes:
• Retention Time Aligner
• Scan Event Filter
• FISh Tracer
• Mass Tracer
• Pattern Tracer
• Expected Finder
• Unknown Detector

Retention Time 
Aligner Node

Any of the other data processing 
nodes

One or more of these nodes: 
• Centroid Filter
• Mass Defect Filter
• Scan Event Filter
• FISh Tracer
• Mass Tracer
• Pattern Tracer
• Expected Finder
• Unknown Detector

Scan Event Filter Node Any of the other data processing 
nodes

One or more of these nodes: 
• Centroid Filter
• Mass Defect Filter
• Retention Time Aligner
• FISh Tracer
• Mass Tracer
• Pattern Tracer
• Expected Finder
• Unknown Detector

Spectrum Selector 
Node

Spectrum Files One or more of these nodes:
• Centroid Filter
• Mass Defect Filter
• Retention Time Aligner
• Scan Event Filter
• FISh Tracer
• Mass Tracer
• Pattern Tracer
• Expected Finder
• Unknown Detector

Tracer

Analog Tracer Node Spectrum Files None

Mass Tracer Node Any of the data processing nodes None

FISh Tracer Node Any of the data processing nodes None

Table 17. Input and output nodes for each workflow node (Sheet 2 of 3)

Workflow node Input nodes Output nodes
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Overview of the Workflows Page and the Workflow Nodes

Use the Workflows page to create or edit processing workflows. The Workflows page is a 
tabbed page on the study page and is available only when the Analysis pane is open.

These topics describe the features of the Workflows page:

• Workflow Nodes and Parameters Pane

• Workflows Command Bar

Workflow Nodes and Parameters Pane

When you select a node in the Workflow Tree pane, the Workflow Nodes pane displays the 
Parameters page for the selected node. When you select a parameter on the Parameters page, 
information about the parameter appears below the parameters area.

Pattern Tracer Node Any of the data processing nodes None

Expected Compounds

Compound Generator 
Node
(one for each parent 
compound)

None One or both of these nodes:
• Expected Finder
• Mass Defect Filter

Expected Finder Node One or more Compound 
Generator nodes and one of the 
data processing nodes

One or both of these nodes:
• FISh Scoring
• Peak Consolidator

Unknown Compounds

Unknown Detector 
Node

One of these nodes:
• Spectrum Selector
• Retention Time Aligner
• Mass Defect Filter

Peak Consolidator

Scoring & Annotation

FISh Scoring Node Expected Finder None

Comparison & Statistics

Peak Consolidator 
Node

One or both of these nodes:
• Unknown Detector
• Expected Finder

None

Table 17. Input and output nodes for each workflow node (Sheet 3 of 3)

Workflow node Input nodes Output nodes
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Table 18 provides a brief description of each node in the Workflow Nodes pane. For 
information about the parameters for each workflow node, see “Setting Up the Workflow 
Node Parameters” on page 117. Or, click the link to the node of interest in the Node column 
of Table 18.

Table 18. Workflow nodes  (Sheet 1 of 5)

Node Description

1. Input/Output

Spectrum Exporter 
Node

Exports the mass spectral scan data in a raw data file to a user-selected open source file 
format. 

You can add multiple Spectrum Exporter nodes to a processing workflow.

You do not need an active software license to create and use a processing workflow that 
consists of only the Spectrum Files node and the Spectrum Exporter node.

Spectrum Files Node All processing workflows begin with this workflow node.

Reads the input file information into the processing workflow.

2. Data Processing

Centroid Filter Node For ITMS and FTMS scans, removes centroids (mass spectral peaks) below the 
user-specified minimum intensity threshold. For FTMS scans only, removes centroids below 
the user-specified signal-to-noise threshold.

Mass Defect Filter 
Node

Filters the mass spectral peaks (centroids) in the full (MS1) scans that pass through the 
Spectrum Selector node by the mass defect filters for one or more elemental compositions. 

Retention Time 
Aligner Node

Chromatographically aligns non-reference samples with an associated reference sample by 
using the selected alignment model (Adaptive Curve or Linear), and the user-specified mass 
tolerance window and maximum time shift. You set up the relationship among the input 
files on the File Relations page of a study (see “Setting Up the Relationship Between the 
Input Files” on page 88).

You can add only one Retention Time Aligner node to a processing workflow.

Scan Event Filter Node Filters the MS scans in a raw data file on the basis of the following:
• Mass analyzer
• MS order
• Activation type
• Minimum collision energy
• Scan type
• Polarity mode
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Spectrum Selector 
Node

Filters the scans in each raw data file on the basis of the following: 
• Scan events (see the Scan Event Filter Node above)
• Ionization source
• Chromatographic retention time
• Scan number
• Charge state of the precursor ions (for MS/MS or higher scans)
• Mass range of the precursor ions (for MS/MS or higher scans)
• Total intensity level of the scan 
• Minimum mass peak count for a centroid mass spectrum

Filtering out scans in the raw data files minimizes the processing time and simplifies data 
review. 

You can add only one Spectrum Selector node to a processing workflow. The Spectrum Files 
node connects directly to the Spectrum Selector node, which is required to filter the MS 
scans in raw data files. The Spectrum Selector node does not process analog data. 

3. Tracer nodes

Analog Tracer Node Converts the UV data, PDA data, or third-party analog detector data in a raw data file 
(.raw) to a graphical plot of intensity versus time (chromatogram). The Analog Tracer node 
can also convert and display a pressure trace from an LC pump and a temperature trace 
from a column heater or autosampler with temperature control, when these instruments are 
controlled by the Xcalibur data system or equivalent Thermo Scientific application. You can 
view the processing results in the Chromatogram View after you select the trace in the 
Specialized Traces table. 

FISh Tracer Node Predicts the fragments (produced by the LC/MS/MS analysis) for the selected library 
compound and searches the all-ion fragmentation (AIF) scans or the data-dependent scans 
for mass spectral peaks (centroids) with m/z values that match the m/z values of the 
predicted fragment ions. When you enable the Individual Traces feature, lists the FISh trace 
for each processed input file in the Specialized Traces table and creates a table of matching 
fragments, the FISh Trace Fragments table.

When you select the FISh trace in the Specialized Traces table, the Chromatogram View 
displays the summed trace of the individual FISh fragments. When you select a fragment in 
the FISh Trace Fragments table, the Chromatogram View displays the extracted ion 
chromatogram (XIC) trace for the individual fragment.

For this node to work, the computer where the Compound Discoverer application is 
installed must also have a licensed version of the Mass Frontier application installed. 

Table 18. Workflow nodes  (Sheet 2 of 5)

Node Description
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Pattern Tracer Node 
and Isotope Ratio 
Editor Dialog Box

Creates a total ion chromatogram (TIC) trace that is made up of the mass spectral peaks 
(centroids) that match a specified pattern within a specified mass tolerance window and a 
specified relative intensity tolerance window.

You can set up the pattern by entering an elemental composition or by entering specific 
mass shifts and relative intensity values.

You can add multiple Pattern Tracer nodes to a processing workflow.

Mass Tracer Node Extracts a TIC trace, a base peak chromatogram (BPC) trace, or an XIC trace for mass 
spectral data retrieved from any of the Data Processing nodes. 

You can add multiple Mass Tracer nodes to a processing workflow.

4. Expected Compounds

Compound Generator 
Node

Generates a list of ions on the basis of these criteria:

• Parent compound that you select from a user-created compound library

• Dealkylation, dearylation, or dealkylation and dearylation predictions that are based on 
the compound’s structure

• Transformation reactions that you select from a predefined list

• Number of combinatory steps for the dealkylation, dearylation, or dealkylation and 
dearylation reactions and the transformation processes 

• Ionization species of the parent compound and its reaction products 

The Compound Generator node does not take input from other nodes. These two nodes 
use the ion list generated by the Compound Generator node:

• Expected Finder Node

• Mass Defect Filter Node

Expected Finder Node Using the input from one or more Compound Generator nodes, looks for expected 
compounds (parent compounds, dealkylation products of the parent compounds, and 
transformation products of the parent compounds) in the full (MS1) scans filtered through 
one or more of the data processing nodes. 

This node creates the Expected Compounds and Expected Compounds Hits tables.

Table 18. Workflow nodes  (Sheet 3 of 5)

Node Description
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5. Unknown Compounds

Unknown Detector 
Node 

Detects unknown compounds as follows:

• Ignores mass spectral peaks below the user-specified signal-to-noise level.

• Builds a set of XIC traces on the basis of the user-specified mass tolerance window and 
ions list. Uses the ions list to determine the mass-to-charge values of the XIC traces.

• Integrates the XIC traces by using the Parameterless Peak Detection (PPD) algorithm.

• Groups chromatographic peaks (unique retention time and m/z value) on the following 
basis: 

– Expected isotopes, which are determined by the user-specified element set and 
intensity tolerance window. 

If the elemental subset does not allow the node to assign elemental formulas; for 
example, if you enter an elemental subset of C 1–1 and H 1–1 (C H in both the 
minimum and maximum element count boxes), the node skips the isotope search 
step, and in some cases defines isotopic mass spectral peaks as adduct ions.

– Adduct ion species

• Rejects chromatographic peaks (unique retention time and m/z value) that contain only 
monoisotopic ions. This means that the node cannot find peaks in filtered data where 
the isotopic peaks in the full (MS1) scan data have been removed.

• Rejects chromatographic peaks with a peak height that is less than the minimum peak 
intensity setting.

• Rejects chromatographic peaks with a full width at half maximum (FWHM) wider than 
the maximum peak width setting.

Table 18. Workflow nodes  (Sheet 4 of 5)

Node Description
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6. Scoring and Annotation

FISh Scoring Node Creates a list of expected fragments by using the expected precursor ion list produced by the 
Compound Generator node or nodes connected to the Expected Finder node. It then 
attempts to match the fragment structures to the centroids in the fragmentation scans of the 
precursor ions.

When a precursor ion scan is followed by only one fragmentation scan, the node calculates 
the FISh coverage score as follows:

where:
# matched centroids represents the number of matched centroids.
# used centroids represents the number of centroids in the fragmentation scan that are 

above the user-specified signal-to-noise threshold.

When a precursor scan is followed by more than one fragmentation scan, the node 
calculates a composite score as follows:

The FISh Scoring node annotates the centroids in the fragmentation scans with the 
matching fragment structures and provides a FISh Coverage score for data-dependent scans 
in the Mass Spectrum View legend and a Best FISh Coverage score in the Expected 
Compound Hits table (best FISh Coverage score in the Related Structures table).

7. Comparison and Statistics

Peak Consolidator 
Node

Combines the detected chromatographic peaks from the Expected Finder and Unknown 
Detector nodes into one table, the Consolidated Peaks table. Each table row represents a 
group of chromatographic peaks with the same m/z values and retention time.

The Peak Consolidator node also includes the Compare with Control feature, which enables 
a comparison of the chromatographic peak areas between reference and non-reference 
samples.

Adding the Peak Consolidator node to the processing workflow adds an empty Custom 
Explanations table to the set of master tables in a result file.

Table 18. Workflow nodes  (Sheet 5 of 5)

Node Description

FISh coverage score
# matched centroids

# used centroids
-------------------------------------- 100=

FISh coverage score
per all scans# matched centroids 
per all scans# used centroids 

-------------------------------------------------------------------- 100=
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Workflows Command Bar

Table 19 describes the Workflows page commands.

Table 19. Workflows page commands

Command Description

Open Opens the Open Workflow dialog box where you can browse to a 
directory folder and select a processing workflow.

Open Common Opens the Open Workflow dialog box to the following folder 
where the application installs the three common processing 
workflow templates:

C:\Users\Public\Public Documents\Thermo\Compound 
Discoverer 1.0\Common Templates

Use this command to open processing templates that you store in 
the Common Templates folder.

Save Opens the Save Workflow dialog box where you can select a 
directory folder and type a file name for the current processing 
workflow in the Workflow Tree pane.

Save Common Opens the Save Workflow dialog box to the folder where the 
application installs the common processing workflow templates.

Use this command to save the current processing workflow in the 
Workflow Tree pane to the Common Templates folder.

Auto Layout Automatically formats the layout of the workflow nodes.

Clear Clears the Workflow Tree pane.
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Setting Up the Workflow Node Parameters
Each workflow node has a set of associated parameters. The following topics, which are 
organized by functionality, describe the workflow node parameters.

For an overview of the workflow nodes, see “Workflow Nodes and Parameters Pane” on 
page 110.

1. Input and Output

• “Spectrum Exporter Node” on page 118

• “Spectrum Files Node” on page 119 

2. Data Processing

• “Centroid Filter Node” on page 120

• “Mass Defect Filter Node” on page 121

• “Retention Time Aligner Node” on page 124

• “Scan Event Filter Node” on page 125 

• “Spectrum Selector Node” on page 129 

3. Tracer

• “Analog Tracer Node” on page 137

• “FISh Tracer Node” on page 140

• “Pattern Tracer Node and Isotope Ratio Editor Dialog Box” on page 142

• “Mass Tracer Node” on page 151

4. Expected Compounds

• “Compound Generator Node” on page 153

• “Expected Finder Node” on page 157

5. Unknown Compounds

• “Unknown Detector Node” on page 159

6. Scoring and Annotation

• “FISh Scoring Node” on page 161

7. Comparison & Statistics

• “Peak Consolidator Node” on page 163
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Spectrum Exporter Node

Use the Spectrum Exporter node to export all or a subset of the mass spectrum scans in a raw 
data file to an open-source format file. The Spectrum Exporter node does not export the data 
from analog detectors. For information about the node connections, see “Workflow Node 
Connections” on page 108.

The Spectrum Exporter node requires input from one of the data processing nodes. Reading 
the input files, extracting the MS scans of interest, and exporting the data to an open source 
format file, requires the processing workflow shown in Figure 80. Running this processing 
workflow does not require an active software license.

Figure 80. Minimum processing workflow for the Spectrum Exporter node

Figure 81 shows the parameters for the Spectrum Exporter node.

Figure 81. Spectrum Exporter node parameters
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Table 20 describes the parameters for the Spectrum Exporter node.

Spectrum Files Node

Every processing workflow must begin with the Spectrum Files node. This node has no 
parameters. 

Table 20. Spectrum Exporter node parameters

Parameter Description

1. Output Data

File Name Specifies the file name of the exported file. If you leave this box 
empty, the node uses the result file name.

Export Format Specifies the data format of the exported file.

Selections: 

• DTA archive (*.dta.zip)—Generates a zip file that contains an 
individual DTA file for each MS scan in the raw data file. The 
individual file names include the scan number of the scan. 
The DTA file format is a simple text file that contains a peak 
table of mass and intensity. This format does not store 
information about data acquisition, such as the instrument 
method or mass resolution, and you cannot reprocess DTA 
files with a mass spectrometry application.

• Mascot Generic Format (*.mgf )—Generates an MGF file, 
which lists the MS scans by retention time. The scan data for 
each time point consists of two columns: mass and intensity. 

• mzDATA (*mzData)—Generates an XML-based file that can 
be read by third-party mass spectrometry software packages.

• mzML (*mzML)—Generates an XML-based file that can be 
read by third-party mass spectrometry software packages.
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Centroid Filter Node

Use the Centroid Filter node to remove mass spectral peaks (centroids) that are below a 
user-specified intensity threshold from the mass scans, below a user-specified signal-to-noise 
threshold for FTMS scans, or both. For information about the node connections, see 
“Workflow Node Connections” on page 108.

Figure 82 shows the parameter settings for the Centroid Filter node.

Figure 82. Centroid Filter node with the default parameter settings

Table 21 describes the parameters for the Centroid Filter node.

Table 21. Centroid Filter node parameters

Parameter Description

1. General Settings

S/N Threshold 
(for FT-only)

Specifies the minimum signal-to-noise threshold for each centroid 
in an FTMS scan. The node excludes centroids from the analysis 
that are below this intensity value. 

Default: 1.5

Minimum Intensity 
Threshold

Specifies the minimum intensity threshold for the mass spectral 
peaks (centroids). The node excludes centroids from the analysis 
that are below this intensity value.

Default: 0 (no filtering)
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Mass Defect Filter Node

Use the Mass Defect Filter node to keep or remove mass spectral peaks (centroids) in the full 
(MS1) scan data that fall within a set of specified mass tolerance and mass defect windows. 
You can add more than one Mass Defect Filter node to a processing workflow. For 
information about the node connections, see “Workflow Node Connections” on page 108.

For more information about using the Mass Defect Filter, see “Using the Mass Defect Filter 
Node to Find Structurally Related Compounds” on page 27.

Figure 83 shows the default parameter settings for the Mass Defect Filter node.

Figure 83. Mass Defect Filter node with the default parameter settings

Table 22 describes the parameters for the Mass Defect Filter node.

Table 22. Mass Defect Filter node parameters (Sheet 1 of 3)

Parameter Description

1. General Settings

Filter Direction Specifies whether the selected mass defect filter keeps or removes mass 
spectral peaks (centroids) from further processing.

Default: Keep
Selections: Keep or Remove
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Mass Defect Type Specifies the mass defect type.

Default: Standard Mass Defect

Selections: 

Where:

Exact mass = monoisotopic mass of the elemental 
composition (in the Composition box or from 
the Compound Generator node)

Nominal mass = integer mass calculated by using the selected 
rounding function (floor, ceiling, or round)

Kendrick Formula When Kendrick Formula is selected as the Mass Defect Type, this 
user-specified elemental composition specifies the Kendrick formula.

Nominal Mass 
Rounding

Specifies how the node calculates nominal masses. 

Default: Floor

Selections: 
• Floor rounds down.
• Ceiling rounds up.
• Round rounds to the nearest integer value.

2. Tolerances

Using the mass defect values calculated above and the exact mass values calculated from the 
elemental composition input, these mass tolerance values define the rectangular mass defect 
filters.

Table 22. Mass Defect Filter node parameters (Sheet 2 of 3)

Parameter Description

Fractional Mass exact mass floor (exact mass)–=

Standard Mass Defect exact mass nominal mass–=

Relative Mass Defect 1e6 (exact mass nominal mass)–
(exact mass)

----------------------------------------------------------------------------------------------------=

Kendrick Mass Defect Kendrick mass nominal Kendrick mass–=

Kendrick Mass exact mass nominal mass of Kendrick formula
exact mass of Kendrick formula

------------------------------------------------------------------------------------------------------=
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Mass Tolerance The input from the data processing nodes is a table of m/z values and 
intensities for each full (MS1) scan.

Specifies the mass range window for the ions that the filter removes or 
passes through to the next node. 

Default: 50 Da
Selection: 0 to 6000 Da

Mass Defect 
Tolerance

Specifies the mass defect tolerance windows for the ions that the filter 
removes or passes through to the next node.

Default: 0.025 (Da or unit-less for the Relative Mass Defect selection)
Range: 0–no limit

3. Custom Compositions

Composition 
(5 entry boxes)

Specify the elemental compositions that the node uses to create the 
mass defect filters.

Leave these boxes empty if you want to use one or more Compound 
Generator nodes to generate the list of elemental compositions.

Ions Specifies the ion definitions to be used with the custom compositions. 
For each elemental composition, the node creates one mass defect filter 
for each ion definition; that is, if you select five ion definitions, the 
node creates five mass defect filters for each elemental composition.

Select the ion definitions from the dropdown list. To create new ion 
definitions, see “Adding or Editing Ion Definitions with the Ion 
Definition Editor” on page 345.

Table 22. Mass Defect Filter node parameters (Sheet 3 of 3)

Parameter Description
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Retention Time Aligner Node

Use the Retention Time Aligner node for chromatographic alignment between one or more 
samples and a reference sample. The Retention Time Aligner node compensates for small 
differences in the retention times of the components in a set of sequence runs. It is not 
designed to align files that were acquired during significantly different time periods (as the 
capacity factor of any chromatographic column changes with time or use) or with different 
chromatographic methods. For information about the node connections, see “Workflow 
Node Connections” on page 108.

When you submit an analysis that contains more than one input file, the application checks 
the file relations.

Figure 84 shows the default parameter settings for the Retention Time Aligner node.

Figure 84. Retention Time Aligner node default settings

IMPORTANT  Follow these guidelines:

• Do not apply a scan filter that excessively reduces the retention time window (see 
“Spectrum Selector Node” on page 129), as doing so might cause an alignment 
failure. The Retention Time Aligner node requires a minimum amount of 
representative scan data to chromatographically align the input files in an analysis.

• Take care to select an appropriate reference sample, as the node chromatographically 
aligns non-reference samples against an associated reference sample. You can typically 
use a predose sample as a reference. A predose sample is a sample matrix without the 
compound or compounds of interest.



 3 Creating, Running, and Reprocessing Analyses
Setting Up the Workflow Node Parameters

Thermo Scientific Compound Discoverer User Guide 125

Table 23 describes the parameters for the Retention Time Aligner node.

Scan Event Filter Node

Use the Scan Event Filter node to filter the mass spectra on the basis of the scan events. For 
information about the node connections, see “Workflow Node Connections” on page 108.

Figure 85 shows the default parameter settings for the Scan Events Filter node.

Figure 85. Scan Events Filter node with the default parameter settings

Table 23. Retention Time Aligner node parameters

Parameter Description

1. General Settings

Alignment Model Specifies the curve fitting algorithm to be used to 
chromatographically align the non-reference files with the 
associated reference files.

Default: Adaptive Curve
Selections: Adaptive Curve or Linear

Mass Tolerance Specifies the mass tolerance window to be used for mass peak 
(centroid) grouping.

Default: 5.0 ppm
Range: 0.1–50 ppm

Maximum Shift (min) Specifies the maximum retention time shift between the 
alignment components in the non-reference and reference files.

Default 0.5 minutes (± 0.5 minute window for each 
chromatographic peak found in the reference file)

Range: 0.01–2.0 minutes



3 Creating, Running, and Reprocessing Analyses
Setting Up the Workflow Node Parameters

126 Compound Discoverer User Guide Thermo Scientific

Table 24 describes the parameters for the Scan Event Filter node.

Table 24. Scan Event Filter node parameters  (Sheet 1 of 3)

Parameter Description

Filter Settings

Mass Analyzer Specifies the mass analyzer that the instrument used to acquire the 
scan. A Thermo Scientific hybrid mass spectrometer, such as the 
LTQ Orbitrap™ mass spectrometer, contains two mass analyzers 
and can acquire both ITMS (low-resolution) and FTMS 
(high-resolution) scans in one data file.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The application does not filter scan 
events on the basis of the mass analyzer that was used to acquire 
the data.

Check box selections:
• Ion Trap (ITMS)
• Fourier Transform (FTMS))
• Time of Flight (TOFMS)
• Single Quad (SQMS)
• Triple Quad (TSMS)
• Sector Field (SectorMS)

MS Order Specifies the MS order (scan power that the instrument used) of 
the scans that you want the node to filter. 

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scans on 
the basis of the MS order.

Check box selections: MS1–MS7

Note  The Unknown Detector and Expected Finder nodes 
search the full (MS1) scans for mass peaks. If you filter out the 
MS1 scans by selecting Is MS2 or higher for the MS Order, the 
result tables for these nodes are empty.
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Activation Type Specifies the activation types that the instrument used to produce 
the product ion spectra.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scans on 
the basis of the activation type.

Check box selections:
• CID (Collision Induced Dissociation)
• MPD (Multi Photon Dissociation)
• ECD (Electron Capture Dissociation)
• PQD (Pulsed Q Collision Induced Dissociation)
• ETD (Electron Transfer Dissociation)
• HCD (Higher Energy Collision Dissociation)
• EThcD (ETD With Supplemental HCD)
• Any Activation Type

Min. Collision Energy Specifies the minimum Normalized Collision Energy™ for a 
higher-order scan to pass through the filter.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked

Max. Collision Energy Specifies the maximum Normalized Collision Energy for a 
higher-order scan to pass through the filter. 

Default: 1000
Minimum value: 0
Maximum value: 1000

Table 24. Scan Event Filter node parameters  (Sheet 2 of 3)

Parameter Description
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Scan Type Specifies the scan type for the scan event that the instrument used 
to produce the product ion.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scan events 
on the basis of the scan type.

Check box selections:
• Full
• Single Ion Monitoring (SIM) 
• Single Reaction Monitoring (SRM) 

Polarity Mode Specifies the polarity mode for the scan.

Filter selection: Any, Is, Is Not

Default: (Not Specified)—The node does not filter the scan events 
on the basis of the polarity mode.

Check box selections:
• Positive
• Negative

Table 24. Scan Event Filter node parameters  (Sheet 3 of 3)

Parameter Description
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Spectrum Selector Node

The raw data file (RAW) contains the mass spectral scans acquired by your Thermo Scientific 
mass spectrometer and any optional data acquired by a PDA, UV-VIS, or analog detector 
during the acquisition run. The Spectrum Selector node can read and filter the mass spectral 
scan data. The Spectrum Selector node cannot read the optional data acquired by a PDA, 
UV-VIS, or analog detector.

The mass spectral scans are numbered 1, 2, 3, and so on from the beginning to the end of the 
acquisition run. Use the Spectrum Selector node to select the mass spectral scans that you 
want the application to process. Limiting processing to the scans of interest decreases 
processing time and minimizes false positives. For example, if you know the retention time of 
the compounds of interest, exclude scans that fall outside a specific retention time window. 

For information about the node connections, see “Workflow Node Connections” on 
page 108.

IMPORTANT  When using settings other than the defaults for the Spectrum Selector node, 
follow these guidelines:

• The application uses the full (MS1) scans to measure the accurate mass and isotope 
patterns of the mass spectral peaks; therefore, do not filter out the full (MS1) scans 
when the processing workflow includes the Expected Finder and Unknown Detector 
nodes.

• Both the Retention Time Aligner and Expected Finder nodes require a representative 
amount of data to function properly. If you excessively reduce the retention time 
window (for example, by using an RT or scan number range), the Retention Time 
Aligner node’s chromatographic alignment algorithm and the Expected Finder node’s 
automatic peak width detection algorithm might fail to produce satisfactory results.
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Figure 86 shows the default parameter settings for the Spectrum Selector node. 

Figure 86. Spectrum Selector node parameters
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Table 25 describes the parameters in the Spectrum Selector node.

Table 25. Spectrum Selector node parameters  (Sheet 1 of 6)

Parameter Description

1. General Settings

Precursor Selection Specifies the MS order of the precursor scans for higher-order MSn scans, like MS3, MS4, 
and so forth.

Default: Use MS(n – 1) Precursor
Selections: Use MS1 Precursor or Use MS(n – 1) Precursor

Use New Precursor 
Reevaluation

Specifies the algorithm used to determine the monoisotopic mass of the precursor ion for a 
higher-order scan when the full (MS1) scan has been acquired with an FT analyzer. 

Default: True
Selections:

• True—The node uses a sophisticated algorithm to determine the best precursor mass 
peak for a given MS/MS spectrum from the corresponding MS1 master scan. Using the 
monoisotopic mass and charge reported by the instrument in the scan header (or if that 
is not available, the isolation mass), the algorithm goes into the master scan and tries to 
find the corresponding peak in the MS1 spectrum both to improve the mass accuracy of 
the monoisotopic mass reported by the instrument and to correct for inaccurate 
precursor masses corresponding to one of the 13C isotopes.

• False—Instead of reevaluating the monoisotopic mass, the node uses the monoisotopic 
mass provided by the instrument in the scan header. The instrument uses a simplified 
algorithm that looks for matching masses only to the left of a reported peak and 
performs a rough check of the detected isotopic intensities.

Use Isotope Pattern in 
Precursor Reevaluation

Determines whether the node considers the isotope pattern in reevaluating precursors.

Default: True
Selections:

• True—The node considers the isotope pattern in reevaluating precursors.

• False—The node does not consider the isotope pattern in reevaluating precursors.

2. Spectrum Properties Filter

Note  The retention time filter excludes scans on the basis of their retention time; however, the application does not 
check the validity of the retention time settings against the actual acquisition time for the raw data file. When both 
the lower and upper RT limits are set to 0 (default), the application does not filter the scans on the basis of their 
retention time.

Lower RT Limit Excludes scans acquired before the user-specified retention time.

Default: 0 
Minimum value: 0
Maximum value: Unchecked 
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Upper RT Limit With the exception of a setting of 0, excludes scans that were acquired after the 
user-specified retention time. 

Default: 0
Minimum value: 0
Maximum value: Unchecked 

Note  The scan number filter excludes scans on the basis of their scan number; however, the application does not 
check the validity of the scan number settings against the actual scan numbers in the raw data file. When both the 
first and last scan number are set to 0 (default), the application does not filter scans on the basis of their scan 
number. When filtering by scan number, verify the scan number range in a mass spectrometry viewer application, 
such as Qual Browser or FreeStyle™. You can access the Qual Browser window or the FreeStyle application from the 
Home Page of the Xcalibur 3.1 data system. FreeStyle is also available as a stand-alone application.

First Scan Specifies the scan number of the first available scan that you want the node to process. 

When this parameter is set to 0, the node processes the first scan that passes through the 
other filters. 

When this parameter is set to a value that is greater than the last available scan number, the 
node filters out all of the scans.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked 

Last Scan Specifies the last available scan number that you want the node to process. 

When this parameter is set to 0 or a value that is greater than the last available scan number, 
the node processes the last scan that passes through the other filters.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked

Note  The charge state filter excludes higher-order scans of precursor ions with a charge state that is outside the 
specified limits. The charge state filter does not affect the MS1 scans.

Lowest Charge State Excludes higher-order scans of precursor ions with a lower charge state than the specified 
charge state.

Default: 0 
Minimum: 0

Highest Charge State Filters out scans from precursor ions with a higher charge state than the specified charge 
state.

Default: 0 (specifies no upper limit)

Table 25. Spectrum Selector node parameters  (Sheet 2 of 6)

Parameter Description
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Min. Precursor Mass Specifies the minimum precursor mass for a higher-order scan.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked 

Max. Precursor Mass Specifies the maximum precursor mass for a higher-order scan.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked 

Total Intensity 
Threshold

Excludes scans that fall below the specified total intensity threshold. The total intensity of a 
mass spectrum is the summed intensity of its mass spectrum peaks (centroids).

Minimum Peak Count Specifies the minimum number of mass spectrum peaks (centroids) that must be in the 
spectrum for the scan to pass through the filter.

Minimum value: 1
Maximum value: Unchecked

3. Scan Event Filters

Mass Analyzer Specifies the mass analyzer that the instrument used to acquire the scan. An LTQ Orbitrap™ 
hybrid mass spectrometer can acquire both ITMS (low-resolution) and FTMS 
(high-resolution) scans in one data file.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter scan events on the basis of the mass 
analyzer used to acquire the data.

Check box selections:
• Ion Trap (ITMS)
• Fourier Transform (FTMS))
• Time of Flight (TOFMS)
• Single Quad (SQMS)
• Triple Quad (TSMS)
• Sector Field (SectorMS)

MS Order Specifies the MS order of the scans that you want the node to process.

Filter selection: Any, Is, Is Not
Default: Any —The application does not filter the scans on the basis of the MS order.

Check box selections: MS1–MS7

Note  The Unknown Detector and Expected Finder nodes search the MS1 scans for mass 
peaks. If you filter out the MS1 scans by selecting Is MS2 or higher for the MS Order, the 
result tables for these nodes are empty.

Table 25. Spectrum Selector node parameters  (Sheet 3 of 6)

Parameter Description
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Activation Type Specifies the activation type that the instrument used to produce the product ion spectra.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scans on the basis of the activation 
type.

Check box selections:
• CID (Collision Induced Dissociation)
• MPD (Multi-Photon Dissociation)
• ECD (Electron Capture Dissociation)
• PQD (Pulsed Q Collision Induced Dissociation)
• ETD (Electron Transfer Dissociation)
• HCD (High Energy Collision Dissociation)
• EThcD (ETD With Supplemental HCD)
• Any Activation Type

Min. Collision Energy Specifies the minimum Normalized Collision Energy for a higher-order scan to pass 
through the filter.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked

Max. Collision Energy Specifies the maximum Normalized Collision Energy for a higher-order scan to pass 
through the filter. 

Default: 1000
Minimum value: 0
Maximum value: 1000

Scan Type Specifies the scan type for the scan event that the instrument used to produce the product 
ion.

Filter selection: Any, Is, Is Not
Default: Any —The application does not filter the scan events on the basis of the scan type.

Check box selections:
• Full
• Single Ion Monitoring (SIM) 
• Single Reaction Monitoring (SRM) 

Table 25. Spectrum Selector node parameters  (Sheet 4 of 6)

Parameter Description
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Polarity Mode Specifies the polarity mode for the scan.

Filter selection: Any, Is, Is Not

Default: (Not Specified)—The node does not filter the scan events on the basis of the 
polarity mode.

Check box selections:
• Positive
• Negative

4. Peak Filters

S/N Threshold 
(FT-only)

Specifies the signal-to-noise threshold for mass peaks in an FTMS scan. Mass peaks below 
this threshold are filtered out.

Default: 1.5

5. Replacements for Unrecognized Properties

Unrecognized Charge 
Replacements

Specifies the charge state or states to process when the charge state of the precursor ion is 
indeterminate. 

Default: 1

In the Qual Browser window, an indeterminate charge state is specified with a question 
mark label (z=?) in a spectrum cell. In the Freestyle application, ions with indeterminate 
charge states are labeled with a charge state of 0.

Default: 1
Selections: All, 1, 2, 3, 4, 5, 6, 7, and 8

Table 25. Spectrum Selector node parameters  (Sheet 5 of 6)

Parameter Description
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Unrecognized Mass 
Analyzer Replacements

Specifies the mass analyzer used to acquire the data when the application cannot retrieve this 
information from the input file.

Default: ITMS

Selections: 
• Ion Trap (ITMS)
• Fourier Transform (FTMS)
• Time of Flight (TOFMS)
• Single Quad (SQMS)
• Triple Quad (TSMS)
• Sector Field (SectorMS)

Unrecognized MS 
Order Replacements

Specifies the MS order when the application cannot retrieve this information from the input 
file.

Default: MS2
Selections: MS1–MS10

Unrecognized 
Activation Type 
Replacements

Specifies the activation type when the application cannot retrieve this information from the 
input file.

Default: CID

Selections: 
• CID (Collision Induced Dissociation)
• MPD (Multi-Photon Dissociation)
• ECD (Electron Capture Dissociation)
• PQD (Pulsed Q Collision Induced Dissociation)
• ETD (Electron Transfer Dissociation)
• HCD (High Energy Collision Dissociation)
• EThcD (ETD With Supplemental HCD)
• Any Activation Type

Unrecognized Polarity 
Replacement

Specifies the polarity mode when the application cannot retrieve this information from the 
input file.

Default: (+)
Selections: Positive (+) or Negative (–)

Unrecognized MS 
Resolution @ 200 
Replacements

Specifies the resolution at m/z 200 for MS scans when the node cannot retrieve the 
resolution from the scan header.

Default: 60 000

Unrecognized MSn 
Resolution @ 200 
Replacements

Specifies the resolution at m/z 200 for MS/MS scans when the node cannot retrieve the 
resolution from the scan header.

Default: 30 000

Table 25. Spectrum Selector node parameters  (Sheet 6 of 6)

Parameter Description
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Analog Tracer Node

Use the Analog Tracer node to view the chromatograms for these trace types: 
ultraviolet-visible (UV), photo-diode array (PDA), or analog (Figure 87). Your Thermo 
Scientific data system supports several brands of UV-Vis and PDA detectors. You can acquire 
UV traces from a UV-Vis or a PDA detector and PDA traces from a PDA detector. If your 
analog detector is not supported by a Thermo Scientific data system, you can acquire an 
analog trace by connecting the detector to one of the analog channels on the communications 
panel of your Thermo Scientific mass spectrometer.

For information about the node connections, see “Workflow Node Connections” on 
page 108. For general information about the node, see “Workflow Nodes and Parameters 
Pane” on page 110.

Figure 87 shows the default parameter settings for the Analog Tracer node.

Figure 87. Analog Tracer node parameters

 To extract a UV trace or an analog trace from the RAW data file

1. Under General Settings, select UV or Analog from the Trace Type list.

2. In the RT offset [min] box, type the offset time, in minutes, for the UV-Vis or Analog 
trace.

If there is a time difference between when the sample enters the mass spectrometer and 
the UV-Vis or analog detector’s flow cell, use the offset time to align the chromatographic 
traces. A value of 0 indicates that the UV-Vis or analog detector and the mass 
spectrometer detected the sample simultaneously.

3. In the Custom Label box, type text to identify the trace in the Specialized Traces table of 
the result file window.
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 To extract a PDA trace from the RAW data file

1. In the General Settings area, do the following:

• In the Trace Type list, select PDA.

• In the RT offset [min] box, type the offset time, in minutes, for the PDA traces.

If there is a time difference between when the sample enters the mass spectrometer 
and the PDA detector’s flow cell, use the offset time to align the chromatographic 
traces. A value of 0 indicates that the PDA detector and mass spectrometer 
simultaneously detect the sample.

• In the Custom Label box, type text to identify the trace in the Specialized Traces table 
on the result file page.

2. In the PDA Settings area, do the following:

• Select the scan range that you want the node to extract as follows:

– To extract a plot of the average intensity of the scanned wavelength range versus 
time, select True for Total Scan.

This trace is labeled as a Total Scan in the Specialized Traces table.

– To extract a plot of the spectrum maximum of the scanned wavelength range 
versus time, select True for Spectrum Maximum.

This trace is labeled as a Spectrum Maximum in the Specialized Traces table.

• Select the scan range to be extracted:

– In the Min. Wavelength box, type the wavelength, in nanometers, of the lowest 
wavelength to be extracted.

– In the Max. Wavelength box, type the wavelength, in nanometers, of the highest 
scan wavelength to be extracted.

Table 26 describes the parameters for the Analog Traces node.

Table 26. Analog Tracer node parameters (Sheet 1 of 3)

Parameter Description

1. General Settings

Trace Type Specifies whether the application extracts a UV, PDA, or analog 
trace from the raw data file.

Selection: UV, PDA, or Analog
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RT Offset [min] Specifies the offset time, in minutes, between the UV, PDA, or 
analog detector and the mass spectrometer traces. 

A negative value shortens and a positive value lengthens the 
apparent retention time of the peaks detected by the UV, PDA, or 
analog detector. 

Default: 0
Range: –10 to 10

Custom Label Type text to identify the trace in the Specialized Traces table on 
the result file page.

2. PDA Settings

Total Scan Specifies whether the node extracts a total scan trace for the 
scanned wavelength range. 

Total scan traces display the average absorbance for each time 
point of all the wavelengths in the scan range.

Default: False
Selection: True or False

Spectrum Maximum Specifies whether the node extracts a spectrum maximum trace for 
the scanned wavelength range.

Spectrum maximum traces display a plot of the maximum 
absorbance values in the scan range for each time point.

Default: False
Selection: True or False

Note  Use the Min. and Max. Wavelength boxes to specify a trace of average absorbance 
versus time.

• To display the chromatogram for a specific scan wavelength, type the same 
wavelength number in the Min. and Max. Wavelength boxes.

• To display a plot of the average absorbance values for a range of wavelengths, type the 
beginning wavelength number in the Min. Wavelength box and the ending 
wavelength number in the Max. Wavelength box.

Wavelength Range Specifies whether the node extracts the entire acquired scan or a 
wavelength range.

Default: True—Node uses specified wavelength range.

Table 26. Analog Tracer node parameters (Sheet 2 of 3)

Parameter Description
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FISh Tracer Node

Use the FISh (Fragment Ion Search) Tracer node to create FISh traces. For information about 
the node connections, see “Workflow Node Connections” on page 108. For general 
information about the node, see “Workflow Nodes and Parameters Pane” on page 110.

Figure 88 shows the default parameter settings for the FISh Tracer node.

Figure 88. FISh Tracer node parameters

Min. Wavelength Specifies the beginning wavelength of the trace that you want the 
node to extract.

Default: 190
Range: 190–800 nm

Max. Wavelength Specifies the ending wavelength of the trace that you want the 
node to extract.

Default: 190
Range: 190–800 nm

Table 26. Analog Tracer node parameters (Sheet 3 of 3)

Parameter Description
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Table 27 describes the parameters for the FISh Tracer node.

Table 27. FISh Tracer node parameters (Sheet 1 of 2)

Parameter Description

1. Compound Selection

Compound Specifies the parent compound that the node uses to generate 
expected fragment ions.

The selection list contains the compounds in the user-created 
compound library. For information about editing the compound 
library, see “Modifying the Compound Library” on page 315.

2. Trace Settings

Mass Tolerance Specifies the mass tolerance window that the node uses to create 
the FISh trace.

Default: 2.5 mmu

Summed Trace Specifies whether the node generates a summed trace of all the 
detected fragment ions.

Default: True
Selections: True or False

Individual Traces Specifies whether the node generates individual traces for each 
generated fragment ion.

Default: True
Selections: True or False

Custom Label Type text that you can use to identify the chromatogram in a 
report.

This box accepts alphanumeric and special characters.

3. Scan Filter Settings

Scan Polarity Specifies the polarity of the scan.

Default: + (Positive)
Selections: Positive or Negative

Fragment Mode Specifies the fragmentation mode of the fragmentation scans that 
you want the node to extract.

Default: All-Ion
Selections: All-Ion and Data-Dependent
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Pattern Tracer Node and Isotope Ratio Editor Dialog Box

Use the Pattern Tracer node to draw a chromatogram from the mass-to-charge peaks that 
match a specific pattern within the filtered set of spectra. The pattern can be based on the 
elemental composition of a target compound or on a user-specified pattern. Use the Isotope 
Ratio Editor dialog box to set up the pattern and the required isotopes.

See these topics to set up the appropriate pattern for your analysis:

• Pattern Tracer Node

• Isotope Ratio Editor Dialog Box

Pattern Tracer Node

This topic describes the parameters for the Pattern Tracer node. For information about the 
node connections, see “Workflow Node Connections” on page 108. For general information 
about the node, see “Workflow Nodes and Parameters Pane” on page 110.

 To set up the parameters for the Pattern Tracer node

1. In the Workflow Tree area, click the Pattern Tracer node of interest.

The parameters for the Pattern Tracer node appear on the Parameters page (Figure 89).

Figure 89. Pattern Tracer node parameters

2. In the Mass Tolerance box, type the mass tolerance window (± user-specified value) for 
the search.

4. Fragment Prediction Settings

Use Libraries Specifies whether the node uses the Mass Frontier fragmentation 
libraries for fragment prediction.

Default: True
Selections: True or False

Table 27. FISh Tracer node parameters (Sheet 2 of 2)

Parameter Description
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3. In the Intensity Tolerance [%] box, type the intensity tolerance window for the isotopes.

The actual intensities of the isotopes must be within this tolerance window.

Actual intensity = ± Specified percentage of expected intensity

4. In the MS Order list, select the MS order for the search.

The application checks the mass spectrum scans of the selected order.

5. In the Custom Label box, type text that you can use to identify the chromatogram.

6. Place the cursor in the Isotope Ratios box. Then, click the browse icon, . 

The Isotope Ratio Editor opens. For information about using the Isotope Ratio Editor, 
see “Isotope Ratio Editor Dialog Box” on page 144.

Table 28 describes the parameters for the Pattern Tracer node.

Table 28. Pattern Tracer node parameters

Parameter Description

1. General Settings

Isotope Ratios Displays either the elemental composition of the compound of 
interest or the following text: [custom pattern]. 

You use the Isotope Ratio Editor to set up the isotope pattern for 
the compound of interest. 

The application can automatically set up the isotope pattern for a 
non-isotopically labeled compound on the basis of its elemental 
composition. For isotopically-labeled compounds, you must enter 
the expected mass shifts of the isotopic peaks as well as their 
relative intensity to the A0 isotope.

Mass Tolerance Specifies the mass tolerance for the mass shifts between the mass 
spectral peaks in the pattern. 

Range: 0.0–1e6

You set up the pattern with the Isotope Ratio Editor dialog box.

Intensity Tolerance [%] Specifies the relative intensity tolerance of the mass spectral peaks 
in the pattern.

Range: 0.01–100.0

The A0 isotope is always the isotope with the lowest m/z value, 
but it is not necessarily the isotope with the highest intensity. For 
example, with more than one bromine atom, a bromine and a 
chlorine atom, or more than four chlorine atoms, the M + 2 
isotope is the most intense isotope.
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Isotope Ratio Editor Dialog Box

This topic describes how to use the Isotope Ratio Editor dialog box. Follow these procedures 
as needed:

• To open the Isotope Ratio Editor

• To set up the pattern for a compound by using its elemental composition

• To set up a custom pattern

• To export a mass spectrum from a raw data file to the Clipboard

 To open the Isotope Ratio Editor

1. Open a processing workflow that includes the Pattern Tracer node or add the node to a 
new workflow.

2. In the workspace, click the Pattern Tracer node.

The parameters for the Pattern Tracer node appear in the Parameters pane.

3. Place the cursor in the Isotope Ratios box.

The browse icon appears. 

4. Click the browse icon, .

The Isotope Ratio Editor dialog box opens (Figure 90).

MS Order Specifies the MS order of the mass spectrum.

Selections: MS1–MS10

Polarity Specifies the polarity of the mass spectrum.

Selections: Positive or Negative

Custom Label Use this box to enter a description of the trace.

Table 28. Pattern Tracer node parameters

Parameter Description
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Figure 90. Isotope Ratio Editor dialog box with the elemental composition for omeprazole

 To set up the pattern for a compound by using its elemental composition

1. In the Isotope Ratio Definition Type area, select the Define from Elemental 
Composition Formula option. 

2. In the Elemental Composition box, type or paste the alphanumeric elemental 
composition of the compound of interest.

The application automatically populates the Mass Shift and Intensity [%] columns.

Tip  To enter an elemental composition for a labeled compound, use brackets to 
identify the type and number of labeled atoms for each element. 

For example, to enter the elemental composition of omeprazole where only one of the 
carbon atoms has been replaced with carbon-13, type C16 [13]C H19 N3 O3 S.
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5. Do the following: 

• In the Int. Threshold [%] box, type the relative intensity threshold.

The application removes isotopic peaks below this relative intensity threshold from 
the Mass Shift versus Intensity [%] table.

• In the Resolution box, type the resolution for the scans.

• In the Charge box, type or select the charge state of the ions.

The application uses the charge state to display the theoretical mass spectrum in the 
graphical display.

 To set up a custom pattern

1. Select the Custom Isotope Ratio Pattern option.

Below the Isotope Ratio Definition Type area, the available parameters change 
(Figure 91).

Tip  To copy the elemental composition of a compound from the compound library, 
do the following: 

1. If the Isotope Ratio Editor dialog box is open, close it.

2. Open the compound library and delete all of the columns except the Elemental 
Composition column by using the Field Chooser dialog box.

3. Right-click the elemental composition of interest and choose Copy from the 
shortcut menu. 

4. After you open the Isotope Ratio Editor dialog box, right-click in the Elemental 
Composition box and choose Paste.

Note  The scan header in the raw data file lists the resolution of each scan, and the 
instrument method that is associated with the raw data file lists the resolution of 
each scan event.
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Figure 91. Custom Isotope Ratio Pattern view

2. To set up the custom isotope ratio pattern, do one of the following:

• Type values in the Mass Shift and Intensity boxes.

• Click Get from Composition Formula.

The application uses the text in the hidden Elemental Composition box.

• Click Get from Clipboard.

The application uses the mass spectrum data that you copied to the Clipboard. For 
information about copying data points from a mass spectrum to the Clipboard, see 
the next procedure.

 To export a mass spectrum from a raw data file to the Clipboard

1. Open the Qual Browser or FreeStyle application.

2. Open the raw data file that contains the mass spectrum of interest and make the mass 
spectrum view or the spectrum list view the active view.

3. Depending on whether you are using the Qual Browser or FreeStyle application, do one 
of the following:

For the Qual Browser application, do the following:

a. In the mass spectrum view, zoom in on the region of interest; for example, the region 
that contains the isotope pattern of interest.

b. Right-click the mass spectrum view and choose View > Spectrum List from the 
shortcut menu.
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c. Change the mass precision of the spectrum list as follows:

i. Right-click the spectrum list view and choose Display Options from the 
shortcut menu.

The Display Options dialog box for the Spectrum List view opens.

ii. On the Style page of the Display Options dialog box, type 5 in the Decimals box 
under Precision.

iii. Click OK to accept the setting.

d. Right-click the spectrum list view and choose Export > Clipboard (Exact Mass) 
from the shortcut menu.

e. Open a spreadsheet application and paste the data that is on the Clipboard to a 
spreadsheet.

For the FreeStyle application, do the following:

a. In the Exports category, select Selection AS.

The Copy to Clipboard/Export dialog box opens.

b. Select the To CSV File option.

c. Click OK to export the data.

The spreadsheet application opens to a Workbook with the pasted data.

4. In the spreadsheet application, select up to 20 rows of m/z and intensity values and copy 
them to the Clipboard. Do not select the spectrum header information.
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Table 29 describes the parameters in the Isotope Ratio Editor dialog box.

Table 29.  Isotope Ratio Editor dialog box parameters (Sheet 1 of 3)

Parameter Description

Isotope Ratio Definition Type

These two options define the parameters that appear below the Isotope Ratio Definition 
Type area.

Define from Elemental 
Composition Formula

Selecting this option makes the following features visible:

• Elemental Composition box

• Int. Threshold [%] box

• Resolution box

• Charge box

Custom Isotope Ratio 
Pattern

Selecting this option makes the following features visible:

• Get from Composition Formula button

• Get from Clipboard button

• Bar graph of Intensity [%] versus the m/z ratio of the isotopic 
mass peaks 

• Data entry table where you define a custom isotope pattern in 
terms of the mass shift and intensity of each mass peak 

Use this option to create a custom isotope pattern.

Elemental composition view

Selecting the Define from Elemental Composition Formula option makes the following 
parameters visible: Elemental Composition , Int. Threshold [%], Resolution, and Charge.

Elemental 
Composition

Specifies the elemental composition of the compound of interest. 

When you type a composition in this box, the application 
automatically creates a table of mass shifts and intensities.

Default: Empty (unless you have already specified the elemental 
composition in the Isotope Ratios box under General Settings for 
the Pattern node).

Int. Threshold [%] Specifies the intensity threshold of the isotope pattern. 

Default: 0.10
Range: 0–100
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Resolution Specifies the resolution of the isotope pattern. 

Default: 60 000
Range: 2–1 000 000 000

Charge Specifies the charge associated with the ion fragment. 

Default: 1
Range: 1–100

Graph of Intensity [%] versus m/z value

Displays a graph of the full isotope distribution in the mass shift and intensity table.

Mass shift and intensity table

When you select the Define from Elemental Composition Formula option, the application 
automatically populates this table; you cannot edit the entries.

Required 
(for an isotope pattern 
defined from a 
user-specified 
elemental composition)

Specifies whether the isotope is required.

• When the check box is selected, the isotope is required.

• When the check box is clear, the isotope is not required.

Mass Shift Specifies the mass shift from the A0 isotope for the ion of interest.

Intensity [%] Specifies the relative intensity [%] of the ion to the A0 mass 
spectral peak.

Rows Row 1 specifies the values for the A0 isotope, row 2 specifies the 
values for the A1 isotope, and so on.

Custom isotope ratio pattern view

Selecting the Define from Elemental Composition Formula option makes the following 
buttons visible: Get from Composition Formula and Get from Clipboard.

Get from Composition 
Formula 

Creates an isotope pattern for an elemental composition formula. 
The application reads the elemental composition that you entered 
in the Elemental Composition box before selecting the Custom 
Isotope Ratio Pattern option.

Get from Clipboard Imports the isotope pattern from the Clipboard. You can export a 
custom pattern to the Clipboard from the spectrum list view in 
the Qual Browser application or from a third-party software 
application.

Graph of Intensity [%] versus m/z value

Displays a graph of the full isotope distribution in the mass shift and intensity table.

Table 29.  Isotope Ratio Editor dialog box parameters (Sheet 2 of 3)

Parameter Description
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Mass Tracer Node

Use the Mass Tracer node to create a mass chromatogram for a specific mass range, a 
fragmentation order for a multistage experiment, and ionization polarity. For information 
about the node connections, see “Workflow Node Connections” on page 108. For general 
information about the node, see “Workflow Nodes and Parameters Pane” on page 110.

Figure 92 shows the default parameter settings for the Mass Tracer node.

Figure 92. Mass Tracer node parameters

Table 30 describes the parameters for the Mass Tracer node.

Mass shift and intensity table

When you select the Custom Isotope Ratio Pattern option, you can edit the mass shift and 
intensity values for the isotope pattern.

Buttons common to both views

OK Closes the dialog box and saves the entries.

Cancel Closes the dialog box without saving the entries.

Table 29.  Isotope Ratio Editor dialog box parameters (Sheet 3 of 3)

Parameter Description

Table 30. Mass Tracer node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Trace Type Specifies the chromatogram type to be generated.

Default: BPC
Selections: TIC (total ion chromatogram), BPC (base peak 
chromatogram), or XIC (extracted ion chromatogram)
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MS Order Specifies the MS order of the mass spectra that make up the 
chromatogram.

Default: MS1
Selections: MS1–MS10

Polarity Specifies the ionization polarity used to produce the mass spectra 
that make up the chromatogram.

Default: + (Positive)
Selections: + (Positive) or – (Negative)

Custom Label Use this box to type text that you can use to identify the 
chromatogram.

This text appears in the Custom Label column of the Specialized 
Traces result table.

This box accepts alphanumeric and special characters.

2. XIC Settings

Mass [Da] Defines the mass-to-charge (m/z) value of the extracted ion 
chromatogram (XIC).

Default: 0 

Mass Tolerance

(typed numeric value 
and selected units)

Specifies the mass tolerance for the spectral search. 

When you select Da in the units list, the mass tolerance is an 
absolute ± window for the mass specified in the Mass box. 

When you select mmu (millimass) or ppm (parts per million) in 
the Units list, the mass tolerance is a relative ± window for the 
mass specified in the Mass box.

Default: 3 ppm
Range: 0 to no upper limit
Units: Da, mmu, ppm 

Table 30. Mass Tracer node parameters (Sheet 2 of 2)

Parameter Description
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Compound Generator Node

Use the Compound Generator node to generate a list of m/z values for the ionized compounds 
that you expect to find in a sample. The list includes the parent compound and its possible 
dealkylation, dearylation, and transformation products. The application generates the list by 
using the structure of the parent compound, the user-specified transformation lists and 
number of combinatory steps, and the user-specified ionic species. 

The default transformations library contains common Phase 1 and Phase 2 metabolic 
transformations. If the transformation list does not include the possible transformations for 
your compound, add them to the transformations library as described in “Adding or Editing 
Transformations with the Transformation Editor” on page 351. 

When you add transformations to the library, you can assign them to one of the following 
groups: Phase I, Phase II, or Others. The Compound Generator node treats transformations 
assigned to the Others group as Phase I transformations; that is, it applies Phase I and Others 
transformations before it applies Phase II transformations.

To predict the transformation products for a selected parent compound, the Compound 
Generator node follow these rules:

1. When the user enables Dealkylation, apply the dealkylation steps first. If a subsequent 
transformation reverses the dealkylation step, reject the subsequent transformation. When 
the user enables both Dealkylation and Dearylation, apply both of these steps first, and 
then determine two separate reaction pathways for the remaining transformation steps. 

Consider all of the steps under Dealkylation together as one step. For example, consider 
the selections shown in Figure 93 as one step in the total set of reaction pathways and 
create separate reaction pathways. Apply the transformations steps on the parent 
compound and the reaction products from the dealkylation pathways. 

Figure 93. Dealkylation step example
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2. When more than one reaction pathway produces the same elemental composition, use the 
pathway with the lowest number of transformation steps. 

3. Reject transformations that remove elements that are not present. For example, do not 
apply an oxidative dechlorination step if the compound does not contain chlorine.

4. For Phase I and Others transformations, limit the maximum number of times to apply 
the transformation on a single compound to the lower of these two values:

– Max Occurrence setting for the transformation in the Transformation library 

For example, for the oxidation transformation, the default value for Max Occurrence 
is 3.

– Maximum number of steps specified by the node’s Max. # All Steps parameter minus 
any previously applied Dealkylation step. 

5. For Phase II transformations, limit the maximum number of times to apply the 
transformation on a single compound to the lowest of these three values:

– Max Occurrence setting for the transformation in the Transformation library

– Maximum number of steps for all reactions (setting for node’s Max. # All Steps 
parameter) minus any previously applied Dealkylation or Transformation step

– Maximum number of steps for a Phase II transformation (setting for node’s Max. # 
Phase II parameter)

For an example of how the Compound Generator node predicts the reaction pathways, see 
Table 9 on page 42. For information about the node connections, see “Workflow Node 
Connections” on page 108. For general information about the node, see “Workflow Nodes 
and Parameters Pane” on page 110.

Figure 94 shows the default parameter settings for the Compound Generator node. 
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Figure 94. Compound Generator node parameters

Table 31 describes the parameters for the Compound Generator node. The application 
cannot use the processing workflow until you select a compound from the Compound list. 

Table 31. Compound Generator node parameters (Sheet 1 of 3)

Parameter Description

1. Compound Selection

Compound Specifies the parent compound that the node uses to build a list of 
possible product compounds.

Note  Before you can use the compound generator node to 
predict the transformation products of a specific compound, you 
must first add the compound to the compound library.

2. Dealkylation

Apply Dealkylation When you select True, the node applies the dealkylation 
transformations for the specified compound before applying other 
transformations.

Default: True

Apply Dearylation When you select True, the node applies the dearylation 
transformations for the specified compound before applying other 
transformations. 

Default: False
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Max. # Steps Specifies the maximum number of Dealkylation steps. 

For example, if you select True for Dealkylation, True for 
Dearylation, and 1 for the Max. # Steps, the node applies up to 
one dealkylation step and up to one dearylation step as the initial 
Dealkylation step in the set of reaction pathways. For another 
example, see Figure 93 on page 153.

Default: 1
Selection: 1–10

Min. Mass [Da] Specifies the minimum mass of the dealkylation product.

Default: 200

3. Transformations

Phase I Specifies the set of possible Phase 1 transformations. 

Default: All check boxes are clear.

Phase II Specifies the set of possible Phase II transformations. 

Default: All check boxes are clear.

Others Specifies other possible transformations. 

The node treats Others transformations as Phase I 
transformations.

Max. # Phase II Specifies the maximum number of Phase II steps to be applied. 

Default: 1
Range: 1–10

Table 31. Compound Generator node parameters (Sheet 2 of 3)

Parameter Description

Parent compound

Products of 
one dearylation

step

Products of
one dearylation

step
Parent compound
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Expected Finder Node

Use the Expected Finder node to search for compounds in the compound ions list provided 
by one or more Compound Generator nodes. 

Using the input from one or more Compound Generator nodes, the Expected Finder node 
looks for expected compounds in the MS1 scans filtered through one or more of the data 
processing nodes. The expected compounds are the parent compounds, one for each 
Compound Generator node that provides input to the Expected Finder node, and the 
reaction products for these parent compounds. Each Compound Generator node predicts the 
reaction products on the basis of the user-specified Dealkylation step and the transformation 
steps. The Dealkylation step can comprise multiple dealkylation and dearylation reactions. 

The processing results for the Expected Finder node appear in the Expected Compounds and 
Expected Compound Hits master tables and the Expected Compound Ions related table.

For more information about how the Compound Discoverer application finds expected 
compounds, see “Finding Expected Compounds” on page 19. For information about the 
node connections, see “Workflow Node Connections” on page 108. For general information 
about the node, see “Workflow Nodes and Parameters Pane” on page 110.

Max. # All Steps Specifies the maximum number of all steps to be applied. 

All of the steps that occur as a result of the selections in the 
Dealkylation area equal one step in the maximum number of all 
steps; that is, after the node applies one or more of the steps in the 
Dealkylation area, the remaining number of possible steps is equal 
to the Max. # All Steps – 1.

Default: 3
Range: 1–10

4. Ionization

Ions Specifies the possible ionic species.

Default: [M+H]+1 (protonated species for the positive mode)

The ion definitions library provided with the application contains 
the common ionic species associated with the positive and 
negative modes for the electrospray ionization-mass spectrometry 
(ESI-MS) technique. If the Ions list does not include the possible 
ionic species for your analysis, add the ion definition to the Ion 
Definition library as described in “Modifying the Ion Definitions 
Library” on page 341.

Table 31. Compound Generator node parameters (Sheet 3 of 3)

Parameter Description
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Figure 95 shows the default parameter settings for the Expected Finder node. 

Figure 95. Expected Finder node parameters

Table 32 describes the parameters for the Expected Finder node.

Table 32. Expected Finder node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance window that the node uses to create each extracted ion 
chromatogram (XIC).

Default: 5 ppm
Range: 0.1 to 20 ppm

Intensity Tolerance [%] Specifies the relative intensity tolerance window that the node uses for isotope pattern 
comparison.

Default: 30%
Range: 0–100

Min. # Isotopes Specifies the minimum number of isotopes (mass spectrum peaks in a centroided mass 
spectrum) that match the theoretical isotope pattern of the expected elemental composition.

Default: 2
Range: 1 to no limit

Minimum Peak 
Intensity

Specifies the minimum apex intensity of the detected chromatographic peak. The node 
discards chromatographic peaks below this intensity threshold.
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Unknown Detector Node

Use the Unknown Detector node to detect unknown compounds. The Unknown Detector 
node processes filtered mass spectral scans and looks for chromatographic peaks above a 
specified signal-to-noise threshold. The processing results for the Unknown Detector node 
appear in the Unknown Compounds and Unknown Compound Hits master tables and the 
Unknown Compound Ions related table.

For information about an untargeted processing workflow, see “Detecting Unknown 
Compounds” on page 25. For information about the node connections, see “Workflow Node 
Connections” on page 108. For general information about the node, see “Workflow Nodes 
and Parameters Pane” on page 110.

Average Peak Width Specifies the average chromatographic peak width (FWHM) in the filtered time range.

Default: 0 (automatic peak width detection)
Range: unchecked

When this value is set to 0, the node automatically determines the average peak width. 

IMPORTANT  The node detects no chromatographic peaks in the following cases:

• The filtered retention time is too small compared to the determined or user-specified 
average peak width value. For information about filtering the scan data, see 
“Spectrum Selector Node” on page 129.

• The determined or user-specified average peak width value is too small compared to 
the scan rate of the instrument. 

For example, if the instrument acquires a full (MS1) scan every 0.01 minutes, do not 
enter an Average Peak Width value of less than 0.02 (2 × 0.01 minutes), as the peak 
detection algorithm requires a minimum of three data points to detect a 
chromatographic peak.

For best results, keep the default setting of 0, which turns on automatic peak width 
detection. Enter a nonzero value only when the automatically detected peak width is not 
suitable or fails for your chromatographic method.

Table 32. Expected Finder node parameters (Sheet 2 of 2)

Parameter Description
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Figure 96 shows the default parameter settings for the Unknown Detector node.

Figure 96. Unknown Detector node parameters

Table 33 describes the parameters for the Unknown Detector node. 

Table 33. Unknown Detector node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance for the XIC traces. 

Default: 5.0 ppm
Range: 1–20.0 ppm

Intensity Tolerance Specifies the intensity tolerance for the isotope pattern search.

Default: 30%
Range: 0 to 100%

S/N Threshold Specifies the signal-to-noise threshold for chromatographic peak 
detection. The unknown compound detection algorithm ignores 
chromatographic peaks below this user-specified threshold. The 
S/N threshold affects FT data only.

Default: 3
Range: 0 to no upper limit

Min. Peak Intensity Specifies the minimum peak height for a chromatographic peak to 
be detected in an XIC trace. 

Default: 10 000
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FISh Scoring Node

Use the FISh Scoring node to provide a confirmation score for compounds detected by the 
Expected Finder node and to annotate the fragmentation spectra for these compounds. The 
FISh Scoring node requires data-dependent fragmentation (DDF) scans to calculate the best 
FISh coverage scores for related structures.

For more information about how the node calculates the confirmation score, see “6. Scoring 
and Annotation” on page 115.

Figure 97 shows the default parameter settings for the FISh Scoring node.

Ions Specifies the adduct ions that might be in your samples. 

Regardless of the selection in the Ions list, the Unknown Detector 
node always searches for [M+H]+1 adduct ions in the positive scan 
mode and [M–H]–1 adduct ions in the negative scan mode.

Default: [M+H]+1, [M+K]+1, [M+Na]+1

Selection: The ion definitions in your Ion Definitions library

Min Element Counts Specifies the minimum number of each possible element. The 
node uses these values for the isotope pattern search.

Default: C H

Max Element Counts Specifies the maximum number of each possible element. The 
node uses these values for the isotope pattern search.

Default: C90 H190 Br3 Cl4 K2 N10 Na2 O15 P2 S5

2. Peak Detection

Filter Peaks Specify whether you want to turn on the chromatographic peak 
filtering parameters. 

Selections: True or False

Max. Peak Width 
[min]

When Filter Peaks is set to True, specifies the maximum peak 
width at half height, in minutes, for detected chromatographic 
peaks on the basis of the expected peak widths.

Default: 0.3 minutes
Range: 0.05 to no upper limit

Table 33. Unknown Detector node parameters (Sheet 2 of 2)

Parameter Description
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Figure 97. FISh Scoring node parameters

Table 34 describes the parameters for the FISh Scoring node.

Table 34. FISh Scoring node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Annotate Full Tree Specifies whether the node annotates the full spectrum tree or 
only the MS2 scans in the Mass Spectrum View.

For information about viewing the FISh annotations in the Mass 
Spectrum View, see “Working with the Mass Spectrum View” on 
page 188.

Default: True
Selections: True or False

Match Transformations Specifies whether the node matches fragments with 
transformation shifts. 

Default: True
Selections: True or False

S/N Threshold Specifies the signal-to-noise threshold for centroids. The node 
ignores centroids below this threshold in the MS2 spectra.

Default: 3

High Acc. Mass 
Tolerance

Specifies the mass tolerance window for high-resolution mass 
spectra.

Default: 2.5 mmu
Minimum: 0.0
Maximum: Unchecked
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Peak Consolidator Node

Use the Peak Consolidator node to combine the expected compounds found by the Expected 
Finder node (Expected Compound Hits) and the unknown compounds found by the 
Unknown Detector node (Unknown Compound Hits) on the basis of their chromatographic 
retention time and m/z values. Also use the Peak Consolidator node to compare the peak area 
of a component in a non-reference sample to its peak area in a reference sample.

For information about the node connections, see “Workflow Node Connections” on 
page 108. For general information about the node, see “Workflow Nodes and Parameters 
Pane” on page 110.

Low Acc. Mass 
Tolerance

Specifies the mass tolerance window for low-resolution mass 
spectra.

Default: 0.5 Da
Minimum: 0.0
Maximum: Unchecked

4. Fragment Prediction Settings

Use Libraries Specifies whether the node uses fragmentation libraries for 
fragment prediction.

Default: False
Selections: True or False

Note  Using fragmentation libraries to predict fragments adds 
significant time to data processing; however, it also provides 
significantly more predicted fragments.

Use Libraries for Full 
Tree

When you enable Use Libraries, specifies whether the node uses 
fragmentation libraries for fragment prediction for MS3 scan and 
higher.

Default: False
Selections:

• True—Uses the fragmentation libraries for all fragmentation 
scans, including MS3 and higher scans.

• False—Uses the fragmentation libraries for MS/MS scans 
only.

Table 34. FISh Scoring node parameters (Sheet 2 of 2)

Parameter Description
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Figure 98 shows the default parameter settings for the Peak Consolidator node.

Figure 98. Peak Consolidator node parameters

 To set up the Compare with Control feature

1. To determine whether a chromatographic peak is found in a control (reference) file and to 
compare the relative peak areas in one or more sample (non-reference) files to those in a 
control file, select True for the Compare with Control parameter.

2. To specify the control limits, type values in the Max. Sample/Control Fold and Max. 
Control/Sample Fold boxes. 

A value of 0 means no limit.

Table 35 describes the parameters for the Peak Consolidator node.

Table 35. Peak Consolidator node parameters (Sheet 1 of 2) 

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance for the peak group.

Default: 5 ppm
Range: 0.1–20 ppm

RT Tolerance [min] Specifies the retention time tolerance, in minutes, for the peak 
group. 

Default: 0.05
Range: 0.0–1.0

2. Compare with Control

Compare with Control Specifies whether non-reference files are compared to a reference 
file.

Default: True
Selections: True or False
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Working with the Job Queue
When you submit one or more analyses for processing, the Job Queue page opens. You can 
also open the Job Queue page by choosing View > Show Job Queue from the Compound 
Discoverer menu bar.

The application can process two runs simultaneously. If you submit a second run while the 
first run is being processed, the status of the second run goes to Not Queued, Running, 
Completed, or Execution Failed. If you submit a third run while the application is processing 
the first two runs, its status goes to Waiting. If you pause a run that is waiting, its status goes 
to Sleeping.

Follow these procedures as needed:

• To open a hidden Job Queue page

• To pause a run that is waiting to be processed

• To resume a paused run

• To cancel a run that is being processed

• To remove a completed or failed run from the Job Queue list

Max. Sample/Control 
Fold

Specifies the maximum sample/control ratio for a compound 
found in both the sample (non-reference sample) and the control 
(reference sample). If the ratio is greater than this fold factor, the 
sample is not within the control limits and the In-Control column 
in the Consolidated Peaks table displays an orange status 
rectangle.

Default: 5
Range: 0 to unchecked

Max. Control/Sample 
Fold

Specifies the maximum control/sample ratio for a compound 
found in both the sample and the control. 

Table 35. Peak Consolidator node parameters (Sheet 2 of 2) 

Parameter Description
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• To refresh the Job Queue list

• To open a result file

• To display verbose messages

• To view the processing steps for a run

• To filter the Job Queue list

• To close the Job Queue page

 To open a hidden Job Queue page

From the Compound Discoverer window, choose View > Show Job Queue.

The Job Queue page opens in the Compound Discoverer window as a tabbed document.

 To pause a run that is waiting to be processed

1. In the Job Queue list, select the run that you want to pause.

You can only pause runs with a status of Waiting.

2. In the Job Queue command bar, click Pause.

The status of the run changes to Sleeping.

 To resume a paused run

1. In the Job Queue list, select the paused run.

2. In the Job Queue command bar, click Resume.

 To cancel a run that is being processed

1. In the Job Queue list, select the run that you want to cancel.

2. In the Job Queue command bar, click Abort.

When you cancel a run, the execution state changes to Aborted, and the application does 
not create a result file for the run.

 To remove a completed or failed run from the Job Queue list

1. In the Job Queue list, select the run that you want to remove.

2. In the Job Queue command bar, click Remove.

The selected run disappears from the Job Queue list. The application does not remove the 
result file from the study.

 To refresh the Job Queue list

In the Job Queue command bar, click Refresh.
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 To open a result file

1. In the Job Queue list, select the completed run of interest.

2. In the Job Queue command bar, click Open Results.

The Results page for the selected run opens as a tabbed document in the Compound 
Discoverer window.

 To display verbose messages

Select the Display Verbose Messages check box.

 To view the processing steps for a run

Click the expand icon, , to the left of the job row.

 To filter the Job Queue list 

1. For the filtering function to the left of the Execution State filter list, select Equals.

2. In the Execution State filter list, select Aborted.

Note  Use the filters for the column that you want to sort by. For example, to display 
only the runs that you ended before completion, follow this procedure.
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The Job Queue list displays only the Aborted runs.

3. To undo filtering, close and reopen the Job Queue page.

 To close the Job Queue page

Do one of the following:

Click the close icon, , to the right of the Job Queue tab text.

–or–

Right-click the Job Queue tab and choose Close from the shortcut menu.

Table 36 describes the command bar and progress table on the Job Queue page.

Table 36. Job Queue page features (Sheet 1 of 2)

Feature Description

Command bar

Pause Pauses a job.

Selecting a job that is waiting to start activates this button.

Resume Resumes a processing job that is sleeping.

Selecting a job with a status of Sleeping activates this button.

Abort Stops processing and removes the selected job from the queue.

Selecting a job that is being processed activates this button.

Remove Selecting a completed job activates this button.

Refresh Refreshes the job queue list.

Open Results Opens the result file for the selected job.

Display Verbose 
Messages

Selecting this check box displays additional messages for jobs that 
contain multiple input files.
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Table columns

Execution State Displays the status of the job.

• Not Queued—The application takes a finite length of time to 
start a job after you click the Run command.

• Running—The application is currently processing the job. 
The application can process two jobs simultaneously. When 
you submit an analysis as a batch, each input file is processed 
as a separate job.

• Aborted—You canceled the job while the application was 
processing the analysis.

• Execution Failed—The application was unable to complete 
the job.

• Waiting—The application has not begun to process the job.

• Sleeping—You paused the job while it was waiting in the 
queue.

• Completed—The application has completed the analysis and 
you can open the result file.

Progress Displays the progress of the run as a percentage.

Type Displays the job type.

Name Displays the name of the result file.

Data Source Displays the location and file names of the input files for the 
current job.

Description Displays the description that you typed in the Description box on 
the Workflows page.

Submitted At Displays the date and time when you submitted the run to the job 
queue.

Table 36. Job Queue page features (Sheet 2 of 2)

Feature Description
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Reprocessing an Analysis
When you submit a run to the job queue, the run appears in the list of analyses on the 
Analysis Results page of the current study. 

Use the Analysis Results page to review or reprocess a completed analysis or to open a result 
file. An analysis consists of a processing workflow and one or more input files.

 To open the Analysis Results page

1. Open the study of interest.

2. Click the Analysis Results tab.

 To review an analysis

1. In the list of analyses on the Analysis Results page, select the analysis of interest.

2. In the Analysis Results command bar, click Show Analysis Details.

The Analysis Sequence Details dialog box opens (see “Reviewing an Analysis Sequence” 
on page 171).

 To reprocess an analysis

1. In the table, select the analysis that you want to reprocess.

You can submit an analysis for reprocessing as soon as it appears in the list on the Analysis 
Results page.

2. In the Analysis Results command bar, click Reprocess.

• If the Analysis pane is closed, it reopens with the settings from the selected analysis.

• If the Analysis pane is open and contains information for an analysis that you have 
not yet submitted to the job queue, the following confirmation message appears in a 
pop-up box:

The analysis was not started. Do you really want to discard the analysis?

3. If a confirmation message appears, do the following:

a. Check the Analysis pane and decide whether you want to discard the current settings. 

b. Click Yes to replace the current settings in the Analysis pane with the settings from 
the selected analysis. Otherwise, click No to return to the in-progress analysis.

4. If necessary, make changes to the processing workflow on the Workflows page and the 
settings in the Analysis pane.

5. To start the analysis, click Run.
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Table 37 describes the command bar and progress table on the Analysis Results page of a 
study. For more information about studies, see “Working with a Study Page” on page 70.

Reviewing an Analysis Sequence
After you run an analysis, you can view the details of the analysis sequence by opening the 
Analysis Sequence Details dialog box for the completed result file.

 To open the Analysis Sequence Details dialog box

1. On the study page, click the Analysis Results tab.

2. On the Analysis Results page, select the completed run of interest in the run table. Then, 
in the Analysis Results command bar, click Show Details.

The Analysis Sequence Details dialog box opens. Only the Save and Save Common 
commands are available (Figure 99). Although you cannot modify the processing 
workflow, you can save it.

Table 37. Analysis Results page parameters

Feature Description

Command bar
Selecting an analysis in the list on this page activates these commands.

Open Result Opens the selected result file.

Show Details Opens the Analysis Sequence Details dialog box.

Reprocess Opens the Analysis pane with the list of input files that were used 
for the selected analysis. In addition, the Workflows page contains 
the processing workflow that the application used to run the 
selected analysis.

Table columns

Execution State Displays the status of the analysis.

Creation Date Displays the date and time when you submitted the run to the job 
queue.

File Name Displays the file name of the result file.

Description Displays the description that you typed in the Description box on 
the Workflows page.

Analysis Results command bar
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Figure 99. Analysis Sequence Details dialog box

If you attempt to close the study, the following message appears.

Want to save your changes to study Study Name?

3. To save the changes, which includes the list of completed runs on the Analysis Results 
page, click Yes.
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4

Reviewing the Analysis Results

When you process one or more input files with a processing workflow, the Compound 
Discoverer application stores the processed data in a result file. When you open a result file, it 
opens as a tabbed document in the Compound Discoverer window. The tabbed document 
contains two graphical views and a set of tabbed result tables. Although you can open only 
one result file at a time, you do not have to close the current result file before opening another 
result file; that is, you can have multiple result files open simultaneously. For ease of viewing, 
you can convert the graphical views to floating windows and drag the floating windows to a 
second monitor. 

This chapter describes the features of the result page. It also describes how to work with and 
interpret the result tables and graphical views, filter the result tables to remove non-pertinent 
data, and modify and store the layout of the current result file.

Contents

• Opening Result Files

• Working with the Graphical Views

• Reviewing the Data in the Result Tables

• Adding Custom Explanations

• Using Result Filters for Data Reduction

• Viewing the Processing Summaries

• Saving a Custom Result File Layout or Restoring the Default Layout



4 Reviewing the Analysis Results
Opening Result Files

174 Compound Discoverer User Guide Thermo Scientific

Opening Result Files
During an analysis, the application processes a set of input files (Xcalibur Raw files) by using a 
processing workflow and stores the processing results in a result file (.cdResult). When you 
open a result file for the first time, you see a tabbed document with the default layout in the 
Compound Discoverer window. You can modify the layout and save these changes with the 
result file. The next time you open the result file, it will open with your custom layout. 

The default layout for a result page includes the following items:

• A title bar that lists the directory and file name of the result file

• An empty Chromatogram View on the top left

• An empty Mass Spectrum View on the top right

• A set of tabbed master tables below the two graphical views 

• A collapsed area for the related tables below the master tables

You cannot drag the tabbed result page to a second monitor screen. However, you can change 
the following properties:

• The location of the tabbed result page with respect to the tabbed documents that are open 
in the Compound Discoverer window (see “Working with Tabbed Documents” on 
page 15) 

• The graphical views that you want to display and their location (see “Rearranging the 
Graphical Views” on page 176)

• The master and related tables and table columns that you want to display and the order of 
the table columns from left to right (see “Reviewing the Data in the Result Tables” on 
page 204 and “Working with Compound Discoverer Tables” on page 369, and “Using 
Result Filters for Data Reduction” on page 236) 

Figure 100 shows a tabbed result page. The result file is the product of processing two input 
files—one sample file and one control file—with a processing workflow that includes the 
Spectrum Selector, Retention Aligner, Compound Generator and Expected Finder, Peak 
Consolidator, and FISh Scoring nodes.
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Figure 100. Default layout for a result page

To open and close result files, follow these procedures:

• To open a result file

• To close a result file

 To open a result file

Open a result file from the Compound Discoverer window, the Start Page, the Job Queue 
page, or the Analysis Results page as follows: 

• In the Compound Discoverer window, do one of the following: 

– From the menu bar, choose File > Open Result. In the Open dialog box, browse 
to the appropriate folder, select the result file of interest, and click Open.

– From the menu bar, choose File > Recent Results > recent result file.

• On the Start Page, do one of the following:

– Under Recent Results, click the name of the result file of interest, which appears 
in blue hypertext.

– Under What Would You Like to Do?, click Open Result.

Result Table Chooser icon

Field Chooser icon
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• On the Job Queue page, do one of the following:

– Double-click the table row for a completed job. 

– Select the table row of a completed job and click Open Results.

• On the Analysis Results page, select the file of interest and click Open Results.

The result file opens as a tabbed document. The tab displays the file name of the 
result file (  File Name X). In the default layout, the document contains two 
graphical views and one or more result tables. 

You can open as many result files as you want. To view a particular result file, click its tab. 

 To close a result file

Do one of the following:

• Right-click the tab and choose Close from the shortcut menu. 

–or– 

• Click the close icon on the document’s tab ( ).

“Working with Tabbed Documents” on page 15 and “Shortcut Menu Commands for the 
Result Tables” on page 230 describe the shortcut menu commands that are available by 
right-clicking the result page tab.

“Saving a Custom Result File Layout or Restoring the Default Layout” on page 247 describes 
how to save a custom layout or restore the default layout.

Working with the Graphical Views
You can display chromatograms, mass spectra, and scatter chart plots on the result page. These 
topics describe how to work with the graphical views:

• Rearranging the Graphical Views

• Working with the Chromatogram View

• Working with the Mass Spectrum View

• Working with the Scatter Chart View

Rearranging the Graphical Views

With the default layout, a result file opens with the Chromatogram View docked in the upper 
left portion of the page, the Mass Spectrum View docked in the upper right portion of the 
page, and a tabbed set of result tables displayed below these two graphical views.
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You can move the docked views from one dock position to another dock position or to a 
second monitor. You can also change the docked views to floating windows and move them 
anywhere on the monitor screen or to a second monitor.

To rearrange the graphical views, follow these procedures as needed:

• To move a view to another dock position

• To move the view to the top of the page

• To move the view to the bottom of the page below the result tables

• To change a docked window to a floating window

• To enlarge a view to the full size of the monitor screen

• To restore the previous size of a floating window

 To move a view to another dock position

1. Click the title bar of the view that you want to move and drag the view. 

As you drag the window, a guide tool appears along the vertical median of the window. 
The guide tool consists of four directional arrows that are arranged in a diamond pattern 
around a central circle. In addition to the guide tool, a directional arrow appears at the 
center of each of the window’s four edges.

2. Drag the pointer until it aligns with the appropriate directional arrow. In some cases, you 
might need to move the view twice to dock it in the position you want.

 To move the view to the top of the page 

1. Drag the pointer over the arrow at the top of the page.

A blue, full-page-width rectangle appears in the top half of the page (Figure 101).

Note  The Result Filters window is also a dockable window.
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Figure 101. Dragging the Chromatogram View to the top of the page

2. Release the mouse button to replace the blue rectangle with the view.

 To move the view to the bottom of the page below the result tables

1. Drag the cursor over the arrow at the bottom of the page.

A blue, full-page-width rectangle appears in the bottom half of the page.

2. Release the mouse button.

The view appears, expanded to the full width of the page, below the result tables.

 To change a docked window to a floating window

Do one of the following:

• Right-click the window’s title bar and choose Floating.

–or–

• Double-click the window’s title bar.

 To enlarge a view to the full size of the monitor screen

Double-click the window’s title bar.

Pointer aligned with directional arrow
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 To restore the previous size of a floating window

Double-click the window’s title bar.

Working with the Chromatogram View

Table 38 describes the traces that you can display in the Chromatogram View.

Table 38. Chromatogram View traces (Sheet 1 of 2)

Trace type Description

UV Displays a chromatogram created from the UV signal from a 
UV-Vis detector or the analog channel of a PDA detector.

Analog Displays a trace of response versus time. 

Raw data files can contain analog data from a device that is 
hard-wired to the analog channels of a Thermo Scientific mass 
spectrometer.

PDA total scan Displays a chromatogram of the total absorbance for the entire 
scan wavelength range for each time point.

PDA spectrum 
maximum

Displays a chromatogram of the highest absorbance reading in the 
wavelength range for each time point.

PDA wavelength range Displays a chromatogram of the total absorbance for the specified 
wavelength range for each time point. 

Base peak 
chromatogram (BPC)

Displays a chromatogram of the most intense mass spectral peak 
in the specified mass range for each time point.

Total ion 
chromatogram (TIC)

Displays a chromatogram of the total intensity from all the mass 
spectral peaks in the specified mass range for each time point.

Extracted ion 
chromatogram (XIC)

Displays an XIC trace, which is a mass range trace, when you 
select a row in any of these tables: Consolidated Peaks, Expected 
Compounds, Expected Compound Hits, Expected Compound 
Ions, Unknown Compounds, Unknown Compound Hits, 
Unknown Compound Ions, FISh Trace Fragments, or Specialized 
Traces.

The XIC trace is made up of the mass spectral peaks that match 
the specified mass value within the specified mass tolerance 
window.
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The Chromatogram View is empty until you select a row in one of these master tables: 
Consolidated Peaks, Expected Compounds, Expected Compound Hits, Unknown 
Compounds, Unknown Compound Hits, FISh Trace Fragments, or Specialized Traces.

For information about the shortcut menu commands, see Table 39 on page 184.

Follow these procedures as needed:

• To view a chromatogram

• To apply a shortcut menu command

• To add a plot in the Chromatogram View

• To overlay multiple chromatograms in one chromatogram plot

• To integrate chromatographic peaks manually

 To view a chromatogram 

1. If the Chromatogram View is closed, open it by choosing View > Chromatogram from 
the menu bar.

2. Do one of the following:

• Click the Consolidated Peaks tab and select a row.

The Chromatogram View displays the chromatographic peaks detected by the 
Unknown Detector and Expected Finder nodes. 

• Click the Expected Compound Hits tab or the Unknown Compound Hits tab and 
select a row.

The Chromatogram View displays the integrated chromatographic peak for the 
selected table row.

• Click the Expected Compounds tab or the Unknown Compounds tab and select a 
row.

The Chromatogram View displays a composite trace of all the chromatographic 
peaks that were detected for the molecular weight listed in the selected table row.

Pattern trace Displays a TIC trace of the summed intensities of the mass 
spectral peaks that match a specified pattern for each time point. 

FISh trace Displays a TIC trace of the summed intensities of the mass 
spectral peaks in a fragmentation scan (MS/MS or MS3) that 
match the predicted fragments of the parent compound and its 
transformation products for each time point.

Table 38. Chromatogram View traces (Sheet 2 of 2)

Trace type Description
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• Click the FISh Trace Fragments tab and select a row.

The Chromatogram View displays a trace for the structure displayed in the selected 
table row. The FISh Trace Fragments table appears in the master table set when you 
select True for Individual Traces in the FISh Tracer node of a processing workflow.

• Click the Specialized Traces tab and select a row.

Depending on the processing workflow, the Specialized Traces table can contain the 
following traces: 

• A Mass Tracer node can generate any of these traces: extracted ion (mass range) 
chromatogram (XIC), base peak chromatogram (BPC), or total ion 
chromatogram (TIC).

• An Analog Tracer node can generate any of these traces: a UV-Vis trace from a 
UV-Vis or PDA detector, up to three traces from a PDA detector, or an analog 
trace from an LC detector that you connected to one of the analog input 
channels of a Thermo Scientific mass spectrometer.

• A Pattern Tracer node generates a TIC trace by summing the intensities of the 
mass spectral peaks (across the entire scan) that match the user-defined isotope 
pattern. 

• A FISh Tracer node generates the following:

– A summed FISh trace of all the matching fragment ion scans (DDF or AIF) 
when you select True in the Summed Trace list. 

– An individual FISh trace for each fragment ion when you select True in the 
Individual Traces list. To view the individual trace for each fragment ion, see 
the FISh Trace Fragments table.

3. To determine the origin of a trace in a result file that includes multiple input files, 
right-click the Chromatogram View and choose Show Legend from the shortcut menu. 

4. To decrease or increase the number of legends displayed, right-click the Chromatogram 
View and choose Legend Size > #Rows from the shortcut menu, where # is an integer 
value from 1 to the 10 (Figure 102).

Note  When the result file includes multiple input files, the application displays the 
traces from different input files in different colors.
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Figure 102. Chromatogram View with the shortcut menu displayed

When the number of legend lines becomes too large for the available display space, the 
application displays an empty view with the following text: 

Not enough space for drawing the chart properly.

 To apply a shortcut menu command

Right-click the Chromatogram View and choose a command from the shortcut menu.

 To add a plot in the Chromatogram View

Right-click the Chromatogram View and choose Add Plot from the shortcut menu.

The new plot appears above the original plot. Only the screen size of your computer 
monitor limits the maximum number of plots that you can add to the Chromatogram 
View. When you exceed the maximum number of plots, the plots disappear from the 
view.

In a Chromatogram View with more than one plot, a gray border highlights the active 
plot. If you right-click the Chromatogram View and choose Remove Plot, the application 
removes the active plot.
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 To overlay multiple chromatograms in one chromatogram plot

Do one of the following:

• Hold down the SHIFT key and select a range of contiguous rows.

• Hold down the CTRL key and select contiguous or noncontiguous rows one by one.

• Hold down the SHIFT key and press the Down Arrow on the keyboard.

 To integrate chromatographic peaks manually

1. Open the Chromatogram View.

2. In the Specialized Traces table, select the trace of interest.

3. Right-click the Chromatogram View and choose Manual Peak Integration from the 
shortcut menu.

Two red dashed lines appear.

4. Drag one line to the beginning of the chromatographic peak and the other line to the end 
of the chromatographic peak.

The application highlights the integrated peak area in blue.

5. Place the cursor over the peak.

A pop-up box appears with the selected retention time range and Apply and Cancel 
buttons (Figure 103).

Figure 103. Manually integrated chromatographic peak

6. To add the manual peak to the Manual Peaks table, do one of the following:

• Click Apply.

–or–

• Press the A key on the keyboard.
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If the result file did not already contain a Manual Peaks table, the new table appears in the 
master table tab set. The Manual Peaks table contains a row for the new manual peak.

Chromatogram View Shortcut Menu Commands

Table 39 describes the shortcut menu commands for the Chromatogram View.

Table 39. Shortcut menu commands for the Chromatogram View (Sheet 1 of 3) 

Command Description

Undo Last Zoom/Pan Undoes the last zoom or pan movement.

Undo All Zoom/Pan Zooms out to the full data acquisition time for the chromatogram 
on the x axis and the height of the largest chromatographic peak 
on the y axis.

Keep Zoom Maintains the same zoom range, as you select components with 
different peak areas. Overrides the Zoom to Detected Peaks 
command as you select different table rows.

Copy Image Copies an image of the Chromatogram View (including the 
legend) to the Clipboard.

You can paste the image into a Microsoft Office document as a 
raster image or into a vector-drawing program as a vector image.

Copy Points Copies the data as a two-column list of data points and also the 
scan header. The first column lists the retention time and the 
second column lists either the relative intensity or the counts. 

Save Image As Opens the Save As dialog box where you can specify a file name 
and save the contents of the Chromatogram View as one of these 
selectable image formats: EMF, PNG, GIF, JPG, TIFF, or BMP. 
The PNG, GIF, JPG, TIFF, and BMP formats are raster images. 

Save Points As Opens the Save As dialog box where you can specify a file name 
and save the contents of the Chromatogram View as a text file. 
The default file name is Chart.txt. 

When the chromatogram is a plot of relative intensity versus 
retention time, the application saves the data points as a 
two-column list. The first column lists the retention time and the 
second column lists the relative intensity (%). When the 
chromatogram is a plot of area (in counts) versus retention time, 
the second column lists the area for the peaks.
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Show ToolTips Displays a pop-up box with the following information, from top 
to bottom, when you place the cursor, +, over a chromatographic 
peak:

• Parent compound and any applicable transformations
• Chemical formula of the peak component
• Molecular weight of the peak component
• Selected retention time, in minutes
• Intensity, in counts, of the selected point on the 

chromatogram trace
• File name of the input file

Show Gridlines Adds grid lines to the Chromatogram View.

Show Detected Peaks Shades the integrated area within the detected chromatographic 
peaks a light gray.

Turning off this command removes the shading.

Show Legend Displays a legend at the top of the view. The displayed 
information depends on the selected trace (see Table 40). 

Legend Size Specifies the number of legend lines that you want the application 
to display.

Selections: 0 to 10

Relative Intensity Displays the y-axis scale as relative intensity (0 to 100%).

Zoom to Detected 
Peaks

Zooms in on the detected peak or peaks.

Add Plot Adds an empty, active plot to the Chromatogram View. Only the 
screen size limits the maximum number of displayed plots. When 
you reach the screen’s limit, the Chromatogram View appears to 
be empty and the following message appears:

Not enough space for drawing chart properly.

Remove Plot Removes the active plot, which has a gray border.

Adding more than one plot activates this command.

Remove All Plots Removes all of the plots in the Chromatogram View.

Adding more than one plot to the Chromatogram View activates 
this command.

Freeze Content Keeps the chromatogram of the currently selected row in the view 
when you select another row.

Table 39. Shortcut menu commands for the Chromatogram View (Sheet 2 of 3) 

Command Description
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Table 40 describes the legend for each trace type.

Clear Frozen Content Clears the frozen chromatogram from the view.

Manual Peak 
Integration

Use to add a manual peak to a specialized trace. Adding a manual 
peak adds the Manual Peaks table to a result file (see “To integrate 
chromatographic peaks manually” on page 183).

Selecting a trace in the Specialized Traces table activates this 
command. 

Table 40. Legend information in the Chromatogram View (Sheet 1 of 3)

Result table Legend information

Consolidated Peaks • Molecular weight
• Area
• Retention time of the selected time point on the integrated 

chromatographic peak
• Intensity of the selected time point
• File name and ID number of the input file

Custom Explanations • Text in the Name column
• Elemental composition formula
• Molecular weight
• Retention time of the selected time point on the integrated 

chromatographic peak
• Intensity of the selected time point
• File name and ID number of the input file

Expected Compounds • Parent compound + (Transformations)
• Elemental composition formula
• Molecular weight
• Retention time of the selected time point on the integrated 

chromatographic peak
• Intensity of the selected time point
• File name and ID number of the input file

Expected Compound 
Hits

• Parent compound + (Transformations)
• Elemental composition formula
• Molecular weight
• Retention time of the selected time point on the integrated 

chromatographic peak
• Intensity of the selected time point
• File name and ID number of the input file

Table 39. Shortcut menu commands for the Chromatogram View (Sheet 3 of 3) 

Command Description



 4 Reviewing the Analysis Results
Working with the Graphical Views

Thermo Scientific Compound Discoverer User Guide 187

Unknown Compound • Molecular weight
• Area
• Retention time of the selected time point on the integrated 

chromatographic peak
• Intensity of the selected time point
• File name and ID number of the input file

Unknown Compound 
Hits 

• Molecular weight
• Area
• Retention time of the selected time point on the integrated 

chromatographic peak
• Intensity at the selected time point
• File name and ID number of the input file

FISh Trace Fragments • Fragment (Formula Ion) of Parent compound
• m/z X.xxxxx
• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

Specialized Traces

You can enter a custom label in the Custom Label box for the Tracer node or in the Custom 
Label column of the Specialized Traces table.

FISh Trace • Text in the Custom Label box [(FISh; Compound name: 
Selected library compound; Scan fragmentation mode: Selected 
fragmentation mode (AIF or DDF); Scan polarity: Selected scan 
polarity (positive or negative)]

• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

Pattern Trace • Text in the Custom Label box [(Pattern: user-specified 
elemental composition; MS Order: Selected MS order; 
Polarity: Selected scan polarity (positive or negative)]

• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

TIC Trace • Text in the Custom Label box [(TIC; MS Order: Selected MS 
order; Polarity: Selected scan polarity (positive or negative)]

• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

Table 40. Legend information in the Chromatogram View (Sheet 2 of 3)

Result table Legend information
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Working with the Mass Spectrum View

The Chromatogram View and the Mass Spectrum View are not interactive; that is, clicking a 
time point in the Chromatogram View does not display the scan for that time point.

The Mass Spectrum View displays the spectral tree of a selected component in the result table. 
When you open a result file, the Mass Spectrum View is empty.

Follow these procedures as needed:

• To display a mass spectrum

• To zoom in or out on the x axis of the Mass Spectrum View

• To open the shortcut menu for the Mass Spectrum View

• To view the matching fragment structures predicted by the FISh Scoring node for 
expected compound hits

• To create a mirror plot

BPC Trace • Text in the Custom Label box [(BPC; MS Order: Selected MS 
order; Polarity: Selected scan polarity (positive or negative)]

• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

XIC Trace • Text in the Custom Label box [(XIC; MS Order: Selected MS 
order; Polarity: Selected scan polarity (positive or negative)] 

• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

UV Trace • Text in the Custom Label box (UV Channel)
• Retention time of the selected time point on the trace
• Intensity at the selected time point
• File name and ID number of the input file

PDA Trace • Text in the Custom Label box (PDA; Selected scan type [Total 
Scan, Spectrum Maximum, or wavelength range]) 

• Intensity at the selected time point
• File name and ID number of the input file

Table 40. Legend information in the Chromatogram View (Sheet 3 of 3)

Result table Legend information
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 To display a mass spectrum

Select a row in the Expected Compound Hits table or the Unknown Compound Hits 
table.

The Mass Spectrum View displays the matching spectral tree and a zoomed-in view of the 
full MS scan.

 To zoom in or out on the x axis of the Mass Spectrum View

• To zoom in, drag the cursor to the right over the m/z range of interest.

• To zoom out, drag the cursor to the left over the m/z range of interest.

 To open the shortcut menu for the Mass Spectrum View

Right-click the Mass Spectrum View. 

 To view the matching fragment structures predicted by the FISh Scoring node for 
expected compound hits

1. Enlarge the view (see “To enlarge a view to the full size of the monitor screen” on 
page 178). 

2. In the spectral tree, select an MS/MS (labeled MS2) or higher scan. 

The FISh Scoring node annotates centroids that match the m/z value of a theoretical 
fragment ion with its theoretical structure and color-codes the centroids in a 
fragmentation scan as follows.

Figure 104 shows a fragmentation spectrum with two direct matches and one shifted 
match.

Color Meaning

( ) Green Direct match—Matches the m/z value of a theoretical fragment 
ion.

( ) Blue Shifted match—Matches the m/z value of a theoretical fragment 
ion with at least one transformation applied. 
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Figure 104. Fragmentation spectrum with FISh annotations

 To create a mirror plot

1. In the spectral tree pane, select the scan that you want to use as a reference scan.

2. Right-click the Mass Spectrum View and choose Use As Reference from the shortcut 
menu.

3. Select the fragmentation scan that you want to compare.

These topics describe the Mass Spectrum View panes and shortcut menu.

• Spectral Tree Pane

• MS1 Spectrum with Isotope Pattern Matching for Expected Compound Hits

• Mass Spectrum View Shortcut Menu Commands

Spectral Tree Pane

The spectral tree pane on the left side of the Mass Spectrum View contains the following: 

• The full (MS1) scan that is closest to the peak apex of an integrated XIC trace

• MS1 scans that meet both of these criteria:

– Elute between the peak start RT and the peak end RT (but limited to a ±0.1 min 
window around the peak apex).

– Have at least one matching data-dependent scan or an AIF scan.
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The spectral tree for an expected compound hit or an unknown compound hit is a 
composition of the spectral trees for its related expected compound ions or unknown 
compound ions, respectively. These combined spectral trees can contain both data-dependent 
and AIF spectra if no data-dependent spectra exist for at least one ion.

For MS1 scans, the tree lists the scan number, the retention time at the apex of the 
chromatographic peak, the mass analyzer, and the scan polarity.

For MSn scans, the tree lists the scan number, the retention time at the apex of the 
chromatographic peak, the mass analyzer, the scan polarity, and the fragmentation 
information, including the scan power, collision cell type, and the fragmentation type (DDF 
or AIF).

MS1 Spectrum with Isotope Pattern Matching for Expected Compound Hits

Selecting a row in either the Expected Compound Hits table or the Unknown Compound 
Hits table populates the Mass Spectrum View with a spectral tree for the selected retention 
time on the left and the first MS1 scan for the selected retention time on the right.

For an expected compound hit, the MS1 scan shows the isotope pattern fit for the detected 
compound. Colored rectangles highlight the mass spectral peaks (centroids) that match the 
theoretical isotope pattern (Figure 105 on page 192 and Figure 106 on page 193). The 
application uses a minimum display width for these rectangle to ensure that they are still 
visible if you zoom out or use the Undo All Zoom shortcut menu command. 

Note  The isotope pattern fit algorithm that the Expected Finder node uses is “resolution 
aware”; that is, in addition to the list of elemental compositions provided by the 
Compound Generator node, it uses the resolution information provided with the scan 
data to perform an isotope pattern fit and calculate a spectral distance score.

If the resolution information is unavailable, it uses the setting for the Unrecognized MS 
Resolution parameter in the Spectrum Selector node.
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Figure 105. MS1 scan with color-coded mass spectrum peaks and the shortcut menu

Table 41 describes the color coding for the centroids in an MS1 spectrum.

Table 41. Color coding for the centroids in an MS1 spectrum for an expected compound hit

Color Meaning 

( ) Lavender The labeled centroid matches the monoisotopic mass of the expected 
compound ion.

( ) Green The labeled centroid matches the delta mass and the relative intensity of 
the theoretical isotope pattern within the specified tolerance windows.

( ) Red The expected centroid for this m/z value is missing or its intensity does not 
fall within the tolerance range for the theoretical isotope pattern.

( ) Light blue The expected centroid for this m/z value might be missing because its 
theoretical intensity is at the level of the baseline noise.
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The elemental formula for this transformation product (C19 H22 N4 O4 S2) yields the 
following expected isotope pattern.

The Expected Finder node found the A0 and A1 isotopes. The A2 isotope with one sulfur-34 
atom is missing. The expected relative intensity of the A3 isotope falls within the baseline 
noise. 

Figure 106 shows an enlarged view of the found A1 centroid and the missing A2 centroid. 
The red rectangle shows the expected mass range and intensity range for the missing A2 
centroid. The mass spectrum does contain a centroid that falls just outside the expected mass 
range.

Figure 106. Enlarged view of the found and missing centroids

Mass spectrum peak Delta mass Relative intensity

A0 monoisotopic protonated molecule 0 100%

A1 protonated molecule with one 13C 1.00319 22%a

a Carbon is an X + 1 element. The relative abundance of 13C is 1.1%. The relative intensity of the A1 isotopic 
peak is approximately equal to 1.1nc, where nc is the number of carbon atoms.

A2 protonated molecule with one 34S 1.99590 9%b

b Sulfur is an X + 2 element. The relative abundance of 34S is 4.22%. The relative intensity of the A2 isotopic peak 
(one 34S) is approximately equal to 4.4ns, where ns is the number of sulfur atoms.

A2 protonated molecule with two 13C 2.00532 3%c

c The relative intensity of the A2 isotopic peak (two 13C) is approximately equal to 0.006 × nc
2, where nc is the 

number of carbon atoms.

A3 protonated molecule with one 13C and 
one 34S 

2.99913 2%

Found centroid

Expected m/z range 
for the missing centroid

Expected 
intensity 
range
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Mass Spectrum View Shortcut Menu Commands

Table 42 describes the shortcut menu commands for the Mass Spectrum view (Figure 105 on 
page 192).

Working with the Scatter Chart View

Use the Scatter Chart view to determine if there is a linear or logarithmic relationship between 
two or three variables in a result table. 

For information about the parameters in the Scatter Chart view, see “Scatter Chart View 
Parameters” on page 201. For information about the shortcut menu commands for the Scatter 
Chart view, see “Scatter Chart View Short Cut Menu” on page 203.

Table 42. Mass Spectrum View shortcut menu commands

Command Description

Undo Last Zoom/Pan Undoes the last zoom or pan movement.

Undo All Zoom/Pan Zooms out to the full scan range.

Copy Image Copies the mass spectrum as a bitmap (raster) image to the 
Clipboard.

Copy Points Copies the data points and the scan header for the selected scan 
to the Clipboard. Also copies all text annotations, such as the 
FISh fragment annotations and the adduct information. 

Use this command to copy the FISh annotations to the 
Clipboard.

Copy Raw Points Copies the data points for the selected scan to the Clipboard.

Use this command to copy points to a library search application.

Save Image As Opens the Save As dialog box, where you can type a name and 
select a file type for the current scan. The available file types are 
BMP, EMT, GIF, JPG, PNG, and TIF.

Save Points As Opens the Save As dialog box, where you can type a name and 
select a file type for the current scan. The available file type is 
TXT. 

Use As Reference Creates a mirror plot that initially consists of the currently 
selected scan. When you select another scan, the reference scan 
remains in the –y-axis portion of the graph and the new scan 
appears in the +y-axis portion of the graph.

Clear Reference Removes the reference plot from the Mass Spectrum View.
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To work with the Scatter Chart view, see these topics:

• Setting Up a Scatter Plot

• Customizing the Appearance of the Scatter Chart

• Working with the Data Points in the Scatter Chart

Setting Up a Scatter Plot

To set up a scatter chart plot, follow these procedures:

• To open the Scatter Chart view

• To select the variables and generate the plot

 To open the Scatter Chart view

1. Open a result file.

2. In the menu bar, choose View > Scatter Chart.

By default, the Scatter Chart view opens as a floating window. You can resize the window, 
drag the window to another screen, or dock the window. For information about working 
with floating and docking windows, see “Rearranging the Graphical Views” on page 176.

 To select the variables and generate the plot

1. In the Data Source list, select one of the available result tables.

The available selections depend on the workflow nodes in the processing workflow.

2. Select the variables as follows: 

a. In the X Data list, select the variable that you want to plot against the x axis.

b. In the Y Data list, select the variable that you want to plot against the y axis.

c. Depending on the plot type, do the following: 

i. To create a two-dimensional scatter plot, leave the Z Data box empty.

ii. To create a three-dimensional scatter plot, select the variable in the Z Data list 
that you want to plot against the z axis. 

Selecting a data value for the z axis adds a color gradient to the plotted data 
points ranging from the lowest to the highest Z data value.

3. Click Refresh.

Depending on your selections, a two- or three-dimensional linear plot of the data points 
appears (Figure 107 and Figure 108). With the default appearance settings, the data 
points appear as blue circles in a 2D plot and as circles of varying colors in a 3D plot. For 
a 3D plot, a color legend for the lowest to the highest Z data value appears to the right of 
the scatter chart.
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Figure 107. Two-dimensional scatter chart

Figure 108. Three-dimensional scatter chart
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Customizing the Appearance of the Scatter Chart

To customize the appearance of the scatter chart, follow these procedures:

• To pin the Options pane to keep it open

• To change the scaling, colors, labels, and legends in the display

• To change the font size or font type of the axis labels

• To return the option settings to the original default settings

 To pin the Options pane to keep it open

1. To display the Options pane, hold the cursor over the Options tab on the left side of the 
view. 

2. Click the pin icon, , in the upper right corner of the Options pane.

Figure 109 shows a pinned Options pane.

Figure 109. Pinned Options pane in the Scatter Chart view
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 To change the scaling, colors, labels, and legends in the display

1. Open the Options pane.

2. Under Axis Options, make the appropriate changes.

The application applies the changes as you make them.

 To change the font size or font type of the axis labels

1. Open the Options pane.

2. To change the fonts, do one of the following:

a. Click the expand icon to the left of Axis Scale Font or Axis Title Font.

A browse icon and a set of font parameters appear.

b. Make the appropriate selections.

–or–

• Click the browse icon to open the Font dialog box where you can make your 
selections.

 To return the option settings to the original default settings

In the Options pane, click Factory Defaults.

Expand icon
Browse icon
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Working with the Data Points in the Scatter Chart

To change the data display, follow these procedures:

• To zoom in

• To zoom out

• To return to the default magnification

• To select the visible data points in the scatter plot

• To undo the selection of the visible data points in the scatter plot

• To select a single data point in the scatter plot

• To undo the selection of a single data point in the scatter plot

• To copy the scatter plot

• To save the scatter plot as an image file

• To export the data from the scatter plot to a text file

• To interactively filter the scatter plot by using the Result Filters view

 To zoom in

Drag the cursor to select the area you want to enlarge in size.

 To zoom out

Drag the cursor to the left and select the area you want to reduce in size.

–or–

Right-click the chart and choose Zoom Out.

 To return to the default magnification

Right-click the chart and choose Undo All Zoom/Pan.

 To select the visible data points in the scatter plot

1. Zoom in to restrict the view to the area of interest.

2. Right-click the chart and choose Select Visible Points.

The color and shape of the points change, and the application places a check mark in the 
result file for all the result items corresponding to the selected data points in the chart. 
The selections in the Options pane control the appearance of the selected points.

Conversely, you can place a check mark next to the items in the result file that you want 
to display in a scatter plot.



4 Reviewing the Analysis Results
Working with the Graphical Views

200 Compound Discoverer User Guide Thermo Scientific

 To undo the selection of the visible data points in the scatter plot

Right-click the chart and choose Deselect Visible Points.

 To select a single data point in the scatter plot

Right-click the data point in the scatter plot, and choose Select Point.

 To undo the selection of a single data point in the scatter plot

Right-click the data point of interest in the scatter plot, and choose Deselect Point.

 To copy the scatter plot

Right-click the chart and choose Copy.

The application places an image file on the Clipboard.

You can paste the chart image into another document.

 To save the scatter plot as an image file

1. Right-click the graph pane and choose Save As from the shortcut menu.

2. In the Save As dialog box, browse to the location where you want to save the file, and type 
the file name in the File Name box.

3. Click Save.

 To export the data from the scatter plot to a text file

1. Right-click the graph pane and choose Save Points As from the shortcut menu.

2. In the Save As dialog box, browse to the location where you want to save the file, and type 
the name of the file in the File Name box. 

3. Click Save.

Exporting data from a scatter plot creates four text files: 

File name Excluded Points.txt

File name Filtered-out Points.txt

File name Points.txt

File name Selected Points.txt

 To interactively filter the scatter plot by using the Result Filters view

1. Set up and apply a set of result filters in the Result Filters view.

In the Scatter Chart view, the Refresh button turns orange.

2. Click Refresh to refresh the scatter chart.
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Scatter Chart View Parameters

These tables describe parameters and shortcut menu commands for the Scatter Chart view:

• Table 43 describes parameters that are visible in the Scatter Chart view. Use these 
parameters to set up the scatter plot.

• Table 44 describes the parameters in the Options pane. Use these parameters to customize 
the appearance of the Scatter Chart view.

• Table 45 describes the shortcut menu commands for the Scatter Chart view. Use these 
commands to work with the data points in the scatter plot.

Table 43. Scatter Chart view parameters

Parameter Description

Data Source Specifies the data source for the plot. The data source is one of the 
available result tables produced by the processing workflow.

Note  The X, Y, and Z Data boxes list the available variables for the selected data source. 
The variables are the available columns in the selected data source (result table).

X Data Specifies the variable to plot against the x axis.

Y Data Specifies the variable to plot against the y axis.

Z Data Specifies the variable to plot against the z axis.

Plot grid Two-dimensional grid where the application plots the data points. 
By default, the plot area has no grid lines. 

To add horizontal and vertical lines to the plot, make the 
appropriate selection under Options in the Options pane.

Axis labels By default, the axis labels are the selected variable names. 

Color legend When you create a 3D plot, the scatter chart includes a color 
legend for the z-axis color gradient. The numeric value of the 
highest z-axis data point appears above the color legend.

Options panel Use the parameters in this pane to customize the Scatter Chart 
view. For more information, see Table 44.

Buttons

Refresh Refreshes the content of the chart area.
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Table 44 describes the options in the Options pane that you can use to format the appearance 
of the chart area.

Table 44. Options pane 

Parameter Description

Buttons

Load Loads the saved Options pane settings.

Save Saves the new settings.

Note  The application automatically updates the scatter chart view as you change the 
settings in the Options pane. If you save the new settings and then continue to make 
changes without saving the additional changes, the application undoes the unsaved 
changes if you click Load. In other words, clicking Load applies only saved settings.

Factory Defaults Resets the settings of the options in the Options pane to the 
defaults in effect when you installed the Compound Discoverer 
application.

Axis Options

X Axis Type Specifies the axis type (scale) of the x axis: Linear or Logarithmic.

Y Axis Type Specifies the axis type (scale) of the y axis: Linear or Logarithmic.

Z Axis Type Specifies the axis type (scale) of the z axis: Linear or Logarithmic.

Axis Scale Font Specifies the font used to denote the scale of the x and y axes. 
Clicking the browse icon, , opens the Font dialog box.

Axis Label Font Specifies the font used for the titles of the x and y axes. Clicking 
the browse icon, , opens the Font dialog box.

X-Axis Title Specifies the title of the x axis.

Y-Axis Title Specifies the title of the y axis.

Series Options

Points Specifies the appearance of the points in the scatter chart. Also 
specifies whether to show the points in the scatter chart.

Selected Points Specifies both the appearance of the selected points in the scatter 
chart and whether to show the points in the scatter chart.

Filtered-out Points Specifies the appearance of the filtered-out points in the scatter 
chart and whether to show the points in the scatter chart.

Excluded Points The Compound Discoverer 1.0 workflow nodes do not generate 
excluded data points; therefore, this parameter does not apply to 
the result data generated by the Compound Discoverer 1.0 
application.
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Scatter Chart View Short Cut Menu

Table 45 describes the shortcut menu commands for the Scatter Chart view.

Table 45. Scatter Chart view shortcut menu commands

Command Description

Show Position Tooltips Displays a ToolTip when you place the cursor over a data point.

Zoom Out Decreases the zoom of both axes.

Undo All Zoom/Pan Displays the full x-axis range of the selected scan.

Copy Copies the scatter chart plot as a bitmap (raster) image to the 
Clipboard.

 As Opens the Save As dialog box, where you can type a name and 
select a file type for the current scan. The available file types are 
BMP, EMT, GIF, JPG, PNG, and TIF.

Save Data As Text Opens the Save As dialog box, where you can save the data as a 
set of plain text files: Excluded Points.txt, Filter-Out Points.txt, 
Points.txt, and Selected Points.txt.

Select Point By default, changes the selected point to a red diamond. You can 
change the appearance of selected points by making the 
appropriate selections in the Selected Options > Selected Points 
area of the Options pane. When you save the data to a text file, 
the Selected Points.txt file lists the selected points.

To select a point, right-click the point of interest on the plot and 
choose Select Point from the shortcut men.

Deselect Point Undoes the selection of a selected point. You can change the 
appearance of points by making the appropriate selections in the 
Selected Options > Points area of the Options pane. 

Select All Visible Points Selects all of the visible points in the scatter plot.

Deselect All Visible 
Points

Undoes the selection of the visible points in the scatter plot.
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Reviewing the Data in the Result Tables
The result tables that appear in the result file depend on the processing workflow. 

For information about the master result tables, see these topics:

• “Specialized Traces Table” on page 205

• “Expected Compounds Table” on page 206

• “Expected Compound Hits Table” on page 208

• “Unknown Compounds Table” on page 212

• “Unknown Compounds Hits Table” on page 214

• “Consolidated Peaks Table” on page 217

• “FISh Trace Fragments Table” on page 219

• “Custom Explanations Table” on page 221

• “Adducts Table” on page 222

For information about the related tables, see these topics:

• “Input Files Table” on page 222

• “Expected Compound Ions Table” on page 223

• “Unknown Compound Ions Table” on page 224

• “Custom Explanation Ions Table” on page 225

• “Related Structures Table” on page 226

• “Transformations Table” on page 227

• “Chromatogram Peaks Table” on page 228

• “Manual Peaks Table” on page 229

For information about the shortcut menus for the result tables, see “Shortcut Menu 
Commands for the Result Tables” on page 230.

 To remove one or more of the result tables from the display

1. Click the Field Chooser icon, .

The Field Chooser dialog box opens.

2. Clear the check box that corresponds to the table that you want to remove.

3. Click OK to accept the changes and close the dialog box.
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Specialized Traces Table

This result table lists the specialized traces that you requested in the processing workflow. For 
information about manually integrating chromatographic peaks in a specialized trace, see “To 
integrate chromatographic peaks manually” on page 183.

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230. 

 To view a trace in the Chromatogram View

Select the trace of interest in the Specialized Traces table.

Table 46 describes the columns in the Specialized Traces table. For general information about 
working with the result tables, see “Reviewing the Data in the Result Tables” on page 204. For 
information about working with the Chromatogram View, see “Working with the 
Chromatogram View” on page 179.

Table 46. Specialized Traces table

Column Description

Checked Use this column to select the rows that you want to display in the 
results table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals True.

Trace Type Displays the trace type generated during data processing.
• Mass Tracer node—TIC, BPC, or XIC. See “Mass Tracer 

Node” on page 151.
• Analog Tracer node—UV trace, Total Scan, Spectrum 

Maximum, Wavelength–Wavelength, or Analog trace. See 
“Analog Tracer Node” on page 137.

• FISh Tracer node—FISh trace. See “FISh Tracer Node” on 
page 140.

• Pattern Tracer node—Isotope pattern trace. See “Pattern 
Tracer Node and Isotope Ratio Editor Dialog Box” on 
page 142.

Custom Label Displays the text that you entered in the Custom Label box for the 
processing workflow node that generated the trace.

You can edit the text in this column.

Description Displays a description of the trace.

File ID Displays the file ID for the processed raw data file.
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Expected Compounds Table

When the Expected Finder node is part of the processing workflow, the Expected Compounds 
table is part of the set of tabbed tables in the result view.

The Expected Compounds table lists the theoretical compounds that the Compound 
Generator node predicts by evaluating the effect of the user-specified dealkylation, 
dearylation, and transformation reactions on the user-specified parent compound. A 
processing workflow can include multiple Compound Generator nodes, with one node for 
each parent compound that you want to evaluate.

Clicking a row in the Expected Compounds table displays one or more overlaid XIC traces for 
the selected expected compound, with one XIC trace for each input file. Each XIC trace is a 
summation of the ion traces for the same neutral elemental composition (same molecular 
weight). Figure 110 shows two overlaid traces, with one drawn in blue and the other in green. 
The integrated peak area is shaded in gray.

Figure 110. Overlaid traces for two input files

The Expected Compounds table has the following primary related tables: Input Files, 
Expected Compound Hits, Related Structures, and Transformations (Figure 11 on page 25). 

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230. For information about creating a targeted processing workflow, 
see “Finding Expected Compounds” on page 19.

Table 47 describes the columns in the Expected Compounds table. 
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Table 47. Expected Compounds table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the results table and in reports 
after you apply result filters. 

A clear check box equals False. A selected check box equals True.

Order (related table) When you select the Expected Compounds table as a related table for the Transformations 
table, this column displays the order of the selected transformation.

Parent Compound Displays the selected compound for each Compound Generator node that you connected to 
the Expected Finder node. Before you can select a specific compound in the Compound 
Generator node, you must first add it to the compound library (see “Working with the 
Compound Library” on page 316)

Formula Displays the elemental formula of the parent compounds and the theoretical formulas for 
the dealkylation and transformation products.

Molecular Weight Displays the molecular weight (MW) of the expected compound. Expected compounds 
include the parent compounds and their theoretical dealkylation and transformation 
products.

Dealkylated When this column contains an X, the expected compound is the product of a dealkylation 
reaction.

Transformations Displays the chemical transformation for the expected compounds that have undergone one 
or more of the user-specified transformations.

Composition Change Displays the composition change caused by any dealkylation or dearylation reaction, any of 
the user-specified transformation reactions, or both.

Area (Max.) Displays the maximum summed chromatographic peak area for the expected compound. 

• When the result file contains data from only one input file, this area matches the 
summed chromatographic peak area for the expected compound.

• When the result file contains data from more than one input file, this area comes from 
the input file with the largest summed chromatographic peak area for the expected 
compound.

Expected compound
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Expected Compound Hits Table

When the Expected Finder node is part of the processing workflow, the Expected Compound 
Hits table is part of the set of tabbed tables in the result view.

The Expected Compound Hits table lists the chromatographic peaks that match the expected 
compounds.

Clicking a row in the Expected Compounds Hits table displays an XIC trace for the selected 
expected compound hit (Figure 111). The XIC trace is a summation of the related ion traces. 
The integrated peak area is shaded in gray. The vertical red line indicates the chromatographic 
peak apex. 

Figure 111. Expected compound hit trace

Total Area [%](Max.) Displays the maximum chromatographic peak area of the expected compound relative to 
the total chromatographic peak area for all of the expected compounds that the Compound 
Generator node or nodes predicted. 

The maximum area comes from one of the input files.

Compound Area [%] 
(Max.) 

Displays the maximum chromatographic peak area of the expected compound relative to 
the total chromatographic peak area of expected compounds with the same elemental 
composition that the Compound Generator node predicted for the parent compound. 

For expected compounds, the parent compound is the compound that was selected in the 
Compound Generator node. The maximum value comes from one of the input files.

Table 47. Expected Compounds table  (Sheet 2 of 2)

Column Description

Red line that 
indicates the 
peak apex
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The Expected Compounds Hits table has the following primary related tables: Expected 
Compound Ions, Consolidated Peaks, Input Files, Expected Compound, and Related 
Structures (Figure 11 on page 25).

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Table 48 describes the columns in the Expected Compound Hits table.

Table 48. Expected Compound Hits table  (Sheet 1 of 3)

Column Description

Checked Use this column to select the rows that you want to display in the result table and in reports 
after you apply result filters. 

A clear check box equals False. A selected check box equals True.

Parent Compound Displays the user-specified parent compound or compounds.

You specify the parent compound or compounds in the Compound Generator node or 
nodes.

Formula Displays the elemental formula of the found expected compound.

Molecular Weight Displays the molecular weight (MW) of the found expected compound.

Dealkylated Displays an X if the parent compound for the found expected compound has undergone a 
dealkylation reaction.

Transformations Displays the chemical transformations for the found expected compound.

Composition Change Displays the composition change caused by a dealkylation reaction, any of the user-specified 
transformation reactions, or both.

RT [min]
(per input file)

Displays the apex retention time (in minutes) of the largest chromatographic peak that the 
node found for the expected compound hit.

The chromatographic peak that the application displays for an expected compound hit is a 
composite peak of all the expected compound ion peaks (adduct ions). The 
chromatographic peak area is the summed area of the adduct peaks.

Best FISh Coverage Displays the maximum fragment coverage from all the related structures.

Adding the FISh Scoring node to the processing workflow adds this column to the table. 
For information about how the FISh Scoring node calculates the FISh coverage score, see 
“6. Scoring and Annotation” on page 115.

Best SD Displays the best spectral distance value for the set of expected compound ions that make up 
the expected compound hit. The spectral distance value increases as the number of 
matching isotopes decreases. A smaller spectral distance value means a better match.

Max. #MI Displays the maximum number of matching isotopes for any of the expected compound 
ions. 
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#Adducts Displays the number of detected adducts. The application only detects the adduct ions that 
you specified for the Ions parameter in the Compound Generator node. If you keep the 
default setting of [M+H]+1 only, the application finds only one adduct ion species.

Area 
(per input file)

Displays the summed chromatographic peak area for all of the expected compound ions 
(adducts) that make up the expected compound hit.

Parent Area [%]
(per input file)

The following equation defines the parent area % value for an expected compound hit:

[(peak area for the current expected compound hit)/(summed peak area of the expected 
compound hits for the same expected compound)] × 100

The parent area is the summed chromatographic peak area for all the expected compound 
hits that are related to the expected compound. The Parent Area [%] column provides 
information about the significance of each chromatographic peak. Hits that contribute 1% 
or less of the total chromatographic peak area for the expected compound might not be 
compounds of interest.

Compound Area [%]
(per input file)

The following equation defines the compound area percentage value for an expected 
compound hit:

[(peak area for the expected compound hit)/(summed peak area for all the expected 
compound hits for the same parent compound)] × 100

The compound area is the summed chromatographic peak area of all the expected 
compound hits from the same parent compound.

Table 48. Expected Compound Hits table  (Sheet 2 of 3)

Column Description

Sum = 100%

Expected compounds for omeprazole = omeprazole and its oxidation product
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File ID Displays a unique integer (per result file) for the processed input file that contains the 
selected expected compound hit.

You can filter the data by using this integer; for example, the following filter reduces the 
table to hits found in one input file: File ID is equal to File ID.

In-Control
(Peak Consolidator)

This column is available when the processing workflow includes the Peak Consolidator 
node, the Compare with Control parameter is set to True, and you have connected the 
Expected Finder node to the Peak Consolidator node.

The color of the status box indicates the following:

( ) Gray Not in control—Found the component in the sample (non-reference) file 
but not in the control file.

( ) Green In control—Found the component in both the sample (non-reference) and 
the control (reference) file, and the area ratio of the chromatographic peaks 
is within the specified limits.

( ) Purple In control (control itself )—The current sample is the control (reference) 
file, and the node found the component in this file.

( )Orange In control but outside thresholds—Found the component in both the 
sample (non-reference) and the control (reference) file, but the area ratio of 
the chromatographic peaks is outside the specified limits.

( )Red Multiple statuses—The particular component has multiple statuses or 
ratios. This happens if the ions identified in the sample file differ from 
those identified in the control (reference) file.

( )White Not in sample—Did not find the component in the sample 
(non-reference) file.

Sample/Control
(Peak Consolidator)

This column is available when the processing workflow includes the Peak Consolidator 
node and the Compare with Control parameter is set to True.

Table 48. Expected Compound Hits table  (Sheet 3 of 3)

Column Description
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Unknown Compounds Table

When the Unknown Detector node is part of the processing workflow, the Unknown 
Compounds table is part of the set of tabbed tables in the result view. The Unknown 
Compounds table has the following primary related tables: Unknown Compound Hits, and 
Input Files (Figure 13 on page 26).

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Clicking a row in the Unknown Compounds table displays one or more XIC traces for the 
selected unknown compound, with one XIC trace for each input file. Each XIC trace is a 
composite of the ion traces for a neutral elemental composition with the same molecular 
weight. The composite XIC trace is made up of the data points with the highest intensity at 
each time point. Figure 112 shows two composite traces for a selected unknown compound, 
with one drawn in blue and the other in green. The integrated peak area is shaded in gray.

Figure 112. XIC traces for an unknown compound
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Table 49 describes the columns in the Unknown Compounds table.

Table 49. Unknown Compounds table 

Column Description

Checked Use this column to select the rows that you want to display in the result table and in reports 
after you apply result filters. 

A clear check box equals False. A selected check box equals True.

Molecular Weight Displays the molecular weight of the neutral compound.

Area (Max.) Displays the maximum chromatographic peak area from all of the input files for compounds 
with the same molecular weight.

Total Area [%] (Max.) Displays the maximum chromatographic peak area for compounds of this molecular weight 
as a percentage of the total chromatographic peak area (in one of the input files).
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Unknown Compounds Hits Table

When the Unknown Detector node is part of the processing workflow, the Unknown 
Compound Hits table is part of the set of tabbed tables in the result view. The Unknown 
Compounds Hits table has the following primary related tables: Unknown Compounds, 
Unknown Compound Ions, and Input Files (Figure 13 on page 26).

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Clicking a row in the Unknown Compound Hits table displays an XIC trace for the selected 
unknown compound hit (Figure 113). The XIC trace is a summation of the related ion traces. 
The integrated peak area is shaded in gray. The vertical red line indicates the chromatographic 
peak apex. 

Figure 113. Unknown compound hits trace

Table 50 describes the columns in the Unknown Compound Hits table.

Red line that 
indicates the 
peak apex

Table 50. Unknown Compound Hits table  (Sheet 1 of 3)

Column Description

Checked Use this column to select the rows that you want to display in the result table and in reports 
after you apply result filters. 

A clear check box equals False. A selected check box equals True.

Molecular Weight Displays the molecular weight of the neutral compound.

RT [min] Displays the retention time at the chromatographic peak apex for the adduct ion that 
contributes the most area to the chromatographic peak.
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#MI Displays the number of matching isotope peaks.

#Adducts Displays the number of adduct ions.

Area Displays the chromatographic peak area in counts * minutes.

Parent Area [%] Displays the chromatographic peak area of the current hit as a percentage of the total 
chromatographic peak area for the parent unknown compound (compound selected in the 
Unknown Compounds table) per input file.

Total Area [%] Displays the chromatographic peak area of the current hit as a percentage of the summed 
chromatographic peak area for all hits.

File ID Displays the file ID of the input file.

Table 50. Unknown Compound Hits table  (Sheet 2 of 3)

Column Description

Sum = 100%
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In-Control
(Peak Consolidator)

Displays whether this chromatographic peak is found in the control (reference) sample and 
whether the current sample is a control sample.

This column is available when the processing workflow includes the Peak Consolidator 
node, the Compare with Control parameter is set to True, and you have connected the 
Unknown Detector node to the Peak Consolidator node.

The color of the status box indicates the following:

( ) Gray Not in control—Found the component in the sample (non-reference) file 
but not in the control file.

( ) Green In control—Found the component in both the sample (non-reference) and 
the control (reference) file, and the area ratio of the chromatographic peaks 
is within the specified limits.

( ) Purple In control (control itself )—The current sample is the control (reference) 
file, and the node found the component in this file.

( )Orange In control but outside thresholds—Found the component in both the 
sample (non-reference) and the control (reference) file, but the area ratio of 
the chromatographic peaks is outside the specified limits.

( )Red Multiple statuses—The particular component has multiple statuses or 
ratios. This happens if the ions identified in the sample file differ from 
those identified in the control (reference) file.

( )White Not in sample—Did not find the component in the sample 
(non-reference) file.

Sample/Control
(Peak Consolidator)

Displays the area ratio of the chromatographic peaks in the sample and control.

Table 50. Unknown Compound Hits table  (Sheet 3 of 3)

Column Description



 4 Reviewing the Analysis Results
Reviewing the Data in the Result Tables

Thermo Scientific Compound Discoverer User Guide 217

Consolidated Peaks Table

When the Peak Consolidator node is part of the processing workflow, the Consolidated Peaks 
table is part of the set of tabbed tables on the result page. The Consolidated Peaks table has 
the following primary related tables: Custom Explanations, Expected Compound Hits, 
Unknown Compound Hits, and Manual Peaks (Figure 11 on page 25 and Figure 13 on 
page 26). 

For information about the Peak Consolidator node, see “Peak Consolidator Node” on 
page 163. For information about the shortcut menu commands, see “Shortcut Menu 
Commands for the Result Tables” on page 230.

Table 51 describes the columns in the Consolidated Peaks table.

IMPORTANT  To consolidate the chromatographic peaks detected by the Expected Finder 
and Unknown Detector nodes, connect these nodes to the Peak Consolidator node in the 
processing workflow. To compare the chromatographic peaks in a non-reference sample 
with those in a reference sample (for example, a control sample), keep the default setting 
of True for the Compare with Control parameter.

Table 51. Consolidated Peaks table  (Sheet 1 of 3)

Column Description

Checked Use this column to select the rows that you want to display in the result table and in reports 
after you apply result filters. 

A clear check box equals False. A selected check box equals True.

Name Use this column to describe or name the found chromatographic peak. To name the 
chromatographic peak, type alphanumeric text in the Name table cell.

Apex m/z Displays the area weighted average mass of all related hits.

RT [min] Displays the area weighted average retention time of all related hits.

Max. Area Displays the area of the largest chromatographic peak found for the current retention time 
and m/z value.

m/z Area
m/z

-------------------------------

RT Area
RT

-------------------------------
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In-Control This column appears when the Compare to Control parameter is enabled (set to True).

( ) Gray The component was not found in the current file.

( ) Green The current file is a sample (non-reference) file and the component was 
found in this file and in the control (reference) file.

( ) Purple The current file is a control (reference) file, and the component was found 
in this file.

( )Orange The current file is a sample (non-reference) file. The component was found 
in this file but outside the threshold.

( )White The current file is a sample (non-reference) file. The component was found 
in this file but not in the control (reference) file.

Ion Conflict When the processing workflow includes both the Unknown Detector and Expected Finder 
nodes, this column indicates whether there is a conflict between the nodes:

( ) Green No conflict—Both nodes assigned the same ion to this chromatographic 
peak.

( )Orange Missing unknown component—Not found by Unknown Detector.

This status indicates that the expected compound hit for this component 
might be in doubt because the Unknown Detector node did not detect it.

( ) Gray No data to compare—The related node did not detect this ion.

( ) Red Either the two nodes assigned different ions or one of the nodes assigned 
more than one ion to this m/z value and retention time.

Unknown Detector This column appears when the processing workflow includes the Unknown Detector node, 
and you connect this node to the Peak Consolidator node. For each input file, this column 
displays a status box that indicates whether the Unknown Detector node found the current 
chromatographic peak.

( ) Gray No matches found

( ) Green Single match found

( ) Red Multiple matches found

Expected Finder This column appears when the processing workflow includes the Expected Finder node and 
this node connects to the Peak Consolidator node. For each input file, this column displays 
a status box that indicates whether the sample is a control (reference) sample and whether 
the Expected Finder node found the current chromatographic peak.

( ) Gray No matches found

( ) Green Single match found

( ) Red Multiple matches found

Table 51. Consolidated Peaks table  (Sheet 2 of 3)

Column Description
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FISh Trace Fragments Table

When the processing workflow includes the FISh Tracer node and the Individual Traces 
parameter in this node is enabled, the FISh Trace Fragments table is part of the set of tabbed 
tables in the result view.

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Figure 114 shows the FISh Trace Fragments table and a FISh trace.

Figure 114. FISh Trace Fragments table

Custom Explanations Use this column to add custom explanations for the compounds of interest in the Expected 
Finder Hits and Unknown Compound Hits tables.

Max. Area 
(for each input file)

Displays the maximum chromatographic peak area for all related components.

Area Ratio Displays the ratio of the maximum chromatographic peak area for the non-reference file to 
that of the reference file.

Comments Use this column to store comments about the current component. This column accepts 
alphanumeric text and special characters.

Table 51. Consolidated Peaks table  (Sheet 3 of 3)

Column Description
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Table 52 describes the columns in the FISh Trace Fragments table.

Table 52. FISh Trace Fragments table 

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Parent Compound Displays the user-specified parent compound or compounds.

Formula Displays the chemical formula of the fragment ion.

Ion Displays the ion description.

m/z Displays the mass-to-charge ratio of the fragment ion.

TIC Displays the total intensity for the fragment ion.

Mode Displays the fragmentation mode:

• AIF—All-ion fragmentation

• DDF—Data-dependent fragmentation

File ID Displays the file ID of the input file.

Structure Displays the structure of the fragment ion.
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Custom Explanations Table

The Peak Consolidator node generates an empty Custom Explanations table. To populate the 
table, add a custom explanation as described in “Adding Custom Explanations” on page 231.

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Table 53 describes the columns in the Custom Explanations table.

Table 53. Custom Explanations table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Structure Displays the structure of the compound (see “Adding 
Custom Explanations” on page 231).

Name Displays an application-generated name or a user-specified 
name for the compound. 

To edit this entry, click the table cell and type text in the box.

Formula Displays the elemental composition formula of the 
compound.

Molecular Weight Displays the molecular weight of the compound.

Comments Displays an application-generated comment or a 
user-specified comment for the compound.

To edit this entry, click the table cell and type text in the box.

Composition Change For an entry from the Expected Compound Hits table, 
displays the composition change that occurred to the parent 
compound (library compound selected for the Compound 
Generator node).

RT [min] Displays the retention time of the corresponding hit.

Best SD Displays the spectral distance value of one of the custom 
explanation ions.

Max. #MI Displays the number of matching isotopes for the 
corresponding hit.

# Adducts Displays the number of adduct ions for the corresponding 
hit.
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Adducts Table

Use the Adducts table to view the list of adducts in the Adducts library. By default, the 
Adducts table is a hidden table.

 To display the Adducts table

1. Click the Result Table Chooser icon, .

The Result Table Chooser dialog box opens.

2. Select the Adducts check box.

3. Click OK to accept the changes and close the dialog box.

Input Files Table

The Input Files table lists the location and file name of the raw data file or raw data files used 
to produce the result file. The Input Files table is a primary, secondary, or both a primary and 
secondary related table.

Area Displays the chromatographic peak area for the 
corresponding hit.

File ID Displays the input file for the corresponding hit.

FISh Coverage Displays the FISh coverage score for the corresponding hit or 
the FISh coverage score from applying the FISh scoring 
algorithm on the FISh Scoring page of the Custom 
Explanations Editor dialog box.

Table 53. Custom Explanations table  (Sheet 2 of 2)

Column Description

Master table Input Files table

Consolidated Peaks Secondary related table

Custom Explanations Primary related table

Expected Compounds Primary and secondary related table

Expected Compound Hits Primary and secondary related table

Unknown Compounds Primary and secondary related table

Unknown Compound Hits Primary and secondary related table

FISh Trace Fragments Primary related table

Specialized Traces Primary related table
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Expected Compound Ions Table

The Expected Compound Ions table is a related table for the Expected Compound Hits table 
(Figure 11 on page 25).

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

 To view the ions for an expected compound hit

1. Select the compound of interest in the Expected Compound Hits table.

2. Click Show Related Tables.

3. Click the Expected Compound Ions tab.

The Expected Compound Ions table displays the expected compound ions for the 
selected compound hit. 

Table 54 describes the columns in the Expected Compound Ions table.

Table 54. Expected Compound Ions table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Ion Displays the ionized form of the compound.

Charge Displays the charge of the ion.

Molecular Weight Displays the molecular weight of the monoisotopic neutral 
compound.

m/z Displays the mass-to-charge ratio of the ion.

Mass [Da] Displays the mass difference, in daltons, between the 
theoretical mass of the ion and the measured mass.

Mass [ppm] Displays the mass difference, in ppm, between the theoretical 
mass of the ion and the measured mass.

RT [min] Displays the chromatographic retention time of the ion.

SD Displays the calculated spectral distance value for the ion.

# MI Displays the number of matched isotopes for the ion.

Area Displays the total area of all related peaks
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Unknown Compound Ions Table

The Unknown Compound Ions table is a related table for the Unknown Compound Hits 
table.

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Table 55 describes the columns in the Unknown Compound Ions table.

Parent Area [%] Displays the chromatographic peak area of the current hit as 
a percentage of the total chromatographic peak area for the 
parent compound (compound selected in the Expected 
Compound Hits table) per input file.

Compound Area [%] [(peak area for the expected compound ion)/(summed peak 
area for all the expected compound ions for the same parent 
compound)] × 100

The compound area is the summed chromatographic peak 
area of all the expected compound ions from the same parent 
compound.

File ID Displays the file ID for the input file where the current 
chromatographic peak was found.

Table 54. Expected Compound Ions table  (Sheet 2 of 2)

Column Description

Table 55. Unknown Compound Ions table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Ion Displays the ion definition of the molecular ion adduct.

Charge Displays the charge on the ion.

Molecular Weight Displays the molecular weight of the unknown compound.

m/z Displays the mass-to-charge ratio of the ion.

RT [min] Displays the retention time in minutes of the 
chromatographic peak that contains the unknown 
compound ion.

# MI Displays the number of matching isotopes for the unknown 
compound ion.
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Custom Explanation Ions Table

The Custom Explanation Ions table is a related table for the Custom Explanations table.

Table 56 describes the columns in the Custom Explanations Ions table.

Intensity Displays the intensity of the ion.

By default, this is a hidden column.

Area Displays the area of the chromatographic peak that contains 
the unknown compound ion.

Parent Area [%] Displays the chromatographic peak area of the current peak 
as a percentage of the total chromatographic peak area for the 
parent compound (compound selected in the Unknown 
Compound Hits table) per input file.

Total Area [%] Displays the chromatographic peak area of the unknown 
compound ion as a percentage of the summed 
chromatographic peak area for all hits.

File ID Displays the integer that the application assigned to the 
input file during data processing.

Table 55. Unknown Compound Ions table  (Sheet 2 of 2)

Column Description

Table 56. Custom Explanations Ions table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Ion Displays the formula for the ion, where M equals the neutral 
molecule.

Charge Displays the ion’s charge.

Molecular Weight Displays the molecular weight of the neutral molecule.

m/z Displays the mass-to-charge ratio of the ion.

Mass [Da] Displays the difference between the theoretical mass and the 
measured mass in daltons.

Mass [ppm] Displays the difference between the theoretical mass and the 
measured mass in ppm.

RT [min] Displays the retention time of the ion.
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Related Structures Table

The Related Structures table is a related table for the Expected Compounds and Expected 
Compounds Hits tables.

 To open the Related Structures table

1. Open a result file from an analysis that included the Expected Finder node.

2. Select a row in one of these tables—Expected Compounds or Expected Compounds Hits.

3. Click Show Related Tables.

4. Click the Related Structures tab.

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Table 57 describes the columns in the Related Structures table.

SD Displays the spectral distance value for the ion’s mass spectral 
peak.

# MI Displays the number of matching isotopes for the ion.

Area Displays the chromatographic peak area for the ion.

Parent Area [%] Displays the chromatographic peak area of the current 
custom explanation as a percentage of the total 
chromatographic peak area for the parent compound 
(compound selected in the Custom Explanations table) per 
input file.

FISh Coverage Displays the composite fragment ion coverage of all the 
related MS/MS spectra.

File ID Displays the input file’s unique identification number within 
the current result file.

Table 56. Custom Explanations Ions table  (Sheet 2 of 2)

Column Description
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Transformations Table

The Transformations table is a related table for the Expected Compounds tables (Figure 11 on 
page 25).

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Table 58 describes the columns in the Transformations table.

Table 57. Related Structures table 

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Parent Compound Displays the user-specified parent compound or compounds.

Formula Displays the chemical formula of the parent compound or 
the theoretical transformed compounds.

Molecular Weight Displays the molecular weight (MW) of the parent 
compound or theoretical reaction product.

Dealkylated Displays an X if the parent compound has undergone a 
dealkylation reaction.

Composition Change Displays the composition change caused by any dealkylation 
reaction, any of the user-specified transformation reactions, 
or both.

Structure Displays the related structure.

Table 58. Transformations table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Name Displays the name of the transformation.

Phase Displays the Phase assignment for the transformation.

Leaving Group Displays the leaving group for the transformation.

Arriving Group Displays the arriving group for the transformation.
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Chromatogram Peaks Table

The Chromatogram Peaks table is a related table for the Expected Compound Ions table 
(Figure 11 on page 25).

Table 59 describes the columns in the Chromatogram Peaks table.

Delta Mass [Da] Displays the neutral mass shift for the transformation in 
daltons.

Order Displays when the transformation was applied in the reaction 
pathway. 

Range: An integer from 1 to the user-specified maximum 
number of steps.

Table 58. Transformations table  (Sheet 2 of 2)

Column Description

Table 59. Chromatogram Peaks table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

A clear check box equals False. A selected check box equals 
True.

Area Displays the integrated peak area.

Apex m/z Displays the m/z value of the mass spectral peak at the peak 
apex. 

Apex RT [min] Displays the retention time of the peak apex.

Apex Intensity Displays the intensity at the peak apex.

Left RT [min] Displays the start point for the chromatographic peak.

Right RT [min] Displays the end point for the chromatographic peak.
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Manual Peaks Table

The Manual Peaks table is a master table and a related table for the Specialized Traces master 
table. To create this table, you must add a manual peak to a specialized trace (see “To integrate 
chromatographic peaks manually” on page 183).

For information about the shortcut menu commands, see “Shortcut Menu Commands for the 
Result Tables” on page 230.

Table 60 describes the columns in the Manual Peaks table.

Isotope Number For chromatographic peaks detected by the Unknown 
Detector node, displays the index number for the isotopic 
mass spectrum peak that the application used to create the 
XIC. The Unknown Detector node creates an XIC trace for 
each isotope.

For chromatographic peaks detected by the Expected Finder 
node, always displays a value of 0, as the Expected Finder 
node creates only one filtered XIC trace for each ion. The 
Expected Finder node creates the filtered XIC trace by 
summing the intensity of all the mass spectrum peaks that 
match the theoretical isotope pattern. If even one required 
isotope is missing, the intensity of the XIC drops down to 0.

By default, this column is hidden.

Peak Model Displays the peak model for the chromatographic peak and 
includes information about the peak’s width and symmetry.

Table 59. Chromatogram Peaks table  (Sheet 2 of 2)

Column Description

Table 60. Manual Peaks table 

Column Description

Trace Type Displays the trace type. The trace type can be any of the 
specialized traces, including Analog, UV, PDA, TIC, BPC, 
XIC, Pattern Trace, or FISh Trace.

Area Displays the chromatographic peak area.

Left RT [min] Displays the start point of the chromatographic peak.

Right RT [min] Displays the end point of the chromatographic peak.

File ID Displays the ID number assigned to the input file in the 
result file.
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Shortcut Menu Commands for the Result Tables

Table 61 describes the shortcut menu commands for the result tables.

Table 61. Shortcut menu commands for the result tables

Command Description

All master and related result tables

Copy With Headers Copies the current table row and its associated column 
headings to the Clipboard.

Copy Copies the current table row to the Clipboard. Does not 
copy the column headings.

Enable/Disable Column 
Fixing

Turns on the column pins. Pinning a column moves it to the 
leftmost column position.

Unselect All Undoes any row selections. Clears the Chromatogram View, 
Mass Spectrum View, or both of these views if they are 
populated with data.

Export to Text File Exports the data to a comma-separated values file (.csv).

All result tables with a Checked column

Check Selected Places a check in the selected row’s check box.

Check All Selects the check boxes for all of the table rows.

Uncheck Selected Clears the selected row’s check box.

Uncheck All Clears the check boxes for all of the table rows.

Expected Compound Hits and Unknown Compound Hits tables

Add to Custom 
Explanations

Creates a new custom explanation for the currently selected 
expected compound hit or unknown compound hit, and 
adds the explanation as a new row at the bottom of the 
Custom Explanations table.

Custom Explanations table

Edit Opens the Custom Explanations Editor.

Delete Removes the selected row from the table.

All related tables that have a corresponding master table

Go to Same Item in Master 
Table

Opens the master table with the same name as the related 
table and selects the corresponding table row in the master 
table.

Custom Explanations Ions table

Delete Deletes the selected row from the Custom Explanations Ion 
table and its parent custom explanation from the Custom 
Explanations table.
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Adding Custom Explanations
Use the Custom Explanation Editor dialog box to create custom explanations for the 
compound hits of interest in the Expected Compound and Unknown Compound Hits tables.

 To add a custom explanation to the Custom Explanations table

1. Right-click the row of interest in the Expected Compound Hits table or the Unknown 
Compound Hits table and choose Add to Custom Explanations from the shortcut 
menu.

2. Click the Custom Explanations tab.

The new explanation is available in the last table row.

3. Right-click the new row and choose Edit from the shortcut menu.

The Custom Explanation Editor dialog box opens (Figure 115).

The application automatically populates the Molecular Weight (original) and Formula 
(original) boxes. 

For entries from the Expected Finder Hits table, the application also populates the 
following:

• The Name box with the name of the library compound appended with the word 
Component 

• The Comments box with the transformations that occurred to the library compound

4. Add a structure to the drawing area by using the structure drawing tools or by opening a 
structure file.

For an expected compound hit, the structure must match the values in the Molecular 
Weight (original) and Formula (original) boxes. If the structure does not match these 
values, a red border appears on both boxes. When the values match, the application 
populates the Molecular Weight and Formula boxes with the values for the matching 
structure.

For an unknown compound hit, only the molecular weight must match within the 
specified mass tolerance window (used for the Unknown Detector node in the processing 
workflow). If the structure does not match the Molecular Weight, a red border appears on 
this box. When the molecular weights match, the application populates the Molecular 
Weight and Formula boxes with the values for the matching structure.

5. Click Save to save your custom explanation in the result file.

Note  The Custom Explanations table is available only when the processing workflow 
includes the Peak Consolidator node.
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Figure 115. Custom Explanation Editor dialog box
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 To get a FISh coverage score for your custom explanation

1. Open the Custom Explanation Editor dialog box if you closed it.

2. Click the FISh Scoring tab.

The FISh Scoring page opens (Figure 116).

Figure 116. FISh Scoring page of the Custom Explanations Editor dialog box

3. Select the Apply FISh Scoring check box.

The other items on the page become available.

4. Make the following selections:

• To annotate the full spectrum tree, select the Annotate Full Spectrum Tree check 
box.

• To use the fragmentation libraries provided with the Mass Frontier application, select 
the Use Fragmentation Libraries check box.

• To use the fragmentation libraries provided with the Mass Frontier application for the 
full spectrum tree, select the Use Libraries for Full Spectrum Tree check box.

5. Use the default values or type new values in the following boxes:

• For the FTMS scans, type a value in the High Accuracy Mass Tolerance box and 
select the appropriate units.

• For the ITMS scans, type a value in the Low Accuracy Mass Tolerance box and select 
the appropriate units.

• In the S/N Threshold box, type a value for the FTMS scans.

Note  For best results, select the Use Fragmentation Libraries check box, as using 
the Mass Frontier fragmentation libraries provides significantly more structural 
information.



4 Reviewing the Analysis Results
Adding Custom Explanations

234 Compound Discoverer User Guide Thermo Scientific

6. To start the FISh scoring algorithm, click Save.

When the FISh scoring algorithm finishes, a score appears in the FISh Scoring column of 
the Custom Explanations table.

Custom Explanation Editor Parameters

Table 62 describes the parameters in the Custom Explanation Editor dialog box.

Tip  If your application computer does not have a licensed version of the Mass 
Frontier application, nothing happens. When you click Save, an error message 
appears. To save the custom explanation, clear the Apply FISh Scoring check box. 
Then click Save.

Table 62. Custom Explanation Editor parameters (Sheet 1 of 2)

Parameter Description

Description page

Molecular Weight Displays the molecular weight of the structure in the drawing area.

Molecular Weight 
(original)

Displays the molecular weight of the structure that made up the 
chromatographic peak found by either the Expected Finder node 
or the Unknown Detector node.

Formula Displays the elemental formula of the structure in the drawing 
area.

Formula (Original) Displays the elemental formula of the component found by the 
Expected Finder node.

Name For library compounds found by the Expected Finder node, 
displays the name of the compound appended with the word 
Component; for example, if Omeprazole was the compound of 
interest in the Expected Finder node, the Name box displays 
Omeprazole Component.

For compounds found by the Unknown Detector node, this box is 
empty by default.

To change the name, type alphanumeric text in this box.

Comments Accepts alphanumeric text and special characters.

Composition Change For compounds found by the Expected Finder node, displays the 
overall composition change that occurred to produce the current 
structure from the original library compound.

FISh Scoring page

Apply FISh Scoring Starts the FISh scoring algorithm.

Annotate Full 
Spectrum Tree

Annotates the full spectrum tree (MS/MS, MS3, and so on) in the 
Mass Spectrum View.
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Table 63 describes the shortcut menu commands for the Custom Explanations Editor dialog 
box.

Use Fragmentation 
Libraries

Uses the Mass Frontier fragmentation libraries.

Use Libraries for Full 
Spectrum Tree

Uses the Mass Frontier fragmentation libraries for all of the 
fragmentation scans (MS/MS, MS3, and so on).

High Accuracy mass 
tolerance and units

Specifies the mass tolerance window for FTMS data.

Default: 2.5 mmu

Low Accuracy Mass 
Tolerance and units

Specifies the mass tolerance window for ITMS data.

Default: 0.5 Da

S/N Threshold Specifies the signal-to-noise threshold for FTMS data. The FT 
mass analyzer calculates the S/N level for each centroid.

Table 63. Shortcut menu for the Custom Explanations Editor dialog box

Menu command Description

Selection Tool Selects a portion of the structure.

Lasso Selection Selects a non-rectangular portion of the structure.

Rectangle Selection Selects a rectangular portion of the structure.

Cut Removes the selected portion of a structure.

Copy Copies the selected portion of a structure to the Clipboard.

Paste Copies a structure from the Clipboard to the drawing area.

Delete Deletes the selected portion of a structure.

Select All Selects everything in the drawing area.

Resize Resizes the selected portion of a structure (see “To resize a 
structure” on page 329).

Rotate Rotates the structure around the selected axis of rotation (see “To 
rotate a structure” on page 329).

Mirror Reflects the structure along its vertical or horizontal axis (see “To 
mirror a structure” on page 329).

Table 62. Custom Explanation Editor parameters (Sheet 2 of 2)

Parameter Description
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Using Result Filters for Data Reduction
To show the most pertinent data only, use the Result Filters window to apply filters to the 
processed data. The left pane of the Result Filters window lists the master tables in the current 
result file. The right pane of the window lists the filters for the master table that you selected 
in the left pane (Figure 117). For information about the panes and buttons in the Result 
Filters window, see Table 64 on page 245.

Figure 117. Result Filters window

The filters for each master table are independent of other master table filters. For example, a 
retention time filter for the Consolidated Peaks table does not affect the entries in the other 
tables that include a retention time RT [min] column. In addition, filtering only removes 
rows from the display, it does not update or change any of the calculated values.

To use the data reduction filters, follow these procedures as needed:

• To open the Result Filters view

• To set up a set of filter conditions with one or more properties

• To create a filter set using the AND logical conjunction

• To create a filter set using the OR logical conjunction

• To create a filter set using both the AND and the OR logical conjunctions

• To apply the filter conditions in the current filter set

• To save a filter as a filterset file

• To load a saved filter set

• To turn off the filter conditions for a specific master table

• To clear the filter conditions for a specific master table

• To clear all of the filters conditions in a filter set

• To set up filters for the status columns
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 To open the Result Filters view

1. Open a result file of interest.

2. Choose View > Result Filters.

The Result Filters view opens as a floating window or as a docked view and displays the 
filter tree for the current table. 

Each table has its own set of filter conditions, with the exception of the Custom 
Explanations table. Deleting custom explanations updates the Consolidated Peaks table.

 To set up a set of filter conditions with one or more properties

1. Select the master table of interest.

The master table name appears in the right pane. The following selection tree appears 
below the table name.

2. Click Add Property.

A list that includes the columns in the selected table and the AND and OR logic 
selections appears. The Add Property list appears below the current filter.

3. Select the table column (property) that you want to filter by.

A (pink) dropdown relationship list with a default selection appears. For numeric 
properties and most non-numeric properties, an empty value box appears to the right of 
the relation list.

Tip  When the result file contains a Consolidated Peaks table, the result file opens with 
the Consolidated Peaks table displayed. If you select a different master table, and then 
open the Result Filters view, the view displays the filter tree for the Consolidated 
Peaks table, rather than the filter tree for the current master table. 

Table Name
AND Add group

Add property Click to open a dropdown list
of table columns.
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4. Do one of the following:

• For a numeric property, such as retention time (RT), select a mathematical 
relationship and type a value in the box to the right of the relationship list, if 
applicable.

This figure shows the relationship list for numeric properties.

This figure shows a set of filter conditions that limits the displayed results to 
chromatographic peaks from 2 to 7 minutes.

• For the Checked property, select a condition.

This figure shows the condition list for the Checked property.

• For a non-numeric property, such as Parent Compound, select a condition and type a 
value in the value box if applicable.

Tip  When you select the Is Equal To relationship, type a numeric value to a 
minimum precision of two decimal places or a minimum precision that is equal 
to the number of decimal places that are displayed in the column, whichever is 
greater. For example, for any of the Area columns, type a numeric value with two 
decimal places, even though the Area column displays a numeric value with no 
decimal places.

Relationship list
Value box

Selected 
property

Condition list

Selected 
property
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This figure shows the condition list for non-numeric properties.

• For a status property, see the next procedure “To set up filters for the status columns.” 

 To set up filters for the status columns

1. If the Result Filters view is not open, open it.

2. Select one of these tables: Consolidated Peaks, Expected Finder Hits, or Unknown 
Detector Hits.

3. Select a status property; for example, for the Consolidated Peaks table, select Expected 
Finder. 

From left to right, the following items appear:

• A (pink) list with one selection: Has Status

• A (green) condition list with no selection 

• A (pink) file relationship list with the selection of In File

• A (green) input file list with no selection

Condition list

Value box

Status (Has Status)

Condition list

File relationship list

Input file list

Selected status column (property)
in the Consolidated Peaks table
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The input file list changes to a value box when you select anything other than In File in 
the file relationship list:

• If you select In File, select the file of interest in the input file list.

• If you select a file relationship that requires additional input, a value box appears. 

4. Select a status condition for the selected property (table column).

5. Select a file relationship and enter a value or select a file. 

In-Control Ion Conflict Expected Finder 
or Unknown Detector

No Control Assigned No Data to Compare No Matches Found
Not In File No Conflict Single Match Found
Not In File (Control Itself ) Conflicting Ions Multiple Matches Found
Not In Control Multiple Ions Per Node –
In Control (Control Itself ) Not Found by Unknown 

Detector
–

In Control But Outside 
Thresholds

Found Only By Unknown 
Detector

–

Multiple Statuses – –
In Control – –

Condition list
File relationship list

Input file list

Condition list
File relationship list

Value box
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 To create a filter set using the AND logical conjunction

1. Keep the AND logical conjunction as the first item in the filter tree.

2. For each property that you want to conjoin with the AND conjunction, click Add 
Property, select a property from the list, and set up the property boundaries.

This figure shows a filter set that uses three properties conjoined with an AND 
conjunction. When you apply this filter set to the data in the Expected Compound Hits 
table, only those rows that meet all three conditions remain; that is, you see only those 
detected chromatographic peaks with a retention time greater than 3.00 minutes, an 
integrated peak area greater than 1 000 000, and where at least two or more matching 
isotopes were found in the MS scans that make up the peak’s data points.

 To create a filter set using the OR logical conjunction

1. Select the OR logical conjunction as the first item in the filter tree.

2. For each property that you want to conjoin with the OR conjunction, click Add 
Property, select a property from the list, and set up the property conditions.

This figure shows a filter set that uses two properties conjoined with an OR conjunction. 
When you apply this filter set to the data in the Expected Compound Hits table, those 
rows that meet at least one of the conditions remain; that is, you see the rows where the 
best FISh coverage value is greater than or equal to 30 or where the best FISh coverage 
column has no reported value.

Note  When you use the AND logical conjunction, all of the connected properties 
conditions must be True.

Note  When you use the OR logical conjunction, only one of the connected property 
conditions must be True.

Three properties connected
to an AND conjunction

Two properties 
connected to an
OR conjunction
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 To create a filter set using both the AND and the OR logical conjunctions

1. Keep the AND logical conjunction as the first item in the filter tree.

2. To conjoin two properties with the OR conjunction, do the following:

a. Click Add Property and select OR from the dropdown list.

b. Set up the properties that you want to conjoin with the OR conjunction. 

This example shows the condition where the Best FISh Coverage (column value) 
must be greater than or equal to 30 or have no value. (The FISh scoring algorithm 
does not calculate Best FISh coverage scores for AIF scans.)

3. For each property that you want to conjoin with the AND conjunction, click the Add 
Property list that connects to the AND conjunction, select a property from the list, and 
set up the property boundaries.

Add Property list 
that connects to the 
OR conjunction

Add Property list that 
connects to the AND 
conjunction
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This figure shows a result filter that keeps chromatographic peaks that meet the following 
conditions:

• A Best FISh Coverage score that meets one of these conditions:

– A Best FISh Coverage that is greater than or equal to 30 

–or–

– No Best FISh Coverage score

–and–

• A Retention time from 4 to 7 minutes

 To apply the filter conditions in the current filter set

Click Apply Filters.

 To save a filter as a filterset file

1. Click Save or Save As.

The Save Filter dialog box opens.

2. Browse to the location where you want to store the file.

3. In the File Name box, type a file name.

4. Click Save.

The application saves the file as a FILTERSET file type.

 To load a saved filter set

1. Click Load.

The Load Filter Set dialog box opens.

2. Browse to the appropriate folder and select the filter set of interest.

3. Click Open.
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If the filter set contains filter conditions for tables that are not in the current result file, 
the application automatically turns off the unused filters. You can modify the filter 
conditions for the applicable tables only.

This figure shows a filter set that contains filter conditions for tables that are not in the 
current result file.

 To turn off the filter conditions for a specific master table

In the left pane of the Result Filters view, click the ON button to the left of the master 
table name.

The indicator icon to the left of the table name turns from green to yellow, and the 
button displays OFF.

 To clear the filter conditions for a specific master table

1. In the left pane of the Result Filters view, select the master table of interest.

2. Click Clear.

 To clear all of the filters conditions in a filter set

Click Clear All.
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Result Filters View

Use the Result Filters view to create data reduction filters for one or more master tables in a 
result file. The Result Filters view is a floating window that can remain open while you work 
in other areas of the Compound Discoverer application. 

Table 64 describes the panes and buttons in the Result Filters view.

Table 64. Result Filters panes and buttons

Feature Description

Left pane

Lists the master tables included in the current result file. An On/Off button and an 
indicator icon appear to the left of the table name.

ON/OFF button Use to turn on or turn off the conditions for the associated master 
table.

Indicator icons The indicator icon states are as follows:

• ( ) Gray—Indicates that the table is unfiltered.

• ( ) Green—Indicates that a filter has been applied to the table.

• ( ) Yellow—Indicates that the table filter is OFF.

• ( ) Red—Indicates that the current result file does not contain 
the associated master table.

Right pane

Displays the filter settings for the selected master table. You can modify these settings as 
described in “To set up a set of filter conditions with one or more properties” on page 237.

AND or OR  Specifies the logical connection between properties or groups.

Add Group Adds a group.

Add Property Adds a property.

Buttons

Load Opens the Load Filter Set dialog box where you can select a saved 
filter set and open it.

Save If a saved filter set is open, clicking Save overwrites the settings in the 
file with the current filter conditions in the Result Filters window.

Save As Opens the Save Filter dialog box where you can define the file name 
and select a folder for a FILTERSET file.

Clear All Clears all of the filter conditions for the current filter set.

Clear Clears the current filter condition.

Apply Filters Applies all of the filter conditions for the current filter set.
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Viewing the Processing Summaries
You can view the following summaries in the review window:

• Workflow Summary

• Processing Message Summary

• Filter Summary

• Study Summary

 To open the Result Summaries view

1. Open a result file of interest (see “To open a result file” on page 175).

2. Choose View > Result Summaries.

The Result Summaries view includes these four pages—the Workflow Summary page, the 
Processing Message Summary page, the Filter Summary page, and the Study Summary 
page.

Workflow Summary

To view the processing workflow used to create the current result file, view the Workflow 
Summary page of the Summaries view.

The Workflow Summary page lists the name of the processing workflow, the creation date for 
the result file (.cdResult), the raw data files (.raw) that were processed to create the result file, 
and the parameter settings for the workflow nodes.

For information about creating a processing workflow, see “Creating and Editing Processing 
Workflows” on page 100.

Processing Message Summary

To view a summary of the processes used to create the result current file, view the Processing 
Message Summary page of the Summaries view.

Filter Summary

To view a summary of the filters used to reduce the data in the results window, view the Filter 
Summary page of the Summaries view.

The Filter Summary page lists the name of the latest filter set (FILTERSET file type) that you 
applied to the result file and the filter conditions in the filter set. Use the Result Filters view to 
create filter sets.
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For information about setting up a filter set, see “Using Result Filters for Data Reduction” on 
page 236.

Study Summary

To view a summary of the study settings for the input files that make up the result file, view 
the Study Summary page of the Summaries view.

The Study Summary page lists the following:

• Name and directory location of the study

• Study factors and their values

• Selected study factors and file name and location of the raw data file for each sample

• File relations between the study samples

In the File Relations area, each non-reference sample is indented below its associated reference 
sample.

Saving a Custom Result File Layout or Restoring the Default Layout
The layout of the result file includes the location of the graphical views and the columns and 
rows that you want to display in the result tables.

 To save the current layout of the result file

With the result file selected as the active page, do one of the following:

• Click the Save the Currently Active Item icon, , in the Compound Discoverer 
toolbar.

–or–

• Choose File > Save (save the currently active item) from the menu bar.

 To restore the default layout

In the study folder, delete the result file’s associated CD Result View file (.cdResultView).

Reference sample
Non-reference sample
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5

Creating and Printing Reports

This chapter describes how to create, preview, and print reports. You can use the standard 
report templates provided with the Compound Discoverer application or you can create your 
own custom report templates.

Reporting Workflow
The following flowchart shows the reporting workflow (Figure 118 and Figure 119).

Contents

• Reporting Workflow

• Generating a Report with an Existing Report Template

• Creating a New Report Template

• Previewing and Printing a Report 
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Figure 118. Reporting workflow (page 1)

Filter the data to display only the 
table rows of interest.

Open a result file.

Can you use an existing 
report template as is?

Yes

From the Reporting menu, 
choose Create Report 

and select a report template. 

The report resolution page opens.

Review the resolved report.

Does the template display 
the data correctly?

Yes

Print the report.

Can you use an existing 
report template with minor 

modifications?

Yes

From the Reporting menu, 
choose Edit Report Template 
and select a report template.

The report designer page opens.

Make the appropriate selections 
and click OK.

The report designer page opens.

Close the page.

No

No No

From the Reporting menu, 
choose Create Report Template. 

The Customize Report dialog box 
opens.

Next page



 5 Creating and Printing Reports
Reporting Workflow

Thermo Scientific Compound Discoverer User Guide 251

Figure 119. Reporting workflow (page 2)

Does the template display 
the data correctly?

Yes

Edit the report template.

To resolve the data and preview the report, click 
the Preview Report icon, , to open the 

Report Preview dialog box. 
Or, click the Print Report icon, , to open the 

Report Print dialog box. 

No

To save the report template with a new name, 
close the dialog box to return to the report 

designer page and click the Save As icon, . 

To print the report, click the Print button, .

To return to the report designer 
page, close the dialog box. 

Previous 
page
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Generating a Report with an Existing Report Template
You can use one of the report templates provided with the Compound Discoverer application 
or one of your own custom report templates to produce reports that display items of interest 
in a result file. For information about creating new report templates, see “Creating a New 
Report Template” on page 254.

The following standard report templates are provided with the application as CD Report 
Template files:

• Custom Explanations without Graphs.cdReportTemplate

• Custom Explanations with Graphs.cdReportTemplate

• Expected Compound Hits without Graphs

• Expected Compound Hits with Graphs

You can find these report templates in the following folder:

C:\Users\Public\Public Documents\Thermo\Compound Discoverer 1.0\Common 
Templates\ReportTemplates

 To preview and print a report by opening an existing report template

1. Open a result file (see “To open a result file” on page 175).

In the Compound Discoverer window, the reporting menu commands and the reporting 
toolbar icons ( )become available.

2. Determine which master table you want to include in the report and filter the data in this 
table. 

For information about filtering the data, see “Using Result Filters for Data Reduction” on 
page 236.

3. To select an existing report template, choose Reporting > Create Report from the menu 
bar or click the Create Report icon, .

The Open Report Design Template dialog box opens to the Report Templates folder. 

To select an appropriate report template, you must know what data the report template is 
designed to resolve. Typically, a report template resolves the filtered data from one of the 
master tables and one or more of the graphs associated with the table. A report template 
can also resolve data from one or more related tables.

4. Select the appropriate report template and click Open.

The report resolution page opens with the thumbnail pane on the right and a report 
preview on the left. 
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The tab format for the report resolution page is as follows:

 Report Template Name

As the application resolves the data with the report template, the following icon displays 
the progress. 

When the data is resolved, the progress icon disappears, and the application begins 
rendering the report pages. The current page/estimated pages box lists the progress. 

Whether the application displays the pages as it renders them depends on whether the 
report template contains any ReportInfo items. If the selected template contains a 
ReportInfo item, the application does not display the rendered pages until it has rendered 
all of the report pages. If the selected template does not contain ReportInfo items, the 
application displays the pages as it renders them. The standard reports provided with the 
application do not contain ReportInfo items nor do unedited report templates that you 
create by using the Customize Report dialog box. For more information about the 
ReportInfo item, see “ReportInfo” on page 281.

If the report contains too many pages, the application cancels report generation, and the 
following message box appears. 

5. Review the contents of the report. 

6. On the report resolution page, click the Print icon, , in the toolbar to print the 
report.

The Print dialog box opens.

7. Select the appropriate printer and the page range that you want to print. 

The report templates that come with the application default to printing on A4 paper. 

8. If you are not printing on A4 paper, change the printer setting.

9. Click OK to print the report.

The Print dialog box closes.
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Creating a New Report Template
You can create a new report template in two ways: by modifying an existing report template or 
by using the Customize Report dialog box that sets up the main properties of a report 
template.

To create a new report template, see these topics:

• Using the Customize Report Dialog Box

• Editing an Existing Report Template

Using the Customize Report Dialog Box

This topic describes how to create a new report template by using the Customize Report 
dialog box where you select the following:

• Data to be included in the report:

– Columns of interest in the master table

– Graphs associated with the master table

– Columns of interest in any of the related tables

– Graphs associated with any of the selected related tables

• Basic appearance of the report, including whether the table columns are displayed from 
left to right or from top to bottom

• Paper type

• Page orientation

• Logo image

Once you make these selections and close the Customize Report dialog box, the report 
designer page opens. Use the report designer page to modify the appearance of the report. For 
information about using this page, see “Editing an Existing Report Template” on page 263.

To work with the Customize Report dialog box, follow these procedures:

• To open the Customize Report dialog box

• To select the master table

• To select the columns, graphs, and related tables

• To draw a line above the table data

• To transpose the tabular data from columns to rows

Tip  To quickly select an item in a list in this dialog box, type the first letter of that item.
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• To indent a related table

• To select a color scheme for a report table

• To modify the current color scheme or to add or remove color schemes from the list

• To select the size of the paper

• To select the page orientation

• To select the logo image

• To apply the settings and close the Customize Report dialog box

 To open the Customize Report dialog box

1. Open a result file.

2. From the menu bar, choose Reporting > Create Report Template or in the toolbar, click 
the Create a New Report Template icon, .

The Customize Report dialog box opens (Figure 120).

Figure 120. Customize Report dialog box

List of data 
items
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 To select the master table

In the Reported Table list at the top of the dialog box, select the master result table for the 
report.

A list of data items for the selected table appears. By default, the list of columns for the 
master table is open and most of the column check boxes are selected.

 To select the columns, graphs, and related tables

1. Under the selected table name, click each expand icon, , to open these sections as 
needed:

• Columns

• Graphs

• Related Tables

2. In the expanded sections, select the check box for each column, graph, or related table 
(and associated columns) that you want to include in the generated reports.

 To draw a line above the table data 

To draw a separator line above the column headers for the tables, select the Draw Lines 
check box.

 To transpose the tabular data from columns to rows

1. In the data item list, select the table that you want to transpose. 

• To transpose the columns in the master table, select the master table name (the first 
data item) in the Customize Report dialog box. 

• To transpose the columns in a related table, select the check box to the left of the 
related table name and click the table name to make sure that it is highlighted in blue. 

Each time you select a table, the application clears the Transpose Data check box.

Tip  Thermo Fisher Scientific recommends that you select the Max Area (…) and Area 
Ratio (…) columns. With these selections, the report automatically displays n 
columns of area data, where n = the number of input files included in the result file.

(Default layout for the master result table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box

(Related table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box
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2. Select the Transpose Data check box.

Each selected data column appears as a two-column row in the report template. The first 
column displays the column heading and the second column displays the data from a 
table row.

 To indent a related table

1. Select the related table in the expanded list of data items. 

2. In the Indenting box, type the indentation value from 0.00 to 1.00 inch. 

 To select a color scheme for a report table

1. In the report item list, select the table of interest, for example, the master table or one of 
the related tables.

2. In the Color Scheme list, select one of the available color schemes. 

Each scheme consists of two colors: the first color for the background of the table headers 
and the second color for the background of the table rows. To undo the selection, click 
Reset.

(Default layout for the master table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box

(Transposed layout for the master table)

Column 1 label Data text box

Column 2 label Data text box

Column 3 label Data text box

Column 4 label Data text box

Column 5 label Data text box

(Default layout for the master result table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box

______________________________________________________________
(Related table indented by 1 inch)

Column 1 label Column 2 label Column 3 label Column 4 label

Data text box Data text box Data text box Data text box
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 To modify the current color scheme or to add or remove color schemes from the list

1. Click Modify.

Two color selection lists appear below the Color Scheme list. The list on the left changes 
the background color for the column headings. The list on the right changes the 
background color for the data columns.

2. From the color lists, select one or two background colors, and then click Add. 

The application displays the effect of the color scheme in the data item list, adds the new 
color scheme to the Color Scheme list, and activates the Remove button.

3. To change the color selection, do one or both of the following:

• If you do not want to apply the new color scheme to the currently selected table, click 
Reset.

The application undoes the color selections, applies the default color scheme 
(Transparent/Transparent), and closes the color lists. When you click OK to accept 
the settings and close the Customize Reports dialog box, the application adds the new 
color scheme to the ColorScheme.xml file.

Note  Accepting the settings in the Customize Report dialog box adds the new color 
scheme to the ColorScheme.xml file that is located in the following directory folder:

C:\Users\Public\Public Documents\Thermo\Compound Discoverer 
1.0\Common Templates\ReportTemplates.

If you remove the new color scheme before you click OK at the bottom of the 
Customize Report dialog box to accept the settings, the application does not add the 
new color scheme to the ColorScheme.xml file.
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• If you do not want to keep the new color scheme, click Remove.

The application undoes the color selections, leaves the color lists open, and removes 
the color scheme from the Color Scheme list.

 To select the size of the paper

In the PaperKind list, select the appropriate paper size.

For information about changing the paper size for an existing report template, see 
“Report Designer Report Template Settings” on page 307.

 To select the page orientation

In the Orientation list, select the appropriate page orientation.

For information about changing the paper orientation for an existing report template, see 
“Report Designer Report Template Settings” on page 307.

 To select the logo image

1. Next to the Logo Image box, click the browse icon, .

2. In the Open Image File dialog box, select the graphic file for the logo and then click 
Open.

 To apply the settings and close the Customize Report dialog box

Click OK.

Your selections appear on the report designer page. 

The tab format for the report designer page is as follows:

 Master Result Table

When you create a report by using the Customize Report dialog box, the application adds the 
following additional TextBox design items to the report template: DateTimeInfo in the 
PageHeader section and PageNumberInfo in the PageFooter section. For information about 
editing the date-and-time stamp, see “To change the format of the date-and-time stamp” on 
page 265.

Figure 121 shows a report template for selected columns in the Expected Compounds table 
and its associated chromatogram graph item.
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Figure 121. Report template with data from the Expected Compounds table 

For information about adding more design items to the current template, previewing a 
resolved report, and saving the template, see “Editing an Existing Report Template” on 
page 263.

Table 65 describes the parameters in the Customize Report dialog box.

Adds a page number to 
the report.

Selected logo imageSelected master table name

Selected 
data 
columns 

Selected 
graph

Adds a date-and-time stamp to the report.

Table 65. Customize Report dialog box parameters (Sheet 1 of 3)

Parameter Description

Reported Table Lists the master tables in the result file.

Columns Lists the columns for the selected master table.

Graphs Lists the graphs for the selected master table.

Related Tables Lists the tables related to the selected master table.

Columns Lists the columns for the selected related table.

Graphs Lists the graphs for the selected related table.

Related Tables Lists the second-level related tables for the selected related table.
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Appearance

Draw Lines Specifies whether the application draws a line above the table 
column headers.

Default: Selected

Transpose Data Specifies the layout of the data in the result table columns.

The default layout (check box cleared) matches the result table 
layout, with columns displayed from left to right and rows 
displayed from top to bottom. Select this check box to transpose 
the columns to rows.

Default: Cleared 

Tip  When you select a table item in the data item list, the 
application automatically clears the Transpose Data check box. 
For each table that you want to transpose, select the table name 
and make sure that it is highlighted in blue. Then select the 
Transpose Data check box.

Indenting Specifies the indentation of the selected related table data from the 
left edge of the page, from 0.00 to 1.00 inch.

Default: 0.00 in.

Color Scheme

Color Scheme Specifies the color scheme for the selected table. 

Each color scheme consists of two colors. The first color is the 
background of the column headings. The second color is the 
background of the table rows.

You can modify the Color Scheme list by adding or removing 
color schemes (see “To modify the current color scheme or to add 
or remove color schemes from the list” on page 258).

Default: Transparent/Transparent

Note  Accepting the settings in the Customize Report dialog box 
adds the new color schemes to the ColorScheme.xml file that is 
stored in the same folder as the common report templates.

General Settings

PaperKind Specifies the size of the paper for printing the report. Select the 
appropriate paper size before sending the report to the printer.

Default: A4 

Table 65. Customize Report dialog box parameters (Sheet 2 of 3)

Parameter Description
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Orientation Specifies the orientation of the report, either Portrait or 
Landscape.

Default: Portrait

Logo Image Specifies the logo image to appear by default in the upper right 
corner of each report page.

The default size of the picture container for the logo is 
1.823 × 0.492 in. (width × height). When the selected image is 
larger than the picture container, the container clips the image. 
You can edit the properties of the picture container in the report 
template (see “Editing an Existing Report Template” on 
page 263).

Buttons

Reset Resets the color scheme to the default scheme.

Modify Opens two color selection lists. 

Add Selecting colors in one or both of the color selection lists below the 
Color Scheme list actives this button.

Applies the new color scheme to the selected table and adds the 
new color scheme to the Color Scheme list.

Remove Removes the selected color scheme from the Color Scheme list.

OK Applies the selected settings to the new report template.

Cancel Cancels your selections and closes the dialog box.

Table 65. Customize Report dialog box parameters (Sheet 3 of 3)

Parameter Description
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Editing an Existing Report Template

Use the report designer page to modify a report template. The report designer page shows the 
design items that you selected using the Customize Report dialog box (see “Creating a New 
Report Template” on page 254) or the items in the existing report template that you selected. 
Some of the design items appear as containers (a rectangular box) where you can add text, 
images, or data graphs.

Figure 122 shows the report designer page.

Figure 122. Report designer page

Note  You can open more than one report designer page in the Compound Discoverer 
window.

Links 
area

Property description pane

Click this square 
to display the 
report template 
properties in the 
Properties pane.

Sizing 
bar

Upper toolbar

Design 
item list

Properties 
pane

Lower
toolbar
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For more information about the features of the report designer page, see these topics:

• Report Designer Workspace Sections and Sizing Bar

• Report Designer Toolbars

• Report Designer Shortcut Menu

• Report Designer Section Reports Pane

• Report Designer Properties Pane

• Report Designer Property Dialog Links

• Report Designer Load File Link

• Report Designer Report Template Settings

To work with the report designer page, follow these procedures as applicable:

• To open the report designer page

• To change the logo image

• To change the format of the date-and-time stamp

• To add a design item to the template that does not extract data from a result file

• To add a master table column to a column set that is arranged from left to right

• To add a master table column to a column set that is vertically arranged

• To add a data graph that is associated with the master table to the template

• To add a column from a related table to the template

• To edit the properties of subreport columns

• To edit a design item by using the mouse

• To modify the properties of a design item by using the Properties pane

• To modify the properties of a design item by using its property dialog box

• To save a modified report template with a different name

 To open the report designer page

1. Open a result file.

2. From the Compound Discoverer window, do one of the following:

a. Choose Reporting > Create Report from the menu bar or click the Create Report 
icon, , in the toolbar. 

The Customize Report dialog box opens.
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b. Make the appropriate selections and click OK.

The report designer page opens as a tabbed document. The tab format is as follows:

 Master Result Table Name

–or–

a. Choose Reporting > Edit Report Template from the menu bar or click the Edit 
Report Template icon, , in the toolbar.

The Open Report Design Template dialog box opens.

b. Select a report template and click Open.

The report designer page opens as a tabbed document. The tab format is as follows:

 Existing Report Template Name

 To change the logo image

1. Select the logo image container on the report designer page.

The picture properties appear in the Properties pane.

2. In the Data area, click the browse icon, , to the right of the Image property. You might 
have to click the row to make the browse icon appear.

The Open dialog box opens with a setting of All image files for the file type.

3. Browse to the folder where you stored the logo of interest, select the logo, and click 
Open.

The selected image appears in the container. 

4. Modify the Layout properties as appropriate.

 To change the format of the date-and-time stamp

1. On the report designer page, select the DateTimeInfo item.

The properties for this TextBox design item appear in the Properties pane.

2. Under Appearance, click the OutputFormat box to make the browse icon appear. Then 
click the browse icon.

The OutputFormat dialog box opens (Figure 123).

Note  The Compound Discoverer icon is the default logo for the common templates 
and the templates that you create with the Customize Reports dialog box. 
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Figure 123. OutputFormat dialog box

3. Select the format of interest.

4. Click OK to accept the setting.

 To add a design item to the template that does not extract data from a result file

From the Section Reports pane to the right of the workspace area (see “Report Designer 
Section Reports Pane” on page 280), drag a design item to the appropriate location on a 
workspace section of the page.

 To add a master table column to a column set that is arranged from left to right

1. Decide where you want to place the additional column.

• To place the new column to the right of the current column set, select the 
PageHeader bar. 

• To place the new column to the right of a specific column, select the column heading.

2. Do one of the following:

• Right-click the PageHeader bar or a specific column heading, and then choose Add 
Field > Data Column from the shortcut menu.

–or–

a. Click the PageHeader bar or a specific column heading.

b. In the toolbar, click the Add Items icon, , to open a list of data column 
selections.

The available items in the list include the unused data columns in the current master 
table. The data columns that are already in the template are unavailable and grayed 
out.

c. Select an available data column from the list.
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The new data column appears to the right of the selected column or the current column 
set. If there is a gap to the right of the selected column or to the right of the column set, 
the new column fills the gap. If there is no space to the right of the selected column or to 
the right of the column set, the new column shares the space with the selected column or 
the last column in the column set.

Figure 124 shows that the outcome of adding a column to the right of another column 
depends on the spacing between the columns. 

Figure 124. Adding a data column to the right of another data column

 To add a master table column to a column set that is vertically arranged

1. Use the sizing bar to display all of the data column rows.

2. Right-click the Label column (heading) of the two-column row that is above where you 
want to add the new two-column data row, and choose Add Field > Data Column from 
the shortcut menu.

The new two-column data row appears below the selected two-column row.

 To add a data graph that is associated with the master table to the template

Do one of the following:

• Right-click the DetailSection_Master_Table_Name bar and choose the Add Field > 
Data Graph of interest from the shortcut menu.

Action

Result

Gap between the RT [min] and #Adducts columns

No gap between the RT [min] and #Adducts columns

Action

Result
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–or–

a. Click the DetailSection_Master_Table_Name bar.

b. In the toolbar, click the Add Items icon, , to open a list of data graphs and 
related table selections.

The available items in the list include the data graphs associated with the current 
master table and the related tables for the current master table.

c. Select an available data graph from the list.

When the table columns are positioned from left to right, the data graph appears below 
the table columns and to the right of any existing data graphs.

 To add a column from a related table to the template

Do one of the following:

• Right-click the DetailSection_Master_Table_Name bar and choose the column of 
interest from the shortcut menu.

–or–

a. Select the DetailSection_Master_Table_Name bar.

b. In the toolbar, click the Add Items icon, , to open a list of data graphs and 
related table selections.

The available items in the list include the data graphs associated with the current 
master table and the related tables for the current master table.

c. Choose an available related table from the list, and then choose a table column.

The table column appears at the bottom of the DetailSection (data area). The application 
automatically adds a line above the column header (Figure 125). 

Figure 125. Consolidated Peaks table with a FISh Coverage column from the Expected 
Compound Hits related table

PageFooter 
handle

Line above the 
related table 
column
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 To edit the properties of subreport columns 

1. To open the subreport editor area, do one of the following:

• Double-click Subreport_Related_Table_Name box.

–or–

a. Select the Subreport_Related_Table_Name box.

The Edit Sub-Report icon, , becomes available.

b. Click the Edit Sub-Report icon.

The TextBox design item for the related table column appears in a separate section. The 
item’s container is sized to the full page width (Figure 126).

Figure 126. Report designer page with the subreport section open

2. To change the properties of the TextBox design item in the subreport section, select it.

The properties for the selected design item appear in the properties pane to the right of 
the workspace.

3. Make changes as necessary in the properties pane or click the property dialog link below 
the properties pane to open the TextBox dialog box where you can make similar changes.

4. To close the subreport section, click the Close Sub-Report icon in the report designer 
toolbar.

Subreport section with the 
container for the Best FISh 
Coverage data item sized to 
the full page width

Column heading for 
the Best FISh Coverage 
data column
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 To move a subreport column up to the set of master table columns

1. Resize the column heading container for the subreport column. Then, move it to an 
appropriate location in the set of master table columns.

2. Resize the Subreport_Related_Table_Name container. Then move it to the appropriate 
location in the DetailSection.

3. If you do not want a separator line between each table row, remove the line below the 
TextBox containers in the DetailSection.

Figure 127 shows a Consolidated Peaks table with an additional column from a related 
table.

Figure 127. Consolidated Peaks template with the Best FISh Coverage column repositioned to 
the DetailSection

 To edit a design item by using the mouse

1. Select the design item on the report designer page.

2. Modify the item as follows:

• Move the item by dragging it to a different location or by using the arrow keys on the 
keyboard.

• Resize the item by dragging the handle points of the container.

 To modify the properties of a design item by using the Properties pane

1. Select the design item on the report designer page.

The properties for the selected design item appear in the Properties pane, at the bottom 
right of the report designer page. For information about the properties of each design 
item, see “Report Designer Properties Pane” on page 282.

2. Modify the properties of interest, including the size and location of the selected design 
item.
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 To modify the properties of a design item by using its property dialog box

1. Select the design item on the report designer page.

2. Click the Property Dialog link at the bottom right of the report designer page (see 
“Report Designer Property Dialog Links” on page 291). 

3. Modify the properties of interest, including the size and location of the selected design 
item.

 To save a modified report template with a different name

1. In the toolbar, click the Save As icon, .

The Save Report Template As dialog box opens.

2. Browse to the directory folder where you want to store the report template.

3. In the File Name box, type a name for the report template.

4. Click Save.

Note  For the RichTextBox design item, in addition to the Property Dialog link, you 
can click the Load File link to load text from a file (see “Report Designer Load File 
Link” on page 307).
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Report Designer Workspace Sections and Sizing Bar

These topics describe the workspace sections and sizing bar on the report designer page:

• Workspace Sections

• Sizing Bar

Figure 128 shows the five workspace sections and the sizing bar.

Figure 128. Workspace sections and sizing bar

For more information about the report designer page, see “Editing an Existing Report 
Template” on page 263.

Sizing 
bar

Resizing the Appendix area
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Workspace Sections

By default, the template workspace on the report designer page has five sections. Table 66 lists 
these sections, from top to bottom.

Table 66. Default workspace sections

Workspace section Description

CoverPage With the following property selections, appears as the first page of a report:

• True is the selection for the Visible parameter in the Behavior section of the properties 
pane. Default: False

• After is the selection for the NewPage parameter in the Data section of the properties 
pane. Default: After (See “NewPage” on page 289.)

To display the CoverPage section without a page break between it and the next section, 
select None for the NewPage parameter.

Use this section to add nonrepeating information, such as the report title, date-and-time 
stamp, and company logo.

PageHeader Adds design items to the top of each report page. The standard templates include a Label 
design item that displays the master table name, a TextBox design item that displays a time 
stamp, and a Picture design item that displays a company logo. The column headings (Label 
design items) appear here when you add table columns to the report.

DetailSection

(concatenated with the 
selected Master_Table 
name)

Adds data from the result file, such as the repeating items (TextBox design item) of a master 
table or the data graphs for each table row.

PageFooter Adds information to the footer of each report page, for example, the page number. 

Report templates created with the Customize Reports dialog box automatically include a 
page number at the bottom of each page. The page number is a TextBox design item.

Appendix Adds information to an appendix section of the report. 

An Appendix section appears after the last page of a report, with the following property 
settings:

• True is the selection for the Visible parameter in the Behavior section of the properties 
pane. Default: False

• Before is the selection for the NewPage parameter in the Data section of the properties 
pane. Default: Before

To display the Appendix section without a page break between it and the previous section, 
select None for the NewPage parameter.
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 To delete a pair of workspace sections

1. Select one of the workspace sections by clicking the section header or by clicking within 
the section area.

2. From the shortcut menu, choose Delete.

Sizing Bar

Use the sizing bar to the left of the workspace to resize each workspace section vertically, 
except for the Appendix section.

 To resize a workspace section (excluding the Appendix section)

In the sizing bar, drag the sizing handle (Figure 128 on page 272). 

To vertically enlarge a workspace section, drag down the handle that is aligned with the 
header of the subsequent section. To reduce a workspace section, drag the handle up.

 To resize the Appendix workspace

To enlarge the Appendix section of the report designer page, drag it down by the bottom 
edge of the report designer page. To reduce this workspace section, drag the bottom edge 
up.

Note  The report designer page pairs these sections together: 

• CoverPage and Appendix 

• PageHeader and PageFooter

When you select one of the paired sections to delete, the application removes both 
sections. You cannot delete one section without deleting the other, and you cannot delete 
the DetailSection section.

Tip  Make sure to enlarge the workspace section enough to hold all of the items that you 
want to add to that section of the template. 

The size of a section on the report designer page is not necessarily the same as its size in 
the generated report.
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Report Designer Toolbars

Table 67 describes the toolbar at the top of the report designer page. Table 68 describes the 
toolbar and magnification bar at the bottom of the report designer page.

For more information about the report designer page, see “Editing an Existing Report 
Template” on page 263.

Table 67. Top toolbar on the report designer page (Sheet 1 of 2)

Icon or button Description

Save Active Item—Saves the report template using the same file name.

By default, the template file name is the same name as the master table that you selected in 
the Customize Report dialog box (see “Creating a New Report Template” on page 254).

Save As—Saves the report template using a different file name.

Preview—Opens the Report Preview dialog box (see “Previewing and Printing a Report” on 
page 309).

Print—Opens the Report Print dialog box.

Edit Sub-Report—Enlarges a selected subreport so that you can edit it.

Selecting a subreport item activates this icon. When you click this icon, the report designer 
opens the subreport in a separate DetailSection workspace section. You can zoom in on this 
temporary section or zoom out of it. Increasing the size of this temporary section does not 
affect the report designer page.

Note  Related tables that you select in the Customize Report dialog box (see “Creating a 
New Report Template” on page 254) appear as subreports on the report designer page.

Close Sub-Report—Closes the separate subreport workspace section.

Clicking anywhere in the separate subreport workspace activates this icon. 

Align Columns—Aligns the Label (column heading) and Textbox (data) containers for the 
selected column or columns. 

Selecting a report column activates this icon.
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Add Items—Opens a list of items that you can add to the currently selected section of the 
report template.

Clicking within a workspace section or the section header activates this icon. The list of 
items varies depending on the selected section:

• CoverPage and DetailSection sections: You can add related table columns or graphs that 
are not currently in the template. 

• PageHeader section: You can add master table columns that are not currently in the 
template. The column heading appears in the PageHeader section as a Label design item, 
and the container for the column data appears in the DetailSection as a TextBox design 
item.

Cut—Deletes the selected item without confirmation.

Copy—Copies the selected item.

Paste—Pastes the selected item.

Delete—Deletes the selected item after you click OK in the confirmation dialog box.

Zoom Out—Reduces the magnification of the page.

Zoom In—Increases the magnification of the page.

Magnification box—Displays the magnification percentage.

Actual Size—Displays the page at 100% magnification.

Changing the magnification by using the Zoom In and Zoom Out icons or by typing a value 
in the magnification box activates this icon.

Table 67. Top toolbar on the report designer page (Sheet 2 of 2)

Icon or button Description

Table 68. Bottom toolbar and magnification bar on the report designer page (Sheet 1 of 2)

Icon Description

Dimension Lines—Displays dimension lines ( ) as you 
resize a design item by using the mouse.

Hide Grid—Clears the grid on the page.

Show Dots—Shows the main grid lines and the small dots within 
the grid.

Show Lines—Shows the main grid and the smaller lines within 
the grid.
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Report Designer Shortcut Menu

Table 69 on page 279 describes the shortcut menu commands for the report designer page.

For more information about the report designer page, see “Editing an Existing Report 
Template” on page 263.

 To open the shortcut menu for the report designer page

Right-click the report designer page.

 To add a design item to a section of the report

Right-click the section bar within a section area and choose Add Field > Item of Interest 
from the shortcut menu.

Snap Lines—When you move a design item on the page, blue 
alignment lines appear. When the selected design item (Item 1 
below) is horizontally aligned with another design item, two 
vertical lines bracket the aligned items. When the selected design 
item is vertically aligned with another design item, two horizontal 
lines bracket the aligned items. 

Snap to Grid—When you move an item on the page, this mode 
automatically snaps it to the smaller grid lines.

Select Mode—Use this mode to select items on the page.

To select multiple items, press the SHIFT key while you select the 
items.

Pan Mode—When the page is zoomed in, use this mode to move 
to a different part of the page.

Magnification bar—Move the slider to the left to zoom out and to 
the right to zoom in. The magnification percentage appears to the 
left of the slider.

Table 68. Bottom toolbar and magnification bar on the report designer page (Sheet 2 of 2)

Icon Description

Item 2

Item 1 Item 3
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 To align a column heading to its associated data field

1. In the PageHeader section, select the column heading (Label design item) that you want 
to align with its associated data field (TextBox design item).

The Align Columns icon becomes available.

2. In the report designer page toolbar, click the Align Columns icon, .

 To transpose the data fields from columns to rows or from rows to columns

1. Right-click a column heading (Label) or a column data field (TextBox) and choose 
Transpose Data Fields from the shortcut menu.

2. To undo the change, if necessary, right-click a column heading (Label) or a column data 
field (TextBox) and choose Transpose Data Fields from the shortcut menu.

 To add a border to a design item

1. Right-click the design item in the workspace and choose Format Border from the 
shortcut menu.

The Format Border dialog box opens (Figure 129).

Figure 129. Format Border dialog box with the selection of a coral, double line border

Selected column header (Label item)

Aligned data field (TextBox item)

Align Columns icon
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2. Click one of the icons in the Presets area or select the line style in the Line Styles area, and 
click the appropriate sides of the square in the Preview area to set up the border.

Table 69 describes the shortcut menu commands for the report designer page.

Table 69. Report designer page shortcut menu

Command Description

Add Field Adds more items to the selected workspace section. Choose the 
item from a submenu.

Align Fields Aligns a column header or subreport with the associated data.

This command becomes available when you select a column 
header or a subreport.

Transpose Data Fields Transposes the data from columns to rows or from rows to 
columns.

This command becomes available when you select a column 
header.

Note  The Insert Section command is available if the template does not already include a 
Report Header/Footer section or a Page Header/Footer section.

Insert Section > Report 
Header/Footer

Inserts the ReportHeader and ReportFooter sections.

Insert Section > Page 
Header/Footer

Inserts the PageHeader and PageFooter sections.

Copy Copies the selected item.

Paste Pastes the selected item.

Cut Removes the selected item without confirmation.

Delete Deletes the selected item after you click OK in the confirmation 
dialog box.

Bring to Front Moves the selected item to the front, on top of other surrounding 
items.

Send to Back Moves the selected item to the back, beneath all other surrounding 
items.

Format Border Opens the Format Border dialog box where you can change an 
item’s border layout, line style, and color.

Properties Highlights the (Name) property in the properties pane of the 
report designer page.
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Report Designer Section Reports Pane

The Section Reports pane to the right of the workspace on the report designer page lists all of 
the different design items that you can add to the report template. Drag the item of interest to 
the appropriate location on the report designer page. Some of the items appear as containers 
(boxes) where you can add text or images.

For more information about the report designer page, see “Editing an Existing Report 
Template” on page 263.

Table 70 describes the design items in the Section Reports pane.

Table 70. Design items in Section Reports pane (Sheet 1 of 2)

Design item Description

Label A text label, usually used as a header or title. The column headers are Label design items.

TextBox A text box, usually used to group multiple items together. The application uses the TextBox 
design item to display the repeating tabular data in the result file. 

CheckBox A check box that you can select or clear.

RichTextBox A text box that you can populate by typing text in the box or by loading text from a file. For 
more information, see “Report Designer Load File Link” on page 307. 

Shape A geometric shape such as a rectangular or square box (with either square or rounded 
corners), an ellipse, or a circle.

Tip  When you add this item, by default, it appears as a rectangular box with square 
corners. To change to a different shape, modify the Style property in the properties pane 
(see “Report Designer Properties Pane” on page 282).

Picture A container for a graphic.

Line A straight line.

PageBreak A break to push the subsequent content to the next page.

Barcode A bar code. For information about setting up the Barcode properties, refer to the 
ActiveReports User Guide on the ComponentOne™ company website.
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ReportInfo A variable that the application automatically replaces with real-time data in the generated 
report. Use the ReportInfo design item to show the current page number or to add a 
date-and-time stamp. Select the page number or date-and-time stamp from the 
FormatString list.

CrossSectionLine A line that can span across multiple workspace sections on the report designer page.

Note  You cannot add this item to the DetailSection workspace section. However, you can 
add it to another section (for example, the PageHeader section) and have it span across the 
DetailSection section.

CrossSectionBox A box that can span across multiple workspace sections on the report designer page.

Note  You cannot add this item to the DetailSection workspace section. However, you can 
add it to another section (for example, the PageHeader section) and have it span across the 
DetailSection section.

Table 70. Design items in Section Reports pane (Sheet 2 of 2)

Design item Description
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Report Designer Properties Pane

The properties pane to the bottom right of the workspace on the report designer page lists all 
of the property settings used to format an object (a workspace section or a design item) that 
you select in the report template. The displayed settings vary depending on the selected 
workspace section or design item.

If it is available, click the expand icon, , to open the settings for a particular property or the 
collapse icon, , to close the settings.

The tables in this topic list all of the possible property settings in alphabetical order. Some of 
these settings apply only to certain selected objects.

The properties pane contains these property groups, from top to bottom:

• Appearance Properties

• Behavior Properties

• Data Properties

• Design Properties

• Layout Properties

• Miscellaneous Properties

Appearance Properties

Table 71 describes the Appearance properties.

IMPORTANT  The Summary properties are not functional.

Table 71. Appearance properties in the Properties pane (Sheet 1 of 4)

Property Description

AnchorBottom (For the Line design item only) Specifies whether the line is anchored to the bottom of the 
workspace section.

Selections:
• False—Does not anchor the line to the bottom of the workspace section. 
• True—Anchors the line to the bottom of the workspace section.

Alignment (For the Label, TextBox, ReportInfo, and Barcode design items) Specifies the horizontal 
alignment of the text within the container.

(For the Barcode design item) Specifies the horizontal alignment of the caption text that is 
associated with the bar code. You enable the caption text by setting the CaptionGrouping 
and CaptionPosition properties.

BackColor Specifies the background or fill color.
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BarHeight (For the Barcode design item only) Specifies the height of the bar code.

CaptionGrouping (For the Barcode design item only) 

Selections:
• False—Does not enable a text caption to be associated with the bar code.
• True—Enables a text caption.

CaptionPosition (For the Barcode design item only) Sets the position of the caption container relative to the 
bar code symbol.

Selections:
• None—Hides the caption.
• Above—Sets the position above the symbol. 
• Below—Sets the position below the symbol, as in the figure above.

CharacterSpacing (For the Label and TextBox design items) Specifies the spacing between the characters in the 
text, in points.

Default: 0

ClassName Specifies the name of the class for a particular format.

Default: Normal

Font (For the Label, TextBox, and CheckBox design items) Specifies the name of the font and 
other font characteristics such as the style, size, effects, and script. Clicking the browse icon, 

, opens the Font dialog box where you can specify the font characteristics. Clicking the 
expand icon, , expands the settings. 

Font >

GdiCharSet

Specifies the GDI character set to use. For a list of valid values, refer to the GdiCharSet 
Property in the Microsoft Developer Network (MSDN) Library.

Font >

GdiVerticalFont

Specifies that the font is derived from a GDI vertical font.

ForeColor (For the Label, TextBox, and CheckBox design items) Specifies the font color.

FormatString (For the ReportInfo design item only) Specifies the format of the generated content as a 
page number or a date-and-time string.

LineColor Specifies the color of a line or border.

LineSpacing Specifies the spacing between multiple lines of content, in points.

LineStyle Specifies the style of a line or border.

LineWeight Specifies the thickness of a line or border, in pixels.

Table 71. Appearance properties in the Properties pane (Sheet 2 of 4)

Property Description
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NarrowBarWidth (For the Barcode design item only) Specifies the width of the narrow bars in the bar code (a 
value of 1.0 equals 0.864 points).

Tip  At a thicker width for the narrow bars, the entire bar code might be too large for the 
container. In this case, enlarge the size of the container to see the entire bar code.

NWRatio (For the Barcode design item only) Specifies the ratio of the width of the wide bars relative 
to the width of the narrow bars in the bar code. The larger the ratio, the thicker the wide 
bars appear.

Tip  At a thicker width for the wide bars, the entire bar code might be too large for the 
container. In this case, enlarge the size of the container to see the entire bar code.

OutputFormat (For the TextBox design item only) Specifies formatting settings for a number, currency, 
date, time, percentage, or custom content. Clicking the browse icon, , for this property 
opens the OutputFormatDialog box (see Figure 123 on page 266) where you can change 
the settings. 

Do not change the OutputFormat settings for data fields from a result table column.

PictureAlignment (For the Picture design item only) Specifies the alignment of the selected image with respect 
to the container. For proper alignment, the container must be larger than the image.

Selections: TopLeft, TopRight, Center, BottomLeft, and BottomRight

QuietZone (For the Barcode design item only) Specifies the left, right, top, and bottom margins of the 
quiet zone for the bar code, in inches. 

Rotation (For the Barcode design item only) Specifies the rotation of the bar code within the 
container.

Tip  At a rotation of 90 or 270 degrees, the entire bar code might be too large for the 
container. In this case, enlarge the size of the container to see the entire bar code.

Style Specifies the formatting settings such as color, alignment, font, geometric shape, or bar code 
properties.

SupplementOptions (For the Barcode design item only) Specifies the supplement options (2- or 5-digit add-ons 
for EAN/UPC bar codes). 

TextJustify (For the Label and TextBox design items) Specifies how to distribute the text when you set 
the Alignment property to Justify.

VerticalAlignment (For the Label and TextBox design items) Specifies the vertical alignment of the text within 
the container.

Selections: Top, Middle, and Bottom

Table 71. Appearance properties in the Properties pane (Sheet 3 of 4)

Property Description
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Behavior Properties

Table 72 describes the Behavior properties.

VerticalText Specifies the a vertical alignment for the text. 
• False—Does not render the text according to the vertical layout settings. 
• True—Renders the text according to the vertical layout settings.

WrapMode Specifies that a long line of text wraps to the beginning of the next line to fit in the 
container.

Table 71. Appearance properties in the Properties pane (Sheet 4 of 4)

Property Description

Table 72. Behavior properties in the Properties pane (Sheet 1 of 3)

Behavior property Description

Angle Specifies the slope of the text within the container, in degrees.

AutoReplaceFields (For the RichTextBox design item only) Specifies whether the data in the container is 
automatically replaced with the data from the data source as specified by the Data Field 
property selection.

• False—Does not automatically replace the fields of the object with the fields in the data 
source that are assigned to the current workspace section.

• True—Automatically replaces the fields of the object with the fields in the data source 
that are assigned to the current workspace section.

AutoSize (For the Barcode design item only) Specifies whether the barcode design item stretches to 
fill its container.

Selections: True or False

CanGrow Specifies whether the container or section can increase in height to fit its contents.

Selections: True or False

CanShrink Specifies whether the container or section can decrease in height to fit its contents. 

Selections: True or False

CheckAlignment (For the CheckBox design item only) Specifies the alignment of the check box in the 
container.

Checked (For the CheckBox design item only) Specifies whether the CheckBox design item appears 
with or without a check mark in the report.

Selections:
• False—Shows the check box selected. 
• True—Shows the check box cleared. 
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CheckSumEnabled (For the Barcode design item only) Specifies whether the application computes and includes 
a checksum in the bar code.

Selections: True or False

ColumnDirection (For the DetailSection workspace section only) Specifies whether to display the data 
columns in the down-and-across direction or the across-and-down direction, for a 
multi-column (newspaper-style columns) report.

Selections: DownAcross or AcrossDown

Enabled (For the PageBreak design item only) Specifies whether the PageBreak design item is 
enabled.

Selections: True or False

KeepTogether (For the DetailSection and Appendix workspace sections only) Specifies whether the 
contents of the current section prints on a single page. This property does not shrink items 
to fit; rather, it acts like a page break between reported table rows.

Selections: True or False

MultiLine (For the Label, TextBox, ReportInfo, and RichTextBox design items only) Specifies whether 
the report template displays only the content that fits on one line or displays all the lines 
that fit in the container.

Selections: True or False

PrintAtBottom (For the Appendix workspace section only) Specifies where the design items in the Appendix 
section are printed.

Selections:
• False—Places the Appendix design items immediately after the DetailSection and 

before the page footer information.
• True—Places the Appendix design items at the bottom of the current page just above 

the page footer information.

RepeatToFill (For the DetailSection workspace section only) 

False— Does not repeat content to fill the report page.

True—Repeats content to fill the report page.

RightToLeft ((For the Label, TextBox, and ReportInfo design items) Specifies whether the text is aligned 
with the right side of the container. Also supports locales that use right-to-left fonts.

Selections: True or False 

Table 72. Behavior properties in the Properties pane (Sheet 2 of 3)

Behavior property Description
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Data Properties

Table 73 describes the Data properties.

ShrinkToFit Specifies whether the font size of the text within the selected container shrinks to fit the 
container. If the WrapMode property under Appearance is set to WordWrap, the application 
first wraps the text to fit the container, and then shrinks the text to fit the container.

Selections: True or False

Visible Specifies whether the selected item appears in the report. By default, the CoverPage and 
Appendix sections are set to False, and therefore do not appear in the report.

Selections: True or False

Table 72. Behavior properties in the Properties pane (Sheet 3 of 3)

Behavior property Description

Table 73. Data properties in the Properties pane (Sheet 1 of 3)

Data property Description

ColumnCount (For the DetailSection workspace section only) Specifies the number of columns in the 
report, similar to a newspaper layout. 

Default: 1

When the template contains data columns that match the layout of the master table (data 
columns displayed from left to right), use the default value of 1 (ColumnCount = 1) for the 
number of columns.

Tip  Increasing the number of columns per page works with transposed data columns 
(transposed from rows to columns).

CountNullValues (For the TextBox design item only) 

False—Does not include null values as zeros in the summary fields.

True—Includes null values as zeros in the summary fields.

ColumnSpacing (For the DetailSection workspace section only) Specifies the space between columns 
(newspaper style columns) in a multi-column report.

Culture (For the TextBox design item only) Formats the report data based on the selected culture 
from a particular country or region.

Default: Inherit
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DataField Specifies the data source (master table column, related table column, or data graph) for the 
content.

IMPORTANT  For best results, do not manually modify the content of this box; that is, do 
not select from the associated dropdown list or type text in the box. 

To change the design item to another design item, delete the current item. Then, add a 
new design item as described in “To add a master table column to a column set that is 
arranged from left to right” on page 266 or “To add a data graph that is associated with 
the master table to the template” on page 267.

Description (For the Picture design item only) Not implemented.

Hyperlink Sets to a URL address for a specific location. The application automatically converts this 
URL to a hyperlink in the HTML or PDF exported reports.

Image (For the Picture design item only) Opens the Open dialog box where you can find and select 
the image file. The default file types for the search are image files.

MaxLength (For the RichTextBox design item only) Specifies the maximum number of characters to be 
displayed.

NewColumn (For the DetailSection workspace section only) Specifies where a new column is printed. 
The default number of report columns is 1. The standard report templates contain only one 
column and the Customize Reports dialog box creates reports with one column. In this 
context, a column is a formatting option, not a table column from a result table.

Table 73. Data properties in the Properties pane (Sheet 2 of 3)

Data property Description
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NewPage (For the CoverPage, DetailSection, and Appendix workspace sections) Specifies whether a 
page break is inserted before, after, or both before and after the section.

Default settings: 
• CoverPage—After
• DetailSection—None
• Appendix—Before

Selections:
• None—No page break.
• Before—Inserts a page break before printing the content of the section. This selection 

does not affect the CoverPage section.
• After—Inserts a page break after printing the content of the section. This selection does 

not affect the Appendix section.
• BeforeAfter—Inserts a page break before and after printing the content of the section. 

For the CoverPage section, these settings affect the formatting as follows:
• None—No page break between the cover page and the next section.
• Before—No effect.
• After—Adds a page break between the cover page and the next section.
• BeforeAfter—Adds a page break between the cover page and the next section.

For the DetailSection, these settings affect the formatting as follows:
• None—No page break between the table rows.
• Before—Adds a page break between each table row.
• After—Adds a page break between each table row.
• BeforeAfter—Adds a page break between each table row.

For the Appendix section, these settings affect the formatting as follows:
• None—No page break.
• Before—Adds a page break before the Appendix section.
• After—No effect.
• BeforeAfter—Adds a page break before the Appendix section.

Tag Displays information associated with an object on the page.

IMPORTANT  Do not modify or delete the Tag property.

Text For a Label design item, you can type text here. For the column headings, this box displays 
the column heading text. For the TextBox design item, this box displays the name of the 
data source (table column in the result file).

Title (For the Picture design item only) Not implemented.

Table 73. Data properties in the Properties pane (Sheet 3 of 3)

Data property Description
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Design Properties

Table 74 describes the Design property.

Layout Properties

Table 75 describes the Layout properties.

Table 74. Design properties in the Properties pane

Design property Description

(Name) Displays the internal name of an object on the report designer page, used by the application 
to uniquely identify each individual object.

Table 75. Layout properties in the Properties pane (Sheet 1 of 2)

Layout property Description

End (For the CrossSectionLine and CrossSectionBox design items only) Specifies the X and Y 
coordinates of the end of the line or the bottom right corner of the box, based on the rulers 
at the top and left side of the report designer page.

Height (For a workspace section only) Specifies the height of the section, based on the ruler to the 
left of the template workspace.

Location Specifies the X and Y coordinates of the upper left corner of an object, based on the rulers at 
the top and to the left of the template workspace.

Padding Specifies the values in points for the space to the left, top, right, and bottom of the textual 
content, within the container.

Radius (For the CrossSectionBox design item only) Specifies the percentage value for the roundness 
of the corners of the box. The default value of 0 creates corners with no rounding. A value of 
100 creates top and bottom sides that look like half circles. 

RoundingRadius (For the Shape design item only) Specifies the percentage value for the roundness of the 
corners when you select RoundRect (rectangle with rounded corners) for the Style property.

Size Specifies the width and height of an object on the page, in inches.

SizeMode (For the Picture design item only) Specifies how the report designer sizes the image to fit in 
the container.

Selections:
• Clip—Clips images that are larger than the container.
• Stretch—Stretches images to fit the container.
• Zoom—Decreases the image size to fit the container.

Start (For the CrossSectionLine and CrossSectionBox design items only) Specifies the X and Y 
coordinates of the start of the line or the top left corner of the box, based on the rulers at the 
top and to the left of the template workspace.

X1 (For the Line design item only) Specifies the coordinate of the left end of a line, based on 
the horizontal ruler at the top of the report designer page.
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Miscellaneous Properties

Table 76 describes the Miscellaneous properties.

Report Designer Property Dialog Links

The reporting feature for the Compound Discoverer application includes a property dialog 
box for each design item in the Section Reports pane. Using this dialog box, you can modify 
the formatting parameters for a selected design item on the report designer page. The available 
properties vary depending on the selected workspace section or design item. Most of these 
parameters are similar to the properties listed in the Properties pane (see “Report Designer 
Properties Pane” on page 282), although some might have slightly different names.

For more information about the report designer page, see “Editing an Existing Report 
Template” on page 263.

X2 (For the Line design item only) Specifies the coordinate of the right end of a line, based on 
the horizontal ruler at the top of the report designer page.

Y1 (For the Line design item only) Specifies the coordinate of the left end of a line, based on 
the vertical ruler to the left of the template workspace.

Y2 (For the Line design item only) Specifies the coordinate of the right end of a line, based on 
the vertical ruler to the left of the template workspace.

Table 75. Layout properties in the Properties pane (Sheet 2 of 2)

Layout property Description

Table 76. Miscellaneous properties in the Properties pane

Miscellaneous property Description

Code128 (For the Barcode design item only) When you select Code_128_x for the Style property in 
the Appearance area, use this property to define the code.

Code49 (For the Barcode design item only) When you select Code49 for the Style property in the 
Appearance area, use this property to define the code.

DataMatrix (For the Barcode design item only) When you select the DataMatrix option for the Style 
property in the Appearance area, use this property to define the code.

PDF417 (For the Barcode design item only) When you select Pdf417 for the Style property in the 
Appearance area, use this property to define the code.

QRCode (For the Barcode design item only) When you select QRCode for the Style property in the 
Appearance area, use this property to define the code.

A QR code (quick response code) is a matrix (2D) barcode. Because smartphones can 
convert QR codes to URLs, QR codes can provide quick access to websites.

RssExpandedStacked (For the Barcode design item only) When you select RssExpandedStacked for the Style 
property in the Appearance area, use this property to define the code.
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 To open the property dialog box for a report design item

1. Select the design item of interest in the workspace.

2. At the bottom right corner of the report designer page, click the Property Dialog link. 

The property dialog box for the selected object opens (Figure 130).

Figure 130. Property dialog box for the Label design item

The parameters in the property dialog boxes have equivalent parameters in the properties 
pane. 

For the workspace sections, these topics provide links to the equivalent parameters in the 
properties pane:

• ReportHeader Dialog Box for the CoverPage Section

• PageHeader Dialog Box for the PageHeader Section

• Detail Dialog Box for the DetailSection

• PageFooter Dialog Box for the PageFooter Section

• ReportFooter Dialog Box for the Appendix Section

Note  For the RichTextBox design item, in addition to the Property Dialog link, you can 
click the Load File link to load text from a file into the box (see “Report Designer Load 
File Link” on page 307). 
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For the design items, these topics provide links to the equivalent parameters in the properties 
pane:

• Label Dialog Box

• Text Box Dialog Box

• CheckBox Dialog Box

• RichTextBox Dialog Box

• Shape Dialog Box

• Picture Dialog Box

• Line Dialog Box

• PageBreak Dialog Box

• Barcode Dialog Box

• ReportInfo Dialog Box

• CrossSectionLine Dialog Box

• CrossSectionBox Dialog Box

ReportHeader Dialog Box for the CoverPage Section

For information about a parameter in the ReportHeader dialog box, click the appropriate link 
in Table 77. 

Table 77. ReportHeader dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Background Color Appearance “BackColor” on page 282

Layout page

Insert New Page Behavior “NewPage” on page 289
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PageHeader Dialog Box for the PageHeader Section

For information about a parameter in the PageHeader dialog box, click the appropriate link in 
Table 78.

Detail Dialog Box for the DetailSection

For information about a parameter in the Detail dialog box, click the appropriate link in 
Table 79.

Table 78. PageHeader dialog box parameters

Parameter Equivalent property in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Background Color Appearance “BackColor” on page 282

Table 79. Detail dialog box parameters (Sheet 1 of 2)

Parameter Equivalent property in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Background Color Appearance “BackColor” on page 282

Layout page

Column Count Data “ColumnCount” on page 287 

Column Spacing Data “ColumnSpacing” on page 287 

Column Direction Behavior “ColumnDirection” on 
page 286

Insert New Page Behavior “NewPage” on page 289

Insert New Column Behavior “NewColumn” on page 288

Keep Together Behavior “KeepTogether” on page 286

Repeat To Fill Behavior “RepeatToFill” on page 286
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PageFooter Dialog Box for the PageFooter Section

For information about a parameter in the PageFooter dialog box, click the appropriate link in 
Table 80.

ReportFooter Dialog Box for the Appendix Section

For information about a parameter in the ReportFooter dialog box, click the appropriate link 
in Table 81.

Section Height

Can Increase to Accommodate 
Contents

Behavior “CanGrow” on page 285

Can Decrease to Accommodate 
Contents

Behavior “CanShrink” on page 285 

Table 80. PageFooter dialog box parameters

Parameter Equivalent property in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Background Color Appearance “BackColor” on page 282

Table 81. ReportFooter dialog box parameters (Sheet 1 of 2)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Background Color Appearance “BackColor” on page 282

Layout page

Insert New Page Behavior “NewPage” on page 289

Table 79. Detail dialog box parameters (Sheet 2 of 2)

Parameter Equivalent property in the Properties pane
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Label Dialog Box

For information about a parameter in the Label dialog box, click the appropriate link in 
Table 82.

Keep Together Behavior “KeepTogether” on page 286

Print at Bottom Behavior “PrintAtBottom” on page 286 

Table 82. Label dialog box parameters (Sheet 1 of 2)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

DataField Data “DataField” on page 288

Text Data “Text” on page 289

Hyperlink Data “Hyperlink” on page 288

Appearance page

Background Color Appearance “BackColor” on page 282

Angle Behavior “Angle” on page 285

Font page

Name Appearance “Font” on page 283

Size Appearance “Font” on page 283

Style Appearance “Font” on page 283 

Weight Appearance “Font” on page 283

Color Appearance “ForeColor” on page 283 

Decoration Appearance “Font” on page 283 

GDI Charset Appearance “GdiCharSet” on page 283

GDI Vertical Appearance “GdiVerticalFont” on page 283

Format page

Line Spacing Appearance “LineSpacing” on page 283

Character Spacing Appearance “CharacterSpacing” on 
page 283

Multiline Behavior “MultiLine” on page 286

Table 81. ReportFooter dialog box parameters (Sheet 2 of 2)

Parameter Equivalent parameter in the Properties pane
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Text Box Dialog Box

For information about a parameter in the TextBox dialog box, click the appropriate link in 
Table 83.

Textbox Height

Can Shrink Text to Fit 
Fixed Size Control

Behavior “ShrinkToFit” on page 287

Text Direction

RightToLeft Behavior “RightToLeft” on page 286

Vertical Text Appearance “VerticalText” on page 285

Alignment page

Alignment

Vertical Alignment Appearance “VerticalAlignment” on 
page 284

Horizontal Alignment Appearance “Alignment” on page 282

Justify Method Appearance “TextJustify” on page 284

Wrap Mode Appearance “WrapMode” on page 285

Padding

Top, Left, Right, 
Bottom

Layout “Padding” on page 290

Table 83. TextBox dialog box parameters (Sheet 1 of 3)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

DataField Data “DataField” on page 288

Text Data “Text” on page 289

Hyperlink Data “Hyperlink” on page 288

Appearance page

Background Color Appearance “BackColor” on page 282

Table 82. Label dialog box parameters (Sheet 2 of 2)

Parameter Equivalent parameter in the Properties pane



5 Creating and Printing Reports
Creating a New Report Template

298 Compound Discoverer User Guide Thermo Scientific

Font page

Name Appearance “Font” on page 283

Size Appearance “Font” on page 283

Style Appearance “Font” on page 283 

Weight Appearance “Font” on page 283

Color Appearance “ForeColor” on page 283 

Decoration Appearance “Font” on page 283 

GDI Charset Appearance “GdiCharSet” on page 283

GDI Vertical Appearance “GdiVerticalFont” on page 283

Format page

Line Spacing Appearance “LineSpacing” on page 283

Character Spacing Appearance “CharacterSpacing” on 
page 283

Multiline Behavior “MultiLine” on page 286

Textbox Height

Can Increase to Accommodate 
Contents

Behavior  “CanGrow” on page 285 

Can Decrease to Accommodate 
Contents

Behavior  “CanShrink” on page 285 

Can Shrink Text to Fit Fixed Size 
Control

Behavior “ShrinkToFit” on page 287 

Text Direction

RightToLeft Behavior “RightToLeft” on page 286

Vertical Text Appearance “VerticalText” on page 285 

Alignment page

Vertical Alignment Appearance “VerticalAlignment” on 
page 284

Horizontal Alignment Appearance “Alignment” on page 282 

Wrap Mode Appearance “WrapMode” on page 285

Table 83. TextBox dialog box parameters (Sheet 2 of 3)

Parameter Equivalent parameter in the Properties pane
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CheckBox Dialog Box

For information about a parameter in the CheckBox dialog box, click the appropriate link in 
Table 84.

Padding

Left, Right, Top, Bottom Layout “Padding” on page 290

Summary page 

The properties on the Summary page are not implemented.

Table 84. CheckBox dialog box parameters  (Sheet 1 of 2)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

DataField Data “DataField” on page 288

Text Data “Text” on page 289

Check Alignment Data “CheckBox” on page 280

Appearance page

Background Color Appearance “BackColor” on page 282

Font page

Name Appearance “Font” on page 283

Size Appearance “Font” on page 283

Style Appearance “Font” on page 283 

Weight Appearance “Font” on page 283

Color Appearance “ForeColor” on page 283 

Decoration Appearance “Font” on page 283 

GDI Charset Appearance “GdiCharSet” on page 283

GDI Vertical Appearance “GdiVerticalFont” on page 283

Alignment page

Alignment

Wrap Mode Appearance “WrapMode” on page 285

Table 83. TextBox dialog box parameters (Sheet 3 of 3)

Parameter Equivalent parameter in the Properties pane
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RichTextBox Dialog Box

For information about a parameter in the RichTextBox dialog box, click the appropriate link 
in Table 85.

Shape Dialog Box

For information about a parameter in the Shape dialog box, click the appropriate link in 
Table 86.

Padding

Top, Left, Right, 
Bottom

Layout “Padding” on page 290

Table 85. RichTextBox dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

DataField Data “DataField” on page 288

Max Length Data “MaxLength” on page 288

AutoReplaceFields Behavior “AutoReplaceFields” on 
page 285

Appearance page

Background Color Appearance “BackColor” on page 282

Format page – RichTextBox Height

Can Increase to Accommodate 
Contents

Behavior  “CanGrow” on page 285 

Can Decrease to Accommodate 
Contents

Behavior  “CanShrink” on page 285 

Multiline Behavior “MultiLine” on page 286

Table 86. Shape dialog box parameters (Sheet 1 of 2)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Table 84. CheckBox dialog box parameters  (Sheet 2 of 2)

Parameter Equivalent parameter in the Properties pane
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Picture Dialog Box

For information about a parameter in the Picture dialog box, click the appropriate link in 
Table 87.

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Shape Type Appearance “Style” on page 284

Rounding Radius Layout “RoundingRadius” on page 290

Line Style Appearance “LineStyle” on page 283

Line Weight Appearance “LineWeight” on page 283

Line Color Appearance “LineColor” on page 283

Background Color Appearance “BackColor” on page 282

Table 87. Picture dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

DataField Data “DataField” on page 288

Choose Image Data “Image” on page 288

Hyperlink Data “Hyperlink” on page 288

Title Data Not implemented

Description Data Not implemented

Appearance page

Line Style Appearance “LineStyle” on page 283

Line Weight Appearance “LineWeight” on page 283

Line Color Appearance “LineColor” on page 283

Background Color Appearance “BackColor” on page 282

Picture Alignment Appearance “PictureAlignment” on 
page 284

Size Mode Layout “SizeMode” on page 290

Table 86. Shape dialog box parameters (Sheet 2 of 2)

Parameter Equivalent parameter in the Properties pane
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Line Dialog Box

For information about a parameter in the Line dialog box, click the appropriate link in 
Table 88.

PageBreak Dialog Box

For information about a parameter in the PageBreak dialog box, click the appropriate link in 
Table 89.

Barcode Dialog Box

For information about a parameter in the Barcode dialog box, click the appropriate link in 
Table 90.

Table 88. Line dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Line Style Appearance “LineStyle” on page 283

Line Weight Appearance “LineWeight” on page 283

Line Color Appearance “LineColor” on page 283

Anchor at Bottom Appearance “AnchorBottom” on page 282

Table 89. PageBreak dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Enabled Behavior “Enabled” on page 286

Location Layout “Location” on page 290

Table 90. Barcode dialog box parameters (Sheet 1 of 3)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290
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Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

DataField Data “DataField” on page 288

Text Data “Text” on page 289

Autosize Behavior “AutoSize” on page 285

Caption

Location Appearance “CaptionPosition” on page 283

Text Alignment Appearance “Alignment” on page 282

Barcode Settings page

Style Appearance “Style” on page 284

Bar Height Appearance “BarHeight” on page 283

Narrow Bar Width Appearance “NarrowBarWidth” on 
page 284

Narrow Width Bar 
Ratio

Appearance “NWRatio” on page 284

Quiet Zone

Left, Right, Top, and 
Bottom

Appearance “QuietZone” on page 284

Checksum

Checksum Enabled Behavior “CheckSumEnabled” on 
page 286

Appearance page

Fore Color Appearance “ForeColor” on page 283

Background Color Appearance “BackColor” on page 282

Rotation Appearance “Rotation” on page 284

Font page

Name Appearance “Font” on page 283

Size Appearance “Font” on page 283

Style Appearance “Font” on page 283 

Weight Appearance “Font” on page 283

Decoration Appearance “Font” on page 283 

GDI Charset Appearance “GdiCharSet” on page 283

Table 90. Barcode dialog box parameters (Sheet 2 of 3)

Parameter Equivalent parameter in the Properties pane
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ReportInfo Dialog Box

For information about a parameter in the ReportInfo dialog box, click the appropriate link in 
Table 91.

GDI Vertical Appearance “GdiVerticalFont” on page 283

Alignment page

Alignment

Wrap Mode Appearance “WrapMode” on page 285

Padding

Top, Left, Right, 
Bottom

Layout “Padding” on page 290

Table 91. ReportInfo dialog box parameters  (Sheet 1 of 2)

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Background Color Appearance “BackColor” on page 282

Font page

Name Appearance “Font” on page 283

Size Appearance “Font” on page 283

Style Appearance “Font” on page 283 

Weight Appearance “Font” on page 283

Color Appearance “ForeColor” on page 283 

Decoration (Strikeout and 
Underline)

Appearance “Font” on page 283 

GDI Charset Appearance “GdiCharSet” on page 283

GDI Vertical Appearance “GdiVerticalFont” on page 283

Format page

Format String Behavior “FormatString” on page 283

Multiline Behavior “MultiLine” on page 286

Table 90. Barcode dialog box parameters (Sheet 3 of 3)

Parameter Equivalent parameter in the Properties pane
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CrossSectionLine Dialog Box

For information about a parameter in the CrossSectionLine dialog box, click the appropriate 
link in Table 92.

ReportInfo Height

Can Increase to Accommodate 
Contents

Behavior  “CanGrow” on page 285 

Can Decrease to Accommodate 
Contents

Behavior  “CanShrink” on page 285 

Text Direction

RightToLeft Behavior “RightToLeft” on page 286

Alignment page

Alignment

Vertical Alignment Appearance “VerticalAlignment” on 
page 284

Horizontal Alignment Appearance “Alignment” on page 282 

Wrap Mode Appearance “WrapMode” on page 285

Summary page

The properties on the Summary page are not implemented.

Table 92. CrossSectionLine dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Line Style Appearance “LineStyle” on page 283

Line Weight Appearance “LineWeight” on page 283

Line Color Appearance “LineColor” on page 283

Table 91. ReportInfo dialog box parameters  (Sheet 2 of 2)

Parameter Equivalent parameter in the Properties pane
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CrossSectionBox Dialog Box

For information about a parameter in the CrossSectionBox dialog box, click the appropriate 
link in Table 93.

Table 93. CrossSectionBox dialog box parameters

Parameter Equivalent parameter in the Properties pane

General page Formatting group Property

Name Design “(Name)” on page 290

Tag Data “Tag” on page 289

Visible Behavior “Visible” on page 287

Appearance page

Line Style Appearance “LineStyle” on page 283

Line Weight Appearance “LineWeight” on page 283

Line Color Appearance “LineColor” on page 283

Radius Layout “Radius” on page 290

Background Color Appearance “BackColor” on page 282
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Report Designer Load File Link

Use the Load File link at the bottom right corner of the report designer page, (see “Report 
Designer Properties Pane” on page 282), to populate a RichTextBox design item with data 
from a file.

 To use the Load File link 

1. Click the Load File link.

2. In the Open dialog box, select the data file and then click Open.

You can load text from one of these file types: RTF, TXT, or HTML or HTM.

Report Designer Report Template Settings

On the report designer page, you can add a watermark, change the print width and the 
orientation of the report template (portrait or landscape), and select the type of paper that you 
want the printer to use.

Follow these procedures as needed:

• To open the property settings for the report template

• To add a watermark to the report template

• To change the print width of the template

• To change the page orientation of the report template

• To change the paper size used by the printer



 To open the property settings for the report template

Click the square in the upper left corner (below the toolbar) of the report designer page.

The watermark properties appear in the Appearance group, and the orientation and paper 
size properties appear in the Miscellaneous group (Figure 131).

Figure 131. Report template properties (in the Properties pane)

 To add a watermark to the report template

1. Under Appearance, click the browse icon, , to the right of the Watermark property.

The Open dialog box opens with the file type setting for all image files.

2. Find and select the image file of interest and click Open.

3. In the WatermarkAlignment list, select the appropriate alignment.

4. In the WatermarkPrintOnPages box, type the page number of the page where you want 
the watermark to appear.

Click this 
square.
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5. In the WatermarkSizeMode list, select whether you want to clip the image if it is larger 
than the container, stretch the image to fit the container, or reduce the image size to fit 
the container.

 To change the print width of the template

Under Behavior, type a numeric value in the PrintWidth box.

 To change the page orientation of the report template

Under Misc, in the IsLandscape list, select True for Landscape or False for Portrait.

 To change the paper size used by the printer

Under Misc, in the PaperKind list, select the appropriate paper size. 

To open the list to the paper size of interest, type the first letter of the paper-size name. 
For example, if you want to change the size from A4 to Letter, type an L in the box. If the 
paper size does not appear in the box, continue typing the first letter of its name. The 
application cycles through the paper sizes that begin with this letter.

Previewing and Printing a Report
This topic describes how to work with the Report Preview and Report Print dialog boxes and 
the report resolution page. 

You can print all of the report pages from the report resolution page or the Report Print dialog 
box. You can print up to five pages from the Report Preview dialog box.

 To open the Report Preview dialog box

In the toolbar on the report designer page, click the Preview Report icon, .

The application opens the Report Preview dialog box and resolves the current result file 
with the current template on the report designer page. The Page Thumbnails pane 
displays up to five resolved pages. A red line in the right page margin indicates that the 
print width does not fit on the selected page size, and the printer will print an empty page 
with every report page it prints, unless you resize the template (see To change the print 
width of the template).
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Figure 132. Report Preview dialog box with a red line indicating an insufficient right margin

 To open the Report Print dialog box

In the toolbar on the report designer page, click the Print Report icon, .

The application opens the Report Print dialog box and resolves the current result file with 
the current template on the report designer page.The Page Thumbnails pane displays all 
of the report pages. 

 To open the report resolution page

1. Open a result file.

2. Select an existing report template as follows:

a. Choose Reporting > Create Report from the menu bar or, click the Create Report 
icon, .

The Open Report Design Template dialog box opens to the Report Templates folder. 

b. Select the appropriate report template and click Open.

The application resolves the current result file with the selected template. The Page 
Thumbnails pane displays all of the report pages.
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 To find a text item in a resolved report

1. In the toolbar, click the Find icon, .

The Find dialog box opens.

2. In the Find What box, type the text that you want to find (see Figure 133).

Figure 133. Find dialog box with a text entry

3. Select the appropriate check boxes.

• To match whole words only, select the Match Whole Word Only check box.

• To match the case—uppercase or lowercase, select the Match Case check box.

4. Click Find Next or Find Prev.

 To copy a portion of the report to the Clipboard

Do one of the following:

a. To copy a specific item to the Clipboard, in the Report Preview toolbar, click the 
Selection Mode icon, .

b. Click the item that you want to copy, and then click the Copy icon, .

–or–

a. To copy a rectangular portion of the report to the Clipboard, click the Snapshot 
Mode icon, . 

b. Drag the cursor across the area of interest.

 To export the contents of the report to an external document

1. Open the Report Print dialog box or the report resolution page.

2. In the toolbar, choose Export > File Type, where the File Type is one of the following:

• Text—text file

• PDF—portable document format file

• RTF—rich text format file

• Excel—Microsoft spreadsheet

• HTML—web page that opens in a browser
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 To print the report

1. Do one of the following:

a. From the Compound Discoverer menu bar, choose Reporting > Create Report. 

The Open Report Design Template dialog box opens. 

b. Select an appropriate template and click Open.

The report resolution page opens.

–or–

• From the report designer page, open the Report Print dialog box by clicking the 
Print Report icon, .

2. In the toolbar, click the Print icon, .

The Print dialog box opens.

3. Select the appropriate printer and the page range that you want to print.

4. Click OK to print the report.

For more information about the toolbar and Page Thumbnails pane, see these topics:

• Report Preview Toolbar

• Page Thumbnails Pane

Report Preview Toolbar

The Report Preview and Report Print dialog boxes and the report resolution page share a 
common toolbar. Table 94 describes the icons in the toolbar, from left to right.

Table 94. Report preview icons (Sheet 1 of 3)

Icon Description

Toggle Sidebar—Opens and closes the Page Thumbnails pane (see “Page 
Thumbnails Pane” on page 314). 

Print—Opens the Print dialog box where you select the appropriate print 
options and send the report to the selected printer.

Copy—Copies the selected item to the Clipboard. Clicking the Selection 
Mode icon activates the Copy icon.

Find—Opens the Find dialog box where you can search for a particular 
word or phrase in the report.

Zoom Out—Reduces the magnification of the report view. The current 
zoom box displays the magnification.
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Zoom In—Increases the magnification. The current zoom box displays the 
magnification.

Current zoom—Use to change the on-screen magnification of the report 
by selecting or typing a percentage from 10–800 in this box, and then 
pressing ENTER.

Fit Width—Sizes the width of the report to the screen width. The current 
zoom box displays the magnification.

Fit Page—Sizes the current report page to the screen width and height, 
while maintaining the aspect ratio. The current zoom box displays the 
magnification.

Single Page View—Fits the current report page to the full-screen view and 
removes the scroll bar. To view the report pages, you must use the First 
Page, Previous Page, Next Page, and Last Page icons or the Page 
Thumbnails pane.

Continuous View—Changes the magnification to 100% and makes the 
scroll bar available so that you can scroll through the document.

Multipage view—Changes the display to the selected multi-page view. 

First Page—Displays the first page of the report.

Previous Page—Displays the previous page of the report.

Current Page—Indicates the current page and the estimated number of 
pages in the report.

Next Page—Displays the next page of the report.

Last Page—Displays the last page of the report.

Backward—Displays the previously selected page in the report.

Selecting pages as you browse activates the Backward icon.

Forward—Displays the next selected page in the report. 

Clicking the Backward icon activates the Forward icon.

Pan Mode—Use the hand cursor to drag the page on the screen.

Selection Mode—Use to copy a report item to the Clipboard.

Table 94. Report preview icons (Sheet 2 of 3)

Icon Description
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Page Thumbnails Pane

The Page Thumbnails pane appears to the left of the page preview in the Report Preview and 
Report Print dialog boxes and the report resolution page. Each thumbnail represents a page in 
the report. The Report Preview dialog box resolves up to five pages of data. The Report Print 
dialog box resolves all of the data. In the Report Print dialog box, click a page thumbnail to 
jump to that page.

Table 95 describes the icons in the Page Thumbnails pane, from top left to bottom right.

Snapshot Mode—Use to copy a rectangular area to the Clipboard.

Export—Use to export the contents of the report to an external document 
of one of these types: Text, PDF, RTF, Excel, or HTML.

Table 94. Report preview icons (Sheet 3 of 3)

Icon Description

Table 95. Page Thumbnails pane icons

Icon Description

Enlarge—Enlarges the size of the thumbnails.

Reduce—Reduces the size of the thumbnails.

Thumbnails Pane—Displays the Page Thumbnails pane.

Search Results—Displays the Search Results pane where you can search for 
a particular word or phrase in the report. The found instances appear in 
the list of results.
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6

Modifying the Libraries

This chapter describes how to add, delete, edit, import, and export entries in the Compound 
Discoverer libraries. This chapter also describes how to filter the library entries and copy the 
library entries to the Clipboard.

For information about copying the contents of a library table to the Clipboard, see “Copying 
Table Entries to the Clipboard” on page 373.

Modifying the Compound Library
The initial compound library contains the specific compounds that you can find in the 
example raw data files provided with the application. To process your raw data files for the 
compounds that you expect to find in your samples, you must first add the compounds of 
interest to the compound library. 

To modify the compound library, see these topics:

• Working with the Compound Library

• Adding and Editing Compounds with the Compound Editor

• Using the Structure Drawing Tools in the Compound Editor

Contents

• Modifying the Compound Library 

• Modifying the Adducts Library

• Modifying the Ion Definitions Library

• Modifying the Transformations Library

• Filtering the Library Entries

• Setting Up a Custom Filter
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Working with the Compound Library

The compound library contains a table of known (parent) compounds and includes 
information about the elemental composition and chemical structure for each compound. 

The Compounds page consists of a button bar and a five-column table of named compounds 
(Figure 134). You can hide or show the table columns by using the Field Chooser dialog box, 
you can sort the table rows by clicking the appropriate column heading, and you can hide or 
show rows by using the appropriate filters. For a summary of the Compounds page features, 
see Table 96 on page 319.

Figure 134. Compounds page with a custom library

For information about manually adding new library compounds or editing existing library 
compounds, see “Adding and Editing Compounds with the Compound Editor” on page 321.

Note  Before you create a processing workflow that includes the Compound Generator 
node, the FISh Tracer node, or both of these nodes, you must first add the compound or 
compounds of interest to your compound library. 

Button
bar

Column
headings

Filters

Field Chooser icon

Shortcut menu
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Follow these procedures: 

• To open the Compounds page

• To hide or display the table columns

• To sort the table rows

• To delete a compound library entry

• To import a compound library from an XML file into the current compound library

• To export the contents of the compound library to an XML file

 To open the Compounds page

In the Compound Discoverer window, do one of the following:

• Click the Compounds icon, , in the toolbar.

–or–

• Choose Libraries > Compounds from the menu bar.

The Compounds page contains your customized compound library.

 To hide or display the table columns

1. Click the Field Chooser icon, . 

The Field Chooser dialog box opens (Figure 135).

Figure 135. Field Chooser dialog box for the compound library table

2. Do one of the following:

• To hide a column, clear its associated check box.

• To display a column, select its associated check box.

3. To close the dialog box, click the Close icon.
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 To sort the table rows

• To sort the rows alphabetically by the compound’s name, click the Name column 
heading.

• To sort the rows by the compound’s mass, click the Molecular Weight column 
heading.

 To lock one or more table rows as you scroll through the library entries

1. For each row that you want to place in the freeze pane, click the pin icon, , to the right 
of the row number.

The locked rows move to the top of the table in the order that you pin them, and a blue 
bar appears below the last locked row. The blue bar defines the freeze pane. As you scroll 
up or down the rows, the locked row or rows remain static in the freeze pane.

2. To remove a row from the freeze pane, click the locked pin icon, . to the right of the 
row number.

For more information about using the freeze pane feature, see “Working with Table 
Rows” on page 369.

 To delete a compound library entry

1. Select the compound of interest in the library and click Delete.

A confirmation dialog box appears with the following message:

Do you really want to delete the selected item(s)?

2. Do one of the following:

• To delete the selected entry or entries, click Yes. 

• To cancel the operation, click No or Cancel.

 To import a compound library from an XML file into the current compound library

1. On the Compounds page, click Import.

The Open dialog box opens.

2. Select the XML file of interest and click Open.

The Open dialog box closes and a message box appears with the following message:

Import of Compounds has been finished (x/y imported)

where:

x = the number of compounds imported

y = the number of compounds that were not imported
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3. To complete the import process and close the confirmation box, click OK.

The application adds the contents of the imported library to your current library.

 To export the contents of the compound library to an XML file

1. On the Compounds page, click Export.

The Save As dialog box opens.

2. Browse to the folder where you want to store the file.

3. In the File Name box, type a name for the file.

The application automatically adds the file name extension (.xml). 

4. Click Save.

After the application exports the compound library to an XML file, a confirmation box 
appears with the following message:

Export of Compounds has been finished

5. To close the confirmation box, click OK.

Table 96 describes the features of the Compounds page.

Table 96. Compounds page buttons, icons, columns, and shortcut menu commands (Sheet 1 of 2)

Feature Description

Buttons and icons

New Opens the Compound Editor, where you can add a new 
compound to the library. 

For information about adding a new compound entry, see 
“Adding and Editing Compounds with the Compound Editor” on 
page 321.

Edit Opens the Compound Editor, where you can edit the compound 
information for the selected compound entry. 

Selecting a compound entry activates this button. 

For information about editing a compound library entry, see 
“Adding and Editing Compounds with the Compound Editor” on 
page 321.

Delete Deletes the selected compound entry.

Selecting a compound entry activates this button. 

Import Opens the Open dialog box, where you can select the compound 
library file (XML file) of interest.
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Export Opens the Save As dialog box, where you can name the compound 
library and store it in a selected directory folder as an XML file.

Field Chooser ( ) Opens the Field Chooser dialog box, where you can select the 
table columns that you want to display. 

These selections apply only to the current display. When you close 
and reopen the library, the application displays all of the columns.

Appears in the filter row of a table column after you set up filter 
conditions for the column.

Clicking this icon removes the selected filter conditions.

For information about setting up the filters, see “Filtering the 
Library Entries” on page 355.

Locks or unlocks the selected row from the freeze pane at the top 
of the table below the column headings.

Table columns

Name Displays the user-specified compound name.

Description Displays the user-specified description.

Elemental 
Composition

Displays the elemental composition that the application 
determines from the compound structure.

Molecular Weight Displays the molecular weight that the application calculates from 
the compound’s elemental composition.

Structure Displays the structure created by using the drawing tools or by 
importing a structure file.

Shortcut menu commands

For information about using these shortcut menu commands, see “Copying Table Entries to 
the Clipboard” on page 373.

Copy With Headers Copies the table header and the selected row or rows to the 
Clipboard.

Copy Copies the selected row or rows to the Clipboard.

Note  The application does not copy the chemical structure to the Clipboard.

Table 96. Compounds page buttons, icons, columns, and shortcut menu commands (Sheet 2 of 2)

Feature Description
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Adding and Editing Compounds with the Compound Editor

Use the Compound Editor dialog box to create new compound entries or edit existing entries 
in the compound library.

For information about using the structure drawing tools, see “Using the Structure Drawing 
Tools in the Compound Editor” on page 325.

Follow these procedures:

• To open the Compound Editor dialog box

• To manually add a compound to the compound library

• To open a structure file

• To edit an existing compound entry

 To open the Compound Editor dialog box

1. Open the Compounds page (see “To open the Compounds page” on page 317).

2. Do one of the following:

• To add a new compound, click New.

• To edit an existing compound entry, select the entry and click Edit.

 To manually add a compound to the compound library

1. On the Compounds page, click New.

The Compound Editor dialog box opens (see Figure 136 on page 324).

2. In the Name box, type the compound name.

3. In the drawing area, add the chemical structure by doing one of the following:

• Draw the structure (see “Using the Structure Drawing Tools in the Compound 
Editor” on page 325).

• Open a structure file as described in the next procedure, “To open a structure file.” 

Compound Discoverer automatically populates the Elemental Composition and 
Molecular Weight boxes. You cannot manually edit the elemental composition or the 
molecular weight. To change the elemental composition and the molecular weight, you 
must modify the chemical structure in the drawing area.

4. (Optional) In the Description box, type a description of the compound.

Note  You can add compounds to the compound library by importing compound libraries 
or by using the Compound Editor.
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5. Click Save. 

The dialog box closes and the compound appears in the compound library.

 To open a structure file

1. In the Compound Editor toolbar, click the Load Structure from Disk button, . 

The Open Structure dialog box opens.

2. In the Known Structure Formats list, select the format of the structure file.

The Compound Editor dialog box supports the following file formats: 

• MOL Format (.mol file name extension)

• Compressed Structure (.mcs file name extension)

• Template (.tml file name extension)

3. Browse to and select the structure file of interest.

4. Click Open.

The chemical structure appears in the drawing pane, and the application automatically 
populates the Elemental Composition and Molecular Weight boxes. 

5. If the structure is not visible or it is only partially visible in the pane, right-click the pane 
and choose Select All from the shortcut menu. Then, while pressing the SHIFT key, drag 
the structure into the pane.

 To edit an existing compound entry

1. On the Compounds page, do one of the following:

• Select the entry of interest and click Edit.

–or–

• Double-click the entry.

The Compound Editor dialog box opens with information for the selected entry.

2. Edit the information of interest.

• To modify the chemical structure, edit the structure in the drawing area or open a 
different structure file.

The application automatically populates the Elemental Composition and Molecular 
Weight boxes.

• To change the compound name, type alphanumeric text in the Name box.
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3. Do one of the following:

• To close the dialog box without saving the changes, click Cancel.

• To save the changes, do the following:

i. Click Save.

The Compound Editor dialog box closes and a confirmation box appears with 
the following message: 

Do you want to save changes?

ii. Do one of the following:

– To save the changes, click Yes. 

– To cancel the changes, click No.

Figure 136 shows the Compound Editor dialog box for a new compound entry. The drawing 
area is empty and the Name box is outlined in red. Figure 136 also shows the ToolTips that 
appear when you place the cursor over the toolbar icons and buttons.
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Figure 136. Compound Editor dialog box 

When you right-click the drawing area, a shortcut menu appears. Table 97 describes the 
shortcut menu commands.

Selection
Tool

Save
Structure to Disk

Redo

Clean

Double Bond

Chain

Benzene Ring

Single Bond

Load 
Structure from Disk

Undo

Check

Triple Bond

6-Membered Ring

5-Membered Ring
n-Membered Ring

Templates

Atom Property

Drawing area

(Required) 
User-specified 
compound name 

(Optional) 
Compound description 
such as
the CAS number The application 

populates these 
boxes as you draw 
the structure.
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Using the Structure Drawing Tools in the Compound Editor

Use the Compound Editor toolbar and the shortcut menu for the drawing area to draw, 
manipulate, and save structures as described in the following topics:

• Using the Template Tool

• Checking the Validity of a Structure

• Manipulating Structures

• Modifying Atoms and Bonds

• Saving a Structure

For more information about the Compound Editor dialog box, see “Adding and Editing 
Compounds with the Compound Editor” on page 321.

 To begin drawing a chemical structure

1. Click any of these structure icons, . 

–or–

Select a template structure as described in “Using the Template Tool.” 

The cursor changes shape to represent the current drawing mode.

Table 97. Shortcut menu for the Compound Editor dialog box

Menu command Description

Selection Tool Selects a portion of the structure.

Lasso Selection Selects an non-rectangular portion of the structure.

Rectangle Selection Selects a rectangular portion of the structure.

Cut Removes the selected portion of a structure.

Copy Copies the selected portion of a structure to the Clipboard.

Paste Copies a structure from the Clipboard to the drawing area.

Delete Deletes the selected portion of a structure.

Select All Selects everything in the drawing area.

Resize Resizes the selected portion of a structure (see “To resize a 
structure” on page 329).

Rotate Rotates the structure around the selected axis of rotation (see “To 
rotate a structure” on page 329).

Mirror Reflects the structure along its vertical or horizontal axis (see “To 
mirror a structure” on page 329).
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2. Click the drawing area where you want to place the selected structural feature.

Until you click another structure icon, you can continue to add the same structural 
feature each time you click the drawing area.

3. Edit the atoms and bond properties as described in “Modifying Atoms and Bonds” on 
page 330.

Using the Template Tool

Use the template tool to draw closely related chemical structures as described in these 
procedures:

• To open a template structure

• To create a template structure

 To open a template structure

1. Click the Templates icon, .

The Templates dialog box opens.

2. In the Explorer view of the Templates dialog box, browse to and select the folder where 
you store your structure files.

The title bar of the Templates dialog box changes from Templates to Templates – Folder 
name, and the 2D structures appear above the Explorer view (Figure 137). The 
application displays all of the structures in the folder. It does not differentiate between 
MOL files and Template files.

Note  Holding the cursor over a drawing icon displays a ToolTip that describes the type of 
structure the icon creates.
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Figure 137. Templates dialog box with a view of the stored structures

3. On the structure that you want to open, click any atom or bond.

The templates cursor, , appears in the drawing area of the Compound Editor dialog 
box.

4. To place the selected structure in the drawing area, click the drawing area.

 To create a template structure

1. Open a structure file or draw a structure in the drawing area.

2. In the Compound Editor toolbar, click the Save Structure to Disk button, .

The Save Structure dialog box opens.

3. Browse to the folder where you want to store the file.

4. In the File Name box, type a name.

5. In the Save As Type list, select Template (*.tml).

6. To save the named file to the selected folder, click Save.

The Compound Editor dialog box remains open.
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Checking the Validity of a Structure

The application does not prevent you from creating and saving invalid structures. To check 
the validity of a structure as you create it or before you save it, use the check structure tool.

 To check a structure

1. Click the Check icon, .

The structure check tool searches for formal errors and unusual structural features. If a 
structure is formally incorrect or if the structure check tool finds its validity questionable, 
the Check Structure message box lists the errors and warnings (Figure 138). 

Figure 138. Check Structure message box

2. To close this dialog box, click OK.

The application automatically selects the atoms and bonds that it considers incorrect. The 
application considers structures that are not connected as mixtures and reports them as 
errors, but it does not select the mixtures.

Manipulating Structures

To manipulate a structure, follow these procedures:

• To resize a structure

• To rotate a structure

• To mirror a structure

• To clean a structure 

Note  The structure checking tool does not perform quantum mechanical or 
thermodynamical calculations that address possible structural stability.
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 To resize a structure

1. Select the structure or part of the structure you want to resize.

2. Right-click and choose Resize from the shortcut menu.

3. Drag one of the small rectangles on the structure edge and release the mouse button.

Dragging one of the diagonal rectangles keeps the aspect ratio constant during structure 
resizing.

 To rotate a structure

1. Select the structure or part of the structure you want to rotate.

2. Right-click and choose Rotate from the shortcut menu.

A small circle with cross in the middle, , appears. The circle indicates the center of 
rotation.

3. Move the center of rotation by dragging the circle.

4. Rotate the selected structure around the center of rotation by dragging any of the small 
rectangles on the structure’s edge.

 To mirror a structure

1. Select the structure or part of the structure you want to mirror.

2. Right-click and choose Mirror from the shortcut menu.

3. Click one of the small rectangles on the structure’s edge.

• The top and bottom rectangles flip the selected structure along a horizontal axis.

• The left and right rectangles flip the selected structure along a vertical axis.
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 To clean a structure 

1. Do one of the following:

• Select an entire structure.

–or–

• Select only the atoms you want to clean.

The selected atoms must be connected.

2. Click the Clean icon, .

The cleaning tool helps you create a professional look for your structures. 

After finishing a structure drawing, always check for errors before proceeding with any other 
procedure.

Modifying Atoms and Bonds

To modify or add elements to a structure or to modify or add bonds to a structure, follow 
these procedures:

• Selecting Atoms and Bonds

• Editing Bond Properties

For information about editing the atom properties, see “Editing Atom Properties” on 
page 333.

Selecting Atoms and Bonds

You can select individual atoms and bonds, a contiguous portion of a structure, an entire 
structure, or groups of atoms and bonds that are not adjacent to each other.

Note  In some complicated cases, the Clean function can lead to structures that you might 
not find satisfactory. If this occurs, click the Undo button.
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Follow these procedures:

• To select an individual atom or bond

• To choose a selection mode

• To select a group of atoms that are adjacent to each other

• To select all of the atoms and bonds in the structure

• To move a structure

 To select an individual atom or bond

Click the Selection Tool icon, and then click the individual atom or bond.

 To choose a selection mode

Right-click anywhere in the drawing area of the Compound Editor dialog box, and 
choose Lasso Selection or Rectangle Selection from the shortcut menu.

 To select a group of atoms that are adjacent to each other

Do one of the following:

• Right-click and choose Rectangle Selection from the shortcut menu. Then drag the 
cursor to form a rectangle around the atoms.

–or–

• Right-click and choose Lasso Selection from the shortcut menu. Then draw a 
free-form shape around the atoms.

 To select all of the atoms and bonds in the structure

Do one of the following:

• Right-click the drawing area and choose Select All from the shortcut menu.

–or–

• Click the Selection Tool icon, and then double-click anywhere in the drawing area, 
except on atoms or bonds. 

Lasso Selection Rectangle Selection
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 To move a structure 

1. Select the atoms or bonds that you want to move.

2. Drag the selected structures to a new location.

 To move all of the structures in the drawing area

1. Right-click the drawing area and choose Select All from the shortcut menu. 

2. Click any atom or bond in the drawing area, and then drag the structures to a new 
location.

Editing Bond Properties

Use the bond icons to change the bond multiplicity. 

 To change the multiplicity of a bond

Click , or , or  and then click the bond that you want to change.

Saving a Structure

After you draw a structure or modify a structure, you can save the structure as a structure file 
(MOL format or compressed structure) or as a template file.

 To save a structure as a structure file

1. Click the Save Structure to Disk button in the toolbar, .

The Save Structure dialog box opens.

2. In the File Name box, type a name for the structure file.

You can save structures under their actual names, regardless of length (for example, 
1-Amino-2-hydroxyindane.mol).

3. In the Save As Type list, select a file type.

4. Click Save.

The application saves the structure file in the designated folder and the Save Structure 
dialog box closes.
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Editing Atom Properties

Use the Atom Properties dialog box to change the isotope of an atom or the entire element. 
For more information about modifying compound structures, see “Using the Structure 
Drawing Tools in the Compound Editor” on page 325.

 To edit the element or nucleon number of a single atom

1. Open the Compound Editor dialog box as described in “To open the Compound Editor 
dialog box” on page 321.

2. Click the Selection Tool icon, .

3. Do one of the following:

• Double-click the atom that you want to change.

–or–

a. Click the atom that you want to change.

b. Click the Atom Properties icon, . 

The Atom Properties dialog box opens with the properties of the selected atom displayed. 

Figure 139. Atom Properties dialog box with the selection of the most abundant isotope of 
carbon

IMPORTANT  The Compound Discoverer 1.0 application does not support compounds 
with a charge or radical. In addition, the application does not support the R-Substituent 
feature.
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4. To change the element, do the following:

• To change the atom to an element that is in the Element area, click the appropriate 
Element button.

• To change the atom to an element not listed in the Element area, do the following:

i. Click Periodic Table. 

The Periodic Table dialog box opens. 

ii. Select an element in the periodic table. 

iii. Click OK.

The Periodic Table dialog box closes.

5. To specify a less abundant isotope of the element, select the Isotope check box, and then 
select the appropriate value in the Nucleon Number list.

6. When you finish editing the selected atom, do one of the following:

• To save the changes, click OK.

• To cancel the changes, click Cancel.

The Atom Properties dialog closes.

Changes you make in the Atom Properties dialog box affect only the selected atom.

Tip  For example, to create a compound that is labeled with one carbon-14 atom, 
double-click the labeling site—the atom that you want to change. In the Atom 
Properties dialog box, select the Isotope check box, and then select 14 in the Nucleon 
Number list. 

The application displays carbon-14 as [14]C. For example, the application displays 
the elemental composition of carbon-14 labeled caffeine as C7 [14]C H10 N4 O2.
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Modifying the Adducts Library
Use the Adducts library to define the possible adducts in your sample solutions (Figure 140).

Figure 140. Adducts library

To modify the adducts library, see these topics:

• Working with the Adducts Library

• Adding and Editing Adducts with the Adduct Editor
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Working with the Adducts Library

Follow these procedures as needed:

• To open the Adducts library

• To delete an adduct from the list

• To import a list of adducts from an XML file

• To export the entire list of adducts to an XML file

 To open the Adducts library

In the Compound Discoverer window, do one of the following:

• In the toolbar, click the Adducts icon, .

–or–

• From the menu bar, choose Libraries > Adducts. 

 To delete an adduct from the list

1. Select the adduct in the table and click Delete.

A confirmation dialog box appears with the following message:

Do you really want to delete the selected item(s)?

2. To delete the selected entry or entries, click Yes. Otherwise, to cancel the deletion, click 
No or Cancel. 

 To import a list of adducts from an XML file

1. Click Import.

2. In the Open dialog box, browse to the folder where the adducts file is stored.

3. Select the XML file and click Open.

The Open dialog box closes and a message box appears with the following message:

Import of Adducts has been finished (x/y imported)

where:

x = the number of ion definitions imported

y = the number of ion definitions that were not imported

The application imports new entries only. If the XML file includes entries that are already 
in the library, the application does not import the duplicate entries.

4. To complete the import process and close the message box, click OK.
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 To export the entire list of adducts to an XML file

1. Click Export.

The Save As dialog box opens.

2. Browse to the folder where you want to save the file.

3. In the File Name box, type a name for the file.

The application automatically adds the file name extension (.xml). 

4. Click Save.

The Save As dialog box closes and a message box appears with the following message:

Export of Adducts has been finished

5. To close the message box, click OK.

Table 98 describes the buttons and icons, table columns, and shortcut menu commands on 
the Adducts page.

Table 98. Adduct library features (Sheet 1 of 2)

Feature Description

Buttons and icons

New Opens the Adduct Editor where you can add a new adduct to the 
library. 

For information about adding a new adduct entry, see “Adding 
and Editing Compounds with the Compound Editor” on 
page 321.

Edit Opens the Adduct Editor where you can edit the information for 
the selected entry. 

Selecting an adduct entry activates this button. 

For information about editing a compound library entry, see 
“Adding and Editing Compounds with the Compound Editor” on 
page 321.

Delete Deletes the selected adduct entry.

Selecting an adduct entry activates this button. 

Import Opens the Open dialog box, where you can browse to the 
appropriate folder and select the XML file of interest.

Export Opens the Save As dialog box, where you can name the XML file 
and select an appropriate storage folder.
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Adding and Editing Adducts with the Adduct Editor

Use the Adduct Editor dialog box to define additional adducts, which are part of the ion 
definition.

 To add adducts to the Adducts library

1. Open the Adducts library (“Adducts library” on page 335).

2. In the button bar, click New.

The Adduct Editor dialog box opens (Figure 143). The Save button is unavailable 
because the Elemental Composition box is empty. 

Field Chooser ( ) Opens the Field Chooser dialog box where you can select the table 
columns that you want to display. 

These selections apply only to the current display. When you close 
and reopen the library, the application displays all of the columns.

Appears in the filter row of a table column after you set up filter 
conditions for the column.

Click this icon to undo the selected filter conditions.

For information about setting up the filters, see “Filtering the 
Library Entries” on page 355.

Locks or unlocks the selected row from the freeze pane at the top 
of the table.

Table columns

Name Displays the user-specified name for the adduct.

Adduct Mass Displays the calculated exact mass of the adduct.

Elemental 
Composition

Displays the elemental composition of the adduct.

Charge Displays the charge supplied by the adduct.

Shortcut menu commands

For information about using these shortcut menu commands, see “Copying Table Entries to 
the Clipboard” on page 373.

Copy With Headers Copies the table header and the selected row or rows to the 
Clipboard.

Copy Copies the selected row or rows to the Clipboard.

Table 98. Adduct library features (Sheet 2 of 2)

Feature Description
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Figure 141. Adduct Editor dialog box (Build 584)

3. Define the new adduct as follows:

• In the Name box, select New and type a name for the adduct.

• In the Elemental Composition box, type the elemental composition of the adduct.

The editor validates the composition entry.

• In the Charge box, type the charge that the adduct adds to the ion definition. 

Range: –10 to 10

4. Click Save.

The new adduct appears in the library.

 To edit an adduct entry

1. Select the entry of interest in the library.

2. Click Edit.

The Adduct Editor opens with the selected entry.

3. Modify the adduct definition as follows:

• In the Name box, select the current name and type a new name for the adduct.

• In the Elemental Composition box, select the current elemental composition and 
type a new elemental composition for the adduct.

The editor validates the composition.

• In the Charge box, type the charge that the adduct adds to the ion definition.

Range: –10 to 10
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4. Do one of the following:

• To cancel the changes, click Cancel.

–or–

• To save the changes, click Save. 

Adduct Editor Dialog Box

Table 99 describes the features of the Adduct Editor dialog box.

Table 99. Adduct Editor features

Feature Description

Name Specifies the name of the adduct.

Elemental 
Composition

Specifies the elemental composition of the adduct.

The editor validates the entry.

Charge Specifies the charge that the adduct adds to the ion definition.

Range: –10 to 10

Buttons and icons

Cancel Closes the Adduct Editor without saving the adduct definition.

Save Closes the Adduct Editor and adds the definition to the library.



 6 Modifying the Libraries
Modifying the Ion Definitions Library

Thermo Scientific Compound Discoverer User Guide 341

Modifying the Ion Definitions Library
These topics describe the features of the Ion Definitions page and how to edit the Ion 
Definitions list:

• Working with the Ion Definitions Library

• Adding or Editing Ion Definitions with the Ion Definition Editor

Working with the Ion Definitions Library

The Compound Discoverer application uses the entries in the Ion Definitions library in the 
following workflow nodes: Unknown Detector and Compound Generator.

The default Ion Definitions library contains the most common adducts and dimers formed 
when using the electrospray-mass spectrometry (ESI-MS) technique in either the positive or 
negative polarity mode (Table 100). 

The Ion Definitions page contains a button bar and a table of possible ion definitions 
(Figure 142). You can sort the ion definitions table by clicking the column headings, and you 
can filter the table rows by making filter selections in the filter lists.

Table 100. Common adducts and dimers for the ESI-MS technique

Positive ion mode Negative ion mode

M+H M+ACN+Na M–H

M+Na M+MeOH+H M+Cl

M+K M+DMSO+H M+Br

M+NH4 M+3H M+FA–H

M+2Na–H M+3Na M+HAc–H

M+2K–H M+2H+Na M+TFA–H

M+2H M+H+2Na M-H2O–H

M+2Na 2M+H M+Na–2H

M+H+Na 2M+Na M+K–2H

M+H+K 2M+K 2M–H

M+H+NH4 2M+NH4 2M+FA–H

M+ACN+2H 2M+ACN+H 2M+HAc–H

M+ACN+H 2M+ACN+Na M–2H
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Figure 142. Ion Definitions page

Follow these procedures as needed:

• To open the Ion Definitions library

• To delete an ion definition

• To import a list of ion definitions from an XML file

• To export the contents of the compound library to an XML file

 To open the Ion Definitions library

In the Compound Discoverer window, do one of the following:

• In the toolbar, click the Ion Definitions icon, .

–or–

• From the menu bar, choose Libraries > Ion Definitions. 

 To delete an ion definition

1. Select the ion definition in the table and click Delete.

A confirmation dialog box appears with the following message:

Do you really want to delete the selected item(s)?

2. To delete the selected entry or entries, click Yes. Otherwise, to cancel the deletion, click 
No or Cancel. 

 To import a list of ion definitions from an XML file

1. Click Import.

2. In the Open dialog box, browse to the folder where the ion definitions file is stored.

3. Select the XML file and click Open.
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The Open dialog box closes and a message box appears with the following message:

Import of Compounds has been finished (x/y imported)

where:

x = the number of ion definitions imported

y = the number of ion definitions that were not imported

The application imports new entries only. If the XML file includes entries that are already 
in the library, the application does not import the duplicate entries.

4. To complete the import process and close the message box, click OK.

 To export the entire list of ion definitions to an XML file

1. Click Export.

The Save As dialog box opens.

2. Browse to the folder where you want to save the file.

3. In the File Name box, type a name for the file.

The application automatically adds the file name extension (.xml). 

4. Click Save.

The Save As dialog box closes and a message box appears with the following message:

Export of Compounds has been finished

5. To close the message box, click OK.

Table 101 describes the buttons and icons, table columns, and shortcut menu commands on 
the Ion Definitions page.



6 Modifying the Libraries
Modifying the Ion Definitions Library

344 Compound Discoverer User Guide Thermo Scientific

Table 101. Ion Definitions page features (Sheet 1 of 2)

Feature Description

Buttons and icons

New Opens the Ion Definition Editor where you can add a new 
compound to the library. 

For information about adding a new compound entry, see 
“Adding and Editing Compounds with the Compound Editor” on 
page 321.

Edit Opens the Ion Definition Editor where you can edit the 
compound information for the selected compound entry. 

Selecting a compound entry activates this button. 

For information about editing a compound library entry, see 
“Adding and Editing Compounds with the Compound Editor” on 
page 321.

Delete Deletes the selected ion definition entry.

Selecting an ion definition entry activates this button. 

Import Opens the Open dialog box, where you can browse to the 
appropriate folder and select the XML file of interest.

Export Opens the Save As dialog box, where you can name the XML file 
and select an appropriate storage folder.

Field Chooser ( ) Opens the Field Chooser dialog box where you can select the table 
columns that you want to display. 

These selections apply only to the current display. When you close 
and reopen the library, the application displays all of the columns.

Appears in the filter row of a table column after you set up filter 
conditions for the column.

Click this icon to undo the selected filter conditions.

For information about setting up the filters, see “Filtering the 
Library Entries” on page 355.

Locks or unlocks the selected row from the freeze pane at the top 
of the table.
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Adding or Editing Ion Definitions with the Ion Definition Editor

Use the Ion Definition Editor dialog box to create new ion definitions.

 To add ion definitions to the Ion Definitions library

1. Open the Ion Definitions library (see “Working with the Ion Definitions Library” on 
page 341).

2. In the button bar, click New.

The Ion Definition Editor dialog box opens (Figure 143). The Ion Definition box 
contains only an M for the uncharged molecule. Because the ion definition must include 
at least one additional component, a charge, or both, the box has a red border, and the 
Save button is unavailable. 

Table columns

Ion Definitions Displays the user-specified ion definition.

Adducts Total Mass Displays the difference between the exact mass of the neutral 
molecule and the molecular ion adduct or the exact mass of the 
neutral dimer and the ionized dimer.

Charge Displays the charge of the molecular ion adduct.

Weight Specifies the weighting factor for the ion definition when the ion 
definition is added to the list of possible ions in the Ions list for 
the Unknown Detector node. 

Shortcut menu commands

For information about using these shortcut menu commands, see “Copying Table Entries to 
the Clipboard” on page 373.

Copy With Headers Copies the table header and the selected row or rows to the 
Clipboard.

Copy Copies the selected row or rows to the Clipboard.

Table 101. Ion Definitions page features (Sheet 2 of 2)

Feature Description
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Figure 143. Ion Definition Editor dialog box

3. In the Weight Factor box, type the weighting factor for the ion definition.

Range: 0 to 99

4. Enter the ion definition as follows:

• Type the ion definition in the Ion Definition box.

–or–

• Use the provided components to build an ion definition as follows:

– To add or subtract a component, click the up or down arrow, respectively, to the 
left of the component.

–or–

– Select the current value to the left of the component and type a new integer 
value.

5. Click Save.

The application calculates the ion’s charge and difference in mass between the uncharged 
molecule and the new ion definition. The new ion definition appears in the library.

 To edit an ion definition

1. Select the definition of interest in the table.

2. Click Edit.

The Ion Definition Editor opens with the selected definition in the Ion Definition box.
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3. Modify the ion definition as follows:

• Type the ion definition in the Ion Definition box.

–or–

• Use the provided components to edit the ion definition as follows:

– To add or subtract a component, click the up or down arrow, respectively, to the 
left of the component.

–or–

– Select the current value to the left of the component and type a new integer 
value.

4. In the Weight Factor box, type a weighting factor from 0 to 99 for the ion. 

The Unknown Detector node uses the weight factor value for the ion definitions. With 
the exception of the protonated molecule [M+H]+ in the positive polarity mode and the 
deprotonated molecule [M-H]– in the negative polarity mode, if you set the weight factor 
to 0, the Unknown Detector node does not look for the specified adduct in the mass 
spectrum. 

5. Do one of the following:

• To cancel the changes, click Cancel.

–or–

• To save the changes, do the following:

i. Click Save. 

The Ion Definition Editor closes and a confirmation box appears with the 
following message:

Do you want to save changes?

ii. To save the changes, click Yes, or to cancel the changes, click No. 

Table 102 describes the features of the Ion Definitions Editor dialog box.

Table 102. Ion Definition Editor features (Sheet 1 of 2)

Feature Description

Ion Definition Displays the current ion definition. Valid ion definitions include the 
neutral molecule, which is represented by M, and one or more components 
from the component list. A red border indicates an invalid ion definition.

As you edit the ion definition by using the component list, the application 
automatically updates the ion definition.

Weight Factor Specifies the weighting factor for the ion definition.
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Modifying the Transformations Library
These topics describe the features of the Transformations page and how to modify the 
transformations library:

• Working with the Transformation Library

• Adding or Editing Transformations with the Transformation Editor

Working with the Transformation Library

The transformation library contains a table of possible transformations (Figure 144). The 
Compound Generator node uses a selection of entries from this table and the information in 
the compound library to generate a table of expected transformations for a known compound.

Figure 144. Transformations page with a transformation library

Available 
Adducts list

Use this list to create custom ion definitions. For information about using 
this list to create ion definitions, see “To add ion definitions to the Ion 
Definitions library” on page 345.

Buttons and icons

Cancel Closes the Ion Definitions Editor without saving the new ion definition.

Save Closes the Ion Definitions Editor and adds the definition to the library.

Table 102. Ion Definition Editor features (Sheet 2 of 2)

Feature Description
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Follow these procedures:

• To open the Transformations page

• To delete an entry from the transformation library

• To import a list of transformations from an XML file

• To export the entire transformation library to an XML file

 To open the Transformations page

In the Compound Discoverer window, do one of the following:

• In the toolbar, click the Transformations icon, .

–or–

• From the menu bar, choose Libraries > Transformations.

 To delete an entry from the transformation library

1. Select the entry that you want to delete and click Delete.

A confirmation dialog box appears with the following message:

Do you really want to delete the selected item(s)?

2. To delete the selected entry or entries, click Yes, or to cancel the operation, click No or 
Cancel.

 To import a list of transformations from an XML file

1. Click Import.

2. In the Open dialog box, browse to the folder where the transformations file is stored.

3. Select the file and click Open.

A message box appears with the following message:

Import of Compounds has been finished (x/y imported)

where:

x = the number of transformations imported

y = the number of transformations that were not imported

The application imports new entries only. If the XML file includes entries that are already 
in the library, the application does not import the duplicate entries.

4. To complete the import process and close the message box, click OK.
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 To export the entire transformation library to an XML file

1. Click Export.

The Save As dialog box opens.

2. Browse to the folder where you want to save the file.

3. In the File Name box, type a name for the file.

The application automatically adds the file name extension (.xml). 

4. Click Save.

A message box appears with the following message:

Export of Compounds has been finished

5. To close the message box, click OK.

The Transformations page contains a button bar and a table with three columns (Table 103).

Table 103. Transformations page features (Sheet 1 of 2)

Feature Description

Buttons or icons

New Opens the Transformation Editor dialog box where you can 
create a new transformation.

Edit Selecting a transformation entry activates this button. 

Opens the Transformation Editor dialog box where you can 
edit the selected transformation.

Delete Selecting a transformation entry activates this button. 

Deletes the selected transformation from the library.

Field Chooser ( ) Opens the Field Chooser dialog box where you can select the 
table columns that you want to display. 

These selections apply only to the current display. When you 
close and reopen the library, the application displays all of the 
columns.

Appears in the filter row of a table column after you set up 
filter conditions for the column.

Click this icon to undo the selected filter conditions.

For information about setting up the filters, see “Filtering the 
Library Entries” on page 355.
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Adding or Editing Transformations with the Transformation Editor

Use the Transformation Editor to add entries to or to edit entries in the transformation 
library.

 To add a transformation to the transformation library

1. On the Transformations page, click New.

The Transformation Editor dialog box opens (Figure 145). The empty Name, Arriving 
Group, and Leaving Group boxes have a red outline. You must enter information in the 
Name box and in at least one of the group boxes.

Locks or unlocks the selected row from the freeze pane at the 
top of the table.

Table columns

Name Displays the user-specified name for the entry.

Arriving Group Displays the user-specified elemental composition of the 
arriving group for the transformation, if specified.

Leaving Group Displays the user-specified elemental composition of the 
leaving group for the transformation, if specified.

Leaving Modification If the transformed compound contains fewer atoms than the 
original compound, this column displays the elemental 
composition difference between the arriving group and the 
leaving group.

Arriving Modification If the transformed compound contains more atoms than the 
original compound, this column displays the elemental 
composition difference between the arriving group and the 
leaving group.

M [Da] Displays the difference in mass between the original 
compound and the transformed compound in daltons.

Phase Displays the user-specified category for the transformation.

Max Occurrence Displays the user-specified value for the maximum number of 
times that this transformation can occur in a sequence of 
combinatorial transformations.

Table 103. Transformations page features (Sheet 2 of 2)

Feature Description



6 Modifying the Libraries
Modifying the Transformations Library

352 Compound Discoverer User Guide Thermo Scientific

Figure 145. Transformation Editor dialog box

2. In the Name box, type alphanumeric text to identify the transformation.

The red outline disappears.

3. Define the transformation as follows:

a. In the Arriving Group box, type alphanumeric text for the arriving group of the 
transformation, if applicable.

Valid alphabetic characters include all of the naturally occurring elements in the 
periodic table. The valid range of integers is from 1 to 100 000.

After you define the arriving group, the red outline remains until you place the cursor 
in the Leaving Group box. If you leave the Arriving Group box empty, the red outline 
remains until you define the leaving group.

b. In the Leaving Group box, type alphanumeric text for the transformation’s leaving 
group.

The red outline disappears when you select a phase from the Phase list or place the 
cursor in the Maximum Occurrence box.

c. In the Phase list, select Phase 1 or Phase 2 for a biotransformation, or select Other 
for other transformation types.

d. In the Max Occurrence box, type an integer from 1 to 10.

The Transformation Editor validates the entries from top to bottom. 

After you make valid entries, the Save button becomes available. 
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4. Do one of the following:

• To save the new entry, click Save.

The Transformation Editor dialog box closes and the new entry appears in the 
transformation library

–or–

• To close the dialog box without saving the new entry, click Cancel.

 To edit an entry in the transformation library

1. On the Transformations page, select the entry that you want to edit and click Edit.

The Transformation Editor dialog box opens. The entry boxes are populated with the 
information for the transformation that you selected in the transformation library 
(Figure 146).

Figure 146. Transformation Editor with information for an acetylation chemical reaction

2. Make the appropriate changes.

3. Click Save. 

• If the changes are invalid, the Save button becomes unavailable, the application 
outlines the invalid entries in red, and the invalid entries temporarily appear in the 
transformation library.

• If the changes are valid, the Transformation Editor dialog box closes and a 
confirmation box appears.

4. To save the changes click Yes, or to cancel the changes, click No.
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Table 104 describes the parameters in the Transformation Editor dialog box.

Table 104. Transformation Editor parameters

Parameter Description

Name Type alphanumeric text in this box.

Arriving Group Type the elemental composition of the arriving group in this box.

Leaving Group Type the elemental composition of the leaving group in this box.

Phase Select a phase from this list.

Selections: Phase I, Phase II, and Other

Max. Occurrence Type the maximum number of times that this reaction can occur 
in a set of combinatorial reactions.

Default: 1
Range: 1 to 10 

Buttons and icons

Cancel Closes the Transformation Editor dialog box without saving the 
new transformation reaction.

Save After you add a new definition, clicking Save closes the 
Transformation Editor and adds the new transformation reaction 
to the library.

After you edit an existing definition, clicking Save closes the 
Transformation Editor dialog box and opens a confirmation box. 
You can click Yes to save the changes or click No to cancel the 
changes. 
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Filtering the Library Entries
You can reduce the number of entries in the current display by using the library filters. A 
library filter displays or hides entries on the basis of the filter settings for each table column. 
The filtering effect is not permanent; closing a filtered library removes the filters.

The library filter for each column consists of an operator and an operand. In an unfiltered 
library, the filter row displays the default operator, which is represented by its symbol, and an 
empty operand box for each column. Figure 147 shows the filter row of an unfiltered 
compound library. The Name, Description, Elemental Composition, and Structure columns 
contain text entries. The Molecular Weight column contains numeric entries.

Figure 147. Unfiltered compounds library

To set up a library filter, you select the operator from a fixed list, and you select the operand 
from a list or type a value in the operand box.

The selections in the operator list depend on whether the column contains text or numeric 
entries (see Figure 148). After you select an operator, the operator symbol appears in the filter 
row to the left of the operand box. For more information about the operator lists, see 
Table 106 on page 361 and Table 107 on page 362. 

Figure 148. Operators for library table entries

Default 
operator for 
text columns

Operand box Default operator for 
numeric columns

Operator list for text columns Operator list for numeric columns
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For all columns, the operand list includes the following: Custom, Blanks, NonBlanks, and the 
column entries. For numerical-entry columns, the operand list also includes the following: 
Above Average, Below Average, Top 10, Top 10 Percentile, Bottom 10, and Bottom 10 
Percentile (see Figure 149). For more information, see Table 105.

Figure 149. Operands for numerical-entry columns

After you set up a column filter, the applied filter icon, , appears to the right of the operand 
box. Figure 150 shows a filtered Ion Definitions library that reduces the number of displayed 
entries to 10 on the basis of the total adduct mass. The filter row of the Adducts Total Mass 
column displays the equals symbol ( )for the mathematical operator, the selection of Top 10 
for the operand, and the applied filter icon, .

Figure 150. Ion Definitions library that is filtered by charge
Operator

Operand
Applied filter icon

Filter row
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Follow these procedures:

• To filter the library entries

• To set up a wild card filter

• To set up a numerical value filter

• To remove an individual filter

 To filter the library entries 

For each column that you want to filter by, set up the operator and the operand as 
follows: 

• Set up the operator by clicking the operator symbol on the left side of the column in 
the filter row and selecting an operator from the list. 

– To set up a wild card filter, see “To set up a wild card filter” on page 357.

– To set up a numerical value filter that uses one of these operators Top, Bottom, 
Top Percentile, or Bottom Percentile, see “To set up a numerical value filter” on 
page 358.

• Set up the operand by selecting or typing a value in the operand box. 

– If you select any of the following operands, the operator changes to  
automatically. These operands are only compatible with the  Equals and 

Not Equals operators.

– (Blanks)

– (NonBlanks)

– Above Average, Below Average, Top, Top 10, Bottom, or Bottom 10

– If you select (Custom), the Custom Filter Selection dialog box opens. For 
information about setting up custom filters, see “Setting Up a Custom Filter” on 
page 362.

After you set up a filter, the applied filter icon, , appears to the right of operand box, 
and the table displays only the rows that contain entries that fulfill the filter condition. 

 To set up a wild card filter

1. In the operator list, select Like (Wildcards) or Not Like (Wildcards).

2. In the operand box, select or type text and use an asterisk “*” to replace more than one 
character or a question mark “?” to replace only one character.

For example, to filter the entries in the transformation library on the basis of the presence 
of nitrogen in the arriving group, do the following in the Arriving Group column: 

• Select * Like (Wildcards) in the operator list.

• Type *N* in the operand box.
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 To set up a numerical value filter

Do one of the following:

• To set up a filter that uses a specific table entry in the operand list, select any of these 
operators: Equals, Not Equals, Less Than, Less Than or Equal To, Greater Than, or 
Greater Than or Equal To.

• To set up a filter that uses any of these operands: (Blanks), (NonBlanks), Above 
Average, Below Average, Top 10, Top 10 percentile, Bottom 10, or Bottom 10 
percentile, select either Equals or Not Equals in the operator list.

• To display the top n number of entries, select Top in the operator list and type an 
integer value in the operand box.

• To display the bottom n number of entries, select Bottom in the operator list and 
type an integer value in the operand box.

• To display the top n percentile of entries, select Top Percentile in the operator list 
and type a numeric value in the operand box. 

• To display the bottom n percentile of entries, select Bottom Percentile in the 
operator list and type a numeric value in the operand box.

 To remove an individual filter

Click the filter icon, , to the right of the operand box.

Table 105 describes the available operand selections and the valid typed operand entries for 
both text and numeric columns.
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Table 105. Operands for the library columns (Sheet 1 of 2)

Operand Description

All table columns

(Custom) Applies the custom filter that you set up by using the Custom Filter Selection dialog 
box. 

A custom filter contains more than one condition. If you set up a single-condition filter, 
the operand box lists the single condition rather than the (Custom) setting. For 
information about setting up a custom filter, see “Setting Up a Custom Filter” on 
page 362.

(Blanks) Compatible operators:  Equals and  Not Equals

 (Blanks)—Displays the table rows that have blank entries in the filtered column. 

 (Blanks)—Displays the table rows that have entries in the filtered column.

(NonBlanks) Compatible operators:  Equals and  Not Equals

 (NonBlanks)—Displays the table rows that have entries in the filtered column.

 (NonBlanks)—Displays the table rows that have blank entries in the filtered column.

Selected entry Table 106 on page 361 describes the compatible operators for text entries. Table 107 on 
page 362 describes the compatible operators for numeric entries.

Filters the table rows on the basis of the selected entry and operator.

Typed alphanumeric text
or numeric value

Table 106 describes the compatible operators for text entries. Table 107 describes the 
compatible operators for numeric entries.

Filters the table rows on the basis of the typed text entry and the selected operator.

Additional selections for numeric value columns

Above Average Compatible operators:  Equals and  Not Equals

 (Above Average)—Displays the table rows with numeric values in the filtered column 
that are greater than the calculated column average.

 (Above Average)—Displays the table rows with numeric values in the filtered column 
that are equal to or less than the calculated column average.

Below Average Compatible operators:  Equals and  Not Equals

 (Below Average)—Displays the table rows with numeric values in the filtered column 
that are less than the calculated column average.

 (Below Average)—Displays the table rows with numeric values in the filtered column 
that are equal to or greater than the calculated column average.
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Top 10 Compatible operators:  Equals and  Not Equals

 (Top 10)—Displays the top 10 table rows for the filter condition.

 (Top 10)—Displays the table rows with numeric values in the filtered column that 
are less than those of the top 10 table rows.

Top 10 Percentile Compatible operators:  Equals and  Not Equals

 (Top 10 Percentile)—Displays the top 10th percentile of table rows for the filter 
condition.

 (Top 10 Percentile)—Displays the table rows with numeric values in the filtered 
column that are less than those of the top 10th percentile.

Bottom 10 Compatible operators:  Equals and  Not Equals

 (Bottom 10)—Displays the bottom 10 table rows for the filter condition.

 (Bottom 10)—Displays the table rows with numeric values in the filtered column 
that are greater than those of the bottom 10 table rows.

Bottom 10 Percentile Compatible operators:  Equals and  Not Equals

 (Bottom 10 Percentile)—Displays the bottom 10th percentile of table rows for the 
filter condition.

 (Bottom 10 Percentile)—Displays the table rows with numeric values in the filtered 
column that are greater than those of the bottom 10th percentile.

Table 105. Operands for the library columns (Sheet 2 of 2)

Operand Description



 6 Modifying the Libraries
Filtering the Library Entries

Thermo Scientific Compound Discoverer User Guide 361

Table 106 describes the operators for columns with text entries. 

Table 106. Operators for text columns

Symbol Text selection Effect Symbol Text selection

Equals Displays the text entries 
that exactly match the 
selected or typed operand.

Like (wildcards) Displays the text entries 
that contain the selected 
or typed text and any 
additional text 
represented by an asterisk.

Not equals Displays the text entries 
that do not exactly match 
the selected or typed 
operand. 

Not like 
(wildcards)

Hides the text entries that 
contain the selected or 
typed text and any 
additional text 
represented by an asterisk.

Less than For alphabetic text 
entries, displays the text 
entries that begin with a 
letter in the alphabet that 
comes before the selected 
or typed operand.

Match (regular 
expression)

Displays the text entries 
that contain the same text 
as the selected or typed 
operand.

Less than or equal 
to

Does not match 
(regular 
expression)

Displays the text entries 
that do not contain the 
same text as the selected 
or typed operand. 

Greater than Starts with Displays the text entries 
that start with the selected 
or typed operand.

Greater than or 
equal to

Does not start 
with

Displays the text entries 
that do not start with the 
selected or typed operand.

Contains Displays the text entries 
that contain the text in 
the selected or typed 
operand.

Ends with Displays the text entries 
that end with the selected 
or typed operand.

Does not contain Displays the text entries 
that do not contain the 
text in the selected or 
typed operand.

Does not end with Displays the text entries 
that do not end with the 
selected or typed operand.
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Table 107 describes the operators for columns with numeric entries.

Setting Up a Custom Filter
To set up a single condition filter for a library table, follow the instructions in “Filtering the 
Library Entries” on page 355. 

These procedures describe how to set up a library table filter with more than one condition by 
using the Custom Filter Selection dialog box.

 To open the Custom Filter Selection dialog box

Select (Custom) from the operand list for a table column.

The Custom Filter Selection dialog box opens (Figure 151).

Table 107. Operators for numeric columns

Symbol Text selection Result Symbol Text selection Result

Equals Displays the numerical 
entries that equal the selected 
operand.

Greater than 
or equal to

Displays the numerical 
entries that are greater than 
or equal to the selected 
operand.

Not equals Displays the numerical 
entries that are not equal to 
the selected operand.

Top Displays the n number of 
highest entries, where n 
equals the integer typed in 
the operand box.

Less than Displays the numerical 
entries that are less than the 
selected operand.

Bottom Displays the n number of 
highest entries, where n 
equals the integer typed in 
the operand box

Less than or 
equal to 

Displays the numerical 
entries that are less than or 
equal to the selected operand.

Top 
percentile

Displays the entries in the 
top nth percentile, where n 
equals the percentage typed 
in the operand box

Greater than Displays the numerical 
entries that are greater than 
the selected operand.

Bottom 
percentile

Displays the entries in the 
bottom nth percentile, where 
n equals the percentage typed 
in the operand box.
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Figure 151. Custom Filter Selection dialog box with no conditions

 To create new conditions

1. Do the following for each condition that you want to add to a group:

a. Click Add Condition.

A new table row appears.

b. Select an operator from the Operator list and an operand from the Operand list.

As you add conditions to the group, the application updates the group filter in the gray 
area below the table.

2. To add the last condition to the group, click its row number (Figure 152). 

Figure 152. Clicking the row number in the last row to add the row to the group

Click the row 
number.
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The last condition appears in the group filter area. By default, the application applies the 
AND operator to all of the conditions in the group (Figure 153). A blue bar to the left of 
the condition rows indicates an AND group.

Figure 153. Group filter with three conditions and the AND group operator

 To change the group operator from AND to OR or from OR to AND

Click Toggle.

An orange bar to the left of the condition rows indicates an OR group (Figure 154). 

Figure 154. Group filter with three conditions and the OR group operator

Third 
condition
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 To add an overlapping group to the filter

1. Select the rows that you want to group as follows:

• To add contiguous rows, hold the SHIFT key as you click the first and last row that 
you want to group.

• To add noncontiguous rows, hold the CTRL key as you click the rows that you want 
to group. 

The selected rows are highlighted in blue and the ‘And’ Group and ‘Or’ Group buttons 
become available (Figure 155).

Figure 155. Rows 2 and 4 are selected and ‘And’ Group and ‘Or’ Group buttons are available

2. Specify the group type by clicking ‘And’ Group or ‘Or’ Group.

The application applies the second group definition and the Ungroup button becomes 
available (Figure 155).
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Figure 156. A set of filter conditions with two groups

3. To remove conditions from a group, select the conditions and click Ungroup.

 To apply the filter and close the dialog box

Click OK. 

The Custom Filter Selection dialog box closes, the text (Custom) appears in the operand 
box, and the application applies the custom filter to the entries in the selected filter 
column.

 To close the dialog box without applying the filter

Click Cancel.

Table 108 describes the features of the Custom Filter Selection dialog box.

Table 108. Custom Filter Selection dialog box features (Sheet 1 of 2)

Feature Description

Buttons or icons

+ Add Condition Adds a blank condition row to the condition table.

– Remove Condition(s) Removes the selected conditions. Selected conditions are 
highlighted in blue.

‘And’ Group When the filter contains more than one group, applies the 
AND group type to a set of selected conditions.

‘Or’ Group When the filter contains more than one group, applies the 
OR group type to a set of selected conditions.

Toggle Changes the selected AND group to an OR group or the 
reverse.
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Ungroup As you create groups, group label columns appear to the left 
of the Operator column.

When conditions belong to more than one group, removes 
the second group condition for the selected conditions.

OK Closes the dialog box and applies the filter conditions.

Cancel Closes the dialog box without applying the filter conditions.

Table

Operator column Use to select an operator for the filter condition. 

See Table 106 on page 361 for a list of the operators for the 
text entry columns. See Table 107 on page 362 for a list of the 
operators for the numerical entry columns.

Operand column Use to select or type an operand for the filter condition.

See Table 105 on page 359 for a list of the operands for the 
library columns.

Third column Displays comments about the filter condition. For example, 
this box displays “Condition is empty” until you define the 
operator and the operand for a condition.

Filter description area

This area, which is highlighted in gray, displays the group filter conditions.

Table 108. Custom Filter Selection dialog box features (Sheet 2 of 2)

Feature Description
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7

Working with Compound Discoverer Tables 

This chapter describes the common operations that you can perform on the rows and 
columns in the library and result tables within the Compound Discoverer application. In 
addition, this chapter describes the functionality of the filter row below the column heading 
row.

Working with Table Rows
Use the following procedures to work with the rows of a library or result table.

 To move down through the rows of a result or library table

Press TAB. 

 To move up through the rows of a result or library table

Hold down the SHIFT key and press TAB. 

 To sort the rows based on the contents of a column

Click the column header to sort the rows between ascending order (A, B, C …) and 
descending order (Z, Y, X …), based on the contents in that column.

 To keep one or more of the rows stationary while you scroll through other rows

Click the pin icon, , to the right of the row or rows that you want to keep stationary. 

Contents

• Working with Table Rows

• Working with Table Columns

• Copying Table Entries to the Clipboard

Note  The application treats formulas the same as text strings and sorts them by the 
order of the characters in the formula string, not by the actual number of elements in 
the formula.
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A freeze pane, which is defined by a blue bar, appears at the top of the table. The locked 
rows move to the freeze pane in the order selected and their icons change to pinned, .

Figure 157 shows a compound library with caffeine in the freeze pane.

Figure 157. Compound library with freeze pane

Pin icon Freeze pane
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Working with Table Columns
You can change the order of the columns or hide one or more of the columns in a library or 
result table. The changes to a library table are temporary. You can save the layout changes to a 
result table by applying the File > Save Result View Layout command.

To work with table columns, follow these procedures as necessary:

• To change the order of the columns in a library or result table

• To stack two table columns into one column

• To show or hide columns in a library or result table

 To change the order of the columns in a library or result table

To move a column to the left of its current position, drag the column header to the left. 
Release the mouse button when the cursor, , appears over the column delineator 
(Figure 158).

Figure 158. Moving a column to the left

 To stack two table columns into one column

Drag the column header of the column that you want to stack below the column header 
of the column that you want on top. Release the mouse button when the cursor, , 
appears over the column heading (Figure 159). 

Column 1 Heading Column 2 Heading Column 3 Heading 

Column 3 Heading 

Column 1 Heading Column 3 Heading Column 2 Heading 

Column 1 Heading Column 2 Heading Column 3 Heading 

Original
arrangement

New
arrangement

Dragging
column 3
to the left
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Figure 159. Stacking two columns into one column

 To show or hide columns in a library or result table

1. Click the Field Chooser icon, , in the upper left corner of the table (Figure 160). 

Figure 160. Field chooser icon in the upper left corner of the Unknown Compounds result table

The Field Chooser dialog box opens with a list of all of the column headers for the 
current table in alphabetical order (Figure 161). 

Figure 161. Field Chooser dialog box for the Unknown Compounds result table

2. In the Field Chooser dialog box, clear the check box for each column that you want to 
hide. To show those columns again, select their corresponding check boxes.

The table updates and shows or hides your chosen columns immediately.

Column 1 Heading Column 2 Heading Column 3 Heading 
Column 1 Entry Column 2 Entry Column 3 Entry 

Column 3 Entry Column 2 Entry Column 1 Entry 

1 

2 

Column 1 Heading Column 2 Heading Column 3 Heading 
Column 1 Entry Column 2 Entry Column 3 Entry 

Column 3 Entry Column 2 Entry Column 1 Entry 

1 

2 

Column 1 Heading Column 2 Heading 

Column 3 Heading 

Column 1 Entry Column 2 Entry 

Column 3 Entry 

Column 3 Entry 

Column 2 Entry Column 1 Entry 

1 

2 

Column 3 Heading 

Original
arrangement

New
arrangement

Dragging
column 3
into column 2

Field Chooser icon
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Copying Table Entries to the Clipboard
You can copy a single table row or multiple table rows to the Clipboard, and then paste the 
Clipboard contents into other documents, such as a Notepad text document or Microsoft 
Office documents.

 To copy a single row to the Clipboard

Do one of the following:

• To copy a single row to the Clipboard, right-click the row and choose Copy.

• To copy a single row and the table header, right-click the row and choose Copy with 
Headers.

 To copy multiple rows to the Clipboard

Do one of the following:

• To copy a range of contiguous rows to the Clipboard, while holding down the Shift 
key, click the first and last row in the range. Then, right-click the last row to open the 
shortcut menu and choose Copy to copy the row contents or choose Copy with 
Headers to copy the row contents and the table header.

• To copy noncontiguous rows to the Clipboard, while holding down the CTRL key, 
click each row that you want to copy. Then, right-click the last row to open the 
shortcut menu and choose Copy to copy the row contents or choose Copy with 
Headers to copy the row contents and the table header.

Note  The application does not copy the compound structure in the Structure column of 
the compound library to the Clipboard.
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8

Using the License Manager

Use the License Manager to install new processing workflow nodes as they become available 
and to activate the software license.

Opening the License Manager
Access the License Manager page from the Help menu.

 To open the License Manager page

From the menu bar, choose Help > License Manager.

The License Manager opens as a tabbed document in the Compound Discoverer window 
(Figure 162). For information about the shortcut menu commands for the License 
Manager page, see “Working with Tabbed Documents” on page 15.

Figure 162. License Manager page

Contents

• Opening the License Manager

• Installing or Updating a Processing Workflow Node
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Table 109 describes the License Manager command bar.

Installing or Updating a Processing Workflow Node
The Compound Discoverer application uses a node-based workflow to process raw data files. 
Following set guidelines, you can create your own custom workflow nodes. In addition, 
Thermo Fisher Scientific might occasionally provide custom workflow nodes on its customer 
website.

 To install a new processing workflow node

1. Download the executable files and store them in the appropriate folder on the computer 
where you are running the Compound Discoverer application.

2. Open the License Manager page.

3. Click Scan for Missing Features.

4. Close and reopen the Compound Discoverer application.

5. Choose Help > About.

The About Compound Discoverer dialog box opens with the Patent and Legal Notices 
page displayed.

6. Expand the Nodes list and verify that it lists the new node.

Table 109. License Manager command bar

Command or feature Description

Add Activation Code Opens the License Activation dialog box where you can apply a 
new license and activate the application on the current computer.

Scan for Missing 
Features

Activates a scan for newly installed processing workflow nodes.

Show Expired Licenses Selecting this check box displays any expired licenses.

Show All Licenses Selecting this check box displays the status of your licensed 
Thermo Scientific software applications.
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I

A
Abort command, Job Queue  168
Activation Type parameter  127, 134
Actual Size icon, reporting  276
Add Activation Code button, License Manager  376
Add Files command, study  71
Add Items icon, reporting  276
Add Plot shortcut menu command  185
Add to Custom Explanations shortcut menu command  230
adding

adducts to the library  338
categorical factors to a study  73
compounds to the library  321
custom explanations to a result file  231
input files to a study  79
input files to the Analysis pane  37, 97
ion definitions to the library  345
manual peaks to a specialized trace  183
numeric factors to a study  74
transformations to the library  351

Adduct Editor  338, 340
adducts

deleting  336
editing  339
exporting  337
library  335

Align Columns icon, reporting  275
Alignment Model parameter  125
Alignment property, reporting  282
alignment, chromatographic  20, 25, 27
Analog Tracer node

connections  109
using  137

analyses
reprocessing  170
submitting to the job queue  98
troubleshooting  98

Analysis pane  99

Analysis Results page, study  170
Analysis Validation Issues confirmation box  98
AnchorBottom property, reporting  282
And logical conjunction, filtering with  245
Angle property, reporting  285
Annotate Full Spectrum Tree check box  234
annotations

copying  194
fragmentation scan  189

Appearance properties, reporting  282
Appendix section, reporting  273
Apply Dealkylation parameter  155
Apply Dearylation parameter  155
Apply Filters button, Result Filters view  245
Apply FISh Scoring check box  234
arranging windows, tool for  177
Arriving Group

data entry box  352
result table column  227
Transformations library column  351

Arriving Group parameter  354
As Batch check box, Analysis pane  44, 99
asterisk, study tab  34
Atom Properties dialog box, using  333
Auto Detect File Relations command, File Relations
 page  36, 90, 92

Auto Layout command, Workflows page  116
AutoReplaceFields property, reporting  285
Autosize property, reporting  285
Average Peak Width parameter  22, 159
Axis labels, Scatter Chart view  201

B
BackColor property, reporting  282
Barcode design item  280
BarHeight property, reporting  283
Behavior properties, reporting  285

Index
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Index: C

blank sample type  88
bond multiplicity, changing  332
borders, adding to design items  278
bracket, using in elemental composition formula  145

C
CanGrow property, reporting  285
CaptionPosition property, reporting  283
carbon-14 labeled compounds  334
Caution symbol, Analysis pane  97–98
Ceiling selection, mass defect  122
Centroid Filter node

connections  108
using  120

changes, unsaved  34
Character spacing property, reporting  283
Charge parameter  150
Check icon, structure checking tool  328
Check Structure message box  328
CheckAlignment property, reporting  285
CheckBox design item, reporting  280
Checked property, reporting  285
CheckSumEnabled property  286
Chromatogram Peaks table  228
Chromatogram View, working with  179
Clear All button, Result Filters window  245
Clear Frozen Content shortcut menu command  186
Close Sub-Report icon, reporting  275
Color legend, Scatter Chart view  201
color schemes, selecting for a report template  257
ColumnCount property, reporting  287
ColumnDirection property, reporting  286
columns, application table

changing the order  371
filtering by  50
stacking  371

columns, report
aligning  275, 278
transposing  257

ColumnSpacing property, reporting  287
Compare with Control feature, Peak Consolidator node  43
Compound Discoverer

application window  7
installing  x

Compound Editor dialog box
description  323
shortcut menu  235, 325
using  321

Compound Generator node
connections  110
using  153

Compound library
description  316
exporting to an XML file  319
features  319
importing from an XML file  318
initial  315
opening  317

compounds labeled with carbon-14  334
connections, workflow node  108
Consolidated Peaks table  217
contacting us  xiv
Continuous View icon, reporting  313
control sample type  88
Copy Image shortcut menu command  184
Copy Points shortcut menu command  184
Copy shortcut menu command  203
Copy with Headers shortcut menu command  230
copying

Chromatogram View as a table of data points  184
Chromatogram View as an image  184
Copy to Clipboard dialog box  148
data points from a mass spectrum  147
elemental composition of a compound  146
example files to your computer  30
result tables  230
study factors  76–77

CoverPage section, reporting  273
Create Report icon  252
Create Study button, Starting a New Study dialog box  67, 69
CrossSectionBox design item  281
CrossSectionLine design item  281
CSV file type  6, 148, 230
Culture property, reporting  287
Custom Explanation Editor dialog box  54, 231
Custom Explanation Ions table  225
Custom Explanations table  221
Custom Filter Selection dialog box, features  366
Custom Isotope Ratio Pattern option  149
custom library filters, creating  362
Customize Report dialog box  254

D
data points, minimum number for peak detection  159
Data properties, reporting  287
Data Source, Scatter Chart view  201
DataField property, reporting  288
dealkylation step, description  153
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Index: E

decimal precision for Is Equal To filter  238
Define from Elemental Composition Formula option  149
deleting

adducts, library  336
compounds, library  318
ion definitions, library  342
part of a structure  235
raw data files, effect of  63
study factors  75
study factors in use, effect of  71
transformations, library  349
workflow nodes in the Workflow Tree pane  102
workspace sections, report template  274

Deselect All Visible Points shortcut menu command  203
Deselect Point shortcut menu command  203
design items, report template

adding to a report template  277
Section Report pane  280

Design properties, reporting  290
DetailSection, reporting  273
Dimension Lines icon, reporting  60, 276
direct match annotations  189
directory structure, Compound Discoverer files  68

E
Edit Sub-Report icon  269
editors

Adduct Editor  338
categorical factor editor  73
Compound Editor  321
Custom Explanations Editor  231
Ion Definitions Editor  347
Isotope Ratio Editor  144
numeric factor editor  74
Transformation Editor  351

Elemental Composition parameter  149
elements, changing  334
Enable Column Fixing shortcut menu command  230
Enabled property, reporting  286
End property, reporting  290
exclamation symbol  81
Execution State column

Analysis Results page  171
Job Queue page  169

Expected Compound Hits table  208
Expected Compound Ions table  223
Expected Compounds table  206
Expected Finder node

automatic peak width detection algorithm  129
connections  110
using  19–21, 157

Export the License Request option  xi
Export to Text File shortcut menu command  230
exporting

mass spectral scan data  111
reports  311

F
F2 key, using to copy cells  86
Factor Unit box, numeric factor  75
Factory Defaults, Scatter Chart view  202
Field Chooser icon, using to select columns  372
File Relations page  36, 92
filling down contiguous rows on the Samples page  85
Filter Summary page  246
Filterset file

saving  243
summary  246

Find dialog box, reporting  311
Find icon, reporting  311
FISh Scoring node

connections  40, 110
FISh coverage score  115
using  161

FISh Scoring page, Custom Explanations Editor  54
FISh Trace Fragments table  219
FISh Tracer node

connections  109
using  2, 140

Fit Page icon, reporting  313
Fit Width icon, reporting  313
Floor selection, mass defect  122
flowchart, reporting  249
folder structure  66
Font property, reporting  283
ForeColor property, reporting  283
FormatString property, reporting  283
Fractional Mass selection, mass defect  122
Fragment Mode parameter  141
FreeStyle application  147
Freeze Content shortcut menu command  185
freeze pane  370

G
GdiCharSet property, reporting  283
GdiVerticalFont property, reporting  283
generating reports  252
Get from Clipboard button, Isotope Ratio Editor  147
Get from Composition Formula button, Isotope Ratio 
Editor  147
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Index: H

Go to Same Item in Master Table shortcut menu
 command  230

gray status rectangle  211, 218
green border, workflow node with  39
green status rectangle  211, 216, 218
guide tool  177

H
Height property, reporting  290
Hide Grid icon, reporting  276
Highest Charge State parameter  132
Hyperlink property, reporting  288

I
Image property, reporting  288
importing

adduct libraries  336
compound library  6
ion definition libraries  342
library compounds  318
transformation libraries  349

indenting a related table in report templates  257
indicator icon, Result Filters window  244–245
Individual Traces parameter  141
input files

adding to a study  79
adding to the Analysis pane  97

Input Files page, study  83
Input Files table  222
installing the software application  x
Ion Definition Editor dialog box  347
Ion Definitions Editor dialog box  347
Ion Definitions library

adding ion definition  338
adding ion definitions  345
deleting entries  342
description  341
editing  346
exporting  343
features  337, 344
importing ion definitions  336, 342
opening  336, 342

Isotope check box  334
isotope pattern

brackets, using to identify isotopic atoms  145
custom  149
inspecting  50
intensity tolerance  160
nomenclature  4
reevaluating precursors  131

Isotope Ratio Editor, using  144
Isotope Ratios parameter  143

J
Job Queue page  165

K
Keep Zoom shortcut menu command  184
KeepTogether property, reporting  286
Kendrick Formula  122
Known Structure Formats list  33, 322

L
Label design item, reporting  280
labeled compounds  143, 145
Last Changed parameter  77
Layout properties, reporting  290
Leaving Group

parameter  354
result table column  227

Legend Size menu command  47
Legend Size shortcut menu command  185
library filters, custom  362
license key  viii
License Manager page  375
Line design item  280
Line Weight property, reporting  283
LineColor property, reporting  283
lines, adding to report templates  256
LineSpacing property, reporting  283
LineStyle property, reporting  283
Load button, Scatter Chart view  202
Load Filter Set dialog box  245
Location property, reporting  290
logo image

changing  265
selecting  259

Lowest Charge State parameter  132

M
Manual Peak Integration shortcut menu command  186
Manual Peaks table  229
Mass Analyzer parameter  133
Mass Defect Filter node

connections  109
using  121

Mass Defect Type parameter  122
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Index: N

Mass Frontier
software requirement  vi
upgrading  ix

Mass Spectrum View, working with  188
Mass Tracer node

connections  109
using  151

Max. Collision Energy parameter  127, 134
Max. Occurrence parameter  354
Max. Precursor Mass parameter  133
Max. Wavelength parameter  140
Maximum Shift parameter  125
MaxLength property, reporting  288
Min. Collision Energy parameter  127, 134
Min. Precursor Mass parameter  133
Min. Wavelength parameter  140
Minimum Peak Count parameter  133
Miscellaneous properties, reporting  291
MS Order parameter  126, 133, 144, 152
MultiLine property, reporting  286
Multipage view icon, reporting  313

N
NarrowBarWidth property, reporting  284
New Analysis command, study  37, 70–71
NewColumn property, reporting  288
NewPage property, reporting  289
nodes, workflow

connecting  39
parameters  117
summary  111

nomenclature, isotope pattern  4
Nominal Mass Rounding parameter  122
Nucleon Number list  334
NWRatio property, reporting  284

O
Open Analysis Template command, study  70–71
Open Common command, Workflows page  116
opening

Analysis Sequence Details dialog box  171
Atom Properties dialog box  333
Compounds page  317
existing studies  64
Ion Definitions library  336, 342
new studies  67
report template  252
structure files  33, 322
Transformations library  349
Workflows page  101

Options panel, Scatter Chart view  201
Or logical conjunction, filtering with  245
orange status rectangle  211, 216, 218
Order, result table column  228
orientation, report template page  254
OutputFormat property, reporting  284

P
Padding property, reporting  290
page numbers, adding to report templates  259
page orientation, selecting for a report  259
Page Thumbnails pane, reporting  314
PageBreak design item, reporting  280
PageFooter handle, reporting  59
PageFooter section, reporting  273
PageHeader bar, reporting  266
PageHeader section, reporting  273
Pan Mode icon, reporting  277, 313
paper size, selecting for a report  259
Pattern Tracer node

connectons  110
using  142

Pattern Tracer node parameters  143
pausing processing runs  166
PDA detector, chromatograms  137
PDF file type, exporting reports  311
Peak Consolidator node

connections  110
using  163

Phase
parameter  354
result table column  227

Picture design item, reporting  280
PictureAlignment property, reporting  284
pinning

Options panel, Scatter Chart view  197
result table columns  230
study or result files on the Start Page  8
table rows  369

Plot grid, Scatter Chart view  201
Polarity Mode parameter  128, 135
Polarity parameter  144, 152
PrintAtBottom property, reporting  286
printing reports  312
Processing Message Summary page  246
Progress column, Job Queue  169
purple status icon  211
purple status rectangle  216, 218
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Index: Q

Q
QRCode property, reporting  291
Qual Browser application  147
QuietZone property, reporting  284

R
Radius property, reporting  290
red border, workflow node with  39
red circle with exclamation symbol  81
red line, vertical  208, 214
red status rectangle  211, 218
Refresh button, Scatter Chart view  201
Related Structures table  226
related tables

basic targeted workflow  25
indenting in a report template  257
untargeted workflow  26

Relative Intensity shortcut menu command  185
Relative Mass Defect parameter selection  122
Remove All Plots shortcut menu cmmand  185
Remove Analysis Result Files message box  81
Remove Files command, study  35, 71
Remove Input File message box  80
Remove Plot shortcut menu command  185
removing

aligned files from an alignment group  90
chromatogram plots  182, 185
color schemes  258, 262
completed runs from the job queue  166
filter conditions  320, 358
input files from the Input Files page  35, 80
result or study files from the Start Page  9
result tables from the display  204

RepeatToFill property, reporting  286
report designer page

description  263
opening  264
shortcut menu  279

Report Preview dialog box, reporting  309
Report Print dialog box, reporting  309
report resolution page, reporting  309
ReportInfo design item, reporting  281
reporting

Customize Report dialog box, using  254
exporting reports  311
previewing reports  309
printing reports  312
properties

Appearance  282
Behavior  285

Data  287
Design  290
Layout  290
Miscellaneous  291

report templates
creating  254
data-and-time stamp, adding to reports  265
editing  263
page numbers  259

Reprocess command, Analysis Results page  171
requirements

minimum number of data points for peak
 detection  159

software and hardware  vi
Reset File Relations command, File Relations page  91–92
Resolution parameter  150
result files

naming  100
opening  175

Result Filters window  49, 236
result tables

Chromatogram Peaks  228
Consolidated Peaks  217
Custom Explanation Ions  225
Custom Explanations  221
Expected Compound Hits  208
Expected Compound Ions  223
Expected Compounds  206
FISh Trace Fragments  219
Input Files  222
Manual Peaks  229
Related Structures  226
Specialized Traces  205
Transformations  227
Unknown Compound Hits  214
Unknown Compound Ions  224
Unknown Compounds  212

resuming processing runs  166
Retention Time Aligner node

brief description  111
connections  109
limitations  129
using  124

RichTextBox design item, reporting  280
RightToLeft property, reporting  286
Rotation property, reporting  284
Round selection, mass defect  122
rows, table

copying  373
pinning  369
sorting  369

RT Offset parameter  139
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Index: S

Run command, Analysis pane  99
runs

pausing  166
processing  166

S
S/N Threshold parameter  135
sample types  88
Samples page, study  35, 87
Save As icon, report designer page  275
Save Common command, Workflows page  116
Save Data As Text shortcut menu command  203
Save Filter dialog box  245
Save Image As shortcut menu command  184
Save Points As shortcut menu command  184
Save Report Template As dialog box  61
saving

all changes to open pages  10
analysis list on the Analysis Results page  172
analysis templates  99
current page  10
data points to a text file  6
data points to image files  6
filter sets  243
license request file  xi
processing workflow templates  107, 116
report templates  275
result file layout  247
scatter plot  200
study factors  74, 78
study files  93

Scan Event Filter node
connections  109
using  125

Scan for Missing Features button, License Manager  376
Scan Polarity parameter  141
Scan Type parameter  128, 134
scatter plots

copying  200
data points, working with  199
saving  200
zooming  199

Search Results icon, reporting  314
sections, report designer page  272
Select All Visible Points shortcut menu command  203
Select Folder button  67
Select Mode icon, reporting  277
Select Point shortcut menu command  203
Select Study Variables Used for File Relations Detection
 pane  90

Select Template Study File dialog box  67

Selection Mode icon, reporting  311, 313
selection mode, choosing  331
Selection Tool, using  331
Shape design item, reporting  280
SHIFT key, using  369
shifted match annotations  189
shortcut menu commands

Chromatogram View  184
Compound Editor dialog box  235, 325
Mass Spectrum View  194
result tables  230
Scatter Chart view  203
Start Page  9
tabbed documents  17

Show Details command, Analysis Results page  171
Show Details icon, Input Files page  80, 83
Show Detected Peaks shortcut menu command  185
Show Dots icon, reporting  276
Show Gridlines shortcut menu command  185
Show Legend menu command  47
Show Legend shortcut menu command  185
Show Lines icon, reporting  276
Show Study File Details bar, Input Files page  83
Show ToolTips shortcut menu command  185
Show Workflow icon, Analysis pane  99
ShrinkToFit property, reporting  287
Single Page View icon, reporting  313
Size property, reporting  290
SizeMode, reporting  290
sizing bar, report designer page  272, 274
Sleeping status, Job Queue  168
Snap Lines icon, reporting  277
Snap to Grid icon, reporting  277
Snapshot Mode icon, reporting  311, 314
software requirements  vi
Specialized Traces table  205
Spectrum Exporter node

connections  108
using  118

Spectrum Maximum parameter  139
Spectrum Selector node

connections  109
using  129, 131

Standard Mass Defect parameter selection  122
standard sample type  88
Start Page

opening  8
pin icon  8
What Would You Like to Do area  7

Start property, reporting  290
Starting a New Study dialog box  67
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Index: T

status columns
Expected Finder, Consolidated Peaks table  218
In-Control

Consolidated Peaks table  218
Expected Compound Hits table  211
Unknown Compound Hits table  216

Ion Conflict, Consolidated Peaks table  218
Unknown Detector, Consolidated Peaks table  218

status conditions, result filter  240
structure

cleaning  330
creating a mirror image  329
moving  332
resizing  329
rotating  329
saving  332

structure drawing tools, using  325
Structure Editor module

Atom Properties dialog box  333
bond multiplicity  332
bond properties  332
check structure  328
clean structure  330
mirror structure  329
move structure  332
resize structure  329

structure files, opening  33, 322
structure, checking the validity  328
studies

File Relations page  36
Input Files page  83
Samples page  35
Study Definition page  77

Study Summary page  247
Style property, reporting  284
SubReport design item, editing  275
Summed Trace parameter  141
SupplementOptions property, reporting  284

T
table rows

copying  373
pinning  369
sorting  369

Tag property, reporting  289
template tool, using  326
text file  6
Text property, reporting  289
TextJustify property, reporting  284
Thumbnails Pane icon, reporting  314
Toggle Sidebar icon, reporting  312

Total Intensity Threshold parameter  133
Total Scan parameter  139
Trace Type parameter  138, 151
Transformation Editor  351
transformations

adding  351
editing  353
exporting  350
importing  349

Transformations library
description  348
features  350
opening  349

Transformations table  227
Transpose Data Fields shortcut menu command  279
transposing data fields, reporting  278
transposing the columns in a report template  257

U
Undo All Zoom/Pan shortcut menu command  184, 203
Undo Last Zoom/Pan shortcut menu command  184
Unknown Compound Hits table  214
Unknown Compound Ions table  224
Unknown Compounds table  212
Unknown Detector node

connections  110
using  159

unrecognized scan event filters  135
unsaved changes  34
Use Fragmentation Libraries check box  235
Use Isotope Pattern in Precursor Reevaluation parameter  131
Use Libraries for Full Spectrum Tree check box  235
Use Libraries parameter  142
Use New Precursor Reevaluation parameter  131
UV-Vis detectors, chromatograms  137

V
verbose messages, displaying in Job Queue  167
VerticalAlignment property, reporting  284
VerticalText property, reporting  285
Visible property, reporting  287

W
Wavelength Range parameter  139
white status rectangle  211, 216, 218
window position tool  177
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Index: X

workflow nodes
connecting  39
installing  376
list of  117
parameters for

Analog Tracer node  137
Centroid Filter node  120
Compound Generator node  153
Expected Finder node  157
FISh Scoring node  161
FISh Tracer  140
Mass Defect Filter node  121
Mass Tracer node  151
Pattern Tracer node  143
Peak Consolidator node  163
Retention Time Aligner node  124
Scan Event Filter node  125
Spectrum Exporter node  118
Spectrum Selector node  129
Unknown Detector node  159

workspace sections, report designer page  272
Wrapmode property, reporting  285

X
X Axis Type parameter, Scatter Chart view  202

Y
Y Axis Type parameter, Scatter Chart view  202

Z
Z Axis Type parameter, Scatter Chart view  202
Zoom In icon, reporting  276
Zoom Out icon, reporting  276, 312
Zoom Out shortcut menu command  203
Zoom to Detected Peaks shortcut menu command  185
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